Macro Express 5
Manual of Instruction
# Table of Contents

## Introduction
- About Macro Express 5
- Quick Start Guide
- Program Navigation
- Converting from v3 to ME 5

## Installing Macro Express
- Installing Macro Express
- Advanced Installation
- Advanced License Information
- Uninstalling Macro Express

## Tutorials
- Tutorial - Introduction
- Creating a Hot Key Macro
- Creating a ShortKey Macro
- Creating a Scheduled Macro
- Capture a Macro - Capture Icon
- Capture a Macro - System Hot Key
- Create Macro with Quick Wizard
- Create a Popup Menu
- Macro Scopes
- Using Window Controls
- Advanced - Copy and Paste Routine
- Advanced - Using Controls
- Advanced - Using Text String Variables
- Advanced - Using Integer Variables
- Advanced - ASCII Text File Process

## Playing Back Macros
- Macro Activation
- Hot Keys
- ShortKeys
- Schedule
  - Schedule Overview
  - When the Program Starts
  - Once
  - Hourly
  - Daily
  - Weekly
  - Monthly
  - System Idle
  - Specified Time Elapsed
  - When Macro File Loaded
- Window Title
- Mouse Event
- Control Event
- No Activation (None)
- Stopping a Macro

## Using the Macro Explorer
- System Macros
- Macro Explorer
- File Menu
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD-ROM</td>
<td>256</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>256</td>
</tr>
<tr>
<td>Clipboard</td>
<td>258</td>
</tr>
<tr>
<td>Clipboard Copy, Cut, Paste</td>
<td>258</td>
</tr>
<tr>
<td>Clipboard Commands</td>
<td>259</td>
</tr>
<tr>
<td>Clipboard File Copy</td>
<td>261</td>
</tr>
<tr>
<td>Clipboard Graphic Copy</td>
<td>262</td>
</tr>
<tr>
<td>Debug</td>
<td>263</td>
</tr>
<tr>
<td>Log Errors</td>
<td>263</td>
</tr>
<tr>
<td>Log Messages</td>
<td>264</td>
</tr>
<tr>
<td>Desktop</td>
<td>265</td>
</tr>
<tr>
<td>Desktop</td>
<td>265</td>
</tr>
<tr>
<td>Dialogs</td>
<td>266</td>
</tr>
<tr>
<td>Message Box</td>
<td>266</td>
</tr>
<tr>
<td>Multiple Choice Menu</td>
<td>268</td>
</tr>
<tr>
<td>Text Box Display</td>
<td>274</td>
</tr>
<tr>
<td>Update Textbox</td>
<td>277</td>
</tr>
<tr>
<td>Explorer</td>
<td>278</td>
</tr>
<tr>
<td>Open Folder</td>
<td>278</td>
</tr>
<tr>
<td>Open Folder in Explorer</td>
<td>279</td>
</tr>
<tr>
<td>Open Special Explorer Folder</td>
<td>280</td>
</tr>
<tr>
<td>Files or Folders</td>
<td>281</td>
</tr>
<tr>
<td>ASCII File Process</td>
<td>281</td>
</tr>
<tr>
<td>Change Directory/Folder</td>
<td>286</td>
</tr>
<tr>
<td>Convert File Name</td>
<td>287</td>
</tr>
<tr>
<td>Create Folder</td>
<td>288</td>
</tr>
<tr>
<td>Delete Folder</td>
<td>289</td>
</tr>
<tr>
<td>File Manipulation</td>
<td>290</td>
</tr>
<tr>
<td>Set File Attributes</td>
<td>292</td>
</tr>
<tr>
<td>Text File Process</td>
<td>293</td>
</tr>
<tr>
<td>Internet</td>
<td>295</td>
</tr>
<tr>
<td>Email Send</td>
<td>295</td>
</tr>
<tr>
<td>FTP ChMod</td>
<td>300</td>
</tr>
<tr>
<td>FTP Directory</td>
<td>302</td>
</tr>
<tr>
<td>FTP File</td>
<td>304</td>
</tr>
<tr>
<td>FTP Keep Alive</td>
<td>307</td>
</tr>
<tr>
<td>FTP Site Command</td>
<td>308</td>
</tr>
<tr>
<td>FTP Site Connect</td>
<td>310</td>
</tr>
<tr>
<td>Get IP Address</td>
<td>312</td>
</tr>
<tr>
<td>Ping Site</td>
<td>313</td>
</tr>
<tr>
<td>Web FTP Site</td>
<td>315</td>
</tr>
<tr>
<td>Web Mailto</td>
<td>316</td>
</tr>
<tr>
<td>Web Site</td>
<td>317</td>
</tr>
<tr>
<td>Keyboard</td>
<td>319</td>
</tr>
<tr>
<td>Caps, Num and Scroll Lock Keys</td>
<td>319</td>
</tr>
<tr>
<td>Encrypted Text</td>
<td>320</td>
</tr>
<tr>
<td>Text Type</td>
<td>321</td>
</tr>
<tr>
<td>Rich Text</td>
<td>327</td>
</tr>
<tr>
<td>Virtual Keys</td>
<td>329</td>
</tr>
<tr>
<td>Logic</td>
<td>337</td>
</tr>
<tr>
<td>Using IF Statements</td>
<td>337</td>
</tr>
<tr>
<td>And/Or/XOr</td>
<td>339</td>
</tr>
<tr>
<td>Break</td>
<td>341</td>
</tr>
<tr>
<td>Case and Switch</td>
<td>342</td>
</tr>
</tbody>
</table>
Else / End If .......................................................... 345
If Commands ......................................................... 347
  If Clipboard ..................................................... 347
  If Control ......................................................... 349
  If Dial-Up Successful ......................................... 351
  If File Exists .................................................... 353
  If File Ready .................................................... 354
  If Folder Exists ................................................ 355
  If Macro .......................................................... 356
  If Message ....................................................... 358
  If Mouse Cursor ................................................ 360
  If Not File Exists ............................................... 361
  If Not File Ready ............................................... 362
  If Not Folder Exists ........................................... 363
  If Not Mouse Cursor .......................................... 364
  If Not Online ................................................... 365
  If Not Program ................................................ 366
  If Not Window .................................................. 367
  If Online ........................................................ 369
  If OS Version .................................................... 370
  If Ping Successful ............................................. 372
  If Program ...................................................... 374
  If Registry ........................................................ 375
  If Variable ...................................................... 376
  If Window ........................................................ 378
Macro Control ...................................................... 380
  Comment ......................................................... 380
  Load Macro Text File .......................................... 381
  Load New Macro File .......................................... 382
  Macro Delete ..................................................... 383
  Macro Disable .................................................. 384
  Macro Enable .................................................... 385
  Macro Playback Speed ........................................ 386
  Macro Return/Stop ............................................. 387
  Macro Run ....................................................... 388
  Password Protection .......................................... 390
Macro Express ..................................................... 391
  Macro Express Commands .................................... 391
Mouse ................................................................. 393
  Get Mouse Position ............................................ 393
  Mouse Click on Control ....................................... 394
  Mouse Clicks .................................................... 395
  Mouse Move ...................................................... 396
  Mouse Wheel ..................................................... 399
  Move Mouse to Tray Icon ..................................... 400
Multimedia .......................................................... 401
  Audio Controls .................................................. 401
  Beep .............................................................. 402
  Media Player Controls ......................................... 403
  Play Video Clip ................................................ 404
  Sound File ........................................................ 405
Network .............................................................. 406
  Dial-Up Networking ............................................ 406
  Network Connect ............................................... 408
Introduction

Welcome to Macro Express 5

Macro Express is the premier macro utility on the market. Use Macro Express to record, edit and play back mouse and keyboard macros. Its powerful tools and robust features will noticeably boost productivity.

What is a Macro?
A macro is a set of written or recorded commands that can be played back at will to perform a specific task. These tasks can be as simple as inserting a name and address into a word processor to something more complex such as launching a program, copying data from it, activating another program, pasting the data into it and repeating the steps several times.

Tasks performed by macros are typically repetitive in nature allowing significant savings in time by executing the macro instead of manually repeating the commands.

Creating a Macro
There are several methods available to create macros with Macro Express. The simplest is to capture (record) keystrokes and mouse movements. Another method is to use the Quick Wizards to build a macro through a series of questions and prompts. Or build more complex macros with the easy to use Script Editor or Direct Editor. The tutorial provides examples of creating macros using each of these methods.

Playing Back a Macro
Macro Express provides a number of methods for executing macros. These include the use of Hot Keys, Shortkeys, Scheduled Macros, Window Activation, Mouse Clicks, Popup/Floating Menus and others described below.

1. A Hot Key is a set of keys on the keyboard that are pressed to initiate the macro. This could include pressing CTRL+ALT+R or CTRL+F12 or any number of combinations.
2. A Shortkey is a small string of characters. When a matching combination is typed on the keyboard, it is erased and the assigned macro executes. For example, type #add to insert an address into another application.
3. A Scheduled Macro executes on a given time schedule.
4. A Window Activated macro runs when a specific window gains focus (appears) on the computer screen.
5. Run macros by clicking on a specific area of the screen with the left, right or middle Mouse button.
6. A Popup Menu or Floating Menu is basically a list of defined macros. Once the list is displayed, click on the desired macro or press an associated number or letter to execute the macro.
7. Activate a macro through a Batch File or Command Line.
8. Execute macros by using Windows API calls or Windows Explorer.
9. Run a macro from the Macro Explorer by using the Run Macro Now option.

Macro Scopes
Macro scopes may be used to place restrictions on macros. Assign macros to play back in all Windows programs, in one specific window or program, or in every program except the one selected. The tutorial section also provides a few examples of how to do this.
**Quick Start Guide**

Macro Express is a utility to help you automate repetitive computer tasks. In the process it will save you time and money.

This guide covers a few basic concepts to help you better understand Macro Express.

**Starting Macro Express**

The default installation of Macro Express places a shortcut in the Windows Startup folder. This action causes Macro Express to load every time Windows starts. To open the Macro Express window do one of the following:

1. Press the system hot key of Ctrl + Alt + Shift + W
2. Left click on the Macro Express icon in the Windows notification area.
3. If the icon is hidden, left click on the triangle button to show the hidden icons. Left click on the Macro Express icon.

**Player and Editor**

Macro Express is comprised of two main components, the Macro Express Player and the Macro Express Editor.

*Macro Express Player*

The Macro Express Player is what executes macros and it must be running in order for macros to play back. When you run Macro Express, you are really running the Player.

By default, the Macro Express Player shows up as an icon in the notification area. From this icon you can invoke the Macro Express Editor or shut down the Macro Express Player.

You can optionally set the Macro Express Player to be completely hidden so that no icon shows in the notification area. With this option set, you would need to use the "System Macros" to invoke the editor or terminate the program.

*Macro Express Editor*

The Macro Express Editor is the tool used to create and edit macros. The Editor cannot be run by itself. The Player needs to be running in order to open the Editor.

**Macros**

A macro is a script containing commands that automate computer tasks. Each command performs one step, such as moving the mouse, launching a program or entering keystrokes.

There are several methods available for creating macros. No programming language or special skills are
required or necessary.

1. Over two dozen Quick Wizards guide you through a series of questions and build the macro for you.
2. Record keystrokes and mouse movements with the easy to use Capture process.
3. Utilize the Script Editor or Direct Editor to write more powerful macros.

**Macro Activation**

Macro Express provides a number of options for executing (running) a macro.

1. Press a hotkey such as Ctrl + R or Alt + F11. Choose from over 840 combinations.
2. Type a shortkey - a short letter combination from 2 to 32 characters.
3. Run the macro on a schedule - hourly, daily, weekly, monthly or practically any other schedule.
4. Run automatically when a window opens or closes.
5. Click on a specific area of a screen or window.
6. Use popup or floating menus
7. Plus others ...

**Files**

Macros shown in the Macro Express - Explorer window are saved to a .mex macro file. The Explorer window displays the name of the .mex file in use and its location.

When the program is first installed, two .mex files are created - macex.mex and samples.mex.

*macex.mex*

On initial installation, this file does not contain any macros. It is suggested that you start with this file to write and save new macros.

*samples.mex*

The samples.mex file contains a number of sample macros that you may use for reference. It is recommended that you do not use this file as the default to create and store macros.

Additional .mex macro files may also be created for use. Open the Macro Express - Explorer window and click on File and New File to create a new file. Or click on File and Open File to load in a file that you previously created and subsequently closed.

**Converting from prior versions of Macro Express**

Some preferences are not transferred from prior versions of Macro Express. You will need to configure Macro Express by clicking Options and Preferences in the Macro Express Editor. Read the help topic “Upgrading from v3.x” in the Macro Express help for more information.

**Tutorials**

Written Tutorials and Video tutorials walk you through the process of creating and running macros.

**Context Sensitive Help**

Macro Express contains extensive help. Access the appropriate help topic by clicking the Help menu or by pressing F1 in any open Macro Express window.
**Program Navigation**

Macro Express consists of several components which may be accessed by clicking on the icons in the Toolbar or through the menu commands. Each component is briefly discussed below with links provided for more detailed information.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Macro Explorer Icon]</td>
<td><strong>Macro Explorer</strong></td>
<td>By default, the program opens to the Macro Express - Explorer. This displays the list of macros in the file currently open. When saving macros in the editors or other options, the program returns to the Macro Explorer.</td>
</tr>
<tr>
<td>![New Macro Icon]</td>
<td><strong>New Macro</strong></td>
<td>Click on the New Macro button to start the process of building a macro in the Script Editor or Direct Editor. The first step prompts to select an activation method and assign a name to the macro. The next step opens the Script Editor to begin creating the macro. The Script Editor is the default editor. If desired, click on the Direct Editor icon while in the Script Editor to switch to the Direct Editor.</td>
</tr>
<tr>
<td>![Edit Macro Icon]</td>
<td><strong>Edit Macro</strong></td>
<td>Highlight a macro from the list of already created macros. Click on the Edit Macro button to open the Script Editor and display the macro. Or double click on the macro in the list to open it in the Script Editor.</td>
</tr>
<tr>
<td>![Capture Icon]</td>
<td><strong>Capture</strong></td>
<td>Starts the process for recording or capturing a macro. Keystrokes and mouse clicks/movements are recorded and saved.</td>
</tr>
<tr>
<td>![Quick Wizards Icon]</td>
<td><strong>Quick Wizards</strong></td>
<td>Opens the Quick Wizards dialog. There are 25+ different wizards to provide step by step instructions for creating various macro types.</td>
</tr>
<tr>
<td>![Recycle Bin Icon]</td>
<td><strong>Recycle Bin</strong></td>
<td>Macro Express contains its own recycle bin. Any macros deleted from the Macro Explorer are sent to the Recycle Bin. If a macro is deleted by mistake it can be restored to its original file. Or the macros in the recycle bin may be removed permanently.</td>
</tr>
</tbody>
</table>
Converting from v3 to Macro Express

By default, Macro Express installs to a different folder than Macro Express 3.

1. Macro Express 3 files converted to the Macro Express file format cannot be converted back to the older format. Keep backup copies of the version 3 macro files if you ever intend to revert back to Macro Express 3 use.

When converting the file to the Macro Express format, a backup copy of the file in Macro Express 3 format is created. The backup is saved to the same location as the original file.

2. Macros written to automate functions within Macro Express may not convert properly because the Macro Express window titles have changed from v3. The accelerator keys have also changed.
Installing Macro Express

The steps for installing Macro Express are fairly standard.

1. First download the program from www.macros.com/download.htm.
2. Save the downloaded file to a folder on your hard drive.
3. Locate the downloaded file and double click the .exe file to start the installation process.
4. Follow the on screen instructions to complete the install.

If not familiar with Macro Express, please read through the Introduction and Tutorial sections of the Help file.

Licensing Macro Express

If you have purchased the license for Macro Express you will also receive a license code. From the Macro Explorer click on Help > License Macro Express to activate the License Information window. Enter your name and code exactly as they appear on the license instructions you received when you purchased Macro Express. Press OK to save the license information. Your license status will now display in the lower left corner of the Macro Explorer window.

See the Advanced License Information topic for consideration of Administrator and non-Administrator login rights and Macro Express licensing.
**Advanced Installation**

**Silent Install**
A silent install means Macro Express will be installed without the user having to answer any questions during the installation process. This is helpful when installing Macro Express from within another setup program or when installing from a server on a network.

The /S command line parameter instructs the Macro Express installer to do a Silent Install. The /S is case sensitive. For example: macexp.exe /S

**Note:** The Macro Express installation file may be named setup.exe or macexp.exe depending on where the file was obtained. In the examples shown, substitute the actual name of the Macro Express installation file. If the installation file was downloaded in zip format, first unzip setup.exe or macexp.exe from the zip file before running a Silent Install.

**Installation options**
The Macro Express Install program allows for using a text file to automatically respond to the install questions during the installation process. By putting entries in the text file, choose things such as where to install the program, whether Macro Express should be put in the Startup folder so it is automatically launched when Windows starts, or whether the Quick Start Guide should be displayed after Macro Express is installed.

In order to do this, first create a text file, name it and use the /M= command line parameter, which is case sensitive. For this example, we will name the file MESetup.txt.

macexp.exe /M=c:\MESetup.txt

The options listed below may be placed in the setup file. **Do not include spaces either before or after the = character.**

**INSTALLPATH** is used to override the default installation folder. If included, Macro Express is installed in the folder specified by INSTALLPATH.

INSTALLPATH=c:\myprograms\Macro Express

STARTUP=Y puts Macro Express in Windows StartUp folder.
STARTUP=N does not put Macro Express in Windows StartUp folder.

LAUNCHNOW=Y Launches Macro Express after installation is completed.
LAUNCHNOW=N does not Launch Macro Express after installation is completed

QUICKSTARTNOW=Y displays Quick Start Guide the first time Macro Express runs (default).
QUICKSTARTNOW=N prevents Quick Start Guide from being displayed when Macro Express runs.
QUICKSTARTNOW=P or NP prevents the Quick Start Guide from being displayed when Macro Express runs. (Deprecated, included for backward compatibility only.)

WHATSNEWNOW=Y Displays What's New in this version after install
WHATSNEWNOW=N does not display What's New in this version after install

REBOOT=N suppresses the dialog suggesting a reboot after installation is completed, even if the installer has determined that one is needed.

LICENSENAME and LICENSECODE are used to license the software during install:
LICENSENAME=Name used when Macro Express was licensed
LICENSECODE=Code received when Macro Express was licensed
**CONFIGFILEPATH**=path to optional configuration file. This allows for setting a specific configuration of Macro Express at the time the program is installed.

To do this, install Macro Express on a computer and set the preferences to desired settings. Follow by clicking Tools > Export Program Configuration to create a file containing the preferences. Then add CONFIGFILEPATH=c:\macexp.wcfg to the MESetup.txt file.

This example assumes the preference information has been saved in the file c:\macexp.wcfg.

*Note:* Do not add double quotes (" " ) around this path even if it contains a space. For example:  CONFIGFILEPATH=C:\Install\Macro Express\macexp.wcfg

**NOEDITOR**=Y does not install the Macro Express Editor.
**NOEDITOR**=N installs the Macro Express Editor (default).

**NOHELP**=Y does not install the Help file.
**NOHELP**=N installs the Help file (default).

**NOICONS**=Y does not install the sample icons.
**NOICONS**=N installs the sample icons (default).

**INSTALLOLDER**=Y installs all files even if they are older than files already in the destination folder.
**INSTALLOLDER**=N does not overwrite newer files in the destination folder (default).

**MACROFILEDEST**=Path and filename of where to install the macro file macexinstall.mex, if it exists.

This option instructs the installer to copy a macro file named macexinstall.mex to the destination and name you specify. It does not instruct Macro Express to load the macro file when it starts. Use the CONFIGFILEPATH option to specify which macro file(s) to load when Macro Express runs. The macro file macexinstall.mex must exist in the same directory as the install file.

When the MACROFILEDEST installation option is not used, the macro file is installed in the current user's My Documents folder and the name of the macro file is macex.mex.

The **RUNQUIET** option is helpful when installing Macro Express on a network with many users. This option sets several default installation values to suppress from end users the information prompts that are typically displayed during the install process.

**RUNQUIET**=N the program's default values are used for the preferences
**RUNQUIET**=Y the preferences are set to install and run quietly. These options apply to the user installing the program and any new users:
- The Splash Screen is disabled
- The Editor is not loaded when the program starts
- The Quick Start Guide is not displayed
- The What's New document is not displayed
- Keyboard Remapping is disabled
- Backups are disabled
- The First Time setup wizard is disabled
- Macro Halted messages are suppressed
- The notification area balloon is not displayed
- The message asking about file associations is disabled
- The display of periodic messages during 30-day trial is disabled

*Note:* The Run Quiet=Y option takes precedence over the configuration settings in the ConfigFilePath option.
Using Notepad, or some other text editor, create the file MESetup.txt containing the following:

```
INSTALLPATH=c:\Program Files\Example
STARTUP=N
LAUNCHNOW=N
QUICKSTARTNOW=N
REBOOT=N
LICENSENAME=Jason Junior
LICENSECODE=AB3EG-45F9X-1Q200-34CCW-45UNL
```

**Note:** The License Information is for demonstration purposes only. You should use the License Information you received when you purchased Macro Express.

This example installs Macro Express into c:\Program Files\Example. The start menu will be Macro Express. Macro Express will not be launched when Windows is started. Macro Express will not run at the end of the install. The Quick Start Guide will not be displayed at the end of the install. The setup will not reboot the computer. After the installation is complete, the program will be licensed to Jason Junior.

**Note:** Only insert valid options into the MESetup.txt file. Do not include comments, blank lines or remarked out options.

### Silent Install with Options

The Silent Install may be combined with the Installation Options listed above. After creating MESetup.txt install Macro Express with the following command:

```
macexp.exe /S /M=c:\MESetup.txt
```

**Note:** Use uppercase for /S and /M.
Windows can be configured to allow different users to log onto a single computer. Some versions of Windows require a user to log in. Normally only one user is logged in at a time. One or more login names have access to the entire computer and are said to have administrative access rights. Other login names do not have administrative access rights. These login names have restrictions about what they can change on the computer.

If the Name and Code are entered into the License Information dialog when logged in as an administrator, Macro Express is licensed for all users. If, however, the License Information is entered when logged in as a non-administrator, Macro Express is only licensed for that user login.
**Uninstalling Macro Express**

To remove Macro Express from the computer follow the steps below:

1. Click on File > Terminate Macro Express Editor & Player to close Macro Express.
2. From the taskbar, click the Start menu button to open the Start menu.
3. Open the Windows Control Panel.
4. Based on the version of Windows you are running, select the option from the control panel used to uninstall applications.
5. Highlight Macro Express in the list of installed programs.
6. Again, depending on your version of Windows click on the option to remove the program.
7. Follow the on-screen prompts to remove Macro Express from your computer.

**There is not an uninstaller for the [portable version](#). Use Windows Explorer / File Explorer to delete the files.**
Tutorials

Tutorial - Introduction

The tutorials in this section demonstrate how to create various macro types and how to use many of the program features.

Creating Macros

There are several ways to create macros with Macro Express.

1. Capture (record) your keystrokes and mouse movements.
   These two tutorials show different options for recording a macro.

   - Capture a Macro using the Capture Icon
   - Capture a Macro - System Hot Key

2. The Quick Wizard guides you through a series of questions and builds the macro.
   Step through the Quick Wizard tutorial to create a reminder message.

   - Create Macro with Quick Wizard

3. Write the macro in the Direct Editor
   Learn more about the Direct Editor with the HotKey tutorial and how it can be used to write macros.

   - Creating a Hot Key Macro

4. Scripting Editor
   Use the Scripting Editor to create simple to complex macros. Each command is displayed on a separate line in the script for easy viewing and modification. These tutorials demonstrate the use of the Scripting Editor.

   - Creating a Shortkey Macro
   - Creating a Scheduled Macro
   - Using Controls - (Windows 7 and prior)
   - Using Window Controls
   - Copy and Paste between Two Applications
   - ASCII Text File Process
   - Using Text String Variables
   - Using Integer Variables

Other Tutorials

This tutorial shows how to build a popup menu. Create a menu of macros to display on screen and just select the one you want to run.

   - Create a Popup Menu

Determine where macros will run using the macro scope feature. This tutorial shows how to have macros only run in specific programs or windows, run in all but one or several windows, or run in all programs.

   - Macro Scope

The videos for each of these tutorials may be viewed online at www.macros.com.
Creating a Hot Key Macro

In this exercise we will create a macro assigned to a hot key. When complete, pressing the hot key will run the macro.

Setting up the Macro and Assigning the Hot Key

1. From the Macro Express - Explorer menu click on Macro > New Macro to open the Create New Macro window.
2. Hot Key should already be selected as the Initial Activation and the blinking cursor should be in the edit box.
3. If the cursor is not in the edit box, click on the edit box with the mouse to place it there.
4. Hold down the CTRL key, the SHIFT key and the T key at the same time and release them.
5. CTRL+SHIFT+T should appear in the edit box. This is the hot key we will define for the macro.
6. Enter "My Address" in the Nickname field.
7. Click OK to open the Script Editor.
8. Next, click on View > Direct Editor to open the Direct Editor, which we will use to create the macro.

Other methods to create macros are via the Quick Wizards or capturing (recording) a macro. These options are reviewed in other sections.

The Direct Editor looks like the screen shot above.
Creating the Macro

1. In the edit field, type in your address.
2. Click on the Scope Tab and make sure Global is selected. Global is the default option.
3. Click on the Save and Close button to save the macro and close the Editor.
4. Open the Macro Explorer window to see the newly defined macro, My Address, added to the list of available macros.

Playing Back the Macro

1. First, run the notepad program. (Depending on your version of Windows, click on the Windows Start button, enter notepad in the Search field and press enter. Or right click on the Windows Start button, select Run, enter notepad and click OK.)
2. Once notepad is running, hold down the CTRL key, the SHIFT key and the letter T. Then release all the keys.
3. Your address will type out into the notepad program.
Creating a Shortkey Macro

This topic shows how to create a macro assigned to a shortkey. When completed the macro will play back your email address.

Defining Shortkey Default Settings
First, we need to define the default settings that will apply to all shortkey macros that you may later create.

1. From the Macro Express - Explorer menu click on Options > Preferences to load the Preferences window.
2. Click on Activations and then the Shortkeys tab to display the shortkeys options.
3. Select the Use Prefix Keys option and enter z in the Prefix Keys entry box.
4. Click the OK button to return to the Macro Explorer.

Note: This setting requires that z be pressed before typing any shortkey defined or the macro will not play back.

Setting up the Macro and Assigning the Shortkey
1. From the Macro Express Explorer menu click on the New Macro icon to open the Create New Macro window.
2. Select Shortkey from the Initial Activation list.
3. Type "email" (without the quotes) into the Original Shortkey entry space.
4. In the Nickname box, enter My Email Address and click OK to open the Script Editor.

Creating the Macro
1. In the Script Editor click on the Scope tab and make sure Global is selected from the drop down menu.
2. Now click on the Script tab to start writing the macro.
3. Scroll down the list of commands and click on the Keyboard category to expand this listing.
4. Double click on the Text Type command found in this group to activate the Text Type window.
5. Type your email address in the Keystrokes field.
6. If you want to have the macro paste the text into your application via the Windows clipboard, select the Use Clipboard to Paste Text option from the drop down menu. Otherwise the text is inserted into your application using the Simulate Keystrokes default option, which types out the text letter by letter.
7. Press the OK button to save the entry and return to the Script Editor.

Note: A new entry should now appear under the section called Macro Script. This entry should read Text Type: followed by the email address that you entered. If you made a mistake entering your email address, you can double click on this entry and edit the address in the Text Type window.

8. From the Script Editor, click on the Save and Close button to save the macro and close the Script Editor.
9. Open the Macro Explorer to see the newly defined macro, "My Email Address", added to the list of available macros.

Playing Back the Macro
1. To test the macro, run the notepad program. (Depending on your version of Windows, click on the Windows Start button, enter notepad in the Search field and press enter. Or right click on the Windows Start button, select Run, enter notepad and click OK.)
2. Once notepad is running, type the following: zemail
3. Watch as your email address is typed into the notepad program.
Creating a Scheduled Macro

This page demonstrates creating a Scheduled Macro, one that plays back on a schedule. To start, click on the New Macro icon from the Macro Express - Explorer window to open the Create New Macro window.

Setting the Schedule

1. Select Schedule from the Initial Activation list to display the scheduling options.
2. For this example select the "When a Specified Time has Elapsed" from the Run the Macro drop down menu.
3. In the Schedule tab, select 0 hours, 1 minutes and 0 seconds.
4. Click on the Range tab.
5. Select the Play Macro Indefinitely option from the drop down list.
6. You should be able to leave the "Start calculating the next runtime at" fields alone. Check to make sure the time listed is not later than the time on the computer clock. Make sure that the date displays today's date.
7. Leave the "Run the macro between these hours of the day" option not checked.
8. Leave every day of the week selected.
9. Enter "Date and Time" as the macro nickname.
10. Click the OK button to open the Script Editor.

Based on the schedule just set, the macro will run every minute.

Setting the Program Scope

We'll create this macro to only play back in the Notepad window and only if it is already running.

1. Click on the Scope tab and select Window/Program Specific.
2. Click on the Add Window button to open the Select Window dialog.
3. Click on the Visible tab and enter "notepad" (without the quotes) in the Window Title edit field.
4. Select Partial Match from the drop down list.
5. Leave the option "A window with this title must be on top" unchecked.
6. Click OK to save the Scope information.

Building the Macro

1. Click on the Script tab to start writing the macro.
2. To begin, expand the Windows/Programs category of commands.
3. Double click on the Window Activate command.
4. Enter "notepad" (without the quotes) for the Window Title and click on the OK button.
5. Select Partial Match from the drop down list and click OK to save the information and insert into the macro script.
6. Expand the Variables category of commands.
7. Double click on Date/Time to open the Date/Time window.
8. In the Date/Time tab, make sure the "Set it to the current date/time" option is selected.
9. Click on the Operation tab.
10. Select the "Type the Date/Time stamp out" option.
11. Enter "ddMMyyyy h:mm:ss" (without the quotes) in the Choose a Date/Time Format edit box.
12. Click OK to save the changes.

Note: There should be two lines of script displayed in the Script Editor. Double click on either of these entries.
13. From the Script Editor, click on the Save and Close button.
14. Open the Macro Explorer window to see your newly defined macro, Date and Time, added to the list of available macros.

Playing back the Macro
As long as Macro Express is running, a scheduled macro should be ready to execute. However, in this example the scheduled macro will only execute if Notepad is running.

1. To test the macro, run the Notepad program. (Depending on your version of Windows, click on the Windows Start button, enter notepad in the Search field and press enter. Or right click on the Windows Start button, select Run, enter notepad and click OK.)
2. Once Notepad is running, just wait.
3. The date and time is typed into Notepad every minute.

Disabling the Macro
After verifying that the macro works, either delete or disable this macro since you won't want this Scheduled Macro to continue executing every minute indefinitely! To delete the macro, highlight the macro in the Macro Explorer list and choose "Macros > Remove Macro" from the menu.

To keep this example around, but not to play back every minute, right mouse click on the macro. Left click on Disable to disable the macro. The macro is now displayed in the Explorer window with italicized red font and a line drawn through it, depending on Preference settings. This quickly alerts that the macro is disabled and will not play back until it is enabled.
Capture a Macro using the Capture Icon

This example shows how to record a macro. We'll capture the macro in the Windows Paint program. (Depending on your version of Windows, click on the Windows Start button, enter paint in the Search field and press enter. Or right click on the Windows Start button, select Run, enter paint and click OK.)

Once Paint is running, we want to switch directly to Macro Express. Left click on the Macro Express icon in the notification area or if the window is minimized or hidden click on Macro Express icon in the taskbar.

Defining the Macro

1. From the Macro Express - Explorer window click on the Capture icon on the sidebar to open the Create New Macro window.
2. HotKey should be the default Initial Activation and the blinking cursor should be in the HotKey edit box. If the cursor is not in the edit box, click on the edit box with the mouse to place it there.
3. Next, hold down the SHIFT key, the CTRL key and the U key all at the same time. Release the keys to display CTRL+SHIFT+U in the edit box. This is the hot key assigned to the macro we record.
4. Make sure the box next to Wait for the Hot Key to be Released Before Activation is checked.
5. Enter My Paint Drawing as the nickname and click OK.

Defining the Capture Options

The Capture a Macro window opens so that the default capture options may be modified before capturing the macro. The default settings are defined from the Macro Explorer window in Options > Preferences > General - Capture tab. Let’s adjust the capture settings for this macro capture.

Set Scope

The first thing to do is to set the scope so that the macro only starts in the MS Paint program.

1. Click on the Set Scope button to open the Set Scope window.
2. Change the scope to Window/Program Specific if not already selected.
3. Click on the Add Program button to open the Select a Program Window.
4. Click on the Running Processes tab and highlight mspaint.exe.
5. Make sure that the "This program must have a window on top" option is checked.
6. Click OK and click OK again to save and return to the Capture a Macro window.

Other Capture Options

1. Check the Capture the Keystrokes option.
2. Check the Capture Mouse option and select the Relative to Window option from the drop down menu.
3. Make sure the Capture and Restore the Window Size option is checked.
4. Only Capture the Mouse Clicks should not be checked.
5. From the drop down menu select Capture the Macro Speed at Actual Speed .
6. Choose "untitled - Paint" from the drop down list of the Begin Capture in Window section.

Start Recording

Now we are ready to record the mouse movements, clicks and keystrokes.

1. Click on the Capture button. This closes the Capture a Macro window and opens the Paint window.
2. At this point the macro is now recording. We'll just draw a simple face in Paint.
3. Click on a color.
4. Draw a circle and place two eyes, a nose and mouth within the circle.
5. Terminate the capture by pressing the hot key we assigned to the capture - CTRL+SHIFT+U.
6. A message appears indicating that the capture is complete.

Play back the Macro
1. Open the Paint window. If it is not already the active window, click on the Paint entry in the task bar.
2. We need to start with a clean screen in Paint. So click on File > New in Paint and follow the prompts to have a fresh screen.
3. Press the hot key CTRL+SHIFT+U to start the macro playback.

The face just drawn will be redrawn complete with any hesitations made while capturing!
Capture a Macro - System Hot Key

Macro Express has eight hot keys automatically assigned as System Macros. One of these System Macros is called Start / Stop Capture and by default is defined as CTRL+ALT+SHIFT+X. Pressing CTRL+ALT+SHIFT+X starts the recording of a macro. Pressing it a second time stops the recording. The system macro hot key combination may be changed to another hot key combination not presently being used in Macro Express.

Capture Settings
Before recording any macros using the System Hot Key we first need to define the default capture settings.

1. From the Macro Express - Explorer click on Options > Preferences > General and select the Capture tab to display the Capture default settings.

   Note: These are the settings that are used when the System Start / Stop Capture Hot Key function is invoked. These are also the default settings that appear when clicking on the Capture icon to start a macro recording.

2. Leave the scope set to global.
3. Check the Capture Keystrokes option.
4. Check the Capture Mouse option and select the Relative to Window option from the drop down menu.
5. Make sure the Capture the Window Size option is checked.
6. We also want to just capture the mouse clicks. We don’t need to capture every movement of the mouse. If we were drawing or dragging with the mouse, then we would want to capture all mouse movements.
7. Turn off the “Capture at a specific speed” option to capture the macro without any delays. Be careful when doing this. In some applications the macro may play back too fast and not work correctly.
8. Check the Display a Prompt Before Capturing box to display a message indicating the capture is starting.
9. Click OK to save the settings.

Capturing the Macro
An important thing to remember when recording a macro is to make sure that the program to start recording in is active and on top. Our example recording uses the WordPad application.

1. First run the Windows WordPad program. (Depending on your version of Windows, click on the Windows Start button, enter wordpad in the Search field and press enter. Or right click on the Windows Start button, select Run, enter paint and click OK.)
2. Once focus is on WordPad, press CTRL+ALT+SHIFT+X.
3. A notice may appear warning about the use of the ALT key. Click OK.
4. Next appears a notice that the macro is about to start recording. Click the OK button to start recording.

The macro is now recording. Let’s do something fairly simple such as selecting a new font color.

5. Press Alt + h then type C2 to open the text color choices.
6. Arrow down several times to choose a color and press Enter.
7. Terminate the macro capture by pressing the same system macro, CTRL+ALT+SHIFT+X.

Macro Information
The "Create New Macro" window opens for assigning a macro activation.

1. Select HotKey as the Initial Activation if not already the default.
2. Place the cursor in the hotkey edit window and press CTRL+SHIFT+S.
3. Release the keys to display CTRL+SHIFT+S in the edit box and use as the macro activation hot key.
4. Type WordPad Color Change in the nickname field and press OK.

**Play back the macro**
1. Open a WordPad window with a little bit of text in it.
2. Highlight the text in the WordPad window.
3. Press the hot key CTRL+SHIFT+S to run the macro.

The text color is changed to what we chose in the macro.
Create Macro with Quick Wizard

In this tutorial we'll demonstrate how to create a macro using the Quick Wizard. The Wizards will guide us step by step through the creation process. For this example we will create a reminder message to display on screen at the time we designate.

1. From the Macro Express - Explorer window click on the Quick Wizards icon to start the wizard.
2. Select the Create a Reminder, Type Text, Type Date/Time or Type a Symbol option and click on the Next button.
3. Select the Create a Reminder option and click on the Next button.
4. The next screen just points out a few possible uses for the reminders. Click Next to continue.
5. In the Edit window enter the text. For this example, enter "This is a reminder to purchase Macro Express at www.macros.com/orders.htm." Click on the Next button to continue.
6. Select the Sound Beep notification option to also play a beep when the macro runs.
7. Check the box next to Delete this macro after displaying the reminder. Once the macro has run, the macro is removed from the list of macros in the Macro Explorer and sent to the Macro Recycle Bin.
8. Click Next to set up the schedule for the reminder message.
9. From the drop down list, change the Macro Run option to Once.
10. Change the Run At time to 15 minutes ahead of the current time.
11. Make sure the date is set to today's date and click Next.
12. Insert "My Reminder" in the Macro Nickname edit field (without the quotes) and click Finish to close the Wizard.

Open the Macro Express Explorer window to see the new macro in the list of created macros. Wait the 15 minutes specified and the reminder message will pop up on the screen.

Close the message and the macro is removed from the macro list in the Explorer window and sent to the Macro Recycle Bin.
Create a Popup Menu

This example demonstrates how to create a popup menu. Before creating a popup menu, you must already have some macros defined. **Note:** If you have not done so, first create both a Hot Key macro and a Shortkey macro as described in the Creating a Hot Key and Shortkey tutorials. This example is based on the assumption that you have already created these macros.

Initial setup of the menu

1. From the Macro Express - Explorer menu click on Macro > New Macro to open the Create New Macro window.
2. Make sure that the Hot Key activation is selected and the cursor is in the hot key edit box.
3. Hold down the ALT key, the SHIFT key and the Z key all at the same time and release them. ALT+SHIFT+Z should appear in the edit box. This is the hot key we will use for the popup macro.
4. Enter My Menu as the macro nickname.
5. Check the box next to build as a Popup macro and click OK to open the Menu Builder.

The Menu Builder

The Menu Builder contains two columns. The left hand column lists all macros available for use in the menu. The right hand column displays the macros that we assign to the menu.

Adding Macros to the Menu

For this example we will only include two macros in the menu. But in practice you can add many more. To build the menu, first highlight the My Address macro (the one we created earlier) and then click on the green Insert button. Next highlight the My Email Address macro (created earlier) and click on the green Insert button. These two macros should now be displayed in the right hand column.

Select Menu Style and Positioning

Before saving the menu, click on the Miscellaneous tab. Make sure the Menu is Enabled button is checked. Select Nickname and Scope from the drop down menu as the Menu Style. Enter 100 in both the X and Y menu positioning fields. Check the box next to Place an icon in the notification area option.

Select an Icon to Display in Notification Area

Now let’s select an icon to use with the menu. Right above the Menu tab and to the left of the Menu Nickname is an icon. Hovering the mouse cursor over the icon displays the text - Change Macro Icon. Click on this icon to open the Select an Icon window. Click on the Browse button to open a view of the Macro Express folder.

Double click on the Icons folder to display the folder contents. You will see a number of folders of icon sets as well as individual icons - .ico files. Click on the arrow01d.ico file (a yellow down arrow) and click on the Open button to return to the Select an Icon window. Highlight the icon and click OK. The icon in the Build a Menu window has been changed. This is the icon that will be displayed in the notification area.

Click on Save and Close to save the menu. Return to the Macro Explorer window to see the newly defined popup macro, ALT+SHIFT+Z, added to the list of available macros.

Testing the Popup Menu

There are two methods for activating the menu we created. One is to press the hot key we assigned or to left mouse click on the icon displaying in the notification area.

Hot Key Activation
Let’s test out the popup menu and run the macros in Notepad. (To run notepad, click on Start > Run from the bottom left of the computer screen, enter notepad and click the ok button.) Once notepad is running, hold down the ALT+SHIFT+Z keys.

A menu like the one above should appear, listing the two macros previously defined. Either press the corresponding letter or number next to the macro or double click on the macro in the menu to run the selected macro in notepad.

**Notification Area Activation**

Another way to invoke the popup menu is to left click on the arrow01d.ico icon (yellow arrow pointing down) in the notification area. The "yellow arrow" icon should now be showing in the notification area, because of the settings we chose previously.

**Menu Styles**

The popup menu may be displayed in four different forms, including Nickname and Scope, which is what we are currently using.

**First Part of Macro**

Let’s take a quick look at the other options for displaying the menu. Double click on the Popup Menu macro from the list of macros in the Macro Explorer to open the Menu Builder window. Click on the Miscellaneous tab. Select the First Part of Macro option from the Menu Style drop down list. Click on Menu > Save Menu to save the change. Left click on the "yellow arrow" icon in the notification area. The menu pops up, but this time, it lists the first part of the contents of each macro.

**Icon**

Close the popup menu and return to the Menu Builder. Click on the Miscellaneous tab and select the Icons Only option from the Menu Style drop down list. Next, choose the Horizontal option and enter 10 for Maximum Icons per Row. Click on Menu > Save Menu to save the change. Now click on the "yellow arrow" icon in the notification area. The menu displays, but this time, it shows a list of icons. Click on one of the icons in the menu to run the macro.

**Windows Default**

Return to the Menu Builder and click on the Miscellaneous tab. Select the Windows Default option from the Menu Style drop down list. Click on Menu > Save Menu to save the change. Now click on the "yellow arrow" icon in the notification area. The menu displays as shown below.

Click on the macro you want in order to execute the macro. Windows also assigns underscores to each of the macros, where possible. So in the example above, pressing the M key activates the My Address macro.
Tutorial - Macro Scopes

Macro Scope
The macro scope indicates under what conditions a macro should play back. Four categories are available. They are Global, Global Except, Window Specific and Program Specific.

A. Global macros play back in all Windows programs.
B. Global Except macros run in all Windows programs or windows except the application or window specified.
C. Window Specific macros run only a window that has a matching Window Title as specified by the macro.
D. Program Specific macros only play back in a selected program.

Let's look at some real examples of how this all works. To illustrate the process, let's run two different programs for testing the macro and scope. Run Windows Notepad and Windows WordPad. (Depending on your version of Windows, click on the Windows Start button, enter notepad in the Search field and press enter. Or right click on the Windows Start button, select Run, enter notepad and click OK. Repeat the process for WordPad.)

Global Macro
We have actually already created a couple of Global macros. If you have not created these macros, please refer to the Hot Key section for instructions on creating the CTRL+SHIFT+T macro. A global macro plays back in all Windows programs.

To illustrate, bring Notepad to the foreground (click on it in the taskbar). Now press CTRL+SHIFT+T to see the address typed into the program. Now bring WordPad to the foreground (click on it in the taskbar). Press CTRL+SHIFT+T to see the address typed into WordPad.

Program Specific Macro
We will first change the CTRL+SHIFT+T macro to become a Program Specific macro.

1. Minimize Notepad and WordPad.
2. With Macro Express - Explorer the active window, highlight the CTRL+SHIFT+T macro (nickname of "My Address") from the Macro Explorer and click on the Edit Macro button to open the Script Editor.
3. Click on the Scope tab from the Script Editor.
4. From the Current Scope drop down menu, select Window/Program Specific.
5. Click on the Add Program button to open the Select a Program window.

Note: The Select a Program window has two tabs, Start Menu and Running Processes. The Start Menu tab allows you to look through programs in your Start Menu to locate the .exe file. Or you can click on the Browse button to find the file anywhere on your computer.

6. For our example, click on the Running Processes tab to list all programs currently running on the computer.
7. Make sure that the box next to "This program must have a window on top" is checked.
8. Scroll through the list of programs running and find notepad.exe.
9. Highlight it in the list and click on the OK button.
10. To see what effect the changes have on the macro and bring Notepad to the foreground (click on it in the taskbar). Press CTRL+SHIFT+T to see the address typed into the program.
11. Now bring WordPad to the foreground (click on it in the taskbar). Press CTRL+SHIFT+T. Nothing happens because the macro is set to only work in Notepad.

Global Except
The next step is to change the CTRL+SHIFT+T macro to become a Global Except macro.

1. First minimize Notepad and WordPad.
2. With Macro Express - Explorer the active window, highlight the CTRL+SHIFT+T (nickname of "my address") macro from the Macro Explorer and click on the Edit Macro button to open the Script Editor.
3. Click on the Scope tab.
4. From the Current Scope drop down menu, select Global Except.

We can now choose to have the macro work everywhere except a specific window or program that we select. For this tutorial we will use the program option.

5. Notepad.exe should be displayed as the program that will not allow the macro to work. If not, highlight any entries and click on the Remove button to delete them. With no programs or windows selected click on the Add Programs button. From the Select a Program window click on the Running Processes tab to list all programs currently running on the computer. Make sure that the box next to "This program must have a window on top" is checked. Scroll through the list of programs running and find notepad.exe. Highlight it in the list and click on the OK button.
6. To see what effect the changes have on the macro, bring Notepad to the foreground (click on it in the taskbar) and press CTRL+SHIFT+T. Nothing happens because the macro is defined to not work with Notepad.
7. Now bring Wordpad to the foreground (click on it in the taskbar). Press CTRL+SHIFT+T to see the address typed into the program.
8. Activate another program that accepts text input such as an email program and press CTRL+SHIFT+T. The address types into the program.

**Window Specific Macro**

The last step is to change the CTRL+SHIFT+T macro to become a Window Specific macro. The macro only plays if a window with a specific title is open or on top. (A Window Title is the text that appears in the top caption bar of most windows).

1. First minimize WordPad and Notepad.
2. With Macro Express - Explorer the active window, highlight the CTRL+SHIFT+T macro from the Macro Explorer and click on the Edit Macro button to open the Script Editor.
3. Click on the Scope tab from the Script Editor.
4. From the Current Scope drop down menu, select Windows/Program Specific.
5. Highlight Notepad.exe listed in the edit field.
6. Click on the Remove button to delete this entry.
7. Click on the Add Window button to open the Select Window dialog.

**Note:** The Select Window dialog contains two tabs, Visible and Hidden. You may select a window that is visible or a hidden program window that is never displayed. For this tutorial we will use a Visible window.

8. Highlight Untitled - Notepad.
9. Check the box next to "A window with this title must be on top".
10. Click OK to save.
11. To see what effect these changes have on the macro, bring Notepad to the front of the screen (click on it in the taskbar). Press CTRL+SHIFT+T to see the address typed into the program.
12. Now bring WordPad to the front of the screen (click on it in the taskbar). Press CTRL+SHIFT+T. Nothing happens because CTRL+SHIFT+T is set to only work in an Untitled - Notepad window.
Using Window Controls

This is an example of using Window Controls with Windows 10. The macro sends text to notepad while the program window is minimized to the task bar.

A copy of notepad needs to be open. To do this type notepad in the Search the web and Windows search box in the Task Bar and press Enter.

Select a Macro Activation
For this example we will create a hot key activated macro.

1. From the Macro Express - Explorer click on the New Macro icon to open the Create New Macro window.
2. HotKey should be the default Initial Activation and the blinking cursor should be in the HotKey edit box. If the cursor is not in the edit box, click on the edit box with the mouse to place it there.
3. Press the Ctrl + Alt + 4 keys and release them. Ctrl + Alt + 4 should appear in the edit box.
4. Enter "Text to Notepad" (without the quotes) in the Macro Nickname edit field.
5. Click OK to save the changes and open the Script Editor.

Set the Macro Scope
1. With the Script Editor open, click on the Scope tab.
2. Set the Current Scope to Global.

Writing the Macro
Setting the Control Variable

1. Click on the Script tab.
2. Expand the Window Controls category of commands.
3. Double click on the Get Control command to open the Get Control window.
4. Select the Hide Macro Express option.
5. Click on the Variables button to the right of the Store the Control In field.
6. Expand the Control Variables list and click on the C variable.
7. In the Variable Name field enter the number 2 between the brackets to show C[2] and click OK to save.
8. Click on the Launch Utility button to open the Capture Window Control window.
9. If notepad is not visible on the screen open the program window.
10. Click on the blue X crosshairs on the Capture Window Control window and drag it over top of the notepad edit field. It will be outlined in black as shown.
11. Release the mouse button to insert the control information into the Control Details panel.

12. Click the save button to save the information and return to the Get Control Window which should now look like the following image.
13. Click OK to save and return to the Script Editor.

Sending Text to the Control

1. Expand the Keyboard Category of commands and double click on the Text Type command to open the
Text Type window.
2. Enter some text in the edit field, such as This is a test.
3. Click on the Simulate Keystrokes drop down list and select Send Text Directly to Control.
4. Click on the Variables button to the right of the Control field.
5. Expand the Control Variables list and click on the C variable.
6. In the Variable Name field enter the number 1 between the brackets to show C[1] and click OK to
save the variable selection.
7. Click OK in the Text Type window to save the change and return to the Script Editor.

Macro Script

When finished the macro script should look like the following example. If something is not in the correct
order, highlight the command and click on the Up or Down arrows to the right of the Script and move the
command to its proper location.

```
Get Control: (NOTEPAD.EXE) Using z-order -> %C[1]%
Text Type (Send Text Directly to Control %C[1]%) : This is a test.
```

Run the Macro

Make sure that notepad is running, but minimized to the task bar. Press the Ctrl + Alt + 4 hotkey. Open
Notepad from the task bar. You will notice that the text has been inserted into notepad. The program window
does not need to have focus in order for the text to be inserted.
Copy and Paste Between Two Applications

Below is a simple example of how to set up a copy and paste routine between two applications. Use this as a guideline for creating routines between other applications.

You might be tempted to try and use the ALT+TAB key to switch between programs. This is actually not always reliable and in fact will not even work via Macro Express on some computers due to the low level nature of this key command. The solution is to use the Window Activate command.

Setting up the Macro

a. From the Macro Express - Explorer menu click on Macro > New Macro to open a Create New Macro window.
b. The Initial Activation defaults to HotKey with the text cursor in the HotKey edit box.
c. If not, place the cursor in the edit box. Hold down the CTRL key, the SHIFT key and the P key all at the same time and release them.
d. CTRL+SHIFT+P is placed in the edit box and is the hot key assigned to activate the macro.
e. Enter Copy and Paste in the Nickname field and click OK to open the Script Editor.
f. Click on the Scope tab and make sure that the macro scope is set to global.
g. Click on the Script tab to start building the macro.

Building the Macro in the Script Editor

Step 1 - Give focus to Notepad

a. Expand the Windows/Programs category of commands and double click on the Window Activate command.
b. Enter "notepad" (without the quotes) as the Window title.
c. Make sure the Partial Match option is selected.
d. Click on the OK button to save the entry.

Step 2 - Highlight a line of text in Notepad

The object of the macro is to repetitively copy one line at a time over to WordPad. The first step in this process is to highlight a single line of text. This can be done by using Shift+End.

a. Expand the Keyboard category of commands and double click on the Text Type command.
b. Click on Shift and then End in the list of options in the yellow area of this window to insert <SHIFT><END> into the Keystrokes edit field.
c. Click OK to save the change.

Step 3 - Copy the highlighted text to the clipboard

a. Expand the Clipboard category of commands.
b. Double click on the Clipboard Copy command to insert into the script.

Step 4 - Adjust the text cursor in Notepad to be ready to copy the next line of text

a. Expand the Keyboard category of commands and double click on the Text Type command.
b. Click on Home and then Arrow Down in the list of options in the yellow area of this window to insert <HOME><ARROW DOWN> into the Keystrokes edit field.
c. Click OK to save the change.

Step 5 - Activate and give focus to WordPad

a. Expand the Windows/Programs category of commands and double click on the Window Activate command.
b. In the Activate Window field, enter "wordpad" (without the quotes) as the Window title.
c. Make sure the Partial Match option is selected.
d. Click on the OK button to save the entry.

**Step 6 - Paste the text copied from Notepad into WordPad**

a. Expand the Clipboard category of commands.
b. Double click on the Clipboard Paste command to insert into the script.

**Step 7 - Position the cursor in Wordpad to accept the next paste**

a. Expand the Keyboard category of commands and double click on the Text Type command.
b. Click on Enter in the list of options in the yellow area of this dialog to insert <ENTER> into the Keystrokes edit field.
c. Click OK to save the change.

**Step 8 - Place the macro in a repeat loop to copy multiple lines**

In this example we will set the macro to copy the first 5 lines in notepad over to WordPad.

a. Highlight the first line of the macro script - Activate Window: "notepad".
b. Expand the Repeat category of commands and single click on the Repeat Start option
c. Click on the Insert Command Before Selected arrow - the top green arrow of the three insert arrows to open the Repeat Options window.
d. Make sure the Repeat Start option is selected and enter 5 in the Number of Times to Repeat entry field.
e. Click OK to save the change.

The Repeat command is inserted as the first line of the macro.

**Step 9 - Close the repeat loop**

a. Single click on the End Repeat command.
b. Click on the Add Command to End of Script button - the bottom of the three Insert buttons to insert the End Repeat command as the last command of the macro script.

**Step 10 - Address possible timing issues with Wordpad**

It's possible for Macro Express to send the Clipboard Paste command before WordPad has fully activated. This step will instruct the macro to wait until WordPad is ready to accept text input before continuing.

a. Expand the Timing category of commands and double click on the Wait for Window Title command.
b. Enter wordpad in the Window Title field.
c. Make sure the Partial Match option is selected.
d. Click OK to save the change.
e. Find where the Wait for Window Title was placed in the script and highlight it.
f. Click on the Up or Down Arrow located to the right of the script and move the command so that it is placed directly below the Window Activate: wordpad command.

**Step 11 - Address possible timing issues with Notepad**

Similar to the step above, we need to ensure that Notepad has focus and is ready to receive text input from the macro.

a. Highlight the Wait for Window Title command just inserted and click on the Duplicate button to make a copy of this command. The Duplicate button is located to the right of the macro script.
b. There should now be two Wait for Window Title commands listed in the script.
c. Highlight one of the two commands and click on the Up or Down arrow on the right side of the macro script.
d. Move the command so that it is positioned directly below the Activate Window: "notepad" command.
e. Double click on the Wait for Window Title command that was just moved and change the Window Title from wordpad to notepad.
f. Click OK to save the change.

Step 12 - Save the macro
a. Click on File > Save to save the macro.

Macro Script
The macro script should look like what is displayed below. If the macro does not look like this, arrange the commands so that they are in the following order, using the up and down arrows to the right of the script.

Repeat Start (Repeat 5 times)
- Window Activate: notepad
- Wait for Window Title: notepad
- Text Type (Simulate Keystrokes): <SHIFT><END>
- Clipboard Copy
- Text Type (Simulate Keystrokes): <HOME><ARROW DOWN>
- Window Activate: wordpad
- Wait for Window Title: wordpad
- Clipboard Paste
- Text Type (Simulate Keystrokes): <ENTER>
End Repeat

Testing the Macro
To test the macro run the notepad and WordPad applications. *(Depending on your version of Windows, click on the Windows Start button, enter notepad in the Search field and press enter. Or right click on the Windows Start button, select Run, enter Notepad and click OK. Repeat the process for WordPad.)*

Enter five lines of text into notepad or copy the first five lines of the macro script displayed above and paste them into notepad. Make sure that there are no blank lines between the lines of text. Next, place the mouse cursor at the beginning of the first line of text in notepad. Then press CTRL + Shift + P to start the macro and watch it switch between both programs, copying each line from notepad and pasting into WordPad.
Using Controls

This example provides a simple demonstration of using the window controls with the Windows calculator. Start the calculator program, leave it running and return to Macro Express. *(Depending on your version of Windows, click on the Windows Start button, enter calculator in the Search field and press enter. Or right click on the Windows Start button, select Run, enter calculator and click OK to start the program.)*

**Note:** This macro will not work in Windows 10, since the calculator program in Windows 10 does not use window controls. Look at the Using Window Controls tutorial for a Windows 10 example.

Select a Macro Activation

For this example we will create a hot key activated macro.

1. From the Macro Express - Explorer click on the New Macro icon to open the Create New Macro window.
2. HotKey should be the default Initial Activation and the blinking cursor should be in the HotKey edit box. If the cursor is not in the edit box, click on the edit box with the mouse to place it there.
3. Press the F3 key and then release it. F3 should appear in the edit box.
4. Enter "Clear Calculator" (without the quotes) in the Macro Nickname edit field.
5. Click OK to save the changes and open the Script Editor.

Set the Macro Scope

1. With the Script Editor open, click on the Scope tab.
2. Set the Current Scope to Global.

Naming the Variable

1. Click on the Variables tab.
2. Click on the Add button to open the Variable Properties window.
3. Type calc into the Variable Name field to assign the variable name as "calc".
4. Select Control Variables as the Variable Type.
5. When finished the screen should look like the example below.
6. Click OK to save.

![Variable Properties](image)

Writing the Macro
Setting the Control Variable

1. Click on the Script tab.
2. Expand the Window Controls category of commands.
3. Double click on the Get Control command to open the Get Control window.
4. Place a check in the box next to Hide Macro Express.
5. Click on the Store the Control In field to display a Variables button.
6. Click on the Variables button and expand the Control Variables list.
7. Highlight the "calc" variable and click OK to save.
8. Click on the Launch Utility button to open the Capture Window Control window.
9. If the Calculator program is not visible on the screen open the Calc window.
10. Click on the blue X crosshairs on the Capture Window Control window and drag it over top of the "C" button on the calculator.
11. Release the mouse button to insert the control information into the Control Details panel.
12. Click the save button to save the information and return to the Get Control Window.

Clicking on the Control

1. Expand the Mouse category of commands.
2. Double click on the Mouse Click on Control command to open the Mouse Click on Control window.
3. In this window, the Command listed will be Mouse Click on Control.
4. Select Single Click which should be the default option.
5. Place the cursor in the Control edit box to display the Variables button.
6. Click on the Variables button and expand the Control Variables list.
7. Highlight the "calc" variable and click OK to save.
8. Make sure the button selected is the Left Button.
9. Click on the Advanced tab and ensure that Center is selected as the Click location.
10. Click OK to save.

Macro Script
The script instructs the macro to perform a single left mouse click on the "calc" variable, which is defined as the "C" button on the Calculator. The script should look like the following:

```
Get Control
Mouse Click on Control %calc%
```

Click on Save and Close to save the macro. Open the Macro Explorer to see the F3 macro with a nickname of Clear Calculator listed as an available macro.

**Playing back the Macro**

To test the macro, open the calculator program. Enter some numbers into the calculator. With numbers displayed in the Calculator edit box, press the F3 button. This simulates clicking on the C button of the calculator and clears the display.
Using Text String Variables

Below is an example of using Text String Variables. There are hundreds, even thousands of uses for Text String Variables. This example provides an idea of how they can be used and manipulated.

This macro, when completed, fixes typing transposition errors such as "adn" or "teh" instead of "and" or "the". Just place the cursor between the two transposed letters and press the assigned hot key to correct the typing error.

Setting up the Macro

a. From the Macro Express - Explorer menu click on Macro > New Macro to open a Create New Macro window.
b. The Initial Activation defaults to HotKey with the text cursor in the HotKey edit box.
c. If not, place the cursor in the edit box. Hold down the F4 key and release it.
d. F4 is placed in the edit box and is the hot key assigned to activate the macro.
e. Enter Fix Transposed Letters in the Nickname field and click OK to open the Script Editor.
f. Click on the Scope tab and make sure that the macro scope is set to global.
g. Click on the Script tab to start building the macro.

Building the Macro in the Script Editor

Step 1 - Place a Comment (instructions) at the beginning of the macro.

a. Expand the Macro Control list of commands and double click on the Comment command.
b. Type "Place cursor between the transposed letters" (without the quotes) in the Comments Text edit field.
c. Click OK to save the entry.

The text is displayed in bold blue font in the Script Editor. The Comment line does not do anything in the script. It is just a reminder for later of how to use the macro.

Step 2 - Highlight the two transposed letters

a. Expand the Keyboard category and double click on the Text Type command.
b. Click on Arrow Left from the list of options in the yellow area of this window.
c. Then click on Shift Down, Arrow Right, Arrow Right and Shift Up.
d. Click OK to save and return to the Script Editor.

The entire entry should look like the following:  <ARROW LEFT><SHIFTD><ARROW RIGHT><ARROW RIGHT><SHIFTU>. This step highlights the two transposed characters.

Step 3 - Cut the highlighted text and copy to the clipboard

a. Expand the Clipboard category of commands
b. Double click on Clipboard Cut to insert the clipboard cut command as the next item in the script.

Step 4 - Save the clipboard contents to a text string variable.

a. Expand the Variable category of commands.
b. Double click on Variable Set String to open the Variable Set String window.
c. Select the Set Value from Clipboard option from the drop down menu.
d. Enter %T[1]% in the Destination Variable field and click OK to save.

Step 5 - Save each of the two transposed letters to individual text string variables
Copy the first letter of the variable T[1] and save it to variable T[2].
   a. Expand the Variable category of commands and double click on the Variable Modify String command.
   b. Select Copy Part of Text from the drop down list.
   d. Enter the number "1" (without the quotations) in the Starting Position field.
   e. In the Number of Characters to Copy field enter the number "1" (without the quotations).
   f. Click OK to save.

Copy the second letter of variable T[1] and save it to variable T[3].
   a. Expand the Variable category of commands and double click on the Variable Modify String command.
   b. Select Copy Part of Text from the drop down list.
   d. Enter the number "2" (without the quotations) in the Starting Position field.
   e. In the Number of Characters to Copy field enter the number "1" (without the quotations).
   f. Click OK to save.

Step 6 - Play back the text in the correct order
   a. Expand the Keyboard category and double click on the Text Type command.
   b. Type the following into the Keystrokes edit field: %T[3]%%T[2]%.
   c. Click OK to save and return to the Script Editor.

This types out the second letter of the transposed text first, reversing the order and correcting the typing error.

Step 7 - Save the macro
   a. Click on File > Save to save the macro.

Macro Script
The macro script should look like what is displayed below. If the macro doesn't look like this, arrange the commands so that they are in the following order by using the Up and Down arrows on the right hand side of the Script Editor.

```plaintext
// Place cursor between transposed letters.
Text Type (Simulate Keystrokes): <ARROW LEFT><SHIFTD><ARROW RIGHT><ARROW RIGHT><SHIFTU>
Clipboard Cut
Variable Set String %T[1]% from the clipboard contents
Variable Modify String %T[2]% to a substring in %T[1]% starting at 1 and 1 characters long
Variable Modify String %T[3]% to a substring in %T[1]% starting at 2 and 1 characters long
Text Type (Simulate Keystrokes): %T[3]%%T[2]%
```

Testing the macro
To test the macro, run the notepad program. *(Depending on your version of Windows, click on the Windows Start button, enter notepad in the Search field and press enter. Or right click on the Windows Start button, select Run, enter notepad and click OK.)*

Type the following text into notepad - Tihs is a tset. (Include the typing errors.)

Insert the cursor between the "i" and "h" in the word "Tihs". Press the F4 key to play back the macro. The letters are reversed to correct the spelling to "This". Try the same thing with the misspelled word "tset".
**Note:** If assigning original names to variables, rather than using T[1], D[1], etc., then the following characters are not allowed in the variable name: `[ ] < > , . - + = \ / * %`
Advanced - Using Integer Variables

The object of the completed macro is to generate three random numbers from 1 to 100 and display the results. This macro requires using the Integer Variables as well as Arrays.

Setting up the Macro
From the Macro Express - Explorer click on the New Macro icon to open the Create New Macro window. The Initial Activation should default to HotKey and the blinking cursor should be in the HotKey edit box. If the cursor is not in the edit box, click on the edit box with the mouse to place it there. Next, hold down the CTRL key, the SHIFT key and the R key all at the same time and release them. CTRL+SHIFT+R should appear in the edit box. This is the hot key used to activate the macro.

Enter "Generate Random Numbers" in the Nickname field and click OK to open the Script Editor. Next click on the Scope tab and make sure that the macro scope is set to global. Then click on the Script tab to start building the macro.

Building the Macro in the Script Editor
1) Scroll through the list of commands and expand the Variables category. Double click on the Variable Set Integer command to open the window of the same name.
2) From the drop down list select the Set to a Random Value option.

Creating the variable and array
a) Place the cursor in the Destination Variable field to display the Variables button to the right of the field.
b) Click on the Variables button to open the Insert Variable window.
c) Click on the Add button to open the Variable Properties window.
d) Enter "Random" in the Variable Name field.
e) From the drop down Variable Type list select Integer Variables.
f) Check the box next to Create as an Array.
g) Enter 3 (three) in the Elements field and click OK to return to the Insert Variable window.
h) Expand the list of Integer variables (click on the +) to see the Random variable created.
i) Highlight the Random variable to see Random[ ] displayed in the Variable Name field.
j) Insert the number 1 (one) between the brackets so it displays as Random[1].
k) Click OK to return to the Variable Set Integer command.

3) The Destination Variable field should now display %Random[1]% as the variable.
4) Enter the number 1 (one) in the Minimum Value field.
5) Enter the number 100 (one hundred) in the Maximum Value field.
6) Click OK to save the command and place it in the Script Editor.

Generating the Random Numbers
7) In the Script Editor highlight the Variable Set Integer command shown in the script and click on the Duplicate button twice (on the right hand side of the script) so that you should now see three identical lines in the script.
8) Double click on the second line in the script to open the Variable Set Integer command.
9) Edit the Variable name by replacing the 1 (one) in brackets with a 2 (two). It should now display as %Random[2]%. 
10) Click OK to save and return to the Script Editor.
11) Double click on the third line in the script to open the Variable Set Integer command.
12) Edit the Variable name by replacing the 1 (one) in brackets with a 3 (three). It should now display as %Random[3]%. 

49
13) Click OK to save and return to the Script Editor.

**Have the macro display the results**

These next steps set up the display of the three random numbers in a text box. After completing lines 14 through 27, the Text Box Display command window should look like the image below.

14) Scroll through the list of commands and expand the Dialogs category. Double click on the Text Box Display command to open the window of the same name.
15) Insert “Display Random Numbers” in the Header field.
16) Place the cursor in the Text Box field and the Variables button will appear to the right of the field.
17) Click on the Variables button and expand the Integer Variables type.
18) Select the Random variable to place Random[ ] in the Variable Name field.
19) Insert 1 (one) between the brackets so that it reads as Random[1] and click OK.
20) This places %Random[1]% in the Text Box field.
21) Copy the text %Random[1] to the clipboard. Highlight the text and press Ctrl + C to copy to the clipboard.
22) Move the cursor to the second line (Right Arrow and the Enter key).
23) Press Ctrl + V to paste the text into the second line.
24) Move the cursor to the third line and press Ctrl + V to paste again.
25) You should now have three identical lines of %Random[1]%.
26) In the second line, replace the 1 (one) with 2 (two) so that it reads %Random[2]%.
27) In the third line, replace the 1 (one) with 3 (three) so that it reads %Random[3]%.
28) Click on the OK button to save and return to the Script Editor.
In the Script Editor, click on Script > Save Macro to save the macro just created.

**Macro Script**
The macro script should look like what is displayed below. If the macro does not look like this, arrange the commands so that they are in the following order.

<table>
<thead>
<tr>
<th>Command Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable Set Integer %Random[1]% to a random value between 1 and 100</td>
</tr>
<tr>
<td>Variable Set Integer %Random[2]% to a random value between 1 and 100</td>
</tr>
<tr>
<td>Variable Set Integer %Random[3]% to a random value between 1 and 100</td>
</tr>
<tr>
<td>Text Box Display: Display Random Numbers</td>
</tr>
</tbody>
</table>

**Testing the Macro**
Press Ctrl + Shift + R to run the macro. A text box opens and displays three random numbers between 1 and 100.

**Note:** If assigning original names to variables, rather than using T[1], D[1], etc., then the following characters are not allowed in the variable name: [ ] < > , . - + \ / * %
Advanced - ASCII Text File Process

This sample tutorial reads the contents of a text file in .csv format and inserts the data into another application. Formatting the text to one of the ASCII formats (comma delimited, tab delimited or ASCII delimited) is a quicker and more reliable way to transfer data than the copy and paste routine described in a previous tutorial. The macro reads directly from the file and inputs the results directly into the receiving application. No need to switch back and forth between applications - no copying from one program and pasting to another.

Creating a .csv file
The first step is to create a .csv file with data for the macro to read.

1. Copy the zip code data shown below to the clipboard. (Highlight the text in the Zip Code Data box and press Ctrl + c.)
2. Open the notepad program. (Depending on your version of Windows, click on the Windows Start button, enter notepad in the Search field and press enter. Or right click on the Windows Start button, select Run, enter notepad and click OK.)
3. Place the cursor in the notepad program and press Ctrl + v to paste the text into notepad.
4. Click on File > Save As and make note or remember the location of where the file is about to be saved.
5. In the Name field remove .txt and type UtahZips.csv.
6. Click on the Save button to save the file.

Zip Code Data

<table>
<thead>
<tr>
<th>Zip Code</th>
<th>State</th>
<th>City</th>
<th>County</th>
<th>Area Code</th>
<th>Time Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>84022</td>
<td>UT</td>
<td>TOOELE</td>
<td>DUGWAY</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84023</td>
<td>UT</td>
<td>DUGWAY</td>
<td>DUGWAY</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84024</td>
<td>UT</td>
<td>ECHO</td>
<td>SUMMIT</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84025</td>
<td>UT</td>
<td>FARMINGTON</td>
<td>DAVIS</td>
<td>801</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84026</td>
<td>UT</td>
<td>FORT DUCHESNE</td>
<td>UINTAH</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84027</td>
<td>UT</td>
<td>FRUITLAND</td>
<td>DUCHESNE</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84028</td>
<td>UT</td>
<td>GARDEN CITY</td>
<td>RICH</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84029</td>
<td>UT</td>
<td>GRANTSVILLE</td>
<td>TOOELE</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84031</td>
<td>UT</td>
<td>HANNA</td>
<td>DUCHESNE</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84032</td>
<td>UT</td>
<td>HEBER CITY</td>
<td>WASATCH</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84033</td>
<td>UT</td>
<td>HENEFER</td>
<td>SUMMIT</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
<tr>
<td>84034</td>
<td>UT</td>
<td>IBAPAH</td>
<td>TOOELE</td>
<td>435</td>
<td>-7:00, Y</td>
</tr>
</tbody>
</table>

Setting up the Macro
From the Macro Express - Explorer click on the New Macro icon to open the Create New Macro window. The Initial Activation should default to HotKey and the blinking cursor should be in the HotKey edit box. If the cursor is not in the edit box, click on the edit box with the mouse to place it there. Next, hold down the CTRL key, the SHIFT key and the Z key all at the same time and release them. CTRL+SHIFT+Z should appear in the edit box. This is the hot key used to activate the macro.

Enter "Process Zip Code Data" in the Nickname field and click OK to open the Script Editor. Next click on the Scope tab and make sure that the macro scope is set to global. Then click on the Script tab to start building the macro.

Building the Macro
Process the ASCII Text File
1. Scroll through the list of commands and expand the Files/Folders category. Double click on the ASCII File Begin Process command to open the window of the same name.
2. Change the File Format option to Comma Delimited Text (.csv) from the drop down list.
3. Click on the browse button next to the File Name field and browse to the location of the saved .csv file.
4. Highlight the file and click on the Open button to place the name of the file and file path into the Filename edit box.
5. Place the cursor in the box next to Variable array to receive result and click on the Variables button to open the Insert Variable window.
6. Click on the + sign next to Type: Text Variables to expand the category.
7. Click on the T to place a letter T in the Variable Name field.
8. Click OK to save and return to the ASCII Begin File Process window.
9. Leave the Starting Index set to 1.
10. Leave the Begin processing on record field set to 1 in order to start processing the first line of the text file.
11. Make sure the Process All Records option is selected.
12. Click OK to save and return to the Script Editor.

The window should look like the above when finished, other than the location of the UtahZips.csv file.

**Note:** The T variable is an array that by default allows up to 99 variables - T[1], T[2] and so on up to T[99]. We could also have named our own variable and created the array by clicking on the Add button in the Insert Variable window. This process is described in the Advanced - Using Integer Variables tutorial.

**Insert the text into another application**

1. Scroll through the list of commands and expand the Keyboard category. Double click on the Text Type command to open a window of the same name.
2. Click on the Variables button at the bottom of the window to open the Insert Variable command.
3. Click on the + sign next to Type: Text Variables to expand this category.
4. Click on the T to place T[ ] in the Variable Name field.
5. Enter the number 1 between the brackets so that it looks like T[1].
6. Click OK to save and return to the Text Type window.
7. Highlight the %T[1]% found in the Text Type window and press Ctrl c to copy to the clipboard.
8. Press Enter to move the cursor to the line below the %T[1]% found on the first line and press Ctrl v to paste.
9. %T[1]% should now be displayed on two lines.
10. Move to line 3 and paste again.
11. Repeat the process so that %T[1]% is displayed seven times, each underneath the other.
12. On the last line, press the Enter key twice to move the cursor two lines below the last line of text.
13. Go to line 2 and change %T[1]% to %T[2]%.
14. Go to line 2 and change %T[1]% to %T[3]% and so on.
15. Click OK to save and return to the Script Editor.

End Process ASCII Text File
1. Scroll through the list of commands and expand the Files/Folders category. Double click on the ASCII File End Process command to insert the command at the end of the script.
2. Click on Script > Save Macro to save the macro just created.

Macro Script
The macro should look like the following in the Script Editor. If the macro doesn't look like the script shown below, arrange the commands so that they are in the following order. The file path in the first command most likely will be different, based on where you saved the UtahZips.csv file.

```
ASCII File Begin Process: C:\Insight Software\UtahZips.csv
Text Type (Simulate Keystrokes): %T[1]%
%T[2]%
%T[4]%
%T[5]%
%T[6]%
%T[7]%
```

ASCII File End Process

Playing Back the Macro
Start the WordPad program. (Depending on your version of Windows, click on the Windows Start button, enter wordpad in the Search field and press enter. Or right click on the Windows Start button, select Run, enter wordpad and click OK.) Make sure the text cursor is in the WordPad program and then press CTRL+SHIFT+Z to play back the macro.

The data is inserted in a vertical format as shown below.
Note: This is a simple example of what can be done using the Process an ASCII Text File command. When entering the data into a database, choose which variables to insert and in what order, or add Tabs to move from field to field, etc. Create macros to update the record in the database, wait for a fresh screen, insert the second line of the text file into the database, and so on.
## Playing Back Macros

### Macro Activation

Below is a chart listing the available options for activating a macro.

<table>
<thead>
<tr>
<th>Activation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hot Key</td>
<td>A <strong>hot key</strong> is a key combination such as CTRL+ALT+A, CTRL+Right Mouse Click, etc. The macro activates when the keys are pressed and released.</td>
</tr>
<tr>
<td>Shortkey</td>
<td>A <strong>shortkey</strong> is a set of characters such as abc, myname, etc. The macro activates when the keys are typed into an application.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The macro runs as a <strong>scheduled</strong> event. These events can be scheduled to play at startup of Macro Express, hourly, daily (choose any or all days of the week), weekly, monthly, one given time, every &quot;x&quot; minutes or after &quot;x&quot; minutes of inactivity.</td>
</tr>
<tr>
<td>Window Title</td>
<td>This option looks for a specific <strong>window title</strong>. The macro activates when the window either gains focus, loses focus, opens or closes, depending on the option selected.</td>
</tr>
<tr>
<td>Mouse Event</td>
<td>Use either the left, middle or right <strong>mouse</strong> buttons to activate the macro. Select an area of the screen to click on or designate a window part to click on, such as scroll bar, title bar, buttons, etc. to activate the macro.</td>
</tr>
<tr>
<td>Control Event</td>
<td>The <strong>Control Event</strong> option activates a macro when a specific Windows control or the window that contains the control gains focus. The control may be a window button, edit box or another identifiable portion of a window.</td>
</tr>
<tr>
<td>Floating Menu</td>
<td>A <strong>Floating Menu</strong> is a menu of macros displayed as a floating tool bar and sits on top of other open applications. The floating menu either displays icons (representing the macros), the first part of the text of the macro or the macro nickname and scope. Clicking on one of the macros or typing a corresponding number or letter activates that macro from the floating menu.</td>
</tr>
<tr>
<td>No Activation</td>
<td>No Activation indicates that there is not an activation associated with the macro. In such cases, the macro may be included as a subroutine of another macro using the <strong>Macro Run</strong> command. Or the macro may be used in a popup menu of macros and no other macro activation is desired for the macro.</td>
</tr>
</tbody>
</table>
### Popup Menu

A **popup menu** of macros is a list of macros displayed in a window. Clicking on one of the macros or typing a corresponding number or letter activates that macro from the popup menu. The popup menu itself is activated by either a hot key or by right clicking on a notification area icon. The popup menu may show icons (representing the macros), the first part of the text of the macro or the macro nickname and scope.

### Command Line Parameters

Invoke a macro using a command line parameter. The specific command line parameters to invoke a macro are the /A and /MXE commands. Both the macexp.exe and the meproc.exe programs may be used. See the [command line parameters](#) help section for more detail.

### Windows Explorer / File Explorer

Double clicking on a **playable macro file** (.MXE) from within Windows Explorer/File Explorer executes the macro.

### Run Macro Now

Run a macro from the Macro Express - Explorer by using the Run Macro Now option. Right click on the macro in the Macro Explorer and then left click on the Run Macro Now menu item. Or highlight the macro in the Macro Explorer list and click on the Run Now button.

### Windows API Calls

This option is only intended for the programmer who wants to add macro functionality directly from their own programs. While the command line parameter options can be used via another program, the following method may be much quicker and remove the overhead of having to run an external program such as macexp.exe or meproc.exe.

Instruct the Macro Express Player to directly execute a macro in the currently loaded macro file by specifying its nickname or instruct it to run a playable macro. The macro nickname is case sensitive. If the macro is named QZStart then it must be typed as QZStart, not qzstart, QZSTART, Qzstart, QZstart, or QzStart. If more than one macro shares the same nickname, only the first one found in the macro file is activated.

### Windows API examples

The following examples demonstrate the basic steps of how to activate a macro using Windows API messages and are presented in several different programming languages. These examples assume familiarity with basic Windows API commands and terminology. The process involves posting a series of messages directly to the Macro Express Player.

These examples use the message WM_USER+20 to run a macro within the currently loaded macro file. To run a playable macro, change the messages in the examples from WM_USER+20 to WM_USER+21.
Delphi Example

var
  i  : integer;
  S  : string;
  Hwnd : THandle;
begin
  Hwnd := FindWindow('TMainWin', 'Macro Express Player');
  if(IsWindow(Hwnd)) then
  begin
    S := MacroName;
    for i := 1 to length(S) do
      PostMessage(Hwnd, WM_USER+20, ord(S[i]), 0);
    PostMessage(Hwnd, WM_USER+20, 0, 0);
  end
  else
    ShowMessage('Macro Express is not running');
end;

C/C++/Visual C Example

HWND hwnd = FindWindow("TMainWin", "Macro Express Player");
if( IsWindow(hwnd) ) {
  for(int x = 0; x < strlen(s); x ++)
    PostMessage(hwnd, WM_USER+20, s[i], 0);
  PostMessage(hwnd, WM_USER+20, 0, 0);
}
else
  MessageBox(GetForegroundWindow(), "Macro Express is not running", "Error", 0);
**VBA Example**

HWnd hwnd = FindWindow("TMainWin", "Macro Express Player");
if( IsWindow(hwnd) ) {
    for(int x = 0; x < strlen(s); x ++)
        PostMessage(hwnd, WM_USER+20, s[i], 0);
    PostMessage(hwnd, WM_USER+20, 0, 0);
} else
    MessageBox(GetForegroundWindow(), "Macro Express is not running", "Error", 0);

Private Declare Function FindWindow Lib "User32" Alias "FindWindowA" ( ByVal lpClassName As String, ByVal lpWindowName As String) As Long

Private Declare Function PostMessage Lib "User32" Alias "Porterage" ( ByVal hWnd As Long, ByVal MSG As Long, ByVal wParam As Long, ByVal lParam As Long) As Long

Private Sub Unsacred)
    'Runs a macro express macro

    Const WM_USER = &H400
    Const Command = WM_USER+20
    Const Macroname = "Macroname"

    Dim hwnd, I, Result As Long

    hwnd = FindWindow("TMainWin", "Macro Express Player")
    For I = 1 To Len(Macroname)
        Result = PostMessage(hwnd, Command, Asc(Mid(Macroname, I, 1)), 0)
        Next I
        Result = PostMessage(hwnd, Command, 0, 0)
    End Sub
A hot key is a combination of keys that, when pressed together, plays back a macro. Macro Express allows hot key combinations ranging from a single key up to four keys pressed simultaneously.

To activate a new macro with a hot key, select the HotKey option in the Create New Macro window. Place the cursor in the edit box and hold down the hot key combination wanted. That combination is inserted in the edit box and will be the combination used to activate the macro.

If unsure which combination to use, scroll through the list of keys and highlight the one wanted.

Available Hot Keys
Hot keys designated as Reserved for Windows are used by Windows for specific functions, but may be overridden by Macro Express. For example, Ctrl + C is used to copy highlighted text to the clipboard, but the key may be assigned to Macro Express to perform a different function.

Hot keys shown as Restricted to Windows are reserved by Windows for its own internal use. Depending on the version of Windows being used, these hot keys may not activate Macro Express macros. They will only perform the function assigned by Windows.

Wait for the Hot Key to be Released before Activating
This default setting requires that all keys in the hot key sequence be released in order for the macro to start playing. De-selecting this option allows the macro to start playing as soon as the hot key sequence is pressed.
**Macro Nickname**  
Optionally assign a name to the macro to later help more readily determine what the macro does.

**Build as a Popup Menu**  
Select this option to open the [Menu Builder](#) window and create a popup menu.

---

**Hot Key Combinations**  
Macro Express supports 846 different hot key combinations. Below is a comprehensive list of available hot keys:

<table>
<thead>
<tr>
<th>Ctrl+A</th>
<th>Alt+Shift+U</th>
<th>Ctrl+`</th>
<th>Win+Ctrl+8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+B</td>
<td>Alt+Shift+V</td>
<td>Alt+`</td>
<td>Win+Ctrl+9</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Alt+Shift+W</td>
<td>Ctrl+Shift+`</td>
<td>Win+Ctrl+F1</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Alt+Shift+X</td>
<td>Alt+Shift+`</td>
<td>Win+Ctrl+F2</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Alt+Shift+Y</td>
<td>Ctrl+Alt+`</td>
<td>Win+Ctrl+F3</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Alt+Shift+Z</td>
<td>Ctrl+Alt+Shift+`</td>
<td>Win+Ctrl+F4</td>
</tr>
<tr>
<td>Ctrl+G</td>
<td>Alt+Shift+0</td>
<td>KeyPad /</td>
<td>Win+Ctrl+F5</td>
</tr>
<tr>
<td>Ctrl+H</td>
<td>Alt+Shift+1</td>
<td>Ctrl+Keypad /</td>
<td>Win+Ctrl+F6</td>
</tr>
<tr>
<td>Ctrl+I</td>
<td>Alt+Shift+2</td>
<td>Alt+Keypad /</td>
<td>Win+Ctrl+F7</td>
</tr>
<tr>
<td>Ctrl+J</td>
<td>Alt+Shift+3</td>
<td>Shift+Keypad /</td>
<td>Win+Ctrl+F8</td>
</tr>
<tr>
<td>Ctrl+K</td>
<td>Alt+Shift+4</td>
<td>Ctrl+Shift+Keypad /</td>
<td>Win+Ctrl+F9</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Alt+Shift+5</td>
<td>Alt+Shift+Keypad /</td>
<td>Win+Ctrl+F10</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Alt+Shift+6</td>
<td>Ctrl+Alt+Keypad /</td>
<td>Win+Ctrl+F11</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Alt+Shift+7</td>
<td>Ctrl+Alt+Shift+Keypad /</td>
<td>Win+Ctrl+F12</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Alt+Shift+8</td>
<td>KeyPad *</td>
<td>Win+Alt+A</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Alt+Shift+9</td>
<td>Ctrl+Keypad *</td>
<td>Win+Alt+B</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>----------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Alt+Shift+F1</td>
<td>Alt+Keypad *</td>
<td>Win+Alt+C</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Alt+Shift+F2</td>
<td>Shift+Keypad *</td>
<td>Win+Alt+D</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Alt+Shift+F3</td>
<td>Ctrl+Shift+Keypad *</td>
<td>Win+Alt+E</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Alt+Shift+F4</td>
<td>Alt+Shift+Keypad *</td>
<td>Win+Alt+F</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Alt+Shift+F5</td>
<td>Ctrl+Alt+Keypad *</td>
<td>Win+Alt+G</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Alt+Shift+F6</td>
<td>Ctrl+Alt+Shift+Keypad *</td>
<td>Win+Alt+H</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Alt+Shift+F7</td>
<td>Keypad -</td>
<td>Win+Alt+I</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Alt+Shift+F8</td>
<td>Ctrl+Keypad -</td>
<td>Win+Alt+J</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Alt+Shift+F9</td>
<td>Alt+Keypad -</td>
<td>Win+Alt+K</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Alt+Shift+F10</td>
<td>Shift+Keypad -</td>
<td>Win+Alt+L</td>
</tr>
<tr>
<td>Ctrl+0</td>
<td>Alt+Shift+F11</td>
<td>Ctrl+Shift+Keypad -</td>
<td>Win+Alt+M</td>
</tr>
<tr>
<td>Ctrl+1</td>
<td>Alt+Shift+F12</td>
<td>Alt+Shift+Keypad -</td>
<td>Win+Alt+N</td>
</tr>
<tr>
<td>Ctrl+2</td>
<td>Ctrl+Alt+Shift+A</td>
<td>Ctrl+Alt+Keypad -</td>
<td>Win+Alt+O</td>
</tr>
<tr>
<td>Ctrl+3</td>
<td>Ctrl+Alt+Shift+B</td>
<td>Ctrl+Alt+Shift+Keypad -</td>
<td>Win+Alt+P</td>
</tr>
<tr>
<td>Ctrl+4</td>
<td>Ctrl+Alt+Shift+C</td>
<td>Keypad +</td>
<td>Win+Alt+Q</td>
</tr>
<tr>
<td>Ctrl+5</td>
<td>Ctrl+Alt+Shift+D</td>
<td>Ctrl+Keypad +</td>
<td>Win+Alt+R</td>
</tr>
<tr>
<td>Ctrl+6</td>
<td>Ctrl+Alt+Shift+E</td>
<td>Alt+Keypad +</td>
<td>Win+Alt+S</td>
</tr>
<tr>
<td>Ctrl+7</td>
<td>Ctrl+Alt+Shift+F</td>
<td>Shift+Keypad +</td>
<td>Win+Alt+T</td>
</tr>
<tr>
<td>Ctrl+8</td>
<td>Ctrl+Alt+Shift+G</td>
<td>Ctrl+Shift+Keypad +</td>
<td>Win+Alt+U</td>
</tr>
<tr>
<td>Ctrl+9</td>
<td>Ctrl+Alt+Shift+H</td>
<td>Alt+Shift+Keypad +</td>
<td>Win+Alt+V</td>
</tr>
<tr>
<td>Ctrl+F1</td>
<td>Ctrl+Alt+Shift+I</td>
<td>Ctrl+Alt+Keypad +</td>
<td>Win+Alt+W</td>
</tr>
<tr>
<td>----------</td>
<td>------------------</td>
<td>-------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Ctrl+F2</td>
<td>Ctrl+Alt+Shift+J</td>
<td>Ctrl+Alt+Shift+Keypad +</td>
<td>Win+Alt+X</td>
</tr>
<tr>
<td>Ctrl+F3</td>
<td>Ctrl+Alt+Shift+K</td>
<td>Insert</td>
<td>Win+Alt+Y</td>
</tr>
<tr>
<td>Ctrl+F4</td>
<td>Ctrl+Alt+Shift+L</td>
<td>Delete</td>
<td>Win+Alt+Z</td>
</tr>
<tr>
<td>Ctrl+F5</td>
<td>Ctrl+Alt+Shift+M</td>
<td>Home</td>
<td>Win+Alt+0</td>
</tr>
<tr>
<td>Ctrl+F6</td>
<td>Ctrl+Alt+Shift+N</td>
<td>End&quot;</td>
<td>Win+Alt+1</td>
</tr>
<tr>
<td>Ctrl+F7</td>
<td>Ctrl+Alt+Shift+O</td>
<td>Page Up</td>
<td>Win+Alt+2</td>
</tr>
<tr>
<td>Ctrl+F8</td>
<td>Ctrl+Alt+Shift+P</td>
<td>Page Down</td>
<td>Win+Alt+3</td>
</tr>
<tr>
<td>Ctrl+F9</td>
<td>Ctrl+Alt+Shift+Q</td>
<td>Left Arrow</td>
<td>Win+Alt+4</td>
</tr>
<tr>
<td>Ctrl+F10</td>
<td>Ctrl+Alt+Shift+R</td>
<td>Right Arrow</td>
<td>Win+Alt+5</td>
</tr>
<tr>
<td>Ctrl+F11</td>
<td>Ctrl+Alt+Shift+S</td>
<td>Up Arrow</td>
<td>Win+Alt+6</td>
</tr>
<tr>
<td>Ctrl+F12</td>
<td>Ctrl+Alt+Shift+T</td>
<td>Down Arrow</td>
<td>Win+Alt+7</td>
</tr>
<tr>
<td>Alt+A</td>
<td>Ctrl+Alt+Shift+U</td>
<td>Ctrl+Page Up</td>
<td>Win+Alt+8</td>
</tr>
<tr>
<td>Alt+B</td>
<td>Ctrl+Alt+Shift+V</td>
<td>Alt+Page Up</td>
<td>Win+Alt+9</td>
</tr>
<tr>
<td>Alt+C</td>
<td>Ctrl+Alt+Shift+W</td>
<td>Shift+Page Up</td>
<td>Win+Alt+F1</td>
</tr>
<tr>
<td>Alt+D</td>
<td>Ctrl+Alt+Shift+X</td>
<td>Ctrl+Shift+Page Up</td>
<td>Win+Alt+F2</td>
</tr>
<tr>
<td>Alt+E</td>
<td>Ctrl+Alt+Shift+Y</td>
<td>Alt+Shift+Page Up</td>
<td>Win+Alt+F3</td>
</tr>
<tr>
<td>Alt+F</td>
<td>Ctrl+Alt+Shift+Z</td>
<td>Ctrl+Alt+Page Up</td>
<td>Win+Alt+F4</td>
</tr>
<tr>
<td>Alt+G</td>
<td>Ctrl+Alt+Shift+0</td>
<td>Ctrl+Alt+Shift+Page Up</td>
<td>Win+Alt+F5</td>
</tr>
<tr>
<td>Alt+H</td>
<td>Ctrl+Alt+Shift+1</td>
<td>Ctrl+Page Down</td>
<td>Win+Alt+F6</td>
</tr>
<tr>
<td>Alt+I</td>
<td>Ctrl+Alt+Shift+2</td>
<td>Alt+Page Down</td>
<td>Win+Alt+F7</td>
</tr>
<tr>
<td>Key Combination</td>
<td>Action 1</td>
<td>Action 2</td>
<td>Action 3</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------</td>
<td>-----------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Alt+J</td>
<td>Ctrl+Alt+Shift+3</td>
<td>Shift+Page Down</td>
<td>Win+Alt+F8</td>
</tr>
<tr>
<td>Alt+K</td>
<td>Ctrl+Alt+Shift+4</td>
<td>Ctrl+Shift+Page Down</td>
<td>Win+Alt+F9</td>
</tr>
<tr>
<td>Alt+L</td>
<td>Ctrl+Alt+Shift+5</td>
<td>Alt+Shift+Page Down</td>
<td>Win+Alt+F10</td>
</tr>
<tr>
<td>Alt+M</td>
<td>Ctrl+Alt+Shift+6</td>
<td>Ctrl+Alt+Page Down</td>
<td>Win+Alt+F11</td>
</tr>
<tr>
<td>Alt+N</td>
<td>Ctrl+Alt+Shift+7</td>
<td>Ctrl+Alt+Shift+Page Down</td>
<td>Win+Alt+F12</td>
</tr>
<tr>
<td>Alt+O</td>
<td>Ctrl+Alt+Shift+8</td>
<td>Ctrl+Left Arrow</td>
<td>ESC</td>
</tr>
<tr>
<td>Alt+P</td>
<td>Ctrl+Alt+Shift+9</td>
<td>Alt+Left Arrow</td>
<td>LMouse</td>
</tr>
<tr>
<td>Alt+Q</td>
<td>Ctrl+Alt+Shift+F1</td>
<td>Shift+Left Arrow</td>
<td>Shift+LMouse</td>
</tr>
<tr>
<td>Alt+R</td>
<td>Ctrl+Alt+Shift+F2</td>
<td>Ctrl+Shift+Left Arrow</td>
<td>Ctrl+LMouse</td>
</tr>
<tr>
<td>Alt+S</td>
<td>Ctrl+Alt+Shift+F3</td>
<td>Alt+Shift+Left Arrow</td>
<td>Alt+LMouse</td>
</tr>
<tr>
<td>Alt+T</td>
<td>Ctrl+Alt+Shift+F4</td>
<td>Ctrl+Alt+Left Arrow</td>
<td>Ctrl+Shift+LMouse</td>
</tr>
<tr>
<td>Alt+U</td>
<td>Ctrl+Alt+Shift+F5</td>
<td>Ctrl+Alt+Shift+Left Arrow</td>
<td>Ctrl+Alt+LMouse</td>
</tr>
<tr>
<td>Alt+V</td>
<td>Ctrl+Alt+Shift+F6</td>
<td>Ctrl+Right Arrow</td>
<td>Shift+Alt+LMouse</td>
</tr>
<tr>
<td>Alt+W</td>
<td>Ctrl+Alt+Shift+F7</td>
<td>Alt+Right Arrow</td>
<td>RMouse</td>
</tr>
<tr>
<td>Alt+X</td>
<td>Ctrl+Alt+Shift+F8</td>
<td>Shift+Right Arrow</td>
<td>Shift+RMouse</td>
</tr>
<tr>
<td>Alt+Y</td>
<td>Ctrl+Alt+Shift+F9</td>
<td>Ctrl+Shift+Right Arrow</td>
<td>Ctrl+RMouse</td>
</tr>
<tr>
<td>Alt+Z</td>
<td>Ctrl+Alt+Shift+F10</td>
<td>Alt+Shift+Right Arrow</td>
<td>Alt+RMouse</td>
</tr>
<tr>
<td>Alt+0</td>
<td>Ctrl+Alt+Shift+F11</td>
<td>Ctrl+Alt+Right Arrow</td>
<td>Ctrl+Shift+RMouse</td>
</tr>
<tr>
<td>Alt+1</td>
<td>Ctrl+Alt+Shift+F12</td>
<td>Ctrl+Alt+Shift+Right Arrow</td>
<td>Ctrl+Alt+RMouse</td>
</tr>
<tr>
<td>Alt+2</td>
<td>F1</td>
<td>Ctrl+Up Arrow</td>
<td>Shift+Alt+RMouse</td>
</tr>
<tr>
<td>Alt+3</td>
<td>F2</td>
<td>Alt+Up Arrow</td>
<td>MMouse</td>
</tr>
<tr>
<td>Alt+4</td>
<td>F3</td>
<td>Shift+Up Arrow</td>
<td>Shift+MMouse</td>
</tr>
<tr>
<td>-------</td>
<td>----</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Alt+5</td>
<td>F4</td>
<td>Ctrl+Shift+Up Arrow</td>
<td>Ctrl+MMouse</td>
</tr>
<tr>
<td>Alt+6</td>
<td>F5</td>
<td>Alt+Shift+Up Arrow</td>
<td>Alt+MMouse</td>
</tr>
<tr>
<td>Alt+7</td>
<td>F6</td>
<td>Ctrl+Alt+Up Arrow</td>
<td>Ctrl+Shift+MMouse</td>
</tr>
<tr>
<td>Alt+8</td>
<td>F7</td>
<td>Ctrl+Alt+Shift+Up Arrow</td>
<td>Ctrl+Alt+MMouse</td>
</tr>
<tr>
<td>Alt+9</td>
<td>F8</td>
<td>Ctrl+Down Arrow</td>
<td>Shift+Alt+MMouse</td>
</tr>
<tr>
<td>Alt+F1</td>
<td>F9</td>
<td>Alt+Down Arrow</td>
<td>Win+Space</td>
</tr>
<tr>
<td>Alt+F2</td>
<td>F10</td>
<td>Shift+Down Arrow</td>
<td>Space</td>
</tr>
<tr>
<td>Alt+F3</td>
<td>F11</td>
<td>Ctrl+Shift+Down Arrow</td>
<td>Enter</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>F12</td>
<td>Alt+Shift+Down Arrow</td>
<td>Keypad .</td>
</tr>
<tr>
<td>Alt+F5</td>
<td>F1</td>
<td>Ctrl+Alt+Down Arrow</td>
<td>Alt+KeyPad .</td>
</tr>
<tr>
<td>Alt+F6</td>
<td>Shift+F2</td>
<td>Ctrl+Alt+Shift+Down Arrow</td>
<td>Ctrl+KeyPad .</td>
</tr>
<tr>
<td>Alt+F7</td>
<td>Shift+F3</td>
<td>KeyPad 0</td>
<td>Win+KeyPad 0</td>
</tr>
<tr>
<td>Alt+F8</td>
<td>Shift+F4</td>
<td>Ctrl+Keypad 0</td>
<td>Win+KeyPad 0</td>
</tr>
<tr>
<td>Alt+F9</td>
<td>Shift+F5</td>
<td>Alt+Keypad 0</td>
<td>Win+KeyPad 1</td>
</tr>
<tr>
<td>Alt+F10</td>
<td>Shift+F6</td>
<td>Ctrl+Alt+Keypad 0</td>
<td>Win+KeyPad 2</td>
</tr>
<tr>
<td>Alt+F11</td>
<td>Shift+F7</td>
<td>KeyPad 1</td>
<td>Win+KeyPad 3</td>
</tr>
<tr>
<td>Alt+F12</td>
<td>Shift+F8</td>
<td>Ctrl+Keypad 1</td>
<td>Win+KeyPad 4</td>
</tr>
<tr>
<td>Ctrl+Shift+A</td>
<td>Shift+F9</td>
<td>Alt+Keypad 1</td>
<td>Win+KeyPad 5</td>
</tr>
<tr>
<td>Ctrl+Shift+B</td>
<td>Shift+F10</td>
<td>Ctrl+Alt+Keypad 1</td>
<td>Win+KeyPad 6</td>
</tr>
<tr>
<td>Ctrl+Shift+C</td>
<td>Shift+F11</td>
<td>KeyPad 2</td>
<td>Win+KeyPad 7</td>
</tr>
<tr>
<td>Ctrl+Shift+Y</td>
<td>Alt+Space</td>
<td>Alt+Keypad 7</td>
<td>Win+Alt+KeyPad .</td>
</tr>
<tr>
<td>Ctrl+Shift+Z</td>
<td>Shift+Space</td>
<td>Ctrl+Alt+Keypad 7</td>
<td>Win+Alt+KeyPad 0</td>
</tr>
<tr>
<td>Ctrl+Shift+0</td>
<td>Ctrl+Shift+Space</td>
<td>Keypad 8</td>
<td>Win+Alt+KeyPad 1</td>
</tr>
<tr>
<td>Ctrl+Shift+1</td>
<td>Alt+Shift+Space</td>
<td>Ctrl+Keypad 8</td>
<td>Win+Alt+KeyPad 2</td>
</tr>
<tr>
<td>Ctrl+Shift+2</td>
<td>Ctrl+Alt+Space</td>
<td>Alt+Keypad 8</td>
<td>Win+Alt+KeyPad 3</td>
</tr>
<tr>
<td>Ctrl+Shift+3</td>
<td>Ctrl+Alt+Shift+Space</td>
<td>Ctrl+Alt+Keypad 8</td>
<td>Win+Alt+KeyPad 4</td>
</tr>
<tr>
<td>Ctrl+Shift+4</td>
<td>Ctrl+Insert</td>
<td>Keypad 9</td>
<td>Win+Alt+KeyPad 5</td>
</tr>
<tr>
<td>Ctrl+Shift+5</td>
<td>Alt+Insert</td>
<td>Ctrl+Keypad 9</td>
<td>Win+Alt+KeyPad 6</td>
</tr>
<tr>
<td>Ctrl+Shift+6</td>
<td>Shift+Insert</td>
<td>Alt+Keypad 9</td>
<td>Win+Alt+KeyPad 7</td>
</tr>
<tr>
<td>Ctrl+Shift+7</td>
<td>Ctrl+Shift+Insert</td>
<td>Ctrl+Alt+Keypad 9</td>
<td>Win+Alt+KeyPad 8</td>
</tr>
<tr>
<td>Ctrl+Shift+8</td>
<td>Alt+Shift+Insert</td>
<td>Win+A</td>
<td>Win+Alt+KeyPad 9</td>
</tr>
<tr>
<td>Ctrl+Shift+9</td>
<td>Ctrl+Alt+Insert</td>
<td>Win+B</td>
<td>Win+Alt+KeyPad /</td>
</tr>
<tr>
<td>Ctrl+Shift+F1</td>
<td>Ctrl+Alt+Shift+Insert</td>
<td>Win+C</td>
<td>Win+Alt+KeyPad *</td>
</tr>
<tr>
<td>Ctrl+Shift+F2</td>
<td>Ctrl+Delete</td>
<td>Win+D</td>
<td>Win+Alt+KeyPad -</td>
</tr>
<tr>
<td>Ctrl+Shift+F3</td>
<td>Alt+Delete</td>
<td>Win+E</td>
<td>Win+Alt+KeyPad +</td>
</tr>
<tr>
<td>Ctrl+Shift+F4</td>
<td>Shift+Delete</td>
<td>Win+F</td>
<td>0</td>
</tr>
<tr>
<td>Ctrl+Shift+F5</td>
<td>Ctrl+Shift+Delete</td>
<td>Win+G</td>
<td>1</td>
</tr>
<tr>
<td>Ctrl+Shift+F6</td>
<td>Alt+Shift+Delete</td>
<td>Win+H</td>
<td>2</td>
</tr>
<tr>
<td>Ctrl+Shift+F7</td>
<td>Ctrl+Home</td>
<td>Win+I</td>
<td>3</td>
</tr>
<tr>
<td>Ctrl+Shift+F8</td>
<td>Alt+Home</td>
<td>Win+J</td>
<td>4</td>
</tr>
<tr>
<td>Ctrl+Shift+F9</td>
<td>Shift+Home</td>
<td>Win+K</td>
<td>5</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>Function Description</td>
<td>Windows Key Combination</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------</td>
<td>------------------------</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Shift+F10</td>
<td>Ctrl+Shift+Home</td>
<td>Win+L</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Shift+F11</td>
<td>Alt+Shift+Home</td>
<td>Win+M</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Shift+F12</td>
<td>Ctrl+Alt+Home</td>
<td>Win+N</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+A</td>
<td>Ctrl+Alt+Shift+Home</td>
<td>Win+O</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+B</td>
<td>Ctrl+End</td>
<td>Win+P</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+C</td>
<td>Alt+End</td>
<td>Win+Q</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+D</td>
<td>Shift+End</td>
<td>Win+R</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+E</td>
<td>Ctrl+Shift+End</td>
<td>Win+S</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+F</td>
<td>Alt+Shift+End</td>
<td>Win+T</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+G</td>
<td>Ctrl+Alt+End</td>
<td>Win+U</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+H</td>
<td>Ctrl+Alt+Shift+End</td>
<td>Win+V</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+I</td>
<td>Ctrl+.</td>
<td>Win+W</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+J</td>
<td>Alt+.</td>
<td>Win+X</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+K</td>
<td>Ctrl+Shift+.</td>
<td>Win+Y</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+L</td>
<td>Alt+Shift+.</td>
<td>Win+Z</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+M</td>
<td>Ctrl+Alt+.</td>
<td>Win+0</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+N</td>
<td>Ctrl+Alt+Shift+.</td>
<td>Win+1</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+O</td>
<td>Ctrl+,</td>
<td>Win+2</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+P</td>
<td>Alt+,</td>
<td>Win+3</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+Q</td>
<td>Ctrl+Shift+,</td>
<td>Win+4</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+R</td>
<td>Alt+Shift+,</td>
<td>Win+5</td>
<td></td>
</tr>
<tr>
<td>Keyboard Combination</td>
<td>Description</td>
<td>Function</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+S</td>
<td>Ctrl+Alt+,</td>
<td>Win+6</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+T</td>
<td>Ctrl+Alt+Shift+,</td>
<td>Win+7</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+U</td>
<td>Ctrl+/</td>
<td>Win+8</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+V</td>
<td>Alt+/</td>
<td>Win+9</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+W</td>
<td>Ctrl+Shift+/</td>
<td>Win+F1</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+X</td>
<td>Alt+Shift+/</td>
<td>Win+F2</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+Y</td>
<td>Ctrl+Alt+/</td>
<td>Win+F3</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+Z</td>
<td>Ctrl+Alt+Shift+/</td>
<td>Win+F4</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+0</td>
<td>Ctrl+;</td>
<td>Win+F5</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+1</td>
<td>Alt+;</td>
<td>Win+F6</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+2</td>
<td>Ctrl+Shift+;</td>
<td>Win+F7</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+3</td>
<td>Alt+Shift+;</td>
<td>Win+F8</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+4</td>
<td>Ctrl+Alt+;</td>
<td>Win+F9</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+5</td>
<td>Ctrl+Alt+Shift+;</td>
<td>Win+F10</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+6</td>
<td>Ctrl+&quot;</td>
<td>Win+F11</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+7</td>
<td>Alt+&quot;</td>
<td>Win+F12</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+8</td>
<td>Ctrl+Shift+&quot;</td>
<td>Win+Ctrl+A</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+9</td>
<td>Alt+Shift+&quot;</td>
<td>Win+Ctrl+B</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+F1</td>
<td>Ctrl+Alt+&quot;</td>
<td>Win+Ctrl+C</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+F2</td>
<td>Ctrl+Alt+Shift+&quot;</td>
<td>Win+Ctrl+D</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+F3</td>
<td>Ctrl+\</td>
<td>Win+Ctrl+E</td>
<td></td>
</tr>
<tr>
<td>Ctrl+Alt+F4</td>
<td>Alt+\</td>
<td>Win+Ctrl+F</td>
<td>Shift+C</td>
</tr>
<tr>
<td>Ctrl+Alt+F5</td>
<td>Ctrl+Shift+\</td>
<td>Win+Ctrl+G</td>
<td>Shift+D</td>
</tr>
<tr>
<td>Ctrl+Alt+F6</td>
<td>Alt+Shift+\</td>
<td>Win+Ctrl+H</td>
<td>Shift+E</td>
</tr>
<tr>
<td>Ctrl+Alt+F7</td>
<td>Ctrl+Alt+\</td>
<td>Win+Ctrl+I</td>
<td>Shift+F</td>
</tr>
<tr>
<td>Ctrl+Alt+F8</td>
<td>Ctrl+Alt+Shift+\</td>
<td>Win+Ctrl+J</td>
<td>Shift+G</td>
</tr>
<tr>
<td>Ctrl+Alt+F9</td>
<td>Ctrl+[</td>
<td>Win+Ctrl+K</td>
<td>Shift+H</td>
</tr>
<tr>
<td>Ctrl+Alt+F10</td>
<td>Alt+[</td>
<td>Win+Ctrl+L</td>
<td>Shift+I</td>
</tr>
<tr>
<td>Ctrl+Alt+F11</td>
<td>Ctrl+Shift+[</td>
<td>Win+Ctrl+M</td>
<td>Shift+J</td>
</tr>
<tr>
<td>Ctrl+Alt+F12</td>
<td>Alt+Shift+[</td>
<td>Win+Ctrl+N</td>
<td>Shift+K</td>
</tr>
<tr>
<td>Alt+Shift+A</td>
<td>Ctrl+Alt+[</td>
<td>Win+Ctrl+O</td>
<td>Shift+L</td>
</tr>
<tr>
<td>Alt+Shift+B</td>
<td>Ctrl+Alt+Shift+[</td>
<td>Win+Ctrl+P</td>
<td>Shift+M</td>
</tr>
<tr>
<td>Alt+Shift+C</td>
<td>Ctrl+]</td>
<td>Win+Ctrl+Q</td>
<td>Shift+N</td>
</tr>
<tr>
<td>Alt+Shift+D</td>
<td>Alt+]</td>
<td>Win+Ctrl+R</td>
<td>Shift+O</td>
</tr>
<tr>
<td>Alt+Shift+E</td>
<td>Ctrl+Shift+]</td>
<td>Win+Ctrl+S</td>
<td>Shift+P</td>
</tr>
<tr>
<td>Alt+Shift+F</td>
<td>Alt+Shift+]</td>
<td>Win+Ctrl+T</td>
<td>Shift+Q</td>
</tr>
<tr>
<td>Alt+Shift+G</td>
<td>Ctrl+Alt+]</td>
<td>Win+Ctrl+U</td>
<td>Shift+R</td>
</tr>
<tr>
<td>Alt+Shift+H</td>
<td>Ctrl+Alt+Shift+]</td>
<td>Win+Ctrl+V</td>
<td>Shift+S</td>
</tr>
<tr>
<td>Alt+Shift+I</td>
<td>Ctrl+-</td>
<td>Win+Ctrl+W</td>
<td>Shift+T</td>
</tr>
<tr>
<td>Alt+Shift+J</td>
<td>Alt-</td>
<td>Win+Ctrl+X</td>
<td>Shift+U</td>
</tr>
<tr>
<td>Alt+Shift+K</td>
<td>Ctrl+Shift+-</td>
<td>Win+Ctrl+Y</td>
<td>Shift+V</td>
</tr>
<tr>
<td>Alt+Shift+L</td>
<td>Alt+Shift+-</td>
<td>Win+Ctrl+Z</td>
<td>Shift+W</td>
</tr>
<tr>
<td>Alt+Shift+M</td>
<td>Ctrl+Alt+-</td>
<td>Win+Ctrl+0</td>
<td>Shift+X</td>
</tr>
<tr>
<td>Alt+Shift+N</td>
<td>Ctrl+Alt+Shift+-</td>
<td>Win+Ctrl+1</td>
<td>Shift+Y</td>
</tr>
<tr>
<td>Alt+Shift+O</td>
<td>Ctrl+=</td>
<td>Win+Ctrl+2</td>
<td>Shift+Z</td>
</tr>
<tr>
<td>Alt+Shift+P</td>
<td>Alt+=</td>
<td>Win+Ctrl+3</td>
<td>Backspace</td>
</tr>
<tr>
<td>Alt+Shift+Q</td>
<td>Ctrl+Shift+=</td>
<td>Win+Ctrl+4</td>
<td>;</td>
</tr>
<tr>
<td>Alt+Shift+R</td>
<td>Alt+Shift+=</td>
<td>Win+Ctrl+5</td>
<td>,</td>
</tr>
<tr>
<td>Alt+Shift+S</td>
<td>Ctrl+Alt+=</td>
<td>Win+Ctrl+6</td>
<td></td>
</tr>
<tr>
<td>Alt+Shift+T</td>
<td>Ctrl+Alt+Shift+=</td>
<td>Win+Ctrl+7</td>
<td></td>
</tr>
</tbody>
</table>
**Shortkey**

A shortkey is a set of characters such as abc, myname, etc. When the characters are typed into an application, the macro runs. To create a new macro with a shortkey, select the Shortkey option to display the shortkey edit box. In this field enter a series of characters from two to 32 characters in length.

![Create New Macro](image)

**Note:** Before using the Shortkey option be sure to first define the shortkey default settings. Click on Options > Preferences > Activations - Shortkeys tab to customize the settings.

**Shortkey Specifications**

Up to 32 characters may be entered as an original shortkey. In addition, up to 3 Prefix Keys may optionally be used and are applied to all original shortkeys created. The following Prefix characters may be entered and used:

- The letters A through Z (both upper and lower case)
- The numbers 0 through 9
- The following characters: ! @ # $ % ^ & _ = < > ? . , ; * - / + ` ' " ] and space bar

Alternatively use the suffix key option and press the space bar, the enter key or a suffix character of . , ; ? ! or - after typing the shortkey to activate the macro.
Macro Nickname
Optionally assign a name to the macro to more readily determine what the macro does.

Build as a Popup Menu
Select this option to open the Menu Builder window and create a popup menu.
Schedule

Schedule Overview

Scheduled Macros are macros that can be scheduled to play back at a specific time. Just set the schedule for the macro and it will play back unattended at the designated time. No need to press a hot key or click on an icon. The macro plays back at the selected time. In order for the macro to execute, Macro Express must be running in the background.

There are a number of scheduling options available. These are briefly described below. Click on the links for more detailed information.

<table>
<thead>
<tr>
<th>Schedule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>At Startup</td>
<td>Instructs Macro Express to immediately execute the macro when it first starts up. If Macro Express is in the Start-up group, then this type of macro would play back when Windows first starts.</td>
</tr>
<tr>
<td>Once</td>
<td>Runs the macro on one specific date and one specific time.</td>
</tr>
<tr>
<td>Hourly</td>
<td>The macro runs repeatedly at a specific time each hour.</td>
</tr>
<tr>
<td>Daily</td>
<td>Runs the macro once each day on the days of the week selected.</td>
</tr>
<tr>
<td>Weekly</td>
<td>The macro runs once a week at the time specified.</td>
</tr>
<tr>
<td>Monthly</td>
<td>The macro plays at a specific time on the same day of the month each month.</td>
</tr>
<tr>
<td>System Idle</td>
<td>Runs the macro after the computer has been idle (no keyboard or mouse activity) for the number of minutes selected. This option allows up to 720 minutes after the computer has been idled.</td>
</tr>
</tbody>
</table>
| **When Specified Time has Elapsed** | Repetitively runs a macro every XX number of minutes or seconds. The intervals can be between 1 second and 99,999 minutes, 59 seconds. If a macro is scheduled to run every 1 second and the macro takes 5 seconds to execute, then this function will not operate properly.

If planning to use macros that will run more frequently than every 10 seconds, first change the **Scheduler Frequency** default setting. The default instructs Macro Express to check every 10 seconds to see if a timed macro is ready to play back. This number must be reduced in order for scheduled macros to play back more frequently. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>When Macro File Loaded</strong></td>
<td>This option instructs the macro to play back when the macro file containing the macro is first loaded.</td>
</tr>
</tbody>
</table>

**Note:** Screen Savers prevent a Scheduled Macro from operating correctly. Focus cannot be given to a program if a screen saver is running. Also, the security measures built into the "Lock Workstation" function of Windows 2000, XP and later prevent Macro Express from executing a macro.
When the Program Starts

Running a macro At Startup instructs Macro Express to immediately execute the macro when Macro Express first starts up. If Macro Express is placed in the Start Up folder, the macro plays back as soon as Windows starts and loads Macro Express.

Schedule
Select the preferred schedule option.

Every time this event occurs
This option plays back the scheduled macro every time Macro Express is started.

Only the first time this occurs for the day
This option plays back the scheduled macro the first time Macro Express is started for the day. If the program is restarted, the macro does not play back.

Range
Select a date and time range for the macro to play back from the three options available in the drop down list. These range options are described below.
Run the macro within this date range
Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date when the macro ceases to run.

*Run between these times each day*
Select a start and an end time for the macro to run.

Run the macro between the dates and time
Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the dates and times specified.

Run the macro indefinitely
Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the schedule is canceled or the macro is disabled or deleted.

*Start calculating the next run time at*
Select the date and time to start calculating the next run of the macro.

*Run the macro between these hours of the day*
Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end times.

Run the macro on these days of the week
Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the macro is not needed on weekends.
Once

Use the Once schedule to play only once at one specific date and time. The macro will not play again, unless the schedule is reset.

**Schedule**

Select the Date and Time for the macro to run. Once the macro is run the first time, it will not run again.

**If the activation was missed, run at the next available time**

If the computer was shut down or Macro Express was closed at the scheduled macro run, this option runs the macro later when the computer is started or Macro Express is reopened.

**Range**

Select a date and time range for the macro to play back from the three options available in the drop down list. These range options are described below.

**Run the macro within this date range**

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date when the macro ceases to run.
**Run between these times each day**
Select a start and an end time for the macro to run.

**Run the macro between the dates and time**
Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the dates and times specified.

**Run the macro indefinitely**
Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the schedule is canceled or the macro is disabled or deleted.

**Start calculating the next run time at**
Select the date and time to start calculating the next run of the macro.

**Run the macro between these hours of the day**
Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end times.

**Run the macro on these days of the week**
Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the macro is not needed on weekends.
Hourly

The Hourly schedule runs a macro at a specific time each hour or every xx number of hours.

**Schedule**

Run every [ ] minutes after the top of the hour
Enter the number of minutes after the hour when the macro is set to start. If the macro is to start at 12:15, 1:15, 2:15, etc., then insert 15 into the edit field.

Check again in [ ] hours
The default value is one, which means that the macro runs every hour. Insert the number 2 for the macro to run every two hours, 3 for every three hours, etc.

*If the activation was missed, run at the next available time*
If the computer was shut down or Macro Express was closed at the scheduled macro run, this option runs the macro later when the computer is started or Macro Express is reopened.

*Don’t run the macro again if the time is within [ ] hours and [ ] minutes of the next scheduled runtime*
If the scheduled activation was missed, it may not be desirable to run the macro twice within a short period of time, such as 12:40 and 1:00. Insert a value such as 30 in this field. For example, if the computer restarts at 12:40, the macro does not run because the time is within 30 minutes of the next scheduled macro at 1:00.
Range
Select a date and time range for the macro to play back from the three options available in the drop down list. These range options are described below.

Run the macro within this date range
Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date when the macro ceases to run.

*Run between these times each day*
Select a start and an end time for the macro to run.

Run the macro between the dates and time
Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the dates and times specified.

Run the macro indefinitely
Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the schedule is canceled or the macro is disabled or deleted.

*Start calculating the next run time at*
Select the date and time to start calculating the next run of the macro.

*Run the macro between these hours of the day*
Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end times.

Run the macro on these days of the week
Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the macro is not needed on weekends.
The Daily schedule runs a macro once a day at the time specified.

Schedule
Run at
Enter the time that the macro is to run each day.

Run every [ ] days
The default value is one, which means that the macro runs every day. Insert the number 2 for the macro to run every two days, 3 for every three days, etc.

If the activation was missed, run at the next available time
If the computer was shut down or Macro Express was closed at the scheduled macro run, this option runs the macro later when the computer is started or Macro Express is reopened.

Don't run the macro again if the time is within [ ] hours and [ ] minutes of the next scheduled runtime
If the scheduled activation was missed, it may not be desirable to run the macro twice within a relatively short period of time. For example, let's say that the value is set to 12 hours, the macro is scheduled to run at noon and the computer is shut down before noon. If the computer is not restarted until 6:00am the following day, the skipped macro does not run because the time is within 12 hours of the next scheduled playback at noon.
Range
Select a date and time range for the macro to play back from the three options available in the drop down list. These range options are described below.

Run the macro within this date range
Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date when the macro ceases to run.

  *Run between these times each day*
  Select a start and an end time for the macro to run.

Run the macro between the dates and time
Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the dates and times specified.

Run the macro indefinitely
Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the schedule is canceled or the macro is disabled or deleted.

  *Start calculating the next run time at*
  Select the date and time to start calculating the next run of the macro.

  *Run the macro between these hours of the day*
  Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end times.

Run the macro on these days of the week
Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the macro is not needed on weekends.
Weekly

The Weekly schedule runs a macro once a week at the time specified.

**Schedule**

**Run At**
Enter the time of day and the day of the week that the macro is to run.

**Check again in [ ] weeks**
The default value is one, which means that the macro plays every week. Insert the number "2" to have the macro run every two weeks, "3" for every three weeks, etc.

**If the activation was missed, run at the next available time**
If the computer was shut down or Macro Express was closed at the scheduled macro run, this option runs the macro later when the computer is started or Macro Express is reopened.

**Don't run the macro again if the time is within [ ] hours and [ ] minutes of the next scheduled runtime**
If the scheduled activation was missed, it may not be desirable to run the macro twice within a relatively short period of time. For example, insert a value of "2" in the days field. If the computer is restarted on Monday after being on vacation for a week and the macro is scheduled to run Tuesday, the skipped macro from the prior week does not run because the date is within 2 days of the next scheduled macro set for Tuesday.
Range
Select a date and time range for the macro to play back from the three options available in the drop down list. These range options are described below.

Run the macro within this date range
Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date when the macro ceases to run.

Run between these times each day
Select a start and an end time for the macro to run.

Run the macro between the dates and time
Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the dates and times specified.

Run the macro indefinitely
Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the schedule is canceled or the macro is disabled or deleted.

Start calculating the next run time at
Select the date and time to start calculating the next run of the macro.

Run the macro between these hours of the day
Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end times.

Run the macro on these days of the week
Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the macro is not needed on weekends.
**Monthly**

This schedule runs a macro once a month at the selected time.

---

**Schedule**

**Run at**

To set the monthly schedule first enter the time of day that the macro is to play back. Then select from one of the three monthly date options explained below.

*On the [ ] day of the month*

Select a day of the month to have the macro run, selecting from day 1 - 31. **Note:** If the 31st day of the month is chosen, the macro will not run during the months that only have 28 or 30 days. Select the Last Day of the Month option instead.

*On the first - last*

Use this option to select the first, second, third, fourth, or last day of any day of the week. For example choose to have the macro run on the second Tuesday of each month, the third Friday of the month, etc.

*On the last day of the month*

Use this option to schedule the macro to run the last day of the month.

[Check again in [ ] months]
The default value is one, which means that the macro is scheduled to run every month. Insert the number "2" to have the macro run every two months, "3" for every three months, etc.

*If the activation was missed, run at the next available time*

If the computer was shut down or Macro Express was closed at the scheduled macro run, this option runs the macro later when the computer is started or Macro Express is reopened.

*Don’t run the macro again if the time is within [ ] hours and [ ] minutes of the next scheduled runtime*

If the scheduled activation was missed, it may not be desirable to run the macro twice within a relatively short period of time. If this is the case, then insert a value such as 10 in the days field. If the computer is restarted on the second Monday after being on vacation and the macro is scheduled to run on the third Tuesday, the skipped macro will not run because the time is within 10 days of the next scheduled macro set for Tuesday.

---

**Range**

Select a date and time range for the macro to play back from the three options available in the drop down list. These range options are described below.

**Run the macro within this date range**

Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date when the macro ceases to run.

*Run between these times each day*

Select a start and an end time for the macro to run.

**Run the macro between the dates and time**

Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the dates and times specified.

**Run the macro indefinitely**

Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the schedule is canceled or the macro is disabled or deleted.

*Start calculating the next run time at*

Select the date and time to start calculating the next run of the macro.

*Run the macro between these hours of the day*

Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end times.

**Run the macro on these days of the week**

Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the macro is not needed on weekends.
System Idle

Setting the schedule with the When the system has been idle option plays back the macro after the computer has been idle (no keyboard or mouse activity) for the number of minutes specified. This option allows for up to 720 minutes after the computer has been idled.

Schedule
When the system has been idle for [ ] minutes
Insert the number of minutes the computer must be idle (no keyboard or mouse activity) before the macro starts.

Run every [ ] minutes
This option plays back the macro every X number of minutes if the macro does not use the keyboard or mouse to change the idle state of the computer.
Example
In the image above, the scheduler waits for the system to be idle for 10 minutes. The macro waits 12 minutes before running the macro.

If the macro does not require use of the keyboard or mouse, it plays back again in 12 minutes.

If the macro does change the idle status of the computer, then the macro does not play back again until the system has been idle for 10 minutes followed by the 12 minute wait period.

Only run once
Select this option to only run the macro once after the computer has been idle for the number of minutes specified.

Range
Select a date and time range for the macro to play back from the three options available in the drop down list. These range options are described below.

Run the macro within this date range
Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date when the macro ceases to run.

Run between these times each day
Select a start and an end time for the macro to run.

Run the macro between the dates and time
Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the dates and times specified.

Run the macro indefinitely
Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the schedule is canceled or the macro is disabled or deleted.

Start calculating the next run time at
Select the date and time to start calculating the next run of the macro.

Run the macro between these hours of the day
Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end times.

Run the macro on these days of the week
Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the macro is not needed on weekends.
When a Specified Time has Elapsed

The When a Specified Time has Elapsed option repetitively runs a macro every XX number of hours, minutes and/or seconds.

Schedule
Run every
Enter the time between every scheduled run of the macro. If the macro is to run every 30 minutes, then set the hours and seconds to 0. Set the minutes to 30.

Note 1: If a macro is scheduled to run every 1 second and the macro takes 5 seconds to execute, then this function will not operate properly.

Note 2: If the macro is scheduled to run more frequently than every 10 seconds, it is necessary to change the Scheduler Frequency default setting. This setting instructs Macro Express to check every 10 seconds to see if a scheduled macro is ready to play back. Reduce this number in order for scheduled macros to play back more frequently.

Range
Select a date and time range for the macro to play back from the three options available in the drop down
list. These range options are described below.

**Run the macro within this date range**
Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date when the macro ceases to run.

*Run between these times each day*
Select a start and an end time for the macro to run.

**Run the macro between the dates and time**
Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the dates and times specified.

**Run the macro indefinitely**
Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the schedule is canceled or the macro is disabled or deleted.

*Start calculating the next run time at*
Select the date and time to start calculating the next run of the macro.

*Run the macro between these hours of the day*
Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end times.

**Run the macro on these days of the week**
Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the macro is not needed on weekends.
When the Macro File is Loaded

This is similar to the At Startup schedule with one difference. Any time that the macro file containing the scheduled macro is loaded, the macro runs. When Macro Express loads, the file opens and the macro plays back.

Schedule
Every time this event occurs
Select this option to play back the macro every time the file loads. If another macro file is opened and then the original file containing the scheduled macro is reopened, the macro executes. Or if Macro Express is shut down during the day and later restarted, the macro runs.

Only the first time this occurs for the day
This option limits the playback to just once a day. The first time the file loads for the day, the macro will play back - but not afterwards, until the next day.

Range
Select a date and time range for the macro to play back from the three options available in the drop down list. These range options are described below.
Run the macro within this date range
Select a range of dates during which the macro may run. The macro plays back during the hours of the day and for the duration of the days selected. Select the Start Date when the macro is to first start running. Then select the End Date when the macro ceases to run.

*Run between these times each day*
Select a start and an end time for the macro to run.

Run the macro between the dates and time
Select a starting date and time. Then select an ending date and time. The macro is available to run anytime between the dates and times specified.

Run the macro indefinitely
Run the Macro Indefinitely does not stop the macro on a specific date. It continues to run at the appointed time until the schedule is canceled or the macro is disabled or deleted.

*Start calculating the next run time at*
Select the date and time to start calculating the next run of the macro.

*Run the macro between these hours of the day*
Optionally choose to have the macro only available to run during certain hours of the day. Insert the start and end times.

Run the macro on these days of the week
Select which days of the week to run the macro. For example, remove the check marks from Saturday and Sunday if the macro is not needed on weekends.
Window Title

The Window Title activation instructs the macro to execute any time a specific event occurs for the window title selected.

**Window Title to Look For**

In the edit box, enter the title of the Window for the macro to find. The window title is that which appears in the caption bar of a window. Macro Express examines all window titles running on the computer in an attempt to find a match.

Click on the Browse button to see a list of all windows currently running on the computer. This includes both windows that are visible when open and other system windows that are not seen, though open. Select the window and click OK.

**Partial Match/Exact Match**

The Window Title does not need to be an exact match. A partial match will work. For example, if looking for the Windows Notepad program, one could insert "notepad" or "notep". This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

**The Title contains Wildcards**

Select this option if a wildcard is included in the window title name. A wildcard includes the " * " or " ? ", or " ? "
characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.

Event to Activate On
Select from one of four different events to trigger the macro. These are described below.

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Gains Focus</td>
<td>The macro starts as soon as the specified window becomes the active window and has focus.</td>
</tr>
<tr>
<td>Window Loses Focus</td>
<td>The macro begins playback as soon as the window is minimized or sent to the background.</td>
</tr>
<tr>
<td>Window is Closed</td>
<td>The macro starts when the defined window is closed.</td>
</tr>
<tr>
<td>Window is Opened</td>
<td>The macro starts when the specified window is open.</td>
</tr>
</tbody>
</table>

Macro Nickname
Optionally assign a name to the macro to more readily determine what the macro does.

Build as a Popup Menu
Select this option to open the Menu Builder window and create a popup menu.
Mouse Event

Create macros that run when the mouse button or a combination of mouse buttons is clicked.

Buttons to Activate the Macro with:
Macro activation can be assigned to the Left, Middle or Right mouse buttons or a combination of the three buttons.

What to click on
After assigning the mouse button or buttons to press, select what to click on in order to trigger the macro - Area on Screen, Area on Window or Window Part. These are explained below.

Area on the screen
Use this option to define regions on the screen that can be assigned as a mouse activated macro. Clicking on the assigned area triggers the macro. This option requires the input of four pixel coordinates - Left, Top, Right, and Bottom. Click on the area within these four pixel coordinates to start the macro.

Area on the window
Use this option to define regions on a window that can be assigned as a mouse activated macro. Clicking on this area of the window triggers the macro. This option requires the input of four pixel coordinates - Left, Top, Right, and Bottom. Click on the area within these four pixel coordinates to start the macro.
Locator
Click on the Locator button to launch this small utility to quickly help define the pixel coordinates. After the locator is running, move the mouse to the upper left corner of the region to be defined. Press Ctrl+Space to insert the pixel coordinates in the Left and Top fields. Then move the mouse to the lower right corner of the region to be defined. Press Alt+Space to insert the pixel coordinates into the Right and Bottom fields. Press OK to save the coordinates.

This action defines a square or rectangular area on the screen. Click within the defined square or rectangular area with the designated mouse button to start the macro.

Specific part of a window
Define a macro to start by clicking on a specific part of a window. Parts include the window border, window title bar, window menu, horizontal scroll bar, vertical scroll bar, system menu, minimize button and maximize button.

Note: A few options have been excluded because they will interfere with Windows. These include such things as Left Mouse with the Maximize or Minimize buttons.

Macro Nickname
Optionally assign a name to the macro to more readily determine what the macro does.

Build as a Popup Menu
Select this option to open the Menu Builder window and create a popup menu.
Control Event

For our purposes, Control refers to the identifiable parts of a specific application window. Controls may include such things as a button, an edit box, a toolbar, a window title bar or others. The control may be part of the main application window or be part of a child window (a window within a window).

Launch Utility

The first step is to select the control that will activate the macro. Below is an image of the Capture Window Control window that appears when launching the control utility.

To select a Window Control place the mouse cursor on the crosshair image, hold down the left mouse button and drag the mouse over the control. When dragging the crosshairs over title bars, buttons, edit boxes, forms, toolbars, etc., the outline of the controls are highlighted. Once the control needed is highlighted, release the left mouse button. Click on the Save button to return to the Create New Macro window. The control details are saved in the edit box.
Save the Control Using the Contents of the Control
This option makes the capture of a control more specific and captures the text found in the control. So for example, if capturing an edit box with the word Test in it, during playback the macro looks for the edit box and verifies that it contains the word Test. If the edit box text is changed to something else, such as Reset or left blank, then the control (C1) that was captured will not match the actual control in the window - edit box.

**Note:** Not every button, menu item or component on a program is actually a Control. Sometimes the only control in a given program is the window or dialog that pops up when the program starts. We have also noticed that many of Microsoft's programs seem to have fewer controls than programs from other manufacturers. How the controls work will depend upon the way the program in use is designed.

Hide Macro Express
Hide Macro Express does what it implies. The program hides or gets out of the way after pressing the Launch Get Control Utility. This makes it easier to locate the application containing the control to capture.

Launch the Macro When
After selecting the control, decide when to activate the macro. Choose either when the control gains focus or when the window that contains the control gains focus.

**The Control Gains Focus**
This option requires that the control be part of the active window and the control gain focus. For example the mouse cursor could be in an edit box, giving focus to this control. Or a button may be highlighted and have control.

**The Control's Window Gains Focus**
With this option the macro starts when the window containing the selected control gains focus.

Control Details
This edit box lists the details of the selected control using the Launch Utility. The information should match what was listed in the Capture Window Control window.

---

**Macro Nickname**
Optionally assign a name to the macro to later help more readily determine what the macro does.

**Build as a Popup Menu**
Select this option and click on the OK button to open the [Menu Builder](#) and create a popup menu.
**No Activation**

It is possible to create a macro and not assign any activation key to the macro. There are two primary uses for the No Activation option. First, create generic macro templates that can be incorporated into other macros - a set of instructions useful for insertion into several other macros. The [Macro Run] command allows for inserting No Activation macros into other macro scripts.

A second use for this option is to place the macro in a popup or floating menu. A macro activation is not necessary if the macro is part of a popup or floating menu. The only way to invoke the macro would be through the menus.

---

**Macro Nickname**
Optionally assign a name to the macro to later more readily help determine what the macro does.

**Build as a Popup Menu**
Select this option and click on the OK button to open the [Menu Builder] and create a popup menu.
Stopping a Macro

Occasionally it may be necessary to stop a running macro before it has finished. There are several ways to stop a running macro.

Abort a Macro

If the **Running icon** displays when a macro is running, right mouse click on the icon in the notification area to stop the macro. Or press the default key sequence of Scroll Lock and Pause to stop the macro. Change the default to Win + ` or the Pause key by going to Options > Preferences > Playback - **Miscellaneous** tab.

Any of these options will cancel a macro that is playing. However, please note that macros that consist of many keystrokes can send the keystrokes rather quickly and they are buffered in Windows. Once such commands have been buffered in Windows, aborting a macro does not cancel them. In these cases, it may appear that the abort command did not work when in reality the macro has already finished issuing its commands and Windows is now processing them.

If more than one macro is running, all macros will be stopped when initiating any of the above mentioned actions.

**Note:** The **Timed Delay in Seconds** and the **Wait for Time to Elapse** commands suspend Macro Express for the amount of time specified. During this delay time the macro cannot be terminated.

Macro Stop

The **Macro Stop** command stops the execution of a macro before the macro steps have completed. Insert the Macro Stop command into the macro script. Whenever this line in the macro is reached, the macro terminates. In most cases this command is used in conjunction with a conditional statement. For example, if a desired condition is not met, terminate the macro.
Using the Macro Explorer

System Macros

Macro Express defines several system macros for a variety of program functions. The macros are stored in a System Macro file and are available with any macro file currently open. Each of the system macros is described below.

Reassigning a System Macro hot key
The system macros are assigned to hot keys but may be renamed at any time to something that is easier to remember. To rename a system macro, expand the System Macros category and right mouse click on the macro to change. Left click on Properties from the menu to open the System Macro window as shown below. Click on the Change button and select another hot key combination.

Description of the available system macros

<table>
<thead>
<tr>
<th>System Macro</th>
<th>Default Hot Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminate Macro Express</td>
<td>Ctrl+Alt+Shift+V</td>
<td>Terminates Macro Express, Editor and Player</td>
</tr>
<tr>
<td>Run Macro Express Editor</td>
<td>Ctrl+Alt+Shift+W</td>
<td>Activates the Macro Express - Explorer window. It brings the Explorer program to the forefront from it's hidden or minimized state.</td>
</tr>
<tr>
<td>Start/Stop Capture</td>
<td>Ctrl+Alt+Shift+X</td>
<td>Starts capturing keystrokes or mouse movements for a new macro. When finished capturing, press Ctrl+Alt+Shift+X again to stop recording.</td>
</tr>
<tr>
<td>Feature</td>
<td>Hotkey</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resume Pause</td>
<td>Ctrl+Alt+Shift+Y</td>
<td>If a macro contains a Pause command press the Ctrl+Alt+Shift+Y hot key to resume the macro and close the Pause window.</td>
</tr>
<tr>
<td>Menu of Macros for Topmost Window</td>
<td>Ctrl+Alt+Shift+Z</td>
<td>Opens a popup menu listing all Window Specific or Program Specific macros that pertain to the window that is active when the hot key is pressed. In addition, any macros that are set to Global Except, that do not exclude the active window, will also be listed in the menu.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, assume that a macro is set to a Program Specific scope, to only play back in notepad. Another macro is set to Global Except scope and will run in all programs except Internet Explorer. Open notepad and press the hotkey of Ctrl+Alt+Shift+Z. A popup menu opens displaying both macros. Press the letter associated with the macro in order to run it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select which information to display in this popup menu. Choose whether to display the icons associated with the macros, the name and activation method defined for each macro in the menu, or the first part of a macro - the first line or two of a macro.</td>
</tr>
<tr>
<td>Suspend / Resume Macro Express</td>
<td>Ctrl+Alt+Shift+U</td>
<td>Toggles between suspending Macro Express and resuming its active status. No macros will play back while Macro Express is suspended.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The icon in the notification area is changed to a gray icon when Macro Express is suspended.</td>
</tr>
<tr>
<td>Capture a Temporary Macro</td>
<td>Ctrl+Alt+Shift+T</td>
<td>This is a quick way to capture a macro for testing purposes. No assigning of hotkeys or checking settings is required. The macro is saved temporarily for playback.</td>
</tr>
<tr>
<td>Play the Captured Temporary Macro</td>
<td>Ctrl+Alt+Shift+S</td>
<td>Starts the play back of the temporary macro created.</td>
</tr>
</tbody>
</table>
**Macro Explorer**

By default Macro Express opens to the Macro Express - Explorer window. This window displays a list of macros contained in the file currently open. The Macro Explorer is the starting point for creating new macros or editing existing ones.

![Macro Express 5 - Explorer](image)

**Categories**
- System Macros
- All Categories (macex.mex)
  - Examples
  - Help
- Tutorials
  - Work
  - *Unassigned*

**Macros**

<table>
<thead>
<tr>
<th>Nickname</th>
<th>Activations</th>
<th>△</th>
<th>Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy and Paste</td>
<td>Ctrl+J</td>
<td></td>
<td>Global</td>
</tr>
<tr>
<td>Click on control</td>
<td>Ctrl+Shift+G</td>
<td></td>
<td>Global</td>
</tr>
<tr>
<td>Generate Random Numbers</td>
<td>Ctrl+Shift+R</td>
<td></td>
<td>Window/Program Specific</td>
</tr>
<tr>
<td>My Paint Drawing #2</td>
<td>Ctrl+Shift+S</td>
<td></td>
<td>Global</td>
</tr>
<tr>
<td>My Address</td>
<td>Ctrl+Shift+T</td>
<td></td>
<td>Global</td>
</tr>
<tr>
<td>My Paint Drawing</td>
<td>Ctrl+Shift+U</td>
<td></td>
<td>Global</td>
</tr>
<tr>
<td>Process ZIP Code Data</td>
<td>Ctrl+Shift+Z</td>
<td></td>
<td>Global</td>
</tr>
<tr>
<td>Fix Transposed Letters</td>
<td>F4</td>
<td></td>
<td>Global</td>
</tr>
<tr>
<td>My Menu</td>
<td>Popup Menu: Alt+Shift+Z</td>
<td></td>
<td>Global</td>
</tr>
<tr>
<td>Date and Time</td>
<td>Schedule</td>
<td></td>
<td>Global</td>
</tr>
<tr>
<td>My email address</td>
<td>Shortkey: email</td>
<td></td>
<td>Global</td>
</tr>
</tbody>
</table>

**Date and Time**

- **Activation**
  - Schedule
  - Once
- **Scope**
  - Global

Left click on the Macro Express icon in the notification area or press the system macro Ctrl + Alt + Shift + W

**Actions**
The icons at the top of the Macro Explorer window are the primary method of navigating through the program. Clicking on any of these icons will initiate a different program function.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro Explorer</td>
<td>Returns to the Macro Explorer window if currently viewing the Recycle Bin. Otherwise this action is not available.</td>
</tr>
<tr>
<td>New Macro</td>
<td>Start the process of creating a new macro.</td>
</tr>
<tr>
<td>Edit Macro</td>
<td>The macro highlighted in the Explorer window is opened in the Script Editor in order to review or edit the macro script.</td>
</tr>
</tbody>
</table>
Capture

The Capture button starts the macro recording process.

Quick Wizards

Start the Quick Wizard module. The Quick Wizards prompt through the process of creating a macro.

Recycle Bin

The Recycle Bin button opens the Macro Express Recycle Bin which displays any macros that have been previously deleted. Permanently remove the macros from the Recycle Bin or restore one or more to the original macro file.

Categories

Use the Categories option to assign macros to user defined categories. With large numbers of macros created, the categories provide an easy way to locate macros for further editing, refinement, exporting, etc.

For example create a Password category to hold any macros containing important passwords or assign any MS Word specific macros to a MS Word category. This makes it easy to quickly find the macro needed.

Categories

<table>
<thead>
<tr>
<th>System Macros</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Categories (macex.mex)</td>
</tr>
<tr>
<td>Examples</td>
</tr>
<tr>
<td>Help</td>
</tr>
<tr>
<td>Tutorials</td>
</tr>
<tr>
<td>Work</td>
</tr>
<tr>
<td><em>Unassigned</em></td>
</tr>
</tbody>
</table>

Upon installation there are three default categories - System Macros, All Categories and Unassigned. These categories may not be renamed or deleted. Additional categories may be created as shown in this example. Since Macro Express allows more than one macro file to be open at a time, multiple sets of categories may be displayed - a set for each open file.

**Note:** A macro may only be assigned to one category.

Macros

The Macros section displays the list of macros in the file or category that is currently open. When saving macros in the editors, quick wizards or with a macro capture, the program will return to the Macro Explorer. The list of macro information is displayed in six columns.

Index

The index column lists the macros in the order that they were created. The first macro created in the file displays as number 1, the second macro as number 2, etc.

Nickname

Optionally assign a nickname to any macro to help more readily identify the purpose of the macro. Any not assigned a nickname display with a blank field.

Activation

The Activation column displays the method selected to execute the macro. This column displays the hot key combinations, any timed macros, the letter combinations used for any shortkeys or any other type of activation method chosen. If more than one activation is assigned to the macro, this column displays
Multiple for that macro. If the **Show Preview Pane** option is selected highlight the macro to view all of the activations in this pane.

**Scope**
This column lists the macro **scope**, whether it is global, global except, window specific, program specific, a system macro, a popup menu or a floating menu.

**Category**
This column lists the **category** to which the macro was assigned.

**Modified**
The Modified column displays the date and time that the macro was last modified.

**Last Run**
The Last Run column displays the date and time that the macro was last run.

**Sorting Macros**
To quickly sort the list of macros displayed, click on one of the column headers, Nickname, Activation, Scope, Category, Modified or Last Run. The macros will be sorted based on the column header selected. Click on the header a second time to reverse the sort order.

**Right Click Context Menu**
Right mouse click on a macro in the macro list to open the context menu. The menu options include **Run Macro Now**, **Copy Macro**, **Edit Macro**, **Enable/Disable Macro**, **Recapture Macro**, **Delete Macro** and **Macro Properties**.

**Keyboard Shortcuts**
Below is a listing of the **Keyboard Shortcuts** available in the Macro Explorer.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+F</td>
<td>Find</td>
</tr>
<tr>
<td>F3</td>
<td>Find Again</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete highlighted macro</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print macro list</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>New Macro</td>
</tr>
</tbody>
</table>
File Menu

New File
Macro Express allows for creation of multiple files with different macros in each file. Click on the File > New File option to create a new file. A dialog box appears prompting for a file name and folder location.

Open File
Click on this option to open a previously created macro file. A dialog box appears prompting to select the file.

Close File
If more than one macro file is currently open, use this option to close one of the files. A dialog box appears prompting to select the file and choose from which folder.

Backup Macro File(s)
This option immediately backs up the macro file that is currently open. If using the automatic backup schedule, this option does disturb the schedule previously created. It uses the settings defined in the Backup Preference panel, such as where the backup is saved and how many backup copies are created.

Restore Macro File
Use this option to restore from a backup file. A Windows dialog will open prompting to select the backup file. The dialog opens to the folder designated in the Backup preferences panel for file backups. If the backup options were recently changed, then it may be necessary to browse to the location where previous backups were stored.

Performing the restore closes the file currently open and replaces it with the backup file selected.

Reopen
This is a convenient way to open a macro file previously used. This option displays the last several macro files opened. Click on the desired file to load into Macro Express.

This may close all other open macro files depending on the Close open macro files before loading another macro file preference setting selected.

Import
There are three different import options available in Macro Express. Click on the topic of interest below to obtain more information.

Import Macros
Import Text File
Import Playable Macro

Export
There are three different export options available in Macro Express. Click on the topic of interest below to obtain more information.

**Export Macros**

**Output Macro Information**

**Export as Playable Macro**

---

**Print Macro List**

Click on File > Print Macro List or click on the speed button to print a list of all macros currently assigned. The list contains the activation method, such as the hot key combination used, the nickname assigned, if any, and macro scope (global, system, window specific or program specific). The list includes the information as shown in the Macro Explorer window.

**Printer Setup**

Select this option to ensure printer settings are accurate before printing the macro list.

---

**Terminate Macro Express Editor**

Selecting this option closes the Macro Express - Explorer window but leaves the Player running. The macros still run with the Explorer window closed.

**Terminate Macro Express Editor and Player**

Selecting this option closes the Macro Express - Explorer and Player. It shuts down the entire program, at which point no macros can run.
Import/Export Macros

Import Macros

The import and export functions are convenient methods to transfer macros between Macro Express users. Use the Export command to save the macros to a disk or drive. On another computer import the macros from the disk, flash drive, or similar device.

Macro Express Explorer > File > Import > Import Macros

To import macros, click on File > Import > Import Macros. A Select a File to Import window opens with a standard dialog box to browse through folders to find the correct file. All Macro Express macro files have a file extension of .mex. Highlight the file to import and click on Open. A list of all macros found in that file are displayed.

Please select the macros that you would like to import
Highlight the macros to import by clicking on each macro.

Select All
This option highlights all macros in the file so that all are imported.

Clear
This option clears any highlighted macros so that none are imported until a new selection is made.

Click on the OK button to start the import process. A progress bar displays during the import process until the Import Complete message appears. Click OK to return to the Macro Explorer. This finishes the process and the macros are now found in the current file.
**Note:** If importing a popup menu, all of the macros contained in the menu must also be imported. Once imported, you will most likely need to rebuild the menu.
Import Text File

Selecting File > Import > Import Text File from the Macro Express - Explorer menu imports a group of Shortkey or Hot Key macros. A standard Windows dialog box opens prompting to navigate and select the text file to import.

The text file must be in a specific format. An improper format will cause unpredictable results. The formatting of the lines in the text file is described below.

Line 1 - The first line requires an <ITEM NAME> tag followed by the shortkey or hotkey name. The hotkey name is the key sequence used and must be in the format found in the Create New Macro window. If a match is not made on one of these, then it is assumed that the name supplied is a shortkey.

Line 2 - This line contains the nickname assigned to the macro.

Line 3 - Line 3 contains the macro text and commands. This line may span multiple lines as shown in the examples below.

The <ITEM NAME> tag marks the start of a new macro in the text file.

Example
This example shows the format for two shortkey macros followed by a hot key macro to be imported.

<ITEM NAME>issadd
Our Address
Insight Software Solutions, Inc.
P.O. Box 106
Kaysville, UT 84037
<ITEM NAME>downm
Download Macro Express
You may download a 30 day evaluation copy of Macro Express from www.macros.com/download.htm.
<ITEM NAME>Ctrl+Shift+m
Overview
Macro Express is the premier macro utility on the market. With Macro Express, you can record, edit and play back mouse and keyboard macros. Its powerful tools and robust features will noticeably boost your productivity.
**Import Playable Macro**

A "Playable Macro" file format is available. Files with an .MXE file extension are similar to .EXE files. Double clicking on the .MXE file from within Windows Explorer plays back the macro.

Macro Express is not required to be running to execute the .MXE macro, though installation of the Macro Express player is necessary. The .MXE file may also be executed from a command line parameter to run a batch file.

**Importing the macro**

This option is used for importing a playable macro from another machine on a network or from a disk that contains a playable macro and converting it to a .MEX macro.

From the Macro Express - Explorer window click on File > Import > Import a Playable Macro. A dialog box prompts to search for the .MXE file to import. Once located, highlight the file to import and click OK to import the file. The Copy Hot Key window opens prompting to assign a hot key or other method for executing the macro. The imported macro is then placed into the list of macros displayed in the Macro Express - Explorer.
Export Macros

The import and export functions are a convenient way to transfer macros between Macro Express users. Use the Export command to save macros to a disk or drive. On another computer Import the macros from the disk, flash drive, or similar device.

Macro Express Explorer > File > Export > Export Macros

Please select the macros that you would like to export:

To export macros, click on File > Export > Export Macros. A window opens showing all macros from the macro file currently in use. Highlight the macros to export.

Select All
This option highlights all macros in the file so that all are exported.

Clear
This option clears any highlighted macros so that none are exported until another selection is made.

Include the category information in the new file
This option saves the category information in the new file if the macros selected for export have been assigned to categories.

Please enter the name of the new macro file

[C:\Macros\Example.mex]
Enter the name and file path of the file where the macros will be exported. Or click on the browse button to navigate to the location of the file to be saved.

Click OK to export to the new file. The file is saved as a Macro Express macro (.mex) file which can be opened directly by Macro Express using the File > Open File menu or the macros may be imported.

**Note:** If exporting a popup menu, all of the macros contained in the menu must also be exported. Most likely the menu will need to be rebuilt in the new file.
Output Macro Information

Use this option to select what information from the macro file to save to a text file. As shown in the window below, select which items to output and click OK. A standard dialog box prompts for a file name and folder destination for storing the data.

The newly generated text file contains selected information about each macro in the file.

<table>
<thead>
<tr>
<th>Macro Info</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activation</td>
<td>Lists the Hot Key, Shortkey or other activation of the macro.</td>
</tr>
<tr>
<td>Scope</td>
<td>Lists the scope of the macro.</td>
</tr>
<tr>
<td>Script</td>
<td>Displays the macro script in Direct Editor format.</td>
</tr>
<tr>
<td>Name</td>
<td>Lists the name assigned to the macro.</td>
</tr>
<tr>
<td>Icon Path</td>
<td>Lists the names of the icons used. The information can then be printed in any text editor.</td>
</tr>
</tbody>
</table>
Export Playable Macro

A "Playable Macro" file format is available in Macro Express. Files with an .MXE file extension are similar to .EXE files. Double clicking on the .MXE file from within Windows Explorer, My Computer or the desktop plays back the macro.

Macro Express is not required to be running to execute the .MXE macro, though installation of the Macro Express player is necessary. The .MXE file may also be executed from a command line parameter to run a batch file or similar.

Exporting the macro

The Export as Playable Macro option exports (creates) any defined macro as a playable .MXE macro. From the Macro Express - Explorer window highlight the macro to export and click on File > Export > Export as Playable Macro. Or right click on the macro and select Export > Export as Playable from the context menu.

A dialog box prompts for a file name and folder destination for storing the .MXE file. By default, the macro nickname is inserted as the file name but may be changed if desired.

Windows does not allow the following characters in a file name: | ? : \ / " < > and *. If the macro nickname contains any of these characters, they will be deleted from the default .MXE file name.

Note: Any activation assigned to the original macro, such as a hot key, schedule or other, is not stored in the playable macro. Double click on the .MXE file to activate the macro.

Note: Do not include any Macro Run commands in the playable macro. The macro from the Macro Run command is not compiled into the playable macro and will cause an error when running.

Highlight macro in Macro Express - Explorer > File > Export > Export as Playable Macro
New Macro

To create a new macro, click on Macro > New Macro from the menu or click on the New Macro icon to open the Create New Macro window. The first step is to select the type of macro activation needed. The hot key activation is the default selection. After assigning the activation type, enter a macro nickname and press OK to proceed to the Script Editor.

**Activation**

- **HotKey**
- **Shortkey**
- **Schedule**
- **Window Title**
- **Mouse Event**
- **Control Event**
- **Floating Menu**
- **No Activation**

**Shortkey**

- **Original Shortkey:** `email`
- **Use Global Settings (Customizable from Options | Preferences | Activations | Shortkeys)**
- **Customize Settings (for this macro only)**
- **Case Sensitivity**
  - Match First Character's Case between Shortkey and Replacement Text
  - If the first letter in the text is uppercase, don’t change it to lowercase
  - Require Exact Uppercase; Lowercase Match on Shortkey
  - No Case Sensitivity
- **Other**
  - Do not Remove Keystrokes Typed

**Macro Nickname:** `My email address`

**Build as a Popup Macro**

**Hot Keys**

To activate a new macro with a hot key, make sure the Hot Key choice is selected. Place the cursor in the edit box and hold down the Hot Key combination to use. The combination pressed is placed in the edit box. When the macro is complete, press this hot key combination to activate the macro.

Or scroll through the list of keys and highlight the one wanted. This also places the hot key combination in the edit box.

**Note:** Use the hot key combinations displayed in red with caution. These combinations may conflict with basic Windows functionality, such as the clipboard copy (Ctrl + c).

**Shortkeys**

Select the Shortkey option and type in the shortkey (up to a 32 letter code) to use to activate the macro.
shortkey is a set of characters such as abc, myname, etc. See the program specifications for a complete list of characters accepted as shortkeys.

The macro runs when the characters are typed into an application that accepts text input. The Shortkeys activation will not trigger a macro from the Windows desktop or other applications that do not accept text input.

**Note:** Before using the Shortkeys feature click on Options > Preferences > Activations - Shortkeys tab to define the settings.

### Scheduled Macro
Selecting **Schedule** activates the Scheduler options. Select the schedule wanted and click OK to build the macro in the Script Editor. The macro then plays back at the time designated.

### Window Title
This option instructs a macro to execute any time the selected **Window Title** has focus. In other words, the macro runs once the window is activated.

In the edit box, enter the title of the Window that will start the macro. The title of the window is that which appears in the caption bar of a window. Macro Express examines all Window Titles running on the computer in an attempt to find a match. The Window Title does not need to be an exact match.

A partial match also works. For example, "notepad" or "notep" would be sufficient for the Windows Notepad program. This is particularly useful as some Window Titles change based on which file is open.

Case sensitivity is not required. For example, "NOTepad" works as well as "notepad".

### Mouse Event
This option uses **mouse** clicks to activate macros. Two different methods are available.

1. Define regions on the screen that can be assigned to the left, middle or right mouse button. Clicking on the defined area of the screen triggers the macro. Macros may be global, window or program specific.

2. The other option is to click on a specific part of a window to execute the macro. Window parts include the window border, window menu, window caption bar, horizontal scroll bar, vertical scroll bar, system button, minimize button and maximize button. Macros can be assigned to the left, middle or right button and can be global, window or program specific. A few options have been excluded where they will interfere with essential functionality of the windows such as Left Mouse with the Maximize or Minimize buttons.

### Control Event
The **Control** option activates a macro when a specific Window control becomes active or the control's window becomes active. The control may be a window button, edit box or another identifiable portion of a window.

### Directory Modification
The **Directory Modification** activation looks for changes to files or folders. When a change is made to the file or folder specified, the macro will start. Among the options, the macro may look for changes to file size, attributes, write time or if a file has been renamed or deleted.

### System Event
The **System Event** activation looks for changes to the system such as an incoming message, resolution change or system color change. When the specified system change occurs, the macro starts.

### Process Event
The **Process Event** activation method starts a macro when a Process starts or shuts down.

**TCP/IP**
The **TCP/IP** activation monitors when an Internet or Network connection has been made or released.

**Clipboard Text**
The **Clipboard Text** activation method starts a macro based on the contents of the clipboard. Select whether the clipboard does or does not match the text supplied in the edit field. Or choose whether the clipboard contains or does not contain the text.

**Floating Menu**
A floating menu has the same form and options as a Popup Menu except that it always remains on top and is always accessible as long as the **Macro Player** is running. A floating menu can be minimized to just the caption bar to free up space if needed. Multiple floating menus can be created. The last location of the floating menu is retained and used with subsequent runs of Macro Express. Use the **Build Macro Menu** window to select which macros to include in the floating menu.

**None**
This option does not assign an activation to the macro. There are at least two possible uses for the No Activation option. First, create generic macro templates that can be incorporated into other macros - a set of instructions that may be useful for insertion into other macros. Use the **Macro Run** command to insert this type macro into other macros.

A second use for this option is to place the macro in a **popup or floating menu**. A macro activation is not necessary if the macro is part of a popup or floating menu. The only way to invoke the macro would be through the menus.

**Macro Nickname**
Assign a name to the macro to help remember what the macro does. The nickname, along with the activation, is displayed in the **Macro Explorer** and is optional.

**Build as a Popup Menu**
Selecting a Popup Menu activates the **Menu Builder**. After selecting the activation, check the Build as a Popup Menu box and click OK to open the Menu Builder window. In this window select which macros to include in the popup menu. When activated, the popup menu displays all macros included in the menu. Choose which one to run from the menu.
Capture Macro Introduction

The simplest type macro to create is a recorded macro. The macro records each keystroke, mouse click or mouse movement made. After saving the macro, play back the macro and watch it repeat each of the steps just recorded. If a mistake is made in the recording, either re-record the macro or edit the macro with the Script Editor.

The first step before capturing a macro is to select capture options, such as whether to record mouse movements, playback speed, base the mouse position relative to the position of the window or entire screen, etc. Use the Options > Preferences > General - Capture tab menu to define the default capture settings.

Each time a capture is started, the options selected are stored as the default values. If a change to one of the settings is necessary for a particular recording, make the change before the capture starts.

There are two different ways to initiate a macro capture. Examples for using both of these methods are outlined in the Tutorial section of the Help file and also in this section for convenience.

Assign Macro Activation First
Click on the Capture Icon or Macro > Capture Macro from the menu to start the capture process. This method requires selecting the macro activation and reviewing or changing the default capture options before starting the capture.

Assign Macro Activation After Capture
The second method uses the System Macro, Ctrl+Alt+Shift+X. While in another application, press the System Macro to begin capturing a macro in that application. This method uses the capture default settings that were defined in the Preferences section. After the capture is complete, follow the prompts to assign a macro activation.
Quick Wizards

The Quick Wizards are a convenient way to step through the macro creation process. The sequence is essentially the same for each of the wizards and are basically self explanatory. We'll briefly discuss the basic steps of the wizard.

Wizard Steps

1. Select the category or type of macro to create and then click on the Next button.
2. The second step prompts to select the specific type of macro to create. Click Next to advance.
3. A window opens listing the functions of the wizard selected as well as giving some examples of macros that may be created with this wizard. Click Next to advance to the next screen.
4. Depending on the wizard selected, a prompt appears asking what to do with the macro or instructions are provided to begin building the macro. Input the necessary information and click next to proceed.
5. After entering the necessary information for the macro, the next step is to select a method for executing the macro - hot key, timed macro, etc. Select an activation method and click Next.
6. Define if the macro should play back in all programs, a single program or only in a specific window. Make a choice and click Next to proceed.
7. Give the macro a nickname and optionally assign an icon with the macro.
8. Click Finish and the macro is complete.

These are the basic steps of the Wizard. Depending on the wizard selected there may be several additional steps, each of which is self explanatory. Each step has a Cancel button to exit the Wizard at any time. Each step includes a Back button to backtrack and make any changes needed.

The Wizards have been divided into categories based on their functionality. Each of the links below lead to brief explanations of each of the wizards and some of the types of macros that can be created. The Tutorial section includes an example of creating a macro with the Wizard.

Text
Internet and Networking
Multimedia
System and Files

Note: The Quick Wizards are handy for less complicated macros. If planning to use If / Then logic, variables or other advanced features, the macro will need to be created with the Script Editor.
Edit Macro

There are several ways to edit an existing macro. In the Macro Express - Explorer window highlight the macro to be edited. Then take one of the following steps:

1. Click on the Edit Macro icon
2. Click on Macro > Edit Macro from the menu
3. Double click on the macro in the Explorer list

The above action opens the Script Editor where changes may be made to the macro script.

Highlight macro in Macro Express - Explorer > Macro > Edit Macro
Copy Macro

Macro Express provides for a simple method to copy of an existing macro.

1. From the Macro Express - Explorer window highlight the macro to copy.
2. Click on Macro > Copy Macro from the menu to open the Create New Macro window.
3. Select a new macro activation.
4. Change the macro nickname and click OK to save.

The new macro is now displayed in the Macro Explorer window. If the macro nickname is not changed it will be displayed as “copy of” followed by the name of the original macro.

Highlight macro in Macro Express - Explorer > Macro > Copy Macro
Enable or Disable Macro

To temporarily disable a macro, highlight the macro from the list in the Macro Express - Explorer. Then click on Macro > Disable Macro. Disabled macros appear in the Macro Explorer with italicized red text to distinguish from active macros. A disabled macro will not function again until it has been Enabled. To enable the macro, highlight the disabled macro with the mouse and click on Macro > Enable Macro. The macro is now ready for use again.

If a macro is disabled it will not execute, but the definition is retained for potential future use. This is helpful for those instances where a particular macro is not needed for a time, but may be needed later. Instead of deleting it and re-creating the macro later, simply disable it and then re-enable in the future.

Floating Menus
When closing a floating menu by clicking on the "X" in the upper right corner of the menu window, the floating menu is disabled. To enable the menu highlight the floating menu from the list of macros in the Macro Explorer and click on Macro > Enable Macro.

Macro Disable and Macro Enable Commands
Also use the Macro Disable and Macro Enable commands in macros themselves to enable and disable other macros in the macro file - such as Floating Menus or Scheduled macros.
Recapture Macro

To overwrite the results of a previous captured macro, highlight the macro from the Macro Express - Explorer list and click on Macro > Recapture Macro. This opens the Capture a Macro window to check the capture settings before recording. Then click the Capture button to start the macro capture.

Press the system hot key Ctrl + Alt + Shift + X, right click on the camera icon in the notification area or press the hot key combination of the macro being recaptured to stop the capture.

Recapturing removes the contents of the existing macro and replaces it with the newly captured script.

Highlight macro in Macro Express - Explorer >Macro > Recapture Macro
Delete Macro

To remove a macro that is no longer needed, first highlight that macro from the list in the Macro Express - Explorer.

There are several ways to delete the highlighted macro.
1. Click on Macro > Delete Macro(s) from the menu.
2. Press the Delete key on the keyboard.
3. Right mouse click on the macro and left click on the Delete Macro menu item.

A dialog window opens to verify that the macro should be deleted. Select Yes to confirm the deletion or No to cancel.

For mass deletions highlight a group of macros and delete them all at the same time.

Deleted macros are sent to the Macro Express Recycle Bin. If necessary a deleted macro can be restored to its original macro file. Or periodically empty all macros from the Recycle Bin.

**Note:** To bypass the Macro Recycle Bin highlight the macros to be deleted and press Shift + Delete. This permanently deletes the macros without placing them in the Macro Recycle Bin.

Macro Delete Command

The Macro Delete command deletes other macros during macro playback. Insert the command at the end of a macro script and the macro can delete itself upon completion of the playback.

This feature is handy for use with one-time reminder messages. The macro runs at its appointed schedule, displays the reminder and then is deleted upon completion. The reminder macro doesn't need to remain in the Macro Explorer list after it has run.
Run Macro Now

This option does what its title implies. Highlight the macro to run from the Macro Express - Explorer. Click on Macros > Run Macro Now or the Run Macro Now icon on the toolbar to run the macro. Of course, make sure that the macro to “Run Now” is appropriate for the window currently open, etc.

Another way to accomplish the same thing is to right mouse click on the macro in the Macro Explorer to open the context menu. Left mouse click on the Run Macro Now menu item.
Move to Category

Use this menu command to assign macros to categories already created. Highlight the macro to be assigned and click on Macros > Move to Category to display a list of categories such as in the example below. Highlight the category to move the macro into and press the OK button. The macro is now assigned to the category selected.

![Move to Category](image)

Macro Express Explorer > Macro > Move to Category

The other method is to drag the macro from the Macro Express - Explorer list to the desired category. To drag the macro, highlight the macro, hold down the left mouse button and move the pointer to the category listed in the Category column. When the mouse is pointing to the correct category, release the left mouse button. The macro is assigned to the category. Expand the category to view all macros stored in that category.

With either of the above options, also highlight a block of macros and move them all at once to the category of choice.

**Note:** The categories selected are specific to the macro file that is currently open. When opening a new macro file, the categories created for the new file are displayed. If more than one macro file is open, multiple sets of categories are displayed, one set for each macro file.
**Place on Desktop**

Use this option to place an icon of any macro onto the desktop. In order to do this, highlight the macro from the list of macros in the Macro Express - Explorer. Then click on Macros > Place on Desktop. The icon previously assigned to the macro is displayed on the desktop.

**Selecting a Desktop Icon**

Change a macro's icon by double clicking on the macro from the list of macros in the Macro Explorer to open the Script Editor.

![Macro Nickname: Generate Random Numbers](image)

The icon (in the example above, a blue number five) is displayed to the left of the macro nickname. Click on the icon to open the Select an Icon window. Click on the browse button to open a folder with a number of icon options. Or navigate to another location on the hard drive where other icons may be found on the computer. If an icon was not selected at the time the macro was created, the default Macro Express icon is displayed.

**Note 1:** When creating an icon on the desktop, the macro nickname also becomes the file name. Windows does not accept the following characters in a file name: / \ : * < > | ? and *.

**Note 2:** To remove an icon from the desktop, right mouse click on the icon and select delete from the menu that opens.
**Macro Properties**

This view of the Properties window may be accessed from the *Macro Express - Explorer* window. Highlight the macro of interest and click on Macros > Properties from the Macro Explorer menu. The other method is to right mouse click on the macro and left click on Macro Properties from the context menu. Each accomplishes the same thing.

![Macro Properties dialog box](image)

*Macro Express Explorer > Right Click on a Macro > Left Click on Macro Properties*

The following information is available about the macro selected.

**General**
This Tab provides some basic information about the macro such as the last modified date or scheduled time if a scheduled macro. Click on the check box to change the status of the macro from Enabled to Disabled or vice versa. This panel also allows editing of the Macro Name.

**Activations**
This tab displays what activation(s) are in use for the macro. The activation(s) may be modified from this screen.

**Scope**
The Scope tab displays the macro scope and any programs or windows assigned if using Program or Window Specific scopes. The selections may be modified from this panel.

**Security**
The Security Tab allows for changes to the existing passwords assigned to the macro or to add a password.

**Logging**
The Logging Tab displays any error logging that the macro is defined to use. The logging options are set in Preferences > Playback > Miscellaneous and will log errors or will log all commands in the macro, depending on the option selected.

The field in this tab is not editable. Click on the Clear Log button to remove all log entries.
Macro Recycle Bin

The Macro Express Recycle Bin works similar to the Windows Recycle Bin. When a macro is deleted from the Macro Express - Explorer, the macro is removed from the macro file that is currently open. The deleted macro is sent to the Macro Express Recycle Bin and is displayed in the bin along with any other macros previously deleted from the current file.

**Note:** Highlight the macro or macros in the Macro Explorer window and press Shift + Delete to permanently delete the macros and bypass the Macro Recycle Bin. This step permanently deletes the macros with no chance for recovery.

Three options are available in the Recycle Bin - Restore Macros, Delete Macros or Empty Recycle Bin.

**Restore Macro(s)**
The Restore Macros option returns a deleted macro from the recycle bin back to its original file. The macro is again available for use in the Macro Express - Explorer. This is a quick way to restore accidentally deleted macros.

To restore, highlight one or more macros in the Deleted Macro list. To highlight a block of macros, click on the first macro to restore, hold down the Shift Key and click on the last macro in the block. Click on the Restore Macro(s) option to place the deleted macros back into the macro file from which they were deleted.

**Delete Macro(s)**
Delete Macros permanently removes the selected macros from the Recycle Bin with no chance to retrieve later. To remove, highlight one or more macros in the Deleted Macro list. To highlight a block of macros, click on the first macro to delete, hold down the Shift Key and click on the last macro in the block. Click on the Delete Macro(s) option to remove from the Recycle Bin.

**Empty Recycle Bin**
Click on the Empty Recycle Bin option to remove all macros from the Recycle Bin. These macros cannot be retrieved once they are removed from the Recycle Bin.
Category

Using Categories

Use this option to assign macros to categories. For example create a Password category to hold any macros containing important passwords or assign any MS Word specific macros to a MS Word category. The categories provide a simple way to find macros after they have been created. A macro may only be assigned to one category.

When the program is first installed, there are two default categories - All Categories and Unassigned which may not be changed. But new categories may be added, renamed or deleted. All Categories displays all of the macros in the file. The Unassigned category displays all macros not assigned to a category other than All Categories.

The category icons may be turned on or off via the Macro Express - Explorer menu, Options > Preferences > Appearance - Explorer tab.

---

New Category

Select this menu option to add a new category. A new category folder and edit box appears in the category list. Type in the name to assign the category. Also create sub-categories within the category list. To do this, right mouse click on the main folder and then left mouse click on New Category. A new category sub-folder is added to the list.

![Create New Category](image)

Macro Express Explorer > Category > New Category

Rename Category

To change the name of a category already created, highlight the category and click on the Category > Rename Category menu option. The category name is highlighted so that a new name may be inserted, similar to the way Windows Explorer works.
Enable/Disable Category
This option disables or enables all of the macros in the category selected. If the category contains both enabled and disabled macros, then the status is toggled. The enabled macros are now disabled and the disabled macros in the category are enabled.

Delete Category
Highlight the name of the category to remove. Then click on Category > Delete Category. A warning message appears verifying that the deletion should continue. Click Yes to delete the category and all of its sub-categories.

Placing Macros in Categories
Once a category is created, there are two methods for moving macros into a category.

Highlight the macro to be assigned and click on Macros > Move to Category to display a list of categories such as in the example below. Choose the category to move the macro into and press the OK button. The macro is now assigned to the category selected.

The other method is to drag the macro from the Macro Explorer list to the desired category. To drag the macro, highlight the macro, hold down the left mouse button and move the pointer to the category listed in the Category column. When the mouse is pointing to the correct category, release the left mouse button. The macro is assigned to the category. Expand the category to view all macros stored in that category.

Using either of the above methods, highlight a block of macros and move them all at once to the category of choice.

Note: The categories selected are specific to the macro file that is currently open. When opening a new macro file, the categories created for the new file are displayed. If more than one macro file is open, multiple sets of categories are displayed, one set for each macro file.
Set/Clear Password(s)

This menu option provides password protection to a category of macros. Select whether to prevent users from running, editing or viewing macros in the selected category. Selecting All Categories effectively password protects the entire macro (.mex) file. The Lock icon indicates that a password is currently in place.

Run Password
None of the macros in the password protected category will run without first typing the password. When a macro is activated, a prompt appears requesting the password be input. Once the password is successfully entered, the macro starts running.

Edit Password
The macros in the password protected category are displayed, but may not be edited without first typing the password.

View Password
None of the macros in the password protected category are displayed without first typing the password. Once the password is successfully input, the macros in the category may be viewed, edited, saved or deleted. Once another category is opened, the password must be typed again to reenter the password protected category.

Create a New Password
To create a password for the first time select the Run, Edit or View option and click on the Change button. Leave the Original Password field empty and enter the password in the New Password field. Confirm the password in the Confirm Password field and save.

Change an Existing Password
To change an existing password select the Run, Edit or View option and click on the Change button. Enter the current password in the Existing Password field. Insert the new password in the New Password field. Confirm the password in the Confirm Password field and save.
**Note:** Leave the New Password and Confirm Password fields blank if removing a password from the category.

*See Also*
- Encrypted Text
- Password Protection
- Security
Search

Find

Use the Find feature to search through the list of macros in the Macro Express - Explorer window. It performs the search beginning with the macro highlighted and continues through the rest of the list. Pressing CTRL + F or clicking on Search > Find will open the Find window.

![Find window](image)

**Find what:**
Enter the details of the search (what is to be found) in this field.

**Search in:**
Perform the search on the Nickname, Activations, Scope or Modified columns in the Macro Explorer window. Select which column to search through.

After entering the search criteria press the Find Next button. If a match is found, the macro that matches is highlighted. If no match is found, a message "Reached the end of the list" is displayed.

**Match case**
This option makes the search case sensitive. Capital and lower case letters need to match exactly in order to find the right match.

**Find Again**
If the first match is not the macro being sought, press F3 or click on Search > Find Again to go to the next match.
Options

View

The View function provides the option to display the Toolbar in the Macro Express - Explorer window or hide it. By default the large toolbar is displayed. Use this option to hide the toolbar and just use the menus for program navigation.

In the Options > Preferences > Appearance - General settings of the program, there is an option to display the toolbars as they were in Macro Express 3. If using the toolbar and sidebar, the View menu allows to turn off one or both of the bars, or leave both visible.

Toolbar

From the Macro Explorer menu, click on Options > View and select to display the toolbar (similar to what is shown below). The toolbar is not displayed in the Macro Explorer window when the option is not selected.

Sidebar

From the Macro Explorer menu, click on Options > View and choose to display the sidebar (similar to what is shown below). The sidebar is not displayed in the Macro Explorer window when the option is not selected.
Preferences

Activations

General Activation

Auto restore the keyboard and mouse hooks

This feature automatically attempts to have Macro Express re-assert itself as the first program to take a look at the keystrokes passed through the Windows system wide keyboard hooks even if other programs are loaded that also use these keyboard hooks.

Typically this is not a problem unless a program is run *after* Macro Express and it uses the keyboard hooks and it places itself there in an improper fashion. When this occurs, keystrokes are no longer passed onto Macro Express and the Macro Express Hot Keys and Shortkeys suddenly fail to trigger macros.

This feature should automatically give Macro Express first looks at the keystrokes thus preserving the use of
Macro Express Hot Keys and Shortkeys. In addition, because Macro Express properly passes on keystrokes through the chain of keyboard hooks, other programs will still function correctly.

The above also applies to the Windows mouse hooks.
Scheduler

Notification

Play a sound when a scheduled macro runs
Select this option to play a sound (.wav) file when a scheduled macro is about to execute. The sound file will not play back for the When the program starts and When the macro file is loaded schedule options are used. The default option is to not play any sound.

Enter the file name and path of the sound file into the edit field. Or click on the Browse button to locate the sound file. Click on the test button to hear the sound selected.

Wait for the sound file to finish
Placing a check in the box causes the playback of the macro to stop until the sound file has finished playing. The macro resumes playback once the sound file has finished.

Timer Interval
Check the scheduled macros every ___ seconds
Specify the interval, in seconds, for how often Macro Express checks to see if a scheduled macro is ready to execute. Macro Express will shut off the timer if no scheduled macros exist in the current file or none are active. The default setting is to check for scheduled macros every 10 seconds.

Suppose a scheduled macro plays back every 3 seconds. For the macro to work correctly, the Timer Interval needs to be set to check at least every 3 seconds. Otherwise some of the scheduled times will not run.

Other
Disable the screensaver when there are scheduled macros
Screen savers prevent a scheduled macro from running. This option prevents a screen saver from starting if Macro Express is running and if there are any active scheduled macros in the macro file currently in use. It stops the screen saver from starting, allowing the macro to run.
A shortkey is a set of characters such as abc, myname, etc. The macro runs when the characters are typed into an application. Click on Options > Preferences > Activations and the Shortkeys tab to define the settings. Below are descriptions of the default settings that can be assigned to all shortkeys.

**Prefixes and Suffixes**
The Prefix Key and Suffix Key options cannot be overridden elsewhere in the program.

**Use prefix keys**
The Prefix Keys are used to designate up to three characters that may be added to the beginning of every shortkey. A prefix key is a method to prevent the accidental triggering of a macro during everyday typing.

This option places a prefix key or keys, such as z, ##, qq, etc., in front of each shortkey. So, if the Prefix Key was set to ## and the shortkey was set to "test", typing ##test starts the macro. Typing ## before any text would make it very unlikely for a macro to start accidentally.

The other option is to leave the Prefix Keys field blank. In the above example, typing the shortkey "test" would start the macro. No other keys are required.
Below is a list of the Prefix characters that are recognized by Macro Express.

- The letters A through Z (both upper and lower case)
- The numbers 0 through 9
- The following characters: ! @ # $ % ^ & _ = < > ? . ; , * - / + ` " ] and space bar

**Shortkey detection**

The program provides two methods of "shortkey" detection. They are the Solitary Usage and the non Solitary Usage. A check mark in the box beside the solitary usage option indicates that the solitary usage option is activated. The non solitary usage option is the default setting.

**Solitary usage**

The solitary usage option indicates that a shortkey is recognized only when the shortkey is preceded by a character or key that is not valid as part of the shortkey name. This is best illustrated by the example below.

Assume the shortkey was named red and the macro text was a bright color. The replacement would not take place if the word Fred were typed. Why? Because "F" is a valid character in a short key name. We really didn't want the replacement to take place because we were typing Fred and not red.

However, if typing the word red preceded by a blank space, the replacement would take place. Why? Because a blank space is not valid as part of a shortkey.

**Non solitary usage**

The non solitary usage option (leaving the Solitary Usage option unchecked) indicates that a shortkey will be recognized whenever the short key text is typed, even if it is part of another word. The following example illustrates this point.

Assume the shortkey was named red and the macro text was a bright color. Typing the word Fred would cause the macro to start and the text typed would be F a bright color.

Typically the "non solitary usage" mode is used with a prefix key or two to ensure that a macro does not play back unintentionally.

**Solitary usage separator characters**

One or two Prefix Keys may optionally be input that are applied to all original shortkeys created. The following Prefix characters may be entered and used:

- The letters A through Z (both upper and lower case)
- The numbers 0 through 9
- Others: Essentially any other valid character or symbol such as ! @ # $ % ^ & _ = < > ? . ; , * - / + \.

This list of Separator Characters provides a method to remove characters for use as a prefix key. Attempting to assign an invalid character as a prefix would not be allowed.

**Use suffix keys**

Another alternative is to use the Suffix Keys option. With this option activated, type the shortkey and then press down either the Space Bar or the Enter Key to activate the macro.

**Use punctuation characters**

Punctuation keys such as . , : ; ? ! ) ' ] " ` and - may also be used as a suffix key for a shortkey when the Include Punctuation Characters box is selected. If the shortkey was set to test, type the word test while in another Windows application and press either the Space Bar, Enter Key or one of the punctuation keys listed above to start the macro. Punctuation characters may be added or removed from this list.
Retype suffix key
The Retype Suffix Key option, when checked, types the suffix key (Enter, Space or punctuation keys) to the end of the macro text. This option is mainly for those who use shortkeys as a simple text replacement in writing documents.

Assume a shortkey of test with a replacement text of This is a test. Typing the word test into notepad or other text editor and using the space bar as the trigger causes the macro to start. The replacement text is typed into the application and the cursor moves one space to the right of the text.

Or typing test and using the ? to activate the shortkey causes the replacement text to appear with a ? at the end of the text. If the Replay Suffix key is not selected, the suffix key is not placed at the end of the replacement text.

Complete list of characters that can be used with shortkeys
Up to 32 characters may be entered as an original short key (which are to be replaced). In addition, up to 3 Prefix Keys may optionally be entered in that are applied to all Original Shortkeys created. The following Prefix characters may be entered and used:

The letters A through Z (both upper and lower case)
The numbers 0 through 9
The following characters:
! @ # $ % ^ & _ = < > ? . ; , * - / ` " ] and space bar

If not using a prefix key, use the suffix key and press the space bar, the enter key or a suffix character of . , ; ? ! or - after typing the shortkey to activate the macro.

Note: Pressing down the CTRL or ALT key is detected by the program when using the Shortkeys option, and is interpreted as a key being pressed. Therefore, if the ALT or CTRL key is pressed in the middle of a shortkey being typed, the shortkey will not be recognized and the macro will not start.

Case Sensitivity
The following options are the default options used for each new shortkey created. These options can be overridden on an individual shortkey basis.

Match first character’s case between shortkey & replacement text
This option causes the upper case setting of the first letter in the shortkey to dictate that the first character in the macro will be upper case (if the first thing in the macro is a character). This option is mainly for those doing simple text replacement in documents and facilitates an easy way to capitalize the replacement text in instances where it needs to be, such as at the beginning of a sentence.

Require exact upper case/lower case match on shortkey
With this setting selected, the shortkey must be typed exactly as it appears (upper and lower case letters) in order for the replacement to work. Without case sensitivity, the shortkey may be typed in either upper or lower case to start the macro. Here are a few examples:

<table>
<thead>
<tr>
<th>Shortkey</th>
<th>Case Sensitive</th>
<th>Not Case Sensitive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mike</td>
<td>Mike</td>
<td>mike</td>
</tr>
</tbody>
</table>
No case sensitivity
Neither of the above cases apply with this option checked.

---

Other
Do not remove keystrokes typed
This option instructs the shortkey to not erase itself after being typed. Normally, backspaces are issued to remove the shortkey from the screen before the macro is executed.

When using shortkeys in non-text usage programs, it may not be desirable to have "backspaces" issued. For example, using a shortkey in Internet Explorer where focus is not on an edit box, will cause the "back" button to be pressed numerous times due to the backspaces being issued. The Do not remove keystrokes typed option will prevent this from happening.
Appearance

General Appearance

**Other**

Show large icons in toolbars
Use this option to display the larger icons in the Macro Express - Explorer toolbar. If this option is turned off, the smaller icons will be displayed. The Macro Express - Explorer must be restarted before the change takes effect.

**Theme**

Choose a theme from the drop down list to change the look of the Explorer window. Choose from Blue Gradient, Retro, Flat, Current and Custom options. The program defaults to the Current theme.

The **Custom theme** allows the user to select colors for various window components, choose from several menu styles and choose the button alignment in the program’s windows and dialogs.
Font

Menu Font

Change the font type and style of the menus in the Macro Express Explorer, Script Editor and Menu Builder windows.
Use these options to adjust the look of the *Macro Express - Explorer* window.

**Macro Categories**
Show macro category icons
This option displays folder icons next to each category in the *Category* field of the Macro Explorer.

**Macro List**
Below is a chart containing the options to display in the Macro Express Explorer window.

<table>
<thead>
<tr>
<th>Display Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid Font: AaBbCcDd 12345</td>
<td>Change</td>
</tr>
<tr>
<td>Category Font: AaBbCcDd 12345</td>
<td>Change</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Icon</td>
<td>Displays icons next to each macro listed in the Macro Express - Explorer. If an icon has not been assigned to the macro, the default Macro Express icon is displayed.</td>
</tr>
<tr>
<td>Show Index</td>
<td>Each macro is assigned an index number. Display the index number for each macro.</td>
</tr>
<tr>
<td>Show Nickname</td>
<td>Display the nickname assigned to each macro created.</td>
</tr>
<tr>
<td>Show Activation</td>
<td>Show the activation (hot key combination, shortkey, etc.) that is assigned to each macro.</td>
</tr>
<tr>
<td>Show Scope</td>
<td>Display the scope that is assigned to each macro.</td>
</tr>
<tr>
<td>Show Modified date/time</td>
<td>Display the date and time that the macros were last modified or edited.</td>
</tr>
<tr>
<td>Show Category</td>
<td>Show the name of the category (if any) that the macro is assigned to.</td>
</tr>
<tr>
<td>Show Last Run Time</td>
<td>Show the date and time that the macro was last run.</td>
</tr>
<tr>
<td>Show grid lines</td>
<td>Show grid lines between each macro listed in the Macro Express - Explorer.</td>
</tr>
<tr>
<td>Show preview pane</td>
<td>Display a panel at the bottom of the Macro Explorer window providing additional details about the highlighted macro.</td>
</tr>
<tr>
<td>Color every other line</td>
<td>Show every other macro in the Macro Express - Explorer list with a shaded background. This helps to read across the line easier.</td>
</tr>
<tr>
<td>Draw a line through disabled macros</td>
<td>This option draws a line through any disabled macros displayed in the Macro Express - Explorer window. This makes it more readily apparent that the macro is disabled.</td>
</tr>
</tbody>
</table>

**Other**

Show full path in the Reopen list
In the Macro Express - Explorer window click on File, Reopen to view a list of the most recently used macro (.mex) files. By default the list only displays the file name. Select this option to show the file name and the path where the file is saved on the computer.

**Fonts**
Grid Font
Change the font type, style, size and color of the text displayed in the Macro Express Explorer grid.

Category Font
Change the font type, style, size and color of the text displayed in the Macro Express Explorer categories column.
**Font**

Use this option to select the font type, style, color and size to display in the Script Editor.

**Display command category icons**

Each group of macro commands in the Script Editor, such as CD-ROM, Logic, etc., has a distinct icon associated with it. Each time a command from that group is used and added to the macro script, the associated icon is also displayed in the script.

If not selected, the icons are not displayed in the category list or next to each command in the macro script.
**Mouse Locator Settings**

**Style (not available in Windows 10)**

The Translucent style is the default for the Mouse Locator. However, depending on what is displayed underneath the Mouse Locator it may be difficult to read the values for the mouse position and colors. Turn off the Translucent style if you experience difficulties reading the text.

---

**Display Pixel Color**

To display colors, computers use the RGB Additive Color System. The letters R, G and B represent Red, Green and Blue respectively. Separate values are used for the amount of Red, Green and Blue. On a Windows computer, each color ranges from 0, all the way off, up to 255 (or FF hexadecimal) all the way on. Combining different values for each basic color allows millions of different colors to be displayed. For example, White has a value of 000000, Green has a value of 00FF00 and black has a value of FFFFFF.

The hexadecimal number that represents a color can also be represented as an integer value. For example, one orange color has a hexadecimal value of 2D42D4. When displayed as an integer this value is 2966228. The Get Pixel command returns the integer value of the color for a given pixel. This allows the integer variable commands to test for specific colors in your macros.
The Mouse Locator displays colors in a variety of formats to make it convenient to enter colors into other programs. For example, the Get Pixel Color uses an integer color value. When entering a color for a web page the color value is in hexadecimal RGB format. To enter a color in Word requires separate integer values for Red, Green and Blue. And some programming languages require a hexadecimal BGR (Blue, Green, Red) format.

The Display Pixel Color options allow you to choose which Pixel Color values to display on the Mouse Locator.

**Copy to Clipboard**

You can use the Mouse Locator to get the value of a color on your computer monitor. Make sure the Mouse Locator is the active window, then move your mouse over the color you want and press Ctrl + c. The color will be copied to the clipboard so you can paste it into another program.

By default, several values are copied to the clipboard including the Screen Position of the mouse and the Pixel Color in a variety of formats. Here is an example:

```
990,385,2966228,2D42D4,212,66,45,#D4422D
```

The Copy to Clipboard options allow you to choose which values to include when copying to the clipboard.
Email

**General Email Settings**

Use MAPI to send email
Select this option to send messages through the default email program rather than using the Macro Express email client. Macro Express will only be able to send email using the default email client if it is compatible with the Messaging Application Programming Interface (MAPI). Mainstream email programs such as Outlook, Eudora, Thunderbird, etc. are compatible.

If using this option, the SMTP Settings tab changes to a MAPI Settings tab so the options can be set.

Keep a log of all messages sent
This option logs all email messages sent through Macro Express to an email log file. From the Macro Explorer window click on Tools > Sent Email Log to review the mails sent via Macro Express.
Related Topics
SMTP Settings

To successfully use the email commands via SMTP, the default email settings need to be entered into the SMTP settings panel. Click on Options > Preferences > Email to enable the email functions of Macro Express.

Server Settings
The SMTP Server is what allows email to be sent over the Internet. The server settings may be obtained from the Internet Email provider or from the configuration section of the default email program on the computer.

- **Host** - The "Host" value may appear as a series of numbers and periods such as 192.168.0.1 or as a set of characters looking something like a web site name such as mail.myisp.com.
- **Port** - The port number is almost always 25. When in doubt, set this value to 25.

Authentication
The SMTP server requires authentication
The email provider may require use of SMTP Server Authentication. If so, select this option and insert the
user name and password in the appropriate fields. If authentication is not required, then leave this option unchecked.

Email Address
This is the name and email address that display in the return address of any email sent through Macro Express. Please note that if the email address entered is incorrect, the recipients of the email may not know how to reply to the message.
This option is only available if MAPI is selected in the Email > General tab.

The MAPI information - Profile Name and Password - is only required if using multiple email profiles. Enter the email Profile to use with Macro Express and the password.

If not using multiple email profiles then this information should be left blank.
**Address Book**

The Address Book is a list of names and email addresses to choose from when creating email macros. Use this function to add names, make changes to existing names or delete names from the list. Click on Options > Preferences > Email to access this option. The Email Send command also has an option for editing the list of email recipients.

![Preferences window with Address Book tab](image)

**Add**

Click on the Add button to open the Email Recipient Maintenance window shown below. The two fields will be blank. Just enter the person’s name and email address and click OK to add that person to the list.

![Email Address window](image)
Modify
If the email address or other information has changed for someone on the list highlight that person's name from the list and click on the Modify button. The name and email address are displayed in the Email Address window as shown above. Edit this information and click OK to save the changes.

Remove
To remove a person from the email recipient list, highlight that person's name and click on the Remove button. The name will be removed from the list.

Related Topics
Use this option to set the default file locations for a number of files used by Macro Express. Descriptions of the files are provided below.

### Email Address Book
Specifies the path and name of the file that holds any email addresses stored by Macro Express. This option is provided so that network users can each have their own individual list of email addresses. If email addresses are common to all users, simply point each user to the same file.

Click on the folder icon to open the address book and view its contents.

### Sent Email Log
The Sent Email Log field displays the path and name of the file that logs the mails sent via Macro Express. The email information will only be saved to this file if the Email Logging option has been set. Start a new log file at any time by changing the file name.
Click on the folder icon to open the sent email log and view the contents.

**Default Macro Log folder**
This specifies the path and name of the file that holds the macro logs created when using the Log, Errors command. Start a new log file anytime by changing the file name. This option is provided so that network users can each have their own individual list of error messages. If error messages are common to all users, simply point each user to the same file.

Click on the folder icon to open the default error log folder and view the logs contained in the folder.

**Crash Report folder**
This specifies the path and folder where crash reports are saved. Crash reports are generated by an unexpected closing of the program. The details of the problem are saved to a file that begins with 'error' and ends with '.TX' in the folder specified here. The default path is the folder where the Macro Express program is installed.

Click on the folder icon to open the crash report folder and view the reports stored in that folder.

**Keyboard Remap folder**
This specifies the path and name of the file that contains the Remap Keyboard information.

Click on the folder icon to open the keyboard remapping folder and view the contents.

**Temporary Capture file**
Use the System Macro - Ctrl + Alt + Shift + T to capture a temporary macro. The temporary macro is stored in the file located in the path defined in this field.

Click on the folder icon to open the folder containing the temporary capture macro.
Network

Macro File Networking
Macro Express can be set to run over a network using the options described below.

Lock the macro(s) currently being edited
This option prevents two or more users from editing a macro at the same time by locking the macro as it is being edited. If this option is disabled the lock is neither set nor checked when a macro is edited. If the Lock the Macro(s) Currently Being Edited option is disabled and two or more users edit a macro at the same time, the macro may become corrupted. We recommend leaving this option enabled.

Synchronize the macro file
This option is available to allow automatic synchronization of data files between users on a network. This updating can be set to occur every minute, every two minutes on up to every 999 minutes.

For example, if the interval is set to 5 minutes and another user makes a change to the same macro file currently open, then within 5 minutes the macro data will automatically be synchronized between the networked computers.
When running Macro Express over a network there are options to prevent certain users from changing any of the Macro Express data. This may be accomplished via the Command Line Parameters.

**Sync every ___ minutes**
Enter the time interval in minutes of the synchronization schedule.

**Note:** Multi-user networking of this product requires the purchase of a multi-user license.
Read Only Prompt

This preference setting refers to Macro Express (.mex) files that have been set to a Read Only status. It may refer to opening a file through the File > Open File menu, loading a macro file during playback of a macro, or other times the .mex file is being accessed.

**Note:** If using the Load New Macro File command and the file to be loaded is a Read Only file, then the Default Action selected in this Preference panel will be used.

Prompt about read-only status on macro files
Select this option to have the program prompt for action when a read only .mex macro file is encountered. The following dialog opens allowing the user to select a course of action.
Default Action
If the Prompt option is not selected, then choose from one of the three default options discussed below. The action selected will occur each time a read only .mex macro file is encountered.

Leave the file as is
The read only status will be left as is. Macro Express will attempt to perform the requested action with the read only file.

Turn off the read-only flag
The read only status of the macro file is turned off, which will allow for editing of the macro file, etc.

Abort the operation
The function that Macro Express is attempting to do with the file will be aborted.
General

Backup

Use this option to create automatic backups of the macro data file currently in use. This option allows for selecting the frequency of the backups, the number of backups to store and where to save the backup files.

Note: Automatic backups will only occur after the macro (.mex) file has been modified. In the example from the image above, if the file has not been modified, then starting the program or closing the editor will not trigger a backup. Only if the file as been modified, does the automatic backup occur. The date/time stamp of the backup file will match the date/time when the original (.mex) macro file was last modified.

Disabling, enabling and deleting macros, as well as creating new or editing existing macros, are considered modifications to the file and will initiate a backup.

Schedule
Determine the frequency of backups.
Backup when program starts
A backup of the data is created when the Macro Express Player is started.

Backup when program closes
This creates a backup of the data every time that the Macro Express Player is closed.

Backup when an editor closes
A data backup file is created each time one of the Macro Express editor windows closes. This includes the Script Editor, the Menu Builder, the Quick Wizard and the Macro Express - Explorer window.

Backup every ___ day at _____________
This options provides flexibility for creating a backup schedule. Select the number of days between backups. If the number 2 is entered, then a backup will run every two days. Choose to have the backups run when the program starts, closes or select a specific time of the day.

No Backup
To not schedule any backups, leave the four options unchecked. Manually back up the macro file by opening the Macro Express - Explorer window and clicking on File > Backup. See the Backing Up Macros topic for more information on this.

Options
Choose to display a message notifying of a backup and decide how many backup files to keep.

Display message while backing up
Choose this option to display a message on screen when the backup occurs. If the file is small, this may happen almost instantaneously, so that the display message may not be visible. If the backups are scheduled intermittently, then this may serve as a reminder that a backup is in progress.

Keep ____ backups
Specify the number of backup copies to store on the computer. The default number of backup files is 10.

Backup Location
Specify the location of the backup files from the drop down list. Select the number of backup copies to keep.

Backup to the same folder as the macro file
The backup file is created and saved into the same folder where the original macro file is currently located.

Backup to a specific path
Use this option to store the backups in a folder other than the one where the original file is located.

Backup path
If using the Backup to a Specific Path option, click on the Browse button to determine the location where the backup file will be stored. Or type in the full file path in the edit field.

Note: To manually back up the macro file at any time, open the Macro Express Explorer window and click on File > Backup.
Capture

Macro Express records macros by capturing mouse and keystrokes and saving this information for later playback as a macro. Options are available to determine what to capture and how much.

Optionally capture keystrokes, mouse movements and clicks and actual time between actions. There are two methods for starting a macro recording. One is to select the activation (hot key, shortkey, etc.) to assign to the macro before recording. Another is to select this information after recording the macro.

When running Macro Express, there are eight hot keys automatically assigned. These eight hot keys are system macros (Scope indicates SYSTEM). One of these system macros is named “Start / Stop Capture” and is defined as CTRL+ALT+SHIFT+X by default. Pressing CTRL+ALT+SHIFT+X starts the recording of a macro and pressing it a second time stops the recording. The actual hot key may be reassigned to any hot key combination available in Macro Express.

When the recording stops, a Capture Complete window appears prompting to assign a Hot Key, Shortkey or other activation. While recording, a "movie camera" icon displays in the Windows notification area. This indicates that the macro is currently recording. Right click on this icon to stop recording. Go to Options > Preferences > General - Notification Area tab in order to turn off the icon.
Before recording a macro using this System Hot Key, make sure that the default capture settings have been defined. Select Options > Preferences > General - Capture tab from the Macro Express - Explorer window to define the capture settings. These are the default settings when the System “Start / Stop Capture” Hot Key is used. These are also the default settings that appear when recording a macro by assigning the Hot Key first.

---

**Default Scope**

The Global scope allows for the playback of the macro into any Windows program. The Program/Window scope indicates that the recorded macro will only start in the program or window selected. Or allow the macro to play back in all programs except the ones defined.

**Capture keystrokes**

Select this option to record all keystrokes made during the capture process.

- **Capture Alt up and down for menus**
  Some window menus do not always respond to a single press of the Alt key in a macro. This option records the Alt key twice to help ensure proper activation of the menu.

  For example, to open the File menu in an application, press Alt + f during the capture. The macro script displays <ALT><ALT>f, even though the Alt key was only pressed once during the capture.

**Capture Mouse Relative to**

A check placed in this option records all mouse clicks and movements made during the capture process. There are several mouse options to choose from.

- **Relative to Screen** - Captures all mouse clicks and movements in relation to the cursor’s position on the monitor.
- **Relative to Window** - Captures all mouse clicks and movements in relation to the application window that is open and has focus.
- **Relative to Last Position** - Captures the mouse clicks or movements based on the last position of the mouse cursor.

**Capture the window size**

This option is only available if Relative to Window is selected. This choice remembers the size of the window in which the capture occurs. When the macro plays back, the window is resized, if necessary, to the original size when the recording was made. This helps ensure that the mouse clicks and movements are accurate.

**Capture only the mouse clicks**

Select this option to only capture the mouse clicks, including the position of the mouse click. This option captures the position where the mouse is to click and also the mouse click itself. No other movements of the mouse are recorded.

Unless drawing or recording the mouse dragging an item, it is best to turn on this option. It reduces the size of the macro considerably and makes it much easier to edit if necessary. It also helps improve the playback speed of the macro, since all of the interim mouse move commands and associated delays are eliminated from the macro.

---

**Capture Speed**

This option refers to how fast the macro plays back in relation to the recording speed.
<table>
<thead>
<tr>
<th>Speed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Speed</td>
<td>Plays the macro back at the same speed as the macro was recorded. Any hesitations, etc. play back at the same speed as recorded.</td>
</tr>
<tr>
<td>Half Speed</td>
<td>Slows down the macro playback to half of the recording speed.</td>
</tr>
<tr>
<td>Double Speed</td>
<td>Speeds up the macro playback to twice the actual recording speed.</td>
</tr>
<tr>
<td>Quadruple Speed</td>
<td>Speeds up the macro playback to four times the actual recording speed.</td>
</tr>
<tr>
<td>Fastest Speed (no delays)</td>
<td>Plays back the macro with no hesitations, delays, etc. Remove the check next to the Capture at a Specific Speed box to eliminate delays from the macro. <strong>Caution:</strong> Selecting this option may cause the macro to play back too fast and throw off the timing of the macro.</td>
</tr>
</tbody>
</table>

After the capture is complete, optionally modify the playback speed of the macro in the Script Editor or Direct Editor. Use the Macro Playback Speed command to do this.

**Other**

**Display a prompt before capturing**

With this option selected, a message is displayed indicating that the capture is starting.
Dialogs

Inform the user when a macro has been cancelled
Select this option to have a dialog box display when a running macro is cancelled.

Prompt the user to create a variable that is not defined
This option prompts a user to define a variable to be used in the macro, but no value has been assigned.

Warn about file format when importing a text file
Receive a prompt when importing a text file (File > Import > Import Text File) to be notified that the file must be in a specific format or the import process may not be successful.

Prompt to associate files at program startup (Windows XP or prior)
A file association has been created for files containing a group of macros (*.MEX file) and for files that are macros (*.MXE file). If for some reason a .mex or .mxe file is not linked to Macro Express, a prompt message
appears asking to link the files to the program. This message appears the first time Macro Express starts.

**This option is not available in the portable version.**

**Display the notification area balloon**
For first time users of the program a balloon appears above the Macro Express icon in the notification area. The balloon notifies users that the program is running and to click on the icon to open the Macro Express Explorer window. Clicking on the balloon causes it to not appear anymore.

Choose this option to have the balloon appear in the future.

**Display the quick setup wizard at startup**
Select this box to display the Quick Setup Wizard when Macro Express first runs. The wizard allows for configuration of some of the more frequently used functions in Macro Express. These settings can be changed later at any time by clicking on the Options > Preferences menu in the Macro Express Explorer.

**Don't show this wizard again**
After completing the wizard check this box to not display the wizard the next time Macro Express starts. To start the wizard again later, select the Display the Quick Setup Wizard at Startup option, save the change and restart Macro Express.

**Display the shortkey conflict warning**
When using the Prefix key activation method for shortkey activated macros, certain shortkey combinations may conflict with each other. For example, if a shortkey activation is set to 'be' and a second activation is set
to 'bet', 'bet' will never play back because 'be' will always play back before typing the last "t" in "bet". The suffix key option does not run into this potential conflict.

The warning message is just a warning of potential conflict. It will not prevent creation of the macro or use of the shortkey.

Select the Don't show this again option to not have the warning display in the future. The warning may be turned back on from the Dialogs preference panel as shown above.

Display message while packing macro file
Select this option to display the progress of the file packing. From the Macro Express - Explorer window click on Tools > Pack and choose to pack the current file.

Display periodic messages during 30-day trial
This option displays 5 reminder messages during the 30 day evaluation period.

Display warning when the Display icon in Notification Area option is disabled
If you elect to not have the Macro Express icon display in the notification area by going to the Options, Preferences, General - Notification Area tab, you will be shown the message below providing instructions for opening the Macro Express - Explorer window.

Warn if a macro file backup fails
Displays a message to let the user know that the .mex file backup has failed.

Display the Use suffix Solitary usage warning
If the suffix key option is turned on, a message will prompt the user to select solitary usage.
We recommend that the "Solitary usage" option be enabled when the "Use suffix keys" option is enabled.

Do you want to enable "Solitary usage" now?

☐ Don't show this again
**Notification Area**

This topic discusses items placed in the notification area and notification area icon functionality. The notification area refers to the small icons in the lower right hand corner of a conventionally configured screen (next to the clock).

### Icons

**Display the program icon in notification area**

This option, when selected, places a Macro Express icon into the Windows notification area when the Macro Express Player is active. The icon in the notification area serves two primary purposes. First, it readily identifies that Macro Express is running in the background. Second, clicking on the icon with the left mouse button activates the Macro Express Editor and brings it to the foreground. Right clicking on the icon opens a small menu to open the editor, access the help file or tools, suspend the program, shut down the program, etc.

When not selected, Macro Express runs in hidden mode. This mode completely hides the macro player. In the absence of a notification area icon, use the **system macros** that are defined for activating the editor and terminating the player. Ctrl Alt Shift W is the default hot key to open the editor.
**Display an icon when a macro is running**
This option displays the "Running Man" icon in the notification area during the execution of a macro. It signals that a macro playback is in progress.

**Display an icon when recording a macro**
This option displays the camera icon in the notification area during the recording (capturing) of a macro. It signals that a macro recording is in progress.

---

**Main Icon Action**
Use this option to change what happens when left clicking on the Macro Express icon in the notification area. Select from three options.

1. The default setting opens the Macro Express Explorer window.
2. Let the program do nothing when left clicking on this icon.
3. Run a macro. Select the macro from the .mex macro file that is open. The macro runs each time the Macro Express icon in the notification area is clicked. If a different macro file is later opened, clicking on the icon will first load the original file containing the macro selected and run it.
Miscellaneous

Disable keyboard remapping
Macro Express includes a function to remap most keys on the keyboard. Select this option to disable keyboard remapping.

Enhanced Wildcard Window Search
This option enhances the use of wildcards in window names when using the partial match option. It provides some additional functionality when the command is looking for wildcards.

Remember the last tab open when restarting the editor
Select this option to have the Script Editor window remember which tab was last opened when the editor is closed. When reopening the editor, that tab will still be open. This function refers to the Script, Activations, Variables, Miscellaneous, Scope, Security or Notes tabs.

Updates
Check for Updates
This option checks to see if a program update is available for download. There are three options available.

  **Automatically** - The program will check for updates automatically and display a notice when one is available.

  **Manually** - Open the program and click on Help, About. The About box will show whether there is an update available or not.

  **Disable** - Don't show any information about updates.

Log Update Progress
The progress of the update is stored in a log file, easily accessible from the Macro Express Explorer window by clicking on Tools, Macro Logs.

Advanced Options
**Save settings as defaults for all users**
The preferences for Macro Express are stored in each user's profile. An option set for one user will not be available for other users. When a new user begins to use Macro Express the program's default preference settings are assigned to that user.

The "Save settings as defaults for all users" can be used to assign preference settings for other users of that computer. To do this, adjust the preference settings as desired. Then select the "Save settings as defaults for all users" check box and click the OK or Apply button. From that point on, other users of the computer will use the same default preference settings.

Unlike all other settings in the preferences, the “Save settings for all users” option is meant for a one-time use. If this option is selected, when either the OK or Apply button is clicked, Macro Express Pro copies all of the settings from the HKCU area of the registry to the HKLM area. This is useful when preparing to Export Program Configuration to use later to import the preferences or to set the preferences when installing the program. The “Save settings for all users” option is always unselected when the Preferences dialog is opened.

Each user may change the preferences to suit their needs. Once changed, the default values will not apply when they are using Macro Express.

**The "Save settings as defaults for all users" option is not available in the portable version.**
Delays

When typing text on the keyboard each key is pressed and then released. Macro Express simulates this action for each keystroke played back in a macro. A delay between keystrokes may be required for longer strings of text, so that the text does not play back too fast and cause a Keyboard Buffer overflow. This may result in some of the text missing or scrambled.

These two delay options are global settings for all macros that play keystrokes. If you find the text playing back too fast, increase the microsecond (millionth of a second) delay and test. Adjust as necessary.

Delay after keystroke down
A delay in the number of microseconds selected is applied after each keystroke is pressed down.

Delay after keystroke up
A delay in the number of microseconds selected is applied after each keystroke is released.
You may choose to use no delays, one of the delays or both. The default setting is 300 microseconds with both options turned on, which should be optimal for most systems.

**Use the hardware high-speed timer when possible**
Some computers make use of a high speed timer. Macro Express makes use of this timer in calculating delays. If the system does not use this timer, then leave this option unchecked.

On other systems the timer does not work properly. Do not select this option in this circumstance either.

**Wait ____ milliseconds between clipboard commands**
This option inserts a default 250 millisecond delay for each clipboard command in a macro. Windows requires a little bit of time to process a clipboard command. A 250 millisecond delay is adequate for most systems.

If the clipboard commands don't seem to be responding correctly, experiment with the timing and adjust the setting. This option also reduces the need to insert Delay commands after each clipboard command.

**Wait ____ milliseconds after executing the window activate command**
This option instructs the macro to wait a minimum of 250 seconds after activating a window before continuing with the next macro command. The default setting is 250 milliseconds. This setting may also be adjusted as needed.
Miscellaneous

HotKeys

HotKey to abort macros
Choose from among seven hot key combinations to stop a macro that is currently running. For example, if the Win + ~ combination is selected, press this combination to stop a running macro.

If displaying the Running Status icon when a macro runs, alternatively right mouse click on the icon to terminate the macro.

Note: The Timed Delay in Seconds command and the Wait for Time to Elapse command suspend Macro Express for the amount of time specified. During this delay time the macro cannot be terminated.

Please note that macros that consist of numerous keystrokes can send the keystrokes rather quickly and Windows buffers up the keystrokes. Once such commands have been buffered in Windows, aborting a macro does not cancel them. In these cases, it may appear that the abort command did not work when in reality the macro has already finished issuing its commands and Windows is now processing them.

HotKey to pause macros
Select from among seven hot key combinations to pause a macro that is currently running. When ready to resume the macro, press the original hot key or click on the Resume button of the Pause dialog that displays.

---

**Errors**

*Log all errors (regardless of individual macro settings)*

This is a quick way to log errors for all macros. There is no need to individually set the error logging for each macro through the macro properties. It automatically logs all information as long as the error logging commands are included in the macros. Each individual macro generates its own separate log file.

**Clear error messages after ________ seconds**

If an error message generated by the Macro Express Player occurs during the playback of a macro, this option closes the error message after the number of seconds designated. When not selected, manually click on the OK button of the error message to close the dialog.

The default setting to is leave this option unchecked, so that error messages are displayed until manually closed. **Note:** Setting the time to (0) zero seconds causes the error message to be displayed indefinitely.

The Clear Error Messages option may be preferable when several macros are scheduled to run unattended. If for some reason the first macro fails and displays an error message, the message closes automatically after the number of seconds specified. When the message window closes, the macro terminates and allows the next scheduled macro to run. Otherwise the first macro would not close, preventing subsequent macros from running as scheduled.

Typical error messages coming from the Player would be Time Out messages while waiting for windows, a file or folder wasn't found or a networking error.

**Take this action**

Set a default course of action to take when the error message occurs.

- **Halt the Macro** - When the error occurs the macro stops and terminates.
- **Ignore the Error** - The error is ignored and the macro continues. Most likely the command that generated the error is skipped.
- **Handle the Error** - Most of the macro commands have an error handling option. If using Error Handling commands in the macro script immediately following the command that generated the error, the macro will take the actions specified.

---

**Macro Logs**

**Timestamp format**

This option formats the time stamp saved in the log file to any pattern preferred. The default format is dd, MM dd, XYY h:mm:ss AMP. The guide in the Date/Time help topic can be used for determining the abbreviations and setting the time stamp.

**Log Unusual Events**

Any unusual events that occur when playing back a macro will be logged. The information will be stored in the same file where all macro log information is stored.

**Notify when an unusual event logged**

This option, enabled by default, displays a notification when an unusual event is logged.

**Check size of Macro logs**

Depending on your settings, every macro command may be logged or only when an error occurs. If the
Macro logs get too large, it can slow the macro. With this option selected, Macro Express checks the size of the macro logs and warns if one or more of them exceed a predefined size.

This check only occurs when Macro Express starts. Changing the settings in the preferences does not cause the log to be checked again, only when the program starts.

Only the Default Macro Log folder is checked. If your individual macros write to a log in a different folder, those logs are not checked.

A sample of the warning message is shown below. Click on the message to open Explorer to the folder where the log is saved. You can delete, edit or archive the log.

Warning: Macro Log too large
One or more macro logs is getting large and may cause your macros to slow down.

Macro Express®, a Windows macro program

Warn if a macro log exceeds ____ KB
Enter the size in KB of the macro log file. When the file exceeds this size, the warning will appear the next time Macro Express is started. The default size is 5120 KB.

Notification
Play a sound when a macro runs
Use this function to help debug macros. When testing a macro, this will alert that the macro has successfully started. When finished testing, you may want to turn off this option so that the sound doesn't play every time a macro starts.

To select a sound file click the browse button to locate a .wav file on the computer or type the full path and file name of the .wav file.

Or select one of the system sounds available on the computer by choosing from the drop down list. A system sound is a sound assigned to specific Program Events within Windows such as Asterisk, Device Connect or Windows Logoff. The sounds assigned to these events are selected in the Windows Control Panel either individually or as part of a theme. Not all system sounds listed in the Control Panel are available in this command.

The Default Beep sound, defined in the Control Panel, plays if a system sound is not defined or no sound is assigned to the specified system sound in the Control Panel.

Click on the test button to listen to the sound. This is a handy way to quickly test if the correct sound was selected. (The sound is played immediately upon clicking the button.)
Startup

Program Startup
Show the splash screen
Displays the Macro Express Splash screen for a few seconds while the program is loading.

Show Macro Explorer on startup
Instructs the Macro Express - Explorer to load and display when Macro Express starts up.

Windows Startup
Run when Windows starts up
This option instructs Macro Express to load when Windows starts.
**Wait for ____ seconds before initializing the program**
On some computers Windows is not completely ready for Macro Express when it tries to load the program. This may be caused by other programs that are loaded when Windows starts.

This option instructs Macro Express to wait the number of seconds specified to ensure that Windows is fully loaded. Most computers do not need this delay. If necessary, experiment with the amount of time to wait.

**Command line parameters**
Macro Express provides a number of command line parameters that are available for use at program startup. Enter the parameters in this edit field so that they will be in effect when the program starts on Windows startup.

For example, to have the program run in Browse Mode and in Network mode, insert the following into the edit field: /B /N

**The Windows Startup options are not available in the portable version.**
Saving macros and deleting macros from a macro file creates holes in the macro file structure or causes it to become fragmented. The Pack command compresses the file and fills in the holes created by the changes to the file. This is similar to performing a defrag on a hard drive, only it will take less time.

You may see this warning as you begin the Pack process. Since Macro Express uses index numbers to track each macro in the file, packing may reorder the index numbers. This may cause the macros in the popup or floating menus to be reordered.
Restore Keyboard & Mouse Hooks

It is possible for other programs which are run after Macro Express to improperly install themselves into the system wide Windows keyboard hooks. This causes Macro Express to no longer be able to monitor keystrokes and/or mouse events. When this occurs, Macro Express will not recognize a hot key, shortkey or mouse activated macros.

This tool reinstall the Windows keyboard and mouse hooks used by Macro Express. It provides Macro Express with the first look at keystrokes and mouse movements/clicks in order to respond to hot keys, shortkeys or mouse activated macros.

Macro Express - Explorer > Tools > Restore Keyboard & Mouse Hooks
Launch Mouse Locator

The Mouse Locator tool displays the X and Y coordinates of the mouse pointer relative to the entire screen or to the window that is active. This is useful when wanting to include mouse clicks in macro scripts.

The Locator displays the exact position of the mouse in order to plot those coordinates into a macro. Just plug in the coordinates when using the Mouse Commands found in the Scripting Editor or Direct Editor. (This function is not necessary if using the Capture option.)

Also activate this window by clicking on the Launch Mouse Locator button provided in the Mouse Move command or the Get Pixel Color command.

If the Mouse Locator window pops up in an area of the screen that covers important data, click on the window, hold the left mouse button down on the title bar at the top of the window and drag to another area of your screen.

Screen Position
The set of numbers directly under Screen Position lists the position of the mouse relative to the computer screen. When the mouse is moved, the numbers change in relation to the mouse cursor position. The number to the left is the X coordinate, or how many pixels from the left edge of the screen. The number on the right is the Y coordinate, or how many pixels the mouse is positioned from the top of the screen.

Active Window
The set of numbers directly under Active Window lists the position of the mouse relative to the active window or the window that has focus. When the Mouse Locator window is first launched, it receives focus. Clicking on a window outside of the Mouse Locator gives focus to that window. The Mouse Locator window remains on top in order to easily read the coordinates for the window with focus.

When the mouse is moved, the numbers change in relation to the mouse position. The number to the left is the X coordinate, or how many pixels the mouse is positioned from the left edge of the active window. The number on the right is the Y coordinate, or how many pixels the mouse is positioned from the top of the active window.

Pixel Color
This option displays the color of the pixel to which the mouse is pointing. Windows assigns a numeric value to each color, normally from 6 to 8 digits in length. The left side is the decimal value. This is the value returned by the Get Pixel Color command. Use the decimal value in macros that compare color values. The right side displays the hexadecimal value in BGR format.

The middle row displays the pixel color in separate values for Red, Green and Blue. These values are used when entering colors in programs, such as Word, that accept separate values for Red, Green and Blue.
The bottom row displays the hexadecimal pixel color value in RGB format.

Which Pixel Color formats are displayed can be adjusted using the Pixel Color options found in Options, Preferences, Appearance, Mouse Locator.

**How colors are displayed**
To display colors, computers use the RGB Additive Color System. The letters R, G and B represent Red, Green and Blue respectively. Separate values are used for the amount of Red, Green and Blue. On a Windows computer, each color ranges from 0, all the way off, up to 255 (or FF hexadecimal) all the way on. Combining different values for each basic color allows millions of different colors to be displayed. For example, White has a value of 000000, Green has a value of 00FF00 and black has a value of FFFFFF.

The hexadecimal number that represents a color can also be represented as an integer value. For example, one orange color has a hexadecimal value of 2D42D4. When displayed as an integer this value is 2966228. The Get Pixel Color command returns the integer value of the color for a given pixel. This allows the integer variable commands to test for specific colors in your macros.

The Mouse Locator displays colors in a variety of formats to make it convenient to enter colors into other programs. For example, when entering a color for a web page the color value is in hexadecimal RGB format. To enter a color in Word requires separate integer values for Red, Green and Blue. And some programming languages require a hexadecimal BGR (Blue, Green, Red) format.

**Copy to Clipboard**
You can use the Mouse Locator to get the value of a color on your computer monitor. Make sure the Mouse Locator is the active window, then move your mouse over the color you want and press Ctrl-c. The color will be copied to the clipboard so you can paste it into another program.

By default, several values are copied to the clipboard including the Screen Position of the mouse and the Pixel Color in a variety of formats. Here is an example:

990,385,2966228,2D42D4,212,66,45,#D4422D

What is copied to the clipboard can be adjusted using the Copy To Clipboard options found in Options, Preferences, Appearance, Mouse Locator.
Restore Program Defaults

Clicking on Tools > Restore Program Defaults from the Macro Express - Explorer menu restores the program settings back to their default values. This primarily affects any settings made in the Options > Preference area. Other things that may be reset include the default macro file that opens, macro sort order and categories.
**Import Program Configuration**

This option imports all of the program configuration settings into Macro Express, if the configuration settings were previously exported to a file. The file replaces the current configuration settings in Macro Express. This would include any Preference settings selected, macro file in use, etc.

Click on Tools > Import Program Configuration to open a browse window to navigate to the file previously exported. Highlight the file and import.

This is a handy way to save program settings if planning to migrate to another computer. Easily import the settings back into the program after installing Macro Express on the other computer. If more than one user shares a computer, each user could save their own configuration settings and load them in while they are at work on the computer.

Another option allows the individual settings to be loaded at startup for each user by setting a Command Line Parameter. Each individual user would need to create their own startup shortcut in order for this to work correctly.

**Note:** Importing the program configuration from a newer version of Macro Express into an older version of the program may cause problems. The newer configuration file may contain additional data that is not supported in the older version of Macro Express.

Macro Express - Explorer > Tools > Import Program Configuration

**This import option is not available in the portable version.**
**Export Program Configuration**

This option saves all of the program configuration settings to a file. This includes any Preference settings selected, macro file in use, etc. Click on Tools > Export Program Configuration to do this. A Save File box appears prompting to name the configuration file and select the file location. Use the Tools > Import Program Configuration to retrieve the file and reload the settings.

This is a handy way to save program settings if planning to migrate to another computer. Easily import the settings back into the program after installing Macro Express on the other computer. If more than one user shares a computer, each user could save their own configuration settings and load them in while they are at work on the computer.

Another option allows the individual settings to be loaded at startup for each user by setting a [Command Line Parameter](#). Each individual user would need to create their own startup shortcut in order for this to work correctly.

Macro Express - Explorer > Tools > Export Program Configuration

**This export option is not available in the portable version.**
**Restore File Associations** *(Windows XP and prior)*

A file association has been created for files containing a group of macros (*.MEX file) and for files that are macros (*.MXE file). Double click on a MEX file from within Windows Explorer to start Macro Express, if not already running, and load in the .MEX file. Double click on a .MXE file from within Windows Explorer to run the macro contained in the file.

If for some reason the file associations are broken, click on Tools > Restore File Associations to restore the links and allow Windows to process the files correctly.

Macro Express - Explorer > Tools > Restore File Associations

**This option is not available in the [portable version](#).**
Remap Keyboard

The Remap Keyboard option allows remapping of many of the keys on the keyboard. For instance remap the $ key so that every time the $ key is pressed the £ symbol is be typed in the application currently running.

Selecting Tools > Remap Keyboard from the Macro Explorer activates the Remap Keyboard window. There are four columns of keys which may be remapped: 1: Upper case - all letters of the alphabet capitalized, 2: Lower case - all letters of the alphabet in lower case, 3: Punctuation - punctuation and symbol keys found on the keyboard, and 4: Numeric - the numbers from 0-9.

Select a Layout
Also create multiple keyboard layouts. Generate a number of layouts to use with different applications. Click on the Add button to create a new layout.

Remap the Keyboard
Select the key to remap by pointing the mouse at that key and double clicking. The select character window appears, as shown below. Find the replacement character and double click on it or highlight the character with a single mouse click. Click OK to save the change and return to the Remap Keyboard window to view the selected character.

For example, double click on the punctuation mark ^ (the right column of the two). The select character window appears. Select ©. Double click on this symbol to return to the Remap Keyboard window. The © has replaced the ^ in the list of keys. Now each time the ^ key is typed in other applications, the © symbol appears.

Note: Click on Options > Preferences > General and select the Miscellaneous tab to disable the Keyboard Remapping feature.
Select Character

Double clicking on any of the letters or symbols from the four columns displayed on the Remap Keyboard window displays a chart of all symbols available, as shown below.

Follow the steps below to remap the keyboard:

1. From the Macro Explorer, select Tools > Remap Keyboard.
2. The Remap Keyboard window will activate.
3. Double click on one of the letters or characters to remap.
4. The Select Character window displays, as shown above.
5. Highlight the symbol to use and then click on the OK Button. Or just double click on the desired symbol.
6. The symbol is inserted into the appropriate field (next to the letter or character to be remapped in the Remap Keyboard window). The program returns to the Remap Keyboard window ready to remap another key or click OK to save the changes and return to Macro Explorer.

Limitations: The remap option is essentially limited to the alphabet keys, number keys, punctuation keys and symbols. Keys such as the F1 - F12 keys, Alt, Ctrl, Insert, Home, Page Up, etc. cannot be remapped through this option. However, many of these keys may be used as single key hotkeys to essentially accomplish the same thing that the Remap function does.

Consider the example of remapping the Home key as the Delete key. This cannot be done with the remap option. But, it can be accomplished with a macro. Assign the Home key as the hotkey. Use the Text Type command when building the macro. In the Text Type window insert Delete in the Keystrokes field. Save the input and then the macro. Press the Home key and it plays back as a Delete.
Remap Specifications

Keys that can be remapped (changed):

1) Lower Case "A" through "Z"
2) Upper Case (Shifted) "A" through "Z"
3) Numerics "0" through "9"
4) 32 Punctuation Keys (period, asterisk, etc)

Keys that may be assigned to a remapped key:

1) The standard Windows ANSI character set including:
   Normal ASCII characters including A through Z, a through z, 0 through 9 and numerous
   punctuation keys such as . , * # ! and dozens more.
2) Western European Language characters including â è ö ì ú Ö Æ ß ñ and dozens more
3) Western European Language punctuation such as i ç
4) Math Symbols such as ÷ × % ½ ± ¼ ½ ¾
5) Currency Symbols such as † £ ¥ $
6) Typographical Symbols such as ¶ §
7) Legal Symbols such as ® © ™
8) And a variety of others found in the ANSI set including some of the following á " ° ¹ ² ³
**Sent Email Log**

If keeping a log of each email sent through Macro Express, click on Tools > Sent Email Log to view the emails sent. A window opens showing the subject, recipient(s) and date of the email. Highlight an email and click on the View button to display its contents.

Macro Express - Explorer > Tools > Sent Email Log
Macro Logs

This link opens the folder where the macro logs are stored. Click on any of the files located in the folder to review the log details.

Macro Express - Explorer > Tools > Macro Logs
Building Macros with the Editors

**Script Editor**

Use the Script Editor to build a macro or to edit a macro already created. The Script Editor is divided into three main sections, the Commands, the Macro Script and the Debugging tabs. Select the commands to insert into the Macro Script. The Macro Script is written so that the top line in the script is the first command that plays back in the macro.

**Note:** More than one macro may be open in the editor at the same time. Tabs at the bottom of the window allow for navigation between open macro scripts. Either click on the tab to open or press Ctrl Alt Left Arrow or Ctrl Alt Right Arrow to move between the tabs.

The Script tab contains the list of commands and the macro script. Additional information about the macro can be viewed or edited in the Activations, Variables, Miscellaneous, Scope, Security and Notes tabs.

**Macro Icon and Nickname**

Located near the top of the editor window is the Macro Nickname field and a macro icon. In the example
below, the icon is a blue number one.

Macro Icon
The icon (in the example above, a blue number one) is displayed to the left of the macro nickname. Click on the icon to open the Select an Icon window. Click on the browse button to open a folder with a number of icon options. Or navigate to another location on the hard drive to find other icons on the computer. If an icon was not selected at the time the macro was created, the default Macro Express icon is displayed.

Macro Nickname
The nickname is used to help remember the function of the macro. If a nickname was entered when assigning the macro activation, the nickname is displayed as shown in the image above. The nickname may be changed in this field if desired.

Command View
This section displays all of the commands that may be used in Macro Express. To insert a command into the script, scroll to find the command category wanted. Click on the category to display all of the commands available for that category.

Double click on the command to display open a dialog window. Define what the command should do and click OK to insert this command into the Macro Script.

Some commands do not require any user selection. Double clicking on these commands inserts the command directly into the Macro Script without an intermediary window.

Search for command
Use this function to help locate a specific command within the Commands list. To look for the Password Protection command, enter "pass" without the quotes. This highlights the Password Protection command within the list of commands. Notice that entering the "p" and the "a" first displays the Pause command. Adding the "ss" moves the highlight to the Password Protection command.

Macro Script
This area lists each of the commands that the macro will perform. The macro plays back sequentially through the list beginning with the top item. Edit any of the commands in the list by double clicking on the line of the script to be edited.

There is also a right mouse click context menu available for the items in the Macro Script. Highlight the line or lines of the script needed and then right mouse click. A context menu appears with a variety of options, also available through the Scripting Editor menus.

One item unique to the context menu is the Edit Macro option. Right mouse click on a Macro Run command in the script and select the Edit Macro option. The contents of the macro from the Macro Run command are displayed in a separate tab in the Script Editor.

Debugging Tabs
The Debugging Tabs located near the bottom of the Editor window provide information when attempting to debug a macro. Also click on Debug > View Variable Values or press the F5 key to see a display of all variables used in the macro and the values saved to those variables. These are displayed when running the macro in Test Mode.
Messages
Any syntax errors or other problems with the macro are displayed in the Messages tab when saving a macro. This tab will alert you to potential problems with the macro script, such as having a Repeat Start command without a matching Repeat End, or an If command without a matching End If.

Breakpoints
This tab displays any breakpoints that were defined in the macro for debugging purposes. The line in the script and the command with the breakpoint are displayed.

Macro Script Navigation
This section describes the functionality of the buttons available to help build and modify the macro script.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button]</td>
<td><strong>Insert Command Before Selected</strong></td>
<td>Inserts the macro command selected from the Commands list above or before the command that is highlighted in the Macro Script edit box. If a script item is not highlighted in the edit box, the macro command is placed as the first or uppermost item in the script.</td>
</tr>
<tr>
<td>![Button]</td>
<td><strong>Insert Command After Selected</strong></td>
<td>Inserts the macro command selected from the Commands list below or after the script item that is highlighted in the Macro Script edit box. If a script item is not highlighted in the edit box, the macro command is placed below or after the first or uppermost item in the script.</td>
</tr>
<tr>
<td>![Button]</td>
<td><strong>Add Command to End of Script</strong></td>
<td>Inserts the macro command selected from the Commands list as the last item in the script, below all other items.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Disable Command</td>
<td>Highlight a line in the Macro Script and then click on this button. It disables the highlighted line in the script, so that it does run during macro playback. A red line is drawn through the disabled script, for a quick visual acknowledgment.</td>
<td></td>
</tr>
<tr>
<td>Enable Command</td>
<td>Highlighting a line in the Macro Script that is disabled displays this symbol. Click on the button to enable the line in the script to allow the command to run during macro playback.</td>
<td></td>
</tr>
<tr>
<td>Direct Editor</td>
<td>Switch from the Script Editor view to the Direct Editor.</td>
<td></td>
</tr>
<tr>
<td>Move Command Up</td>
<td>Moves the highlighted command up one spot in the Macro Script, ahead of other script items already in place. Each click moves the command up one space in the script. Also highlight several consecutive lines in the script and move them all at the same time.</td>
<td></td>
</tr>
<tr>
<td>Move Command Down</td>
<td>Moves the highlighted command down one spot in the edit box, beneath the other script items already in place. Each click moves the command down one space in the script. Also highlight several consecutive lines in the script and move them all at the same time.</td>
<td></td>
</tr>
<tr>
<td>Duplicate Macro Command</td>
<td>Highlight one or more lines of the macro script and click on the Duplicate button. This adds another copy of the command line or lines to the script. This is essentially a one step method for copy and paste. Or press CTRL D to duplicate the highlighted command or commands.</td>
<td></td>
</tr>
<tr>
<td>Insert Comments</td>
<td>Highlight a line in the macro script and click on the Insert Comments button or press Ctrl Alt C to open a Comments edit box. Type any comments about the line in the script into this box and click OK. The comments are inserted next to the command listed in the script.</td>
<td></td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts**

Below is a list of keyboard shortcuts available in the Script Editor.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hotkey Combination</td>
<td>Function</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Alt+Right Arrow</td>
<td>Move to the macro script area</td>
</tr>
<tr>
<td>Alt+Left Arrow</td>
<td>Move to the All Commands panel</td>
</tr>
<tr>
<td>Alt+Down Arrow</td>
<td>Move to the Search for command box</td>
</tr>
<tr>
<td>Ctrl+Alt+Left Arrow</td>
<td>Move to the previous macro tab.</td>
</tr>
<tr>
<td>Ctrl+Alt+Right Arrow</td>
<td>Move to the next macro tab</td>
</tr>
</tbody>
</table>
**Activations**

Typically the activation of a macro is assigned when the macro is first created. However, this screen may be used to change the macro activation or assign more than one activation method to a macro. Activations and details about the activations are listed in this tab.

<table>
<thead>
<tr>
<th>Script</th>
<th>Activations</th>
<th>Variables</th>
<th>Miscellaneous</th>
<th>Scope</th>
<th>Security</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl</td>
<td>Generate Random Numbers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**HotKey:** Ctrl+Shift+R  
Activate when the keys are released

---

**Properties**

To view the Properties, highlight an activation listed and click on the Properties button. This opens an edit field where changes may be made to the activation selected. For example if the activation is a hot key of Ctrl+Shift+R, assign the activation to another combination.

**Add**

Click on the Add button to open the Add Activation window, as shown below. Use this window to add a second or third activation type to your macro.
Remove
Highlight a macro activation and click on the Remove button to remove this activation from the macro.
Variables

This tab lists all variables available for use in the macro. Use this option to create, edit or delete variables.

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Elements</th>
<th>Global</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>99</td>
<td></td>
</tr>
<tr>
<td>Random</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

Script Editor > Variables Tab

Type
The variable type is listed in this column.

Variable Name
Expand the Variable Type to view the variable names.

Elements
This column displays the number of array elements associated with the variables.

Global
If the Global check box is selected for a variable, the variable values are available to other macros. The values may be passed using the Macro Run command or the Variable Save and Variable Restore commands.

Add, Properties, Delete Buttons
The Add, Properties and Delete buttons provide options to create a new variable, edit an existing variable or delete one.

Add
Click on the Add button to create a new variable for use in the macro. The Variable Properties window, as shown below, opens, allowing the creation of additional variables. This option does not allow for assigning values to a variable. Use this function to create the variable name and type. Use the Variable commands to assign values to variables.
**Variable Name**
Assign a name to the variable, preferably something that is easy to remember or that identifies the variable. In the example above the variable is named "sales". Variable names may not exceed 31 characters. **Note:** If assigning original names to variables, instead of using T[1], D[1], etc., then the following characters are not allowed in the variable name: [ ] < > , . - + = \ / * %

**Variable Type**
Select from the five different types of variables. The example above displays the Text Variable option.

**Create as an array**
Select this option to set the variable as an array and then choose the number of elements to make available in the array.

**Elements**
Select the number of elements to place in the array. In the example above, 30 elements have been selected, allowing for the use of up to 30 variables in the array. Array elements start with [1] and not [0]. The variable format looks like the following:

```
sales[1]
sales[2]
sales[3]
...
sales[30]
```

**Make this variable available to macros called by this macro**
The variable value may be passed between macros when using the Macro Run command or when using the Variable Save and Variable Restore commands.

When this option is selected the variables are also referred to as Global variables, because they are available to other macros. When not selected, the variable values are local and may only be seen in the current macro.

**Properties**
Highlight a variable that has already been created. Click on the Properties button in order to edit the variable using the Variable Properties window.

**Delete**
Highlight a variable that has already been created. Click on the Delete button in order to remove the selected variable.
Macro is Enabled
This check box shows whether the macro has been disabled or is still an active macro. A check in the box signifies that the macro is enabled (active).

Logging
The logging option captures any error message or command logging in the macro. Decide what to log and where to store the information. The information may also be viewed by right clicking on the macro in the Macro Explorer window. Left click on Macro Properties from the menu that opens. Then click on the Logging tag to see the results.

Log all Errors
This option logs any error messages generated during playback of the macro.

Log all Commands
This option logs each command that runs successfully and date/time stamps the command.

What to do with the macro log
After determining what to log, select what to do with the log.

Email Macro Log when the macro completes or aborts
Use this option if the log is to be sent via email. Enter a recipient email address and optional carbon copy and blind carbon copy addresses.
Save to Default Macro Log folder
The log details are saved to the default error log. The log location is defined in Options > Preferences > File Systems > File Paths. A separate log is created for each macro that includes logging details.

Save to File
Save the log to the desired file name and location. Enter the file name and path or click on the Browse button to choose the location.

Turn off the CAPS Lock prior to running a macro
With this option selected, the macro turns off the CAPS Lock key before starting the macro playback.

Restore the CAPS Lock state after finishing a macro
With this option checked, the CAPS Lock key is returned to the state it was in before the macro ran. For example, assume that the Caps Lock key is initially turned off and a macro runs that turns the Caps Lock key on during the playback. After the macro has finished playing, the Caps Lock key is turned back off again. In the previous scenario, leaving this option unchecked would keep the Caps Lock key on after the macro finished playing.

Note: These two CAPS Lock options previously were global options set through the Preferences in version 3 and prior. Due to the fact that version 4 allows more than one macro to run at a time, these settings needed to be moved to the individual macro level to avoid conflicts.
Scope

Scope essentially refers to which program or programs allow the macro to activate. The default setting is Global for each new macro created. Choose to have the macro run in all applications, limit it to specific programs or windows, or have it play back in all windows and programs except for the ones specified.

**Global**
The global option allows a macro to play back in any Windows application.

**Window/Program Specific**
Use this option to select a specific window or program in which the macro starts. If the window or program selected is not active, the macro does not start. Click on the Add Window or Add Program button to select the window or program wanted.

**Note:** A Window or Program Specific Scope does not prevent a macro from playing back in an application not assigned in the scope. It prevents a macro from starting unless the specified window or program is active.

For example, assume a hot key macro of F12, with a scope is set to program specific and Notepad is the selected program. Press F12 in Wordpad and the macro does not run. Press F12 in Notepad and the macro runs. The F12 macro may insert text into Notepad and then later open Wordpad during the same macro. The macro scope does not prevent this.

**Global Except**
The Global Except option allows the macro to play back in all Windows applications, except in the programs or windows selected. Click on the Add Window or Add Program button to select the window or program required.

**Note:** A hot key may only be assigned to one macro if the scope is set to General. The same hot key may be used multiple times if the scope is assigned to Window or Program Specific.
Buttons
These four buttons are only available when using the Window/Program Specific or Global Except scopes.

Modify
Highlight an entry made in the scope window and click on the Modify button to change the window or program selected previously.

Add Window
Click on the Add Window button to view all windows that are currently running on the computer. One tab lists all visible windows currently running and a second tab lists all windows running that are hidden. Hidden windows are not displayed when an application is running, but are active.

If the window is currently running, scroll through the list and click on the title. The window selected is placed in the Window Title edit field. If the window is not currently running, type the window name in the Window Title edit field.

Exact Match/Partial Match
The exact match option requires that the Window title match exactly before the macro plays back. A partial match only requires a portion of the window title in order to work. For example, "notep" would be sufficient to find the "notepad" window.

The title contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.

A Window with this title must be on Top
This option plays the macro back only if the window is the current top-most window (the one that is showing on top of all other windows). If this option is not selected, the macro will start if the window is running in the background and play back in whatever window has focus.

Include hidden windows in the scope
By default the macro will only look for windows that are visible, not those that run hidden and are not seen by the user. Select this option to have the scope apply to the windows listed in the Hidden tab, as well as those that are visible.

After making a selection, click OK and the window is listed in the Scope tab. Repeat the process to add additional windows if necessary.

Add Program
Click on the Add Program button to view all programs that are currently running on the computer. One tab displays the tree view of the programs in the Start Menu. The other tab displays a list of processes currently running. Scroll through the list or tree view and highlight the program wanted. The program name displays in the Executable Path edit box. If the program is not found in either tab, manually type the file name and path or click on the Browse button to find the file on the computer.

This program must have a window on top
This option only runs the macro if the program is the current top-most program (the one that is showing on top of all other windows). If this option is not selected, the macro will start if the program is running in the background and play back in whatever program has focus.

After making a selection, click OK and the program is listed in the Scope tab. Repeat the process to add additional programs if necessary.

Delete
Highlight an entry made in the scope window and click on the Delete button. The scope entry previously made is removed.
Security

Use this option to password protect a macro before it can be edited, played back or both. From the Macro Explorer, click on the Edit Macro icon to open the Script Editor. Or double click on a defined macro in the list of macros to open the Script Editor. Then click on the Security tab to edit the security settings. Three security options are available.

<table>
<thead>
<tr>
<th>Security Tab</th>
<th>Security Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>Activations</td>
</tr>
<tr>
<td>Variables</td>
<td>Miscellaneous</td>
</tr>
<tr>
<td>Scope</td>
<td>Security</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
</tbody>
</table>

Use separate passwords for editing and running this macro

Edit Password
Password set

Run Password
Password not set

Do Not Password Protect this Macro
This is the default setting. No password is required to view, edit or run the macro.

Use a Single Password to Protect this Macro
Select this option and click on the Change button to create a password. With the password information defined, the password must be entered before viewing or editing the contents of the macro in the Script Editor. This same password is also required before running the macro.

Use Separate Passwords for Editing and Running This Macro
Select this option to create one password to edit the macro and another password to run the macro. Or use a password for either the Edit or Run functions and not use a password for the other.

Edit Password
Highlight Edit Password and click on the Change button to set up a password. With the password information defined, the password must be entered before viewing the contents of the macro in the Script Editor. This is one way to prevent others from viewing the macros or being able to alter them.

Run Password
Highlight Run Password and click on the Change button to set up a password. With this password information defined, the password must be entered before the macro runs.
Note: Password protect the entire macro file from viewing or editing. Also prevent Macro Express from playing back any macros until a proper password has been entered.

See Also

Encrypted Text
Password Protection
Set/Clear Passwords
Notes

This tab opens the Notes field. This is a free form text editor for keeping notes about the macro. Make notes about what the macro does, how it is to be used or how frequently. Essentially this field can be used to input any information about the macro.

Insert any comments you want to make about the macro into this field. You can **bold**, *italics*, underline, strike through, or color the font.

The Notes field supports Rich Text editing. Optionally use colored fonts, bold, italics, underlines and strikeouts.
Editor Menu

Editor Menu - Script

Import from Text File - (Direct Editor Only)
Use this option to import the entire text contents of a text file into the script field in the Direct Editor.

Save Macro
Save the macro data to the macro file.

Save and Close
Save the macro data to the macro file and close the Editor.

Save All
Save all macros that are currently open in the Editor.

Print Script
Print the macro script. The script prints as displayed in the Editor.

Close Current Tab
If more than one macro is loaded in the editor, this option closes the tab (macro script) that is currently being viewed.

Close
This option closes the Editor.
Editor Menu - Edit

Modify Command - (Script Editor Only)
Select this option to modify the command highlighted in the macro script. The alternative is to double click on the line in the script.

Duplicate Command - (Script Editor Only)
Highlight one or more lines of the macro script. Click on Edit > Duplicate Command to add another copy of the command line or lines to the script. This is essentially a one step method for copy and paste.
Alternatively press CTRL + D or click on the Duplicate button.

Comment - (Script Editor Only)
Use this function to insert a comment next to a line of script in the Editor. Highlight a line in the macro script and click on Edit > Comment to open a Comments edit box. Type any comments about the line in the script into this box and click OK. The comments are inserted next to the command listed in the script. Alternatively press Ctrl Alt C or click on the Insert Comments button to open the Comments edit box.

Delete - (Script Editor Only)
Highlight one or more lines of the macro script and click on Edit > Delete Command to remove them from the script. In the Script Editor optionally right mouse click on the highlighted lines and left click on Delete Command from the context menu.

Enable/Disable - (Script Editor Only)
Highlight one or more lines of the macro script and click on Edit > Enable/Disable to disable the lines in highlighted lines in the script or enable previously disabled lines. Alternatively press CTRL + N or click on the Enable/Disable button. A disabled line does not run during macro playback. It is displayed with a red line through the text.

Cut
Standard Windows cut command. Removes the highlighted command from the script and saves it to the Windows clipboard.

Copy
Standard copy to Windows clipboard command. This copies a highlighted command in the script and saves to the clipboard.

Paste
Standard Paste from Windows clipboard. This pastes a command that was copied to the clipboard into the script.

Undo
This option removes the last change made to the script and restores the script to the way it was before the change was made.

Copy Command Text - (Script Editor Only)
Highlight one or more lines of the macro script. Then click on Edit > Copy Command Text. This option copies the lines of script to the Windows clipboard. Paste the script into another application and the contents are displayed as shown in the Script Editor.
Typically the contents display in a macro format similar to the Direct Editor script when copying the script to the clipboard and pasting. Use the Copy Command Text function to display the contents exactly as they are shown in the Script Editor.

---

**Find**

Use the Find command to locate a key word in the text of the macro being modified. Click on Edit > Find or Ctrl F to activate the Find window as shown below. Type in the word or phrase to find and click the Find Next button or press Enter. The search scans the macro for a potential match. If one is found, the first item located is highlighted. If no match is found, a message displays indicating that no match was found.

The Find process starts from the location of the text cursor through the end of the text.

![Find Window](image)

The drop down list contains the previous ten search items.

**Find Again**

Click on Edit > Find Again or press the F3 key to look for the next item that matches the search criteria as discussed above. Continue using the Find Again feature until a message displays advising that the entire replacement text has been searched and no more matches have been found.

**Replace**

Use this feature to quickly replace a word found in the macro with another. Click on Edit > Replace or Ctrl R to activate the Replace window as shown below. Type in the word or phrase to replace in the box next to Find What. Then input the replacement word or phrase in the Replace With box.

Click the Find Next button to begin a search. If a match is found, the word or phrase in the script is highlighted. Click on Replace to just replace that one instance of a match. Or click Replace All to replace all matches found in the macro.

The Replace process starts from the location of the text cursor through the end of the text. The drop down list contains the previous ten find or replace items.

![Replace Window](image)

Be advised that in addition to replacing editable text in the macro, the command structure text may also be...
replaced, which could possibly render the macro inoperable.

**Goto Line** - *(Script Editor Only)*
This option prompts to input the number of the line in the script to be viewed or edited. This is handy for larger macros and is quicker than scrolling through the script.

![Goto Line dialog box](image)

---

**Select All**
Select All highlights the entire macro contents of either the macro script in the Script Editor or macro text in the Direct Editor.
Test Run Macro
Press the Test Run button on the tool bar, press F9 or click through the menu option to test run the macro open in the Editor. This is a quick way to determine if any fine tuning is necessary. Before the macro starts, the Start Debugger in a Different Window dialog is displayed. Choose whether to test run the macro in a specific window or leave focus as is.

Which window to use will depend on the first line or two of the macro.

For example if the first line of the macro types text, then select a window from the list where the text can be inserted. The macro needs to know where to type the text during the debug testing. With the (Don't Switch Focus) option the macro will attempt to insert the text into Macro Express, since this is the window that currently has focus.

If the macro does not use mouse clicks or type text before opening a program or window, then choose the (Don't Switch Focus) option. Or if the first line of the macro is to open a program or window and then insert text, use the (Don't Switch Focus) option as the macro will determine the focus.

Turning off the Switch Focus menu option, discussed below, will run the macro without opening the Start Debugger in a Different Window dialog.

Pause (Script Editor Only)
While the macro is running in test run mode click on Debug > Pause or the Pause button on the tool bar. This pauses the test run of the macro. Click on the Test Run button to resume.

Stop (Script Editor Only)
While the macro is running in test run mode, click on Debug > Stop or the Stop button on the tool bar. This stops the test run of the macro.

Toggle Breakpoint (Script Editor Only)
Highlight a line in the script to set as a breakpoint and then select the Toggle Breakpoint menu option or press CTRL B. When test running a macro, the macro stops at the set breakpoint. During the break, it's possible to view the Variables window (Debug > Show Variable Values from the menu) and verify that the variables are being populated correctly.

Press the Test Run Macro button to resume until finished or until the next breakpoint. To remove a Breakpoint, highlight the command in the script and press CTRL B or click on the menu item Debug > Toggle Breakpoint.

Note: The breakpoints are saved when the macro is saved and are available for use the next time the macro is run through the debugger. The breakpoints are ignored when running the macro outside of the debug mode.

Step Options (Script Editor Only)
Select the Step Over or Step Into option to test run the macro and have the macro pause after each line in the script. Pressing the F8 or F7 button causes the macro to run the next command and so on, until the macro has finished. This simplifies the process for debugging a macro.
Step Into - F7
If the script contains a Macro Run command, pressing the F7 key or clicking on the Step Into button loads the script of the called macro into the editor and steps through each line of the called macro script.

Step Over - F8
If the script contains a Macro Run command, pressing the F8 key or clicking on the Step Over button plays the called macro at the appropriate point in the script, but does not step through the called macro.

Switch Focus (Script Editor Only)
When using the F7 or F8 key to step through a macro, it is necessary to click the mouse to return focus to the Editor between each step. In order to avoid this, select the Switch Focus option. The focus returns to the prior window when stepping through a macro.

Save Before Test Run
This option saves the macro script first and then performs a test run of the macro.

Show Variable Values
The values of the variables are displayed in a separate window when debugging a macro. Use this window to determine that the correct values are being saved to the variables. The window displays the variable type, variable name and the corresponding value.

Click on Debug, Show Variable Values or press the F5 key to open a window similar to the one displayed below. Give focus back to the Script Editor, press F7, F8, F9 or click on the Test Run button to run the macro in a test mode and watch the window populate with the variable values. Running in test mode again clears the values and repopulates the window with new data as the macro runs.
Editor Menu Options

The three insert commands are the equivalents of the buttons found in the Script Editor. These options determine where the command is positioned in the macro script. Choose from one of the three options to be the program default.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button]</td>
<td>Insert Command Before Selected</td>
<td>The command is inserted above (before) the highlighted line in the macro script.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Insert Command After Selected</td>
<td>The command is inserted to the line below (after) the highlighted line in the macro script.</td>
</tr>
<tr>
<td>![Button]</td>
<td>Add Command to End of Script</td>
<td>The command is inserted as the last line (end) of the macro script.</td>
</tr>
</tbody>
</table>

These buttons are only available when using the Script Editor mode.

**Example: Using the program default**
Assume the macro script contains 10 lines and Insert Command Before Selected is assigned as the default. A new Text Type command needs to be inserted between lines 5 and 6.

1. Highlight line number 6 in the script.
2. Then expand the Keyboard category and double click on the Text Type command.
3. Insert the text and click OK to save.
4. The Text Type command is inserted before line 6 in the macro script.

**Example: Overriding the default**
Assume the command needs to be inserted at the end of the script.

1. Expand the Keyboard category and highlight the Text Type command.
2. Click on the Add Command to End of Script button to open the Text Type command.
3. Insert the text and save.
4. The button overrides the default and places the Text Type command at the end of the script.
Editor Menu - View

Direct Editor
From the Script Editor click on View > Direct Editor to open the Direct Editor. Or click on the Direct Editor button to change Editors.

These three toolbar options are only available if you have selected the setting found in Options > Preferences > Appearance - General tab to display the small icons.

Main Toolbar
Choose whether to display or hide the Main Toolbar. This toolbar includes the save and print icons.

Edit Toolbar
Choose whether to display or hide the Edit Toolbar. This toolbar includes the copy, paste, word wrap, and other icons.

Debug Toolbar
Choose whether to display or hide the Debug Toolbar. This toolbar includes the Test Run, pause, stop and step icons. The icon to the far right is the run macro now icon, which plays back the macro without running through the debugger.

Line Numbers
Select this option to display line numbers next to each command in the script. The line numbers make it easier to find specific lines in longer scripts.

Word Wrap
The word wrap selection displays several lines of macro information in the Script Editor (if more than one line is required).
Editor Menu - Tools

Launch Mouse Locator
The Mouse Locator tool displays the X and Y coordinates of the mouse pointer relative to the entire screen or to the window that is active. This is useful when wanting to include mouse clicks in macro scripts.

The locator displays the exact position of the mouse in order to plot those coordinates into a macro. Just plug in the coordinates when using the Mouse Commands found in the Scripting Editor or Direct Editor. (This function is not necessary if using the Capture option.)

Also activate this window by clicking on the Launch Mouse Locator button provided in the Mouse Move command or the Get Pixel Color command.

<table>
<thead>
<tr>
<th>Mouse Locator</th>
<th>x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Position</td>
<td>209, 168</td>
</tr>
<tr>
<td>Active Window</td>
<td>-193, -454</td>
</tr>
<tr>
<td>Pixel Color</td>
<td>4727808 / 0x462400</td>
</tr>
<tr>
<td>R:0 G:36 B:72</td>
<td></td>
</tr>
<tr>
<td>RGB: #002448</td>
<td></td>
</tr>
</tbody>
</table>

Macro Express Script or Direct Editor > Tools > Launch Mouse Locator

If the Mouse Locator window pops up in an area of the screen that covers important data, click on the window, hold the left mouse button down on the title bar at the top of the window and drag to another area of your screen.

Screen Position
The set of numbers directly under Screen Position lists the position of the mouse relative to the computer screen. When the mouse is moved, the numbers change in relation to the mouse cursor position. The number to the left is the X coordinate, or how many pixels from the left edge of the screen. The number on the right is the Y coordinate, or how many pixels the mouse is positioned from the top of the screen.

Active Window
The set of numbers directly under Active Window lists the position of the mouse relative to the active window or the window that has focus. When the Mouse Locator window is first launched, it receives focus. Clicking on a window outside of the Mouse Locator gives focus to that window. The Mouse Locator window remains on top in order to easily read the coordinates for the window with focus.

When the mouse is moved, the numbers change in relation to the mouse position. The number to the left is the X coordinate, or how many pixels the mouse is positioned from the left edge of the active window. The number on the right is the Y coordinate, or how many pixels the mouse is positioned from the top of the active window.

Pixel Color
This option displays the color of the pixel to which the mouse is pointing. Windows assigns a numeric value to each color, normally from 6 to 8 digits in length. The left side is the decimal value. This is the value returned by the Get Pixel Color command. Use the decimal value in macros that compare color values. The right side displays the hexadecimal value in BGR format.

The middle row displays the pixel color in separate values for Red, Green and Blue. These values are used when entering colors in programs, such as word, that accept separate values for Red, Green and Blue.
The bottom row displays the hexadecimal pixel color value in RGB format.

Which Pixel Color formats are displayed can be adjusted using the Pixel Color options found in Options, Preferences, Appearance, Mouse Locator.

**How colors are displayed**
To display colors, computers use the RGB Additive Color System. The letters R, G and B represent Red, Green and Blue respectively. Separate values are used for the amount of Red, Green and Blue. On a Windows computer, each color ranges from 0, all the way off, up to 255 (or FF hexadecimal) all the way on. Combining different values for each basic color allows millions of different colors to be displayed. For example, White has a value of 000000, Green has a value of 00FF00 and black has a value of FFFFFF.

The hexadecimal number that represents a color can also be represented as an integer value. For example, one orange color has a hexadecimal value of 2D42D4. When displayed as an integer this value is 2966228. The Get Pixel Color command returns the integer value of the color for a given pixel. This allows the integer variable commands to test for specific colors in your macros.

The Mouse Locator displays colors in a variety of formats to make it convenient to enter colors into other programs. For example, when entering a color for a web page the color value is in hexadecimal RGB format. To enter a color in Word requires separate integer values for Red, Green and Blue. And some programming languages require a hexadecimal BGR (Blue, Green, Red) format.

**Copy to Clipboard**
You can use the Mouse Locator to get the value of a color on your computer monitor. Make sure the Mouse Locator is the active window, then move your mouse over the color you want and press Ctrl-c. The color will be copied to the clipboard so you can paste it into another program.

By default, several values are copied to the clipboard including the Screen Position of the mouse and the Pixel Color in a variety of formats. Here is an example:

```
990,385,2966228,2D42D4,212,66,45,#D4422D
```

What is copied to the clipboard can be adjusted using the Copy To Clipboard options found in Options, Preferences, Appearance, Mouse Locator.
Direct Editor

In the Script Editor, macro commands are displayed in an easily recognized and understood format. To achieve this simplicity, some of the details about each command are only displayed in the edit dialog for the macro command. In the Direct Editor, all details about each macro command are visible. When describing these two ways of viewing macros, we refer to them as the Script and ASCII representations.

To view the ASCII representation of a macro click View > Direct Editor from the Script Editor menu. Note that when in the Direct Editor view, all open macros are displayed in their ASCII form. You can use either the Script Editor or the Direct Editor to build or edit a macro.

The Direct Editor is divided into three main components, the Commands, the Macro Text and Edit Buttons/Debugging tabs. Select from the commands what to insert into the Macro Text. The Macro Text reads from left to right so that the top line in the text, starting at the left, is the first command that plays back in the macro.

The Script tab contains the list of commands and the macro script. Additional information about the macro can be viewed or edited in the Activations, Variables, Miscellaneous, Scope, Security and Notes tabs.

**Note:** More than one macro may be open in the editor at the same time. Tabs at the bottom of the window allow for navigation between open macro scripts.
Macro Icon and Nickname

The Macro Nickname field and a macro icon are displayed near the top of the Direct Editor window. In the example below the icon is a blue number one.

![Macro Nickname: Generate Random Numbers](image)

Macro Icon

The icon (in the example above, a compass) is displayed to the left of the macro nickname. Click on the icon to open the Select an Icon window. Click on the browse button to open a folder with a number of icon options. Or navigate to another location on the hard drive to find other icons on the computer. If an icon was not selected at the time the macro was created, the default Macro Express icon is displayed.

Macro Nickname

The nickname is used to help remember the function of the macro. If a nickname was assigned when creating the macro, the nickname is displayed as shown in the image above. The nickname may be changed in this field if desired.

Command View

This section displays all of the commands that may be used in Macro Express. To insert a command into the script, scroll to find the command category wanted. Click on the category to display all of the commands available for that category.

Double click on the command to display open a dialog window. Define what the command should do and click OK to insert this command into the Macro Script.

Some commands do not require any user selection. Double clicking on these commands inserts the command directly into the Macro Script without an intermediary window.

Search for command

Use this function to help locate a specific command within the Commands list. To look for the Password Protection command, enter "pass" without the quotes. This highlights the Password Protection command within the list of commands. Notice that entering the "p" and the "a" first displays the Pause command. Adding the "ss" moves the highlight to the Password Protection command.

Macro Text

This area lists each of the commands that the macro performs. The macro plays back sequentially from top to bottom. Each command in the macro is typically displayed on a separate line. But it is possible to insert more than one command on a line. To insert a command into the text, place the mouse cursor where the command should be positioned. Then select the command and it is inserted to the right of the mouse cursor in the Macro Text field.

Note: It is not necessary to use the Text Type command in the Direct Editor. Just type the text to be played back directly into the edit field. Macro Express converts the text to a Text Type command.

Debugging Tabs

These tabs provide information when trying to debug a macro. Also click on Debug > View Variable Values or press the F5 key to see a display of all variables used in the macro and the values saved to those variables. These are displayed when running the macro in Test Mode.
Messages
When saving a macro, any syntax errors or other problems with the macro are displayed in the Messages tab.

Breakpoints
This tab displays any breakpoints defined in the macro for debugging purposes. The line number of the Break and the command are displayed.

Keys Tab
Use the Keys tab to insert symbols or other keystrokes directly into the script.

Special Keys and the F1 - F12 Keys
Click on any of the entries (keys) in the yellow box area. For example, clicking on the Alt key places the Alt command into the Macro Text field. The Alt key plays back in the macro at that point in the script. Or Tab to the entry and press Enter. Click on the F1 - F12 keys to input these keystrokes in the Macro Text field and have them play back in the macro.

Symbols
To insert a symbol into the Macro Text click on the Symbols button to display a window with a number of symbols. Double click on the symbol wanted and it is inserted into the Macro Text. Or highlight the symbol and click on the OK button. Also use this function to insert Alt Key Sequences. See the Text Type topic for more information.

Misc Keys
Click on the Misc Keys button to display a list of miscellaneous keys that may be inserted into a macro script. Highlight the key needed and click the OK button to insert the key into the script. The key is placed into the Macro Text script at the location where the text cursor is positioned.
Variables
Click on the Variables button to open the Insert Variables window and choose a variable to play back in a macro. Select the variable from the variable types available and click on the OK button. This places the variable into the Macro Text at the location where the cursor is positioned. Or click on the Add button to name a new variable to use in the macro.
Capture (Record) Macros

Capture Settings

Macro Express can capture keyboard and mouse activity for later playback as a macro. Options are available to determine what to capture and how much. Optionally capture keystrokes, mouse movements and clicks and actual time between actions.

There are two methods for starting a macro recording. One is to select the activation (hot key, shortkey, etc.) before recording. The other is to define the macro activation after recording.

Press System Hot Key to Start Capture
One of the System Macros is defined as CTRL+ALT+SHIFT+X by default. This is the Start/Stop Capture system hot key. Pressing CTRL+ALT+SHIFT+X starts the recording of a macro and pressing it a second time stops the recording. The default key may be changed to another combination available in Macro Express, such as ALT+F7.

While recording, a Camera icon displays in the Windows notification area to indicate that a capture is taking place. Besides pressing the system hot key to stop the recording, right click on the Camera icon to stop the capture. Open Options > Preferences > General > Notification Area tab and turn off the Show Recording Status option to not display the Camera icon.

When the recording stops, a Capture Complete window appears. Assign the captured macro to a Hot Key, Shortkey or other activation.

Before recording a macro using the System Hot Key method, make sure that the default settings have been defined. Select Options > Preferences > General > Capture tab from the Macro Explorer to define the capture settings. These are the settings used when utilizing the System Start/Stop Capture macro.

Click on Capture Icon to Start Capture
This option requires defining the macro activation and other information before recording the keystrokes and mouse moves. Upon clicking on the capture icon in the Macro Explorer window, the Create New Macro Window opens. Select an activation and optionally assign a nickname to the macro. Click OK to open the capture settings window to determine what to capture, etc. The options are listed below.

Scope
The Global scope allows for the playback of the macro into any Windows program. The Program scope indicates that the recorded macro will only play back in the program it is recorded in. Only use the "program" option if recording all of the macro in the same program. The macro playback will have unpredictable results, if recording in several programs and the Program scope is selected.

Capture the Keystrokes
Select this option to record all keystrokes made during the capture process. If this option is not selected, then only mouse moves and clicks are recorded.

When the Alt Key is Pressed, Capture It Twice
Use of the <ALT> key does not always work properly for activating menu commands. (Example: "<ALT>f" for activating the file menu command). To ensure that a menu command will always work, a double <ALT> is used. (Example: "<ALT><ALT>f") Selecting this option captures a double <ALT>
whenever the ALT key is pressed. Use this option if planning to capture keystroke commands that activate window menus.

**Capture the Mouse**

Choose this option to record all mouse clicks and movements made during the capture process. If not selected, only keystrokes are recorded. There are several mouse options to choose from.

**Relative to Screen**

This option captures all mouse clicks and movements in relation to the cursor's position on the monitor.

**Relative to Window**

This option captures all mouse clicks and movements in relation to the application window being used.

*Capture and Restore the Window Size*

This option is only available if the Relative to Window option is selected. It remembers the size of the window when the capture occurred. When the macro plays back, the window is resized, if necessary, to the original size when the recording was made. This helps ensure that the mouse clicks and movements are accurate.

**Relative to Position**

This option captures the mouse clicks or movements based on the last position of the mouse cursor.

**Only Capture the Mouse Clicks**

Use this option to only capture the mouse clicks and the position of the mouse click. This option captures the position where the mouse is to click and also the mouse click itself. No other movements of the mouse are recorded.

Unless drawing or needing to record the dragging of an item, select the Only Capture the Mouse Clicks option. This option reduces the size of the macro considerably and makes it much easier to edit, if needed. It also increases the playback speed of the macro, since all of the interim mouse move commands and associated delays from the macro are eliminated.

**Capture the Macro Speed At**

This option actually refers to how fast the macro plays back in relation to the recording speed.

<table>
<thead>
<tr>
<th>Speed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Speed</td>
<td>Plays the macro back at the same speed as the macro was recorded. Any hesitations, etc. play back at the same speed as recorded.</td>
</tr>
<tr>
<td>Half Speed</td>
<td>Slows down the macro playback to half of the recording speed.</td>
</tr>
<tr>
<td>Double Speed</td>
<td>Speeds up the macro playback to twice the actual recording speed.</td>
</tr>
<tr>
<td>Quadruple Speed</td>
<td>Speeds up the macro playback to four times the actual recording speed.</td>
</tr>
</tbody>
</table>
Fastest Speed (no delays) | Plays back the macro with no hesitations, delays, etc. Remove the check next to the Capture at a Specific Speed box to eliminate delays from the macro. **Caution:** Selecting this option may cause the macro to play back too fast and throw off the timing of the macro.

**Note:** After the capture is complete, it is possible to modify the playback speed of the macro in the Script Editor. Use the Macro Playback Speed command to do this.

**Display a Prompt before Capturing** *(Capture preference option)*

After pressing the system macro to start a capture, this option displays a message indicating that the capture is about to start.

**Begin Capture in Window** *(available when clicking on the Capture icon)*

Select the program from the drop down menu in which the macro recording will start. The drop down menu lists the windows currently open on the computer. Or select the last active window option. This refers to the window that was open prior to opening Macro Express Explorer to start the capture.

Press the Capture button and the program selected is brought to the foreground so capturing may begin.
**Capture a Temporary Macro**

There is a quick way to capture a temporary macro for testing purposes. No assigning of hotkeys or checking settings is required. The macro is saved temporarily for playback. Open the application in which to record the macro and press the **system macro** hot key combination of Ctrl+Alt+Shift+T to start the capture. Next enter the keystrokes, mouse clicks and movements. When finished, press the system macro Ctrl+Alt+Shift+X to stop the capture.

The macro is not saved as a viewable macro in the Macro Express - Explorer and cannot be edited in the Editor windows. The macro is stored in a file. Once another macro is captured using Ctrl+Alt+Shift+T, the previously captured macro is overwritten. The location of the file is displayed in Options > Preferences > File System - **File Paths** tab. Use the File Paths preference option to change the location of this file.

The capture of a temporary macro uses the **capture settings** defined in Options > Preferences > General - **Capture** tab.

**Run the Captured Temporary Macro**

Press the system macro hot key combination of Ctrl+Alt+Shift+S to start the play back of the temporary macro.
Quick Wizards

Multimedia Wizards

Below is a listing of each of the Multimedia wizards available.

Play Audio CD-ROM
Play an Audio CD.

- Play favorite music CDs
- Pause the CD to answer the phone
- Repeat a favorite song (go to previous, next or specific track)
- Open and close CD Tray

Play a Video Clip
Play a Video Clip.

- Display and watch a favorite video clip

Sounds and Volume
Play a sound or set audio volume, treble and bass controls.

- Play an audio clip to alert of an event
- Adjust volume down or up depending on music being played
- Mute the volume when on the phone
- Adjust treble and bass volume depending on music being played

Macro Express - Explorer > Quick Wizards Button > Uses Multimedia
Networking Wizards

Below is a listing of each of the Networking wizards available.

Send an Email
Send Email and attachments to one or more recipients.

- Send a set of instructions to a user. Prompt for user.
- Send a message to a specific set of friends or associates. Prompt for message.
- Send favorite pictures or other attachments.
- Send data captured in the clipboard.

Go to a Web Page
Go to a web site or initiate an ftp download.

- Go to a favorite web site.
- Download the latest version of a software program

Work with a Network Drive
Connect, Disconnect or Toggle Network drives.

- Access the network server or another computer
- Make network connections temporary
- Bypass Network Neighborhood

Dial-Up Networking
Connect and Disconnect to the Internet and other computers using Dial-Up Networking.

- Quick one keystroke access to dialing up the Internet and hanging up the phone

Macro Express - Explorer > Quick Wizards Button > Networking
System and Files Wizard

Below is a listing of each of the System and File wizards available.

Launch or Activate a Program
Launch a program or a document. Or switch to a program that is already running.

- Switch to an E-Mail program if it is running; otherwise, launch and run it.
- Open a Word Document
- Open a spreadsheet document
- Launch a database program

Reboot or Shut Down
Logoff, Reboot or Shut Down the computer.

- Bypass explorer, task manager, etc.
- Shut down and power off with a single command

Copy, Delete or Rename a file(s)
Copy, Delete, Rename Files. Change current folder.

- Backup files
- Delete temporary files
- Change folder prior to using an open dialog box

Change the display resolution.
Change or set the system’s display resolution.

- Maintain screen resolution preferences among multiple users
- Develop presentations or html that is optimized for all screen resolutions
- View graphics in high color resolutions
- Maintain multiple settings for laptop and desktop

Change the Default Printer
Choose a Default Printer.

- Switch between color and non color printers
- Maintain printer preferences among multiple users
- Quickly fax documents

Change Desktop Wallpaper
Change the desktop wallpaper.

- Place favorite images on the desktop
- Place a family picture on the desktop
- Tile the image (multiple copies spread over the desktop)
• Stretch, Center or Position the image on the desktop

**Move or Resize a Window**
Resize or Position a Window.

• Automatically position windows anywhere on the screen.
• Resize windows to allow perfect alignment of Windows
• Position the top most window in the center, top corner or anywhere on the screen.

**Maximize/Minimize a Window**
Maximize, Minimize, Restore, Hide, Close Windows.

• Maximize or Minimize the Top Most Window with a keystroke
• Temporarily hide windows and then restore (unhide) them when needed
• Shut down the Top Most program with a keystroke.

**Open an Explorer Folder**
Open up an Explorer Folder.

• Go directly to a specified folder in Explorer
• Clean up a cookie folder
• Clean up the temp folder
• Rearrange the start menu folders

**Desktop Goodies**
Cascade, Tile, Minimize or Restore All Windows. Undock and suspend computer.

• Quickly unclutter the desktop
• Align all windows on the desktop with a keystroke
• Undock the computer from a docking station by pressing a key

**Run Control Panel**
Open up the Control Panel or run a Control Panel applet.

• Quickly go directly to Internet Settings to make changes.
• Quickly go directly to Display properties to make changes.
• Quickly go directly to Network Options to make changes.
• Quickly go directly to System Properties to make changes.
• Quickly go directly to Accessibility Options to make changes.

Macro Express - Explorer > Quick Wizards Button > Works with Systems and Files
Text Based Wizards

Below is a listing of each of the Text Based wizards available.

Create a Reminder
Create a reminder to be displayed at a specific time.

- Create a reminder for an appointment or meeting
- Create reminders for birthdays or anniversaries
- Create reminders for a chore
- Create reminders of an upcoming event

Paste Text or Graphics
Paste Text or Graphic images into programs automatically.

- Insert commonly used phrases, paragraphs or boilerplate into a Word Processor, Email and other programs such as:
  - Answers to frequently asked questions
  - Sales quotes
  - Legal, Medical, Real Estate, etc documents
- Insert graphic images into documents.

Type the Date or Time
Type the current, future or past date or time into programs.

- Time stamp documents with today's date and time
- Date and time stamp an email
- Place yesterday's or tomorrow's date into a document

Type a Symbol
Place an international character or a symbol in programs.

- Insert Western European Language characters including â è ö î ú Ö Æ ß ñ and more
- Insert Western European Language punctuation such as i ç
- Insert Math Symbols such as ÷ × %₀ ± ¼ ½ ¾
- Insert Currency Symbols such as ¢ £ ¥ $
- Insert Legal Symbols such as ® © ™

Type Some Text
Have Text, Keystrokes and Symbols typed into programs automatically.

- Insert into a Word Processor, Email and other programs commonly used phrases such as:
  - Name, Address, Phone
  - Headers & Footers
  - EM ail Taglines
- Insert common keystrokes such as tabs or ALT commands to invoke menu options.
Menu Builders

Menu Builder - Menu

The Macro Menu Builder creates popup menus or floating menus of the most frequently used macros or any other combination of macros. The completed popup menu can be activated by pressing a hot key or designating a notification area icon. The floating menu always stays on top of the desktop allowing continual access to the macros in the menu.

The [Create a Popup Menu](#) tutorial walks through the process of building a popup menu.

Macro Express Explorer > Double click on existing Popup menu or  Macro > Add Macro > Select Activation and Build as a Popup Menu > Click OK

Available Macros

All of the macros available for the menu are listed in the left hand column of the window. To include a macro in the menu, highlight the macro and click on the Insert Macro icon to place the macro in the menu. Or highlight the macro and drag it to the right hand column to place it in the menu.

Macros in Menu

This column lists all of the macros included as part of the popup or floating menu. This is the order that they are displayed in the popup menu or the floating toolbar. To rearrange the order, highlight the macro to move and then click on the Up or Down buttons. The highlighted macro will be moved up or down in the list.
depending on the button selected.

To remove a macro from the menu, highlight the macro and then click on the Remove button. The macro is removed from the popup list and returned to the list of available macros. This macro can now be assigned to another menu, left alone or returned to the popup or floating menu later.

**Menu Builder Navigation**
This section describes the functionality of the buttons available to build and modify the menus.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Insert Macro]</td>
<td>Insert Macro</td>
<td>Highlight a macro from the list of available macros and click on the Insert Macro button to add the macro to the popup or floating menu.</td>
</tr>
<tr>
<td>![Remove]</td>
<td>Remove</td>
<td>Highlight a macro already placed in the menu and click on the Remove button to remove the macro from the menu. The macro will be displayed again as an available macro in the general menu.</td>
</tr>
<tr>
<td>![Move Item Up]</td>
<td>Move Item Up</td>
<td>Highlight a macro in the menu and click on the Move Item Up button to change the position of the macro in the menu. Each click moves the macro up one spot in the menu.</td>
</tr>
<tr>
<td>![Move Item Down]</td>
<td>Move Item Down</td>
<td>Highlight a macro in the menu and click on the Move Item Down button to change the position of the macro in the menu. Each click moves the macro down one spot in the menu.</td>
</tr>
<tr>
<td>![Insert Separator]</td>
<td>Insert Separator</td>
<td>This option inserts a separator line in the menu to separate two macros. This is strictly for visual effect.</td>
</tr>
<tr>
<td>![Set Accelerator]</td>
<td>Set Accelerator</td>
<td>Assign an accelerator key to the macro selected. Pressing the accelerator key plays back the macro when the menu is open. Highlight the macro and click on the Set Accelerator button for a prompt to assign an accelerator key. Choose from any letter of the alphabet or a number from 0 to 9 as the accelerator key.</td>
</tr>
</tbody>
</table>

**Floating Menu Hint:** If the floating menu has somehow been dragged far enough off the edge of the screen so that it cannot be drug back into position, follow one of these two procedures to correct the problem.

1. Right mouse click on the notification area icon. From the menu that opens left click on Tools > Restore Toolbars.
2. From the Macro Explorer, find the Floating Menu macro and double click on it to open the Menu Builder. Click on the Miscellaneous Tab, uncheck the Menu is Enabled box and click on the Save icon. Then place a check next to the Menu is Enabled box and click Save.

This restores the Floating menu so that it is again visible on the screen. The menu is placed at the 0,0 screen coordinates in the upper left hand corner of the screen.
Menu Builder - Activations

Typically the activation of a macro is assigned when first creating the macro. However, use this screen to change the macro activation or assign more than one activation method to a macro. The current menu activations and details about the activations are listed in this tab.

Properties
To use the Properties option, first highlight an activation listed. This allows changes to be made to the highlighted activation. For example if the activation is a hot key of Ctrl+K, it may be assigned to another combination using this function.

Add
Click on the Add button to add another activation to the macro. The Add Activation window opens, as shown below, so that an additional activation may be selected.
Remove
Highlight a macro activation and click on the Remove button to remove this activation from the macro.
The Miscellaneous tab provides several different options for the menu being built. Select the menu style and where it displays on the screen, as well as other settings described below.

### Miscellaneous

- **Menu is Enabled**
  - This check box shows whether the menu has been disabled or is still an active menu. A check in the box signifies that the menu is enabled (active).

- **Don't close menu after running a macro** (Popup menu only)
  - Select this option to keep the menu open after running a macro from the popup menu.

- **Don't allow menu to be closed** (Floating menu only)
  - This option keeps the floating menu open with no chance to click on the red X or press Alt + F4 to close it. The menu may still be closed from the Macro Express - Explorer window by disabling the floating menu.

### Menu Style

Use this option to select what information to display in the popup window. To more readily identify the macros placed in the popup menu, the macro information may be displayed in several different ways - Icons Only, First Part of the Macro, Nickname and Scope or Windows Default.

- **Icons - Horizontal**
  - This option displays the icons assigned to each macro in the menu. The icons are displayed horizontally. The
maximum number of icons displayed in a single row is 20.

**Icons - Vertical**
This option displays the icons assigned to each macro in the menu. The icons are displayed vertically. The maximum number of icons displayed in a single column is 20.

**Menu Icons**
When using menu icons, select from the drop down list the size of the icons to appear in the popup window or floating menu. The sizes are listed in pixels. The icon size options are 16x16, 24x24, 32x32, 48x48, and 64x64 pixels.

**Use Transparent Icon Backgrounds**
Select this option to display the backgrounds of the icons transparently.

Clicking on the icon in the menu starts the playback of the macro.

**First Part of the Macro**
This option displays the first few words or commands of the macro script in the menu. When the popup window appears, either double click on the macro or press the number or letter associated with the macro to have it play back.

**Nickname and Scope**
The Nickname and Scope option displays the name assigned to the macro and the macro scope, such as a global, or program or window specific macro. When the popup window appears, either double click on the macro or press the number or letter associated with the macro to play it back.

**Windows Default**
The Windows Default menu displays the icon associated with the macro and the macro nickname. Click on the macro to start the playback. Also assign accelerator keys to the macros using the Set Accelerator button. Pressing the A key activates the My Address macro in the example below. The accelerator keys are underlined and displayed to the left of the macro name.
Menu Positioning
Determine where to display the menu when activated.

Display the Menu under the Mouse
This option displays the menu underneath the current position of the mouse cursor. The upper left corner of the menu is positioned under the mouse cursor.

X, Y
Enter the X and Y screen coordinates where the popup menu should be displayed on the screen. The default is to display in the upper left hand corner of the screen with coordinates of 0,0.

Place an Icon in the Notification Area
This option is only available for the popup menu. The icon associated with the popup menu is placed in the notification area. A left mouse click on the icon displays the popup menu. **Note:** The scope of the menu is set to Global when this option is selected.

Transparency
When using any of the menu styles, other than Windows Default, optionally set the transparency level of the menu. The transparency setting enables viewing the text or image underneath the menu when it is displayed. Moving the slider to the right makes the menu image more transparent.
Menu Builder - Scope

The scope for a popup menu is similar to that of a macro. Assign the menu to only open in a specific window or program, in all windows or programs except for those chosen, or allow it to open in all applications. Floating menus always have a Global scope.

Global
The global option allows the menu to open in any Windows application.

Note: If opting to display the icon in the notification area, the scope is automatically Global. The icon in the notification area displays regardless of which program or window is open and behaves as a global macro. If a hot key is assigned to the popup menu, the hot key may be assigned to a scope.

Example
Assume that a popup menu icon is assigned to display in the notification area. But a hot key (CTRL Q) is also assigned to the same popup menu. The scope is set to Program Specific and is to only work with Wordpad.

So if is Wordpad active and CTRL Q is pressed, the popup menu appears. Open notepad and nothing happens after pressing CTRL Q.

But it is still possible to left click on the icon in the notification area to open the menu. The menu is always global when clicking on the icon in the notification area.

Global Except
This option allows the menu to open in all Windows applications, except the program or window selected. More than one window or application may be listed.

Window/Program Specific
With this option, the menu opens only if the specific window or program selected is active. If the window or application is not active the menu does not open.

Buttons
These four buttons are only available when using the Window/Program Specific or Global Except scopes.

Modify
Highlight an entry made in the scope window and click on the Modify button. This allows for changes to the window or program previously selected.

Add Window
Click on the Add Window button to view all windows that are currently running on the computer. One tab lists all visible windows currently running and a second tab lists all windows running that are hidden. Hidden windows are not displayed when an application is running, but are still active.

If the window requested is currently running, scroll through the list and click on the title. The window name is placed in the Window Title edit field. If the window is not currently running, type the window name in the Window Title edit field.

Exact Match/Partial Match
The exact match option requires that the Window title match exactly before the menu opens. A partial match will only require part of the window title in order to work. For example, "notep" would be sufficient to find the "notepad" window.

The title contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.

A Window with this Title Must Be on Top
This option opens the menu only if the window is the current top-most window (the one that is showing on top of all other windows).

Include Hidden Windows in the Scope
By default the macro will only look for windows that are visible, not those that run hidden and are not seen by the user. Select this option to have the scope apply to the windows listed in the Hidden tab, as well as those that are visible.

After making a selection, click OK and the window is listed in the Scope tab. The process may be repeated to add additional windows if necessary.

Add Program
Click on the Add Program button to view all programs that are currently running on the computer. One tab displays the tree view of the programs in the Start Menu. The other tab displays a list of processes currently running. Scroll through the list or tree view and highlight the program to display the program name in the Executable Path edit box. If the program is not found in either tab, manually type the file name and path or click on the Browse button to find the file on the computer.

This Program Must Have a Window on Top
This option only opens the menu if the program is the current top-most program (the one that is showing on top of all other windows).

After making a selection, click OK and the program is listed in the Scope tab. The process may be repeated to add additional programs if necessary.
Delete
Highlight an entry made in the scope window and click on the Delete button. The scope entry previously made is removed.
Menu Builder - Security

Use the Security tab to set up a password that is required before the menu can be edited, played back or both. Three security options are available.

Do Not Password Protect this Macro
This is the default setting. No password is required to view, edit or run the menu.

Use a Single Password to Protect this Macro
Select this option and click on the Change button to set up a password. With the password information defined, the password must be entered before viewing or editing the contents of the menu is possible. This same password is also required before running the menu.

Use Separate Passwords for Editing and Running This Macro
Select this option to create one password to edit the menu and another password to run the menu. Or choose to have a password for either the Edit or Run and not use a password for the other.

Edit Password
Highlight Edit Password and click on the Change button to set up a password. With the password information defined, the password must be entered before view the contents of the menu. This is one way to prevent others from viewing the macros or being able to alter them.

Run Password
Highlight Run Password and click on the Change button to set up a password. With this password information defined, the password must be typed before the menu opens.
Menu Builder - Notes

This tab opens the Notes field. This is a free form text editor for keeping notes about the macro. Use this option to make some notes about the menu, how it is to be used or how frequently. Essentially this field can be used to input any pertinent information about the menu.

Make any notes about the menu in the Notes tab.

The Notes field supports Rich Text editing, including the use of various font types, sizes and colors, bold text, italics, underlines and strikeouts.
Macro Commands

CD-ROM

If you enjoy listening to audio CD's while working at the computer, you can create a number of macros to automate features found in the CD-Player application shipped with Windows. Create macros to replay a favorite track, open and close the tray, start, stop or pause the CD for an interruption, or skip tracks -- practically anything except physically inserting the CD into the drive.

Below is a chart of the CD-ROM commands available in Macro Express and a brief description of what each command performs.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play CD-ROM</td>
<td>Starts the play of a CD inserted in the CD-ROM drive.</td>
</tr>
<tr>
<td>Stop CD-ROM</td>
<td>Stops the play of the CD.</td>
</tr>
<tr>
<td>Pause CD-ROM</td>
<td>Pauses the playback of the CD. This is handy when the phone rings or some other type of interruption occurs.</td>
</tr>
<tr>
<td>CD-ROM Next Track</td>
<td>Skips forward to the next track of the CD.</td>
</tr>
<tr>
<td>CD-ROM Previous Track</td>
<td>Backtracks to the previous track of the CD.</td>
</tr>
<tr>
<td><strong>CD-ROM Goto Track</strong></td>
<td>Automatically forwards to the track number requested. A small box prompting for the desired track number appears. Enter the track number and click OK.</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>CD-ROM Step</strong></td>
<td>Specify the number of seconds to fast forward through the CD. Enter the number of seconds to step forward in the Seconds edit box.</td>
</tr>
<tr>
<td><strong>CD-ROM Back</strong></td>
<td>Specify the number of seconds to backtrack through the CD. Enter the number of seconds to backtrack in the Seconds edit box.</td>
</tr>
<tr>
<td><strong>Eject CD-ROM</strong></td>
<td>Opens the CD tray to eject the CD.</td>
</tr>
<tr>
<td><strong>Close CD-ROM Tray</strong></td>
<td>Closes the CD tray.</td>
</tr>
</tbody>
</table>

If multiple CD-ROM drives exist on the computer, such as a standard drive and a CD-ROM burner, use these options to select which drive to use.

**Use the first available drive**
This option selects the first available CD-ROM drive.

**Choose the drive**
Use this option to select which drive to use.

**CD-ROM Drive Letter**
Use this in conjunction with the Choose option. Use the drop down list to select which drive to use in the macro.
Clipboard

**Clipboard Copy, Cut and Paste**

The following clipboard commands do not open an edit window in the Script Editor. These commands are inserted directly into the script. No modifications are required. Expand the Clipboard category in the Script Editor and select the command needed.

**Clipboard Copy**
Clipboard Copy is the same as issuing a Ctrl + c in Windows. It copies to the clipboard whatever is selected (highlighted). This function should follow commands in the macro script that highlight the text or image.

**Clipboard Cut**
Clipboard Cut is the equivalent of issuing a Ctrl + x in Windows. It deletes the selected (highlighted) text or image and copies it to the Windows clipboard. Follow this command by saving the clipboard contents to a variable or issuing a clipboard paste command.

**Clipboard Empty**
This command clears or empties the clipboard of all its contents.

**Clipboard Paste**
Clipboard Paste is the same as issuing a Ctrl + v in Windows. The Paste command inserts the contents of the Windows clipboard into the application currently running.

**Clipboard Start Copy / Clipboard End Copy**
The Clipboard Start Copy command instructs the macro to consider anything that follows in the macro to be copied to the clipboard. It copies everything in the script to the clipboard until it finds the Clipboard End Copy command.

In most cases the Text Type command is much more convenient than using the Clipboard Start Copy and Clipboard End Copy commands. Insert the text into the Text Type command and select the Use Clipboard and Paste Text option.

---

**Note 1:** The Clipboard Copy, Cut and Paste commands will not work in applications that do not support the standard Windows shortcuts of Ctrl + c, Ctrl + x or Ctrl + v. Most applications support these Windows standards, but there are some that do not.

**Note 2:** Windows requires a small amount of time to process a Clipboard function. If the macro is ignoring a copy, cut or paste during playback, the macro may be going faster than Windows can process the clipboard functions.

To make sure the macro doesn't play too fast, click on Options > Preferences > Playback > Delays. Bump the default clipboard delay value from 250 milliseconds to a larger delay. Some experimentation may be necessary to determine the optimal value for the system. The other alternative is to insert a Delay after the clipboard command to allow Windows the necessary time.
Clipboard Commands

These clipboard commands save the clipboard contents to either a text file or a graphics file. Other options include appending text to an existing file or having the clipboard contents typed out into another application.

Type Clipboard Text
This option types the clipboard text letter by letter into another application instead of pasting the entire contents. Although this method inserts the text slower, (especially large blocks of text), there are applications which do not accept standard Windows clipboard paste commands.

Ignore CR/LF
The Ignore CR/LF function instructs the macro to type the clipboard text without any carriage returns or line feeds that may have been copied to the clipboard.
- Select this option to ignore carriage returns and line feeds.
- Leave the box unchecked to include the carriage returns and line feeds in the text playback.

Clipboard Save Text
Clipboard Save Text saves the text contents of the clipboard to a text file. Any images, etc. are ignored.

Prompt for the filename at runtime
Select this option to be prompted at macro runtime to enter the file name to store the clipboard contents.

To save to a specific file each time the macro is run, enter the file name and full path, click on the Browse button to select the desired text file, or insert a variable that stores the file path and name information.

Clipboard Append Text
The Clipboard Append Text option appends (adds) the text contents of the clipboard to the end of an existing text file.

Prompt for the filename at runtime
Choose this option to be prompted, when running the macro, to enter the file name that will receive the text from the clipboard.

To save to a specific file each time the macro is run, enter the file name and full path, click on the Browse button to select the desired text file, or insert a variable that stores the file path and name information.

Clipboard Save Graphic
The Clipboard Save Graphic option saves the graphic content of the clipboard to either a Windows Bitmap file
or a JPG file.

**Prompt for the filename at runtime**
Choose this option to be prompted, when running the macro, to enter the file name to store the graphic image from the clipboard.

To save to a specific file each time the macro is run, enter the file name and full path, click on the Browse button to select the desired text file, or insert a variable that stores the file path and name information.
The Clipboard File Copy command copies the contents of a text file directly to the clipboard. Rather than opening the file, highlighting the text and copying to the clipboard, this command reads the contents directly from the file and places the contents into the clipboard. Issuing a subsequent Paste command pastes the contents of the text file into the application currently open.

Either insert the file name and full path, click on the Browse button to select the desired text file, or enter a variable that stores the file path and name information.
Clipboard Graphic Copy

The Clipboard Graphic Copy command copies a .PNG, .JPG, Windows Bitmap or Windows Metafile directly into the clipboard. Issuing a subsequent Paste command pastes the image into the application currently open.

Either insert the file name and full path, click on the Browse button to select the desired image file, or enter a variable that stores the file path and name information.
Debug

Log Errors

This command logs any errors that occur during the execution of a macro to a text file. When this command is encountered, an entry is immediately made in the error log file to indicate that a macro has started. Place this macro command as the first step in the macro script to ensure that the entry is made when the macro runs.

A macro completion entry is made in the log file when the macro completes, indicating that the macro completed successfully. All entries are date/time stamped. This command is especially useful for unattended scheduled macros.

Optionally turn off the display of any error messages so that Macro Express is not stuck waiting for user intervention in cases where the macro runs unattended.

Use the Default Macro log
Select this option to have the error messages sent to the default file log. The default macro log folder can be set from Options > Preferences > File System - File Paths tab. Each macro is assigned its own individual log file.

If not using the Default Macro Log, then insert the file name and path to log the errors. Or click on the Browse button to locate the file.

Do not display error messages (only log them)
This option suppresses the display of Macro Express error messages during the playback of a macro. An error message typically requires user intervention to clear the message from the screen. The error message is sent to a log file for later review.
Log Messages

The Log Messages command logs messages to a file. This could be used to log that the macro has progressed to a certain point in the macro and then log subsequent messages about the macro's progress.

Use the Default Macro Log
Select this option to have the messages sent to the default macro log. The default log can be set from Options > Preferences > File System - File Paths tab.

If not using the Default Macro Log, then insert the file name and path of the file to log the messages. Or click on the Browse button to locate the file.

Message to log
Insert the message to be entered into the log.

Include a date/time stamp
Check this box to include a date and time stamp of when the entry was made to the log. The date/time stamp is based on the date and time of the system clock.
The Desktop commands provide a number of handy shortcuts for arranging the desktop. These commands are the same as those found in Windows by right clicking on a blank area of the Task Bar and selecting a function.

There is not an edit window available for these commands in the Editors. The commands are inserted directly into the script. From the Editor expand the Desktop category and double click on the command required.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade Desktop Windows</td>
<td>Layers all open windows to display the caption bar of each window.</td>
</tr>
<tr>
<td>Tile Desktop Windows Horizontally</td>
<td>Arranges all open windows horizontally on the screen.</td>
</tr>
<tr>
<td>Tile Desktop Windows Vertically</td>
<td>Arranges all open windows vertically on the screen.</td>
</tr>
<tr>
<td>Minimize All Windows</td>
<td>Minimizes all active windows so that the desktop is visible.</td>
</tr>
<tr>
<td>Restore All Windows</td>
<td>Restores all windows to their original size from a minimized state.</td>
</tr>
</tbody>
</table>
Dialogs

Message Box

Use the Message Box to display messages during the playback of the macro. Use this function to create reminder messages. Set the macro to run on a schedule to remind of an important event. Or generate the message box to instruct users of what to do next in the macro.

This option is similar to the Text Box Display command, but with several differences. The message box displays one of several message icons. Several of the icons produce an accompanying Windows sound when the message box is displayed. But there are no options for dictating the length of time that the box should appear or rich text features.

Caption
Enter the caption in this field. This entry is displayed as the window title of the message box that opens during macro playback.

Message
Insert the text of the message in this edit field.

Icon
Select an icon to display next to the text of the message. Or choose to display no icon by selecting the None option. Each of the icon options are shown below.

![Warning](image)
Sample image
Below is an example of what the Message Box looks like during macro playback. It is based on the entries made in the MessageBox image above.

Time to purchase a copy of Macro Express!
The Multiple Choice Menu command displays a menu of options during macro playback. Choices can be displayed as either radio boxes (one selection out of the group) or as check boxes (select as many as wanted). The selection results are stored in a text string variable which can be tested for conditional processing of the macro.

**Note:** To create Yes/No, True/False, or OK/Cancel type menu options, use the If Message command.

**Menu Options**
Choose whether to allow the user to choose only one valid selection or multiple selections.

- **Single Choice**
  With this option selected the user may only select one choice from the displayed list.
Sample Macro
This sample macro is based on the screen shot of the Create a Multiple Choice Menu window displayed in this topic. Essentially the macro will display a menu of four choices.

Select the desired option and click OK. The macro then continues based on the choice made. For example if A is selected, then the default web browser would load the Macro Express home page.

Macro Script
Multiple Choice Menu: Prompt
If Variable %T[1]% Equals A
   Web Site, "https://www.macros.com", using Default Web Browser
End If
If Variable %T[1]% Equals B
   Launch Program and Activate Window: Program "NOTEPAD", Window "notepad"
End If
If Variable %T[1]% Equals C
   Text Type (Simulate Keystrokes): Insight Software Solutions, Inc.
End If
If Variable %T[1]% Equals D
   FTP Site Connect to www/wintools.com
End If

Multiple Choice
The Multiple Choice option allows the user to select more than one choice from the displayed list. The correct logic must be inserted into the macro so that it can correctly handle more than one selection. A sample of how this would be done is shown below.
Sample Macro

Multiple Choice Menu: Prompt
If Variable %T[1]% Contains A
   And
If Variable %T[1]% Contains B
   Insert commands to perform
End If
If Variable %T[1]% Contains A
   And
If Variable %T[1]% Contains C
   Insert commands to perform
End If
If Variable %T[1]% Contains A
   And
If Variable %T[1]% Contains D
   Insert commands to perform
End If
If Variable %T[1]% Contains B
   And
If Variable %T[1]% Contains C
   Insert commands to perform
End If
If Variable %T[1]% Contains B
   And
If Variable %T[1]% Contains D
   Insert commands to perform
End If
If Variable %T[1]% Contains C
   And
If Variable %T[1]% Contains D
   Insert commands to perform
End If

Result Options

Save Item Text
Selecting this item requires entering the menu list name used when writing the macro. Based on the example above, use If Variable T[1] = Go to Macro Express web site, If Variable T[2] = Run Notepad, etc. to create the rest of the Multiple Choice macro.

Save Item Value
Selecting this item requires entering the letter associated with the option. Based on the example above, use If Variable T[1] = A, If Variable T[2] = B, etc. to create the rest of the Multiple Choice macro.

Note: Number of Menu Items Allowed
The number of menu choices permitted varies depending on which combination of Single/Multiple Choice and Item Value/Text is selected. Below are the various combinations and the possible number of menu items allowed.

<p>| Single Choice / Item Value | No limit to the number of items in menu. |</p>
<table>
<thead>
<tr>
<th>Single Choice / Item Text</th>
<th>No limit to the number of items in menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple Choice / Item Value</td>
<td>Menu limited to 36 items.</td>
</tr>
<tr>
<td>Multiple Choice / Item Text</td>
<td>No limit to the number of items in menu.</td>
</tr>
</tbody>
</table>

**Destination Variable**
This is the variable that receives the result of the user choices from the menu. The "If Variable" command is used to test the value of this variable to determine what choice has been selected by the user. The variable T[1] was selected in the window displayed above.

To ensure the menu functions correctly use the command "If Variable T[1] Equals A" to see if the user chose the first item in the Menu List. (Use "If Variable T[1] Equals B" to test for the second item in the Menu List, and so on.)

---

**Position and Size the Multiple Choice Window**
Choose from the options below to size, position and format the window.

- **Left/Top**
  Position the upper left hand corner of the Multiple Choice window "x" number of pixels from the top and left edges of the screen. Enter the pixel values to position the window.

- **Width/Height**
  Enter the pixel values to manually set the size of the Multiple Choice window. For example, entering a width of 500 and a height of 600 would generate a window size of 500 x 600 pixels. Insert the word Auto in the fields to have the window auto-sized, based on the contents of the menu.

- **Columns**
  Choose the number of columns to display in the Multiple Choice window. The default setting is Auto, which adds a second column when more than 10 items are listed in the menu.

- **Monitor**
  This option applies to systems that utilize more than one monitor. If a system has a single monitor, then leave the monitor setting to zero (0). Zero represents the single monitor or the left monitor if there is more than one monitor. One (1) represents a second monitor or the monitor to the right of the left monitor. Similarly, two (2) represents the third monitor or two monitors to the right of the left monitor, and so on.

- **Set Size and Position**
  Use this option to manually position the Multiple Choice window to the desired location. Also manually set the size of the Multiple Choice window. The [Window Position and Size](#) topic explains these options in detail.

- **Keep the Menu on Top**
  This option keeps the Multiple Choice menu visible on the screen (on top of other running applications) until the menu is closed.
The Title contains the text that appears in the caption bar of the Window displaying the menu.

Prompt
The Prompt contains the text that appears right above the menu choices. This text should help the user understand why they are being prompted to make a choice. For example, if the menu contains a list of income ranges, the prompt could simply consist of something like "Please choose your income bracket".

Menu List
The Menu List contains the list of choices for the menu. Each corresponding letter (A, B, C...) represents a different choice in the menu. They are displayed in the order shown on this screen. If only 3 choices are entered (i.e. an entry for A, B and C), then the menu only shows the 3 entries.

Do not leave gaps in the entries or the menu will end up with blank items. In other words, use the first 3, 5 or however many entries needed. For example, don't just create entries for items A, D, E and G or the menu will display blank items for items B, C and F.

Note: Text Variables may be placed in the Title, Description/Prompt and Menu List input fields. For example, place the variable T[1] (you would actually enter %T[1]%) in the "Description/Prompt" edit box.

-- Review the Multiple Choice Menu with Defaults sample macro in the samples.mex file, which is supplied with the program, for a working example of the Multiple Choice Menu. --
Multiple Choice Tips

Make one of the Multiple Choice selections the Default
Let's say you want option B to be your default selection. Use the Variable Set String command and select the Set Value Now option. Set the value of variable T[1] to B. Insert this command before your Menu command in the macro script. When the macro runs, option B will display as the default selection.

Allow users to select a menu item with the keyboard instead of clicking with the mouse
Let's look at the Multiple Choice Menu image above. There are four entries in the Menu List. We want to set this up so that when the menu is displayed, the user can press a keystroke rather than click on their choice with the mouse. To do so we would modify the Menu List to look like the following:

A  &Go to Macro Express web site
B  &Run Notepad
C  &Insert email tagline
D  &Connect to FTP site

You'll notice that an ampersand "&" has been placed in front of each item in the menu list. When the list is displayed during playback of the macro, the letter following the ampersand "&" will be underlined (set as the accelerator key). The user can then press the underlined letter for the choice they want. This will highlight their choice. Pressing the Enter key will perform the macro selection chosen.

The ampersand may be placed anywhere in the text string. It doesn't need to be placed before the first letter as in the example above. For example, we could set item A to read as follows: Go to &Macro Express web site. In this case the M is underlined and pressing the "M" key during playback will highlight this menu option.

Note 1: Be careful not to duplicate the underlined letters. Otherwise the first duplicate letter will be the default choice each time the letter is pressed.

Note 2: If you are using the If Variable Contains command with the Multiple Choice Menu and you have "Save Item Text" checked, be sure to change the text you are comparing so that it includes the ampersand "&". For example, change "If Variable %T[1]% contains "Choice One" to "If Variable %T[1]% contains "&Choice One"."

Note 3: To insert an ampersand in the text that is not used as an accelerator, such as a menu item of "This & That", insert two ampersand symbols. Write the menu item as "This && That", so that it displays correctly when the macro runs.
**Text Box Display**

Use the Text Box Display feature to pop up text windows during macro playback. There are a number of possible uses for this command. A few are listed below.

**Reminders**
Set up reminder messages on a monthly, weekly, daily or a one time occurrence. Create reminders to pop up on screen to make an important phone call at a specific time or to pick up a few items at the store after work. Create the macro as a scheduled macro to play back at the appointed time.

**Display Instructions**
Use the Text Box Display to provide instructions for a user to follow during macro runtime.

**Debugging**
This command is also useful for debugging macros, such as displaying the contents of variables. Make sure the values match what they are expected to be. For example, to display the contents of T[1], insert \%T[1]\% into the Box Content field. When playing back the macro, the value for T[1] displays in the text box during macro run time and shows exactly what is being saved to the variable.

![Image of Text Box Display dialog box]

*These contents are displayed during the playback of the macro.*

Insert your instructions, reminders or messages in this field.

You can center the text, italicize, underline, change fonts, sizes, colors, etc.

Display the values of variables by inserting the variable name, surrounded by % symbols.
Text Box Command
Select one of the four text box options available from the drop down list.

**Text box display**
The Text Box Display option pauses the macro. The user is required to click on the "OK" button to close the text box and allow the macro to continue.

**Timed floating box or end of macro**
The execution of the macro continues when this option is selected. The text box remains floating on top until either the specified time passes or the macro finishes. The Timed floating box does not stop or delay the macro. All the Floating Text Boxes are closed when the macro finishes. Add a Delay or Timed Delay command after the Text Box command in order to keep the box open for a specific amount of time.

*Stay on top for ____ seconds*
Specify the amount of time to display the text box by inserting the number of seconds in this field. The field is large enough that the box can stay open for hours. However, the box closes if the macro finishes before the number of seconds selected elapses.

**Floating box until "Close Box" command or end of macro**
With this option checked the execution of the macro continues. The text box remains on top until either the macro terminates, a "Close Text Box" command inserted in the macro is reached or the box is manually closed.

**Text Box Close**
The Text Box Close command closes an existing text box that is being displayed. The Header must match exactly (uppercase/lowercase sensitive) in order for the text box to close. If no match is found on the header, the Text Box Close command is ignored during the playback of the macro. Note: All floating text boxes are closed at the end of the macro run.

**Header**
Use this option to create a title for the display window. The Header appears in the window caption bar and is required in order to use the Close Text Box option.

**Box Content**
The Box Content field provides space to place a more detailed message or instructions. This field contains the message displayed during playback of the macro.

**Rich Text**
The edit box supports rich text. Use this option to create messages with different fonts, sizes, colors, etc.

Display text with bold, underline, italics and strike through features.

Left, center or right justify the text.

Use different font colors, sizes or font types.

Colors such as clWindowText, clWindowFrame, clScrollBar are assigned to specific parts of the text box window. For example, on different computers clWindowText may be black, dark gray or white depending on the theme or custom color choices.
Always on Top
With the Always on Top option selected the text box remains visible on the screen (on top of other running applications) until the box is closed.

Keep Focus
Select this option to give focus to the Text Box Display window. If not selected, focus returns to the application that had focus before the display window opened.

Set Size and Position
These options position and size the Text Box Display window on the screen. The Window Position and Size topic explains these options in detail.

Quick Wizard Option
Using the Quick Wizard for creating a reminder provides a couple of additional options. If creating a one-time reminder, there is an option to automatically delete the macro after playback. Also choose to tack on a beep or a sound file to the macro to alert when a message is displayed. The scheduler is built into the wizard to make the whole process quick and easy.

Sounds may also be added to reminder macros when not using the wizard. Use the Sound File command to insert a sound into the macro script.
Update Textbox

Use this command to update a Text Box being displayed in the macro with a new value, further instructions, etc. Also use this function to display and update the number of passes through a Repeat Loop or a Text File Process.

**Note:** The Update Textbox command is to **only** be used with the Timed floating box or end of macro or Floating Box until "Close Box" command or end of macro options.

Header
Insert the name of the Text Box to be updated during the playback of the macro. The Header name must match exactly with the header of the Text Box previously defined in the macro script.

Box Content
Enter the information to be displayed or updated in the Text Box into the Box Content field. This text replaces any information previously displayed in the Text Box.
**Explorer**

**Open Folder**

This command is similar to the [Open Folder in Explorer](#) command. "Open Folder" opens a window with only the contents of a folder displayed. "Open Folder in Explorer" opens a window with two panes that displays the Folder tree view on the left and the contents of the selected folder on the right.

The Open Folder command provides a shortcut to folders on the computer. Set up a hot key or other trigger to instantly go several layers deep in the File/Folder structure.

One example might be to create a shortcut to the Startup folder to periodically make adjustments. Or create a shortcut to the Cookies folder to see how it has grown after a day of Internet usage.

Another option would be to monitor a Temporary folder full of old downloads or email attachments that might require a periodic cleaning. In short, this option provides a quick way to get to the folders most frequently accessed.

Enter a folder name and the full path or click on the Browse button to search for the desired folder. Click the OK button when finished to save.

**See Also**
- [Open Folder in Explorer](#)
- [Open Special Explorer Folder](#)
Open Folder in Explorer

This option provides a shortcut to specific folders found in Windows Explorer. Set up a hot key or other trigger to instantly go several layers deep in Windows Explorer.

One example might be to create a shortcut to the Startup folder to periodically make adjustments. Or create a shortcut to the Cookies folder to see how it has grown after a day of Internet usage.

Another option would be to monitor a Temporary folder full of old downloads or email attachments that might require a periodic cleaning. In short, this option provides a quick way to get to the folders most frequently accessed.

Enter a folder name and the full path or click on the Browse button to search for the desired folder. Click the OK button when finished to save.

See Also
Open Folder
Open Special Explorer Folder
**Open Special Explorer Folder**

This command provides a quick way to get to some of the most frequented folders or dialog boxes. Other Explorer folders not listed below can be directly accessed with a macro using the [Open Folder](#) or [Open Folder in Explorer](#) command.

Use this option to quickly open any of the fourteen Explorer folders listed below. Select the folder and click OK to save.

## Available Folders
- Control Panel
- Desktop Folder
- Desktop Programs
- Favorites
- Fonts
- My Computer
- Network Neighborhood
- Printers
- Programs Folder
- Recent Documents
- Recycle Bin
- Start Menu
- Startup Folder
- User Documents

**See Also**
- [Open Folder](#)
- [Open Folder in Explorer](#)
Files or Folders

ASCII File Process

The ASCII File Process is a powerful command that extracts data from text files, one line at a time. The values of each record are saved to variables for later use, such as inserting the extracted values into other applications. This is an efficient method for transferring data from one file to another.

**Cautionary Note:** Do not manually edit or have another program edit the file during the processing, as this may cause unpredictable results on the computer. If you need to edit or update the file while the ASCII File Begin Process command is running, then have the macro make a copy of the file and process the file copy.

![ASCII File Begin Process](image)

**Filename**
Enter the name of the file to be opened and processed in this field. Click on the Browse button to locate the file and path on the computer.

**File Format**
The ASCII File Process processes three commonly used Delimited Text file formats. Most spreadsheet and database programs can export information in at least one of these file formats.

**Comma Delimited Text**
In a Comma Delimited Text file every field in each record is separated by a comma. Any field that contains a comma must be surrounded by a double quote (").
Comma Delimited Text file sample

MC,"98 SE, 2000",Athlon,750 MHz,256 M,,83
JH,95 B,5.00.3314.2101,P II,333 MHz,65 M
KH,"98 SE, 2000",5.00.3314.2101,P III,550 MHz,384 M,,,"17"" Flat"
KG,XP,5.50.4807.2300,P 4,1.7 GHz,256 M,,,"17"" Flat, 15"" LCD"
JH,98 SE,,Athlon,900 MHz,128 M,,,"17""
CM,2000 SP1,,Athlon,650 MHz,128 M,,,"17""
BW,98,,P II,300 MHz,192 M,,79
JW,NT SP6,,Celeron,600 MHz,256 M,35 Gig,83
JW,98 SE,,P III,700 MHz,256 M,18 Gig
JW,95,,Pentium,200 MHz,80 M,500 M
JC,2000,,P III,,128 M,,76
BF,Win 95,,,78
BL,2000,,Dual PIII,1GHz,256M,30G raid,83
SP,2000 SP2,,Mobile Pentium MMx,233MHz,128M,,76

Tab Delimited Text
In a Tab Delimited Text file every field in each record is separated by a Tab character.

Tab Delimited Text file sample

MC<tab>98 SE, 2000<tab>Athlon<tab>750<tab>256 M<tab>83
JH<tab>95 B<tab>5.00.3314.2101<tab>P II<tab>333<tab>65 M
KH<tab>98 SE, 2000<tab>5.00.3314.2101<tab>P III<tab>550<tab>384 M<tab>"17"" Flat"
KG<tab>XP<tab>5.50.4807.2300<tab>P 4<tab>1.7<tab>256 M<tab>"17"" Flat, 15"" LCD"
SJ<tab>98 SE<tab>Athlon<tab>900 MHz<tab>128<tab>"17"
CM<tab>2000 SP1<tab>Athlon<tab>650 MHz<tab>128<tab>"17"
BW<tab>98<tab>P II<tab>300 MHz<tab>192<tab>"79"
JW<tab>NT SP6<tab>Celeron<tab>600 MHz<tab>256<tab>35 Gig<tab>83
JW<tab>98 SE<tab>P III<tab>700 MHz<tab>256<tab>18 Gig
JW<tab>95<tab>Pentium<tab>200 MHz<tab>80<tab>500 M
JC<tab>2000<tab>P II<tab>128 M<tab>76
BF<tab>Win 95<tab>78
BL<tab>2000<tab>Dual PIII,1GHz,256M,30G raid,83
SP<tab>2000 SP2<tab>Mobile Pentium MMx,233MHz,128M,76

ASCII Delimited Text
In an ASCII Delimited Text file every field in each record is surrounded by double quote marks ("”) and separated by a comma. If the text contains a double quote it must use two double quotes in a row or it will be interpreted as the end of the field.
Each field in a record (a record is a line of the text file) is loaded into a variable which can be used throughout the macro. Optionally specify from which line to start in the text file and to either process all the records from that point or just a specific number of records. Use of the variables and processing will take place between the command to open the file and the command to end the file processing.
Example
This example uses any one of the example data files shown above and the following macro:

ASCII File Begin Process: "test.txt" (Tab Delimited Text)
ASCII File End Process

For this example, %T[1] % is entered in the field labeled "Variable Array to Receive Result" in the ASCII File Begin Process command.

The first time through the Process loop the variables will be:
  T[1] = MC
  T[3] =
  T[4] = Athlon
  T[5] = 750 MHz
  T[6] = 256 M
  T[7] =
  T[8] = 83
  T[9] =

The second time through the Process loop the variables will be:
  T[1] = JH
  T[2] = 95 B
  T[3] = 5.00.3314.2101
  T[4] = P II
  T[5] = 333 MHz
  T[6] = 65 M
  T[7] =
  T[8] =
  T[9] =

The third time through the Process loop the variables will be
  T[1] = KH
  T[3] = 5.00.3314.2101
  T[4] = P III
  T[5] = 550 MHz
  T[6] = 384 MHz
  T[7] =
  T[8] =
  T[9] = 17" Flat

Variable array to receive result
This is the text variable array that will receive the first field in a record (or line of text). Sequential text variables will receive subsequent field numbers. For example, if T is selected as the starting text variable, the first field in the record is saved to T[1], the second field in the record is saved to T[2] and so on.

Or instead of using T as the variable, assign a name to the variable such as "sales" and create as an array.

These variables may then be used and processed by other macro commands. For example, to type out the first two records into another application, use the Text Type command. Insert the variables to play back. In this case insert %T[1] % %T[2] %. This plays back the values saved to the first two variables.
Starting Index
The Starting Index defines which element in the array to start with. In the example above the variables used in the Process an ASCII Text File would start with T[1]. If the starting index is set to 5 then the first variable used would be T[5].

If other variables in the macro were previously assigned to T[1], T[2], etc. and will be used later, then start the index with a higher value in order to not overwrite the values saved to these variables.

Note: The "T" variable is automatically set up as an array. The variables are assigned as T[1], T[2], T[3], etc. There is not a limit as to the number of elements in the array. If using a named variable, first create the variable, assign it as an array and select the number of elements needed.

Begin processing on record 

Use this option to select which record to begin processing in the file. To process the entire file, enter 1 in the value field to indicate starting with the first record. Or use an Integer variable when specifying which record to start processing and the number of records to process.

What to process
Process All Records
Select this option to process every record in the file, if electing to start with record #1. Or it will start with the record selected and process all subsequent records.

Process Partial Records
Choose the "Process Partial Records if only needing to process a certain range of records (or lines of text).

Number of records to process
Enter in this field the number of records to process - how many lines of the file to process.

Parse blank lines
Use this option to process any blank lines in the file. The variable values will be empty when the blank line of the file is processed.

Leave this option unchecked so that the macro skips any blank lines in the file.

Clear the array before processing the file
Select this option to clear the values of all elements in the array selected to receive the results before the file processing begins. In the example above, the T variable array is selected. If a value were previously set to the array element T[10] before the processing begins, this value would be cleared when the file processing starts.

ASCII File End Process
Each ASCII File Begin Process command requires a corresponding ASCII File End Process command. All commands in the script between the Begin and the End Process commands will be repeated the number of times instructed.

If all records have been read out of the text file and processed, then control goes to the macro command that immediately follows the ASCII File End Process command.

See Also
Text File Begin Process
Break
Continue
Change Directory/Folder

Some programs require a specific default folder to be set before they are run. The Change Directory/Folder allows for this situation.

Enter the name of the path and folder or use the Browse button to locate a specific folder. Click OK to save the setting.
**Convert File Name**

Some programs or systems may display file names and paths in a truncated format, shortening any names in the path to eight characters or less. Select the file and path and choose whether to convert it to a long or short file name.

### Filenames to convert
Select the file name to be converted. The folder and entire path must be entered. Or click on the Browse button to navigate to the desired file. The file name must be a valid file in order for the conversion to work properly.

### Action
Select from the drop down list whether to convert the file to a short name or a long name.

### Variable to receive result
The converted file name is saved to a Text String variable for later use in the macro.
Create Folder

Use this option to create a new folder anywhere on the computer.

File Name/Path
Insert the new folder name and path. Or click on the Browse button to fill in the path information and insert the new folder name.
**Delete Folder**

Use this option to delete a folder and the contents of that folder from the computer.

![Delete Folder dialog box](image)

**File Name/Path**

Insert the folder name to be deleted and path. Or click on the Browse button to select the folder to be deleted.
File Manipulation

Use the file commands to change, create or delete folders as well as copy, rename, delete or move files. Select the desired function from the Command drop down list. Note: Wild cards may be used in the copy, rename, move and delete "File" commands. Use *.* to perform actions on all files in the folder, *.doc for all .doc files, fa.* for all files that start with an f, etc.

Delete File or Files
This option deletes the selected file or files. It can be particularly helpful when creating temporary files and deleting them when finished.

File(s) Path/Name
Insert the file name and path or click on the Browse button to locate the file to be deleted.

Delete Files Permanently
Deletes the file so that it bypasses the Windows Recycle Bin. Once deleted it is not recoverable through the Recycle Bin.

Copy File or Files
Make copies of existing files on the computer.

File(s) Path/Name
Insert the file name and path or click on the Browse button to locate the file to be copied.

Destination Path/Name
Insert the new file name to assign to the copy. Optionally click on the Browse button to copy over top of an existing file or to insert the file path and edit the file name.

Note: This function may also be used for copying folders and the contents of the folder. Insert the path and the name of the folder in the edit field. Or use the browse button to select a file in the folder to be copied. Remove the file name from the edit field so that just the path and folder name remain.

Rename File or Files
Rename existing files on the computer.

**File(s) Path/Name**
Insert the file name and path or click on the Browse button to locate the file to be renamed.

**Destination Path/Name**
Insert the name to assign to the renamed file. Or click on the Browse button to insert the file path and edit the file name.

**Move File or Files**
Move files on the computer to a new location.

**File(s) Path/Name**
Insert the file name and path or click on the Browse button to locate the file to be moved.

**Destination Path/Name**
Insert the name to assign to the moved file. Or click on the Browse button to insert the file path and edit the file name.

**Note:** This function may also be used for moving folders and the contents of the folder. Insert the path and the name of the folder in the edit field. Or use the browse button to select a file in the folder to be moved. Remove the file name from the edit field so that just the path and folder name remain.

If creating a new folder - the Destination Path/Name, the original folder will be deleted and all of the contents moved to the new folder. If moving the files to an existing folder, the original folder is not deleted but the files are moved into the existing folder.

**Rename Folder**
Use this option to rename an existing folder.

**Old Filename**
Insert the folder name and path or click on the Browse button to locate the folder to be renamed.

**New Filename**
Insert the name you want to give the folder. Or click on the Browse button to insert the file path and edit the folder name.

**Show Progress Dialog Box**
If this is checked, then a standard Windows dialog box opens displaying each file being copied. If the action takes only a very short time to perform, then the dialog box does not appear.

**Recurse into subfolders, if using wildcards**
This allows action to be taken on any folder found within the folder selected, if that folder matches the wildcard. For example, if using \\*, a match occurs on every folder name. If the command is to copy \\*.* and this option is selected, then all subfolders and their contents will be copied as well.
Set File Attributes

When using My Computer or Windows Explorer, right click on a file name to open the menu. Left mouse click on the Properties menu item to see more details about the file. At the bottom of the Properties window the following File Attributes may be displayed - Archive, System, Hidden and Read Only.

The Set File Attributes command changes the file attributes of files without having to navigate through My Computer or Windows Explorer.

**Filename**
Insert the file name and path or click on the Browse button to locate the file to be changed.

**Attributes**
Select the attribute or attributes to be turned on or off. True activates the attribute. False removes the attribute from the file.

**Note:** The If File Attribute command is available to first test the state of that file.
Text File Process

The Text File Process command reads each line of a text file into a variable. The entire line of text is saved into a single variable.

![Text File Begin Process dialog box](image.png)

Each line of the text file is loaded into a variable which can be used later in the macro. Select which line of the text file to begin with and either process all the lines from that point or just process a specific number of lines. Use of the variable and processing take place between the command to open the text file and the command to end the text file processing.

**Cautionary Note:** Do not manually edit or have another program edit the file during the processing, as this may cause unpredictable results on the computer. If you need to edit or update the file while the Text File Begin Process command is running, then have the macro make a copy of the file and process the file copy.

**Example**

If a text file contains the following data:

FMC, "98 SE, 2000", Talon, 750 MHz, 256 B,, 83
H, 95 B, 5.00.3314.2101, P II, 333 MHz, 65 B
H, "98 SE, 2000", 5.00.3314.2101, P III, 550 MHz, 384 B,, "17"" Flat"

and variable T[1] is used as the "Variable to Receive First Field".

The first time through the Process loop the variables will be:

\[ T[1] = \text{FMC, } "98 SE, 2000", \text{Talon, } 750 \text{ MHz, } 256 \text{ B, }, 83 \]

The second time through the Process loop the variables will be:

\[ T[1] = \text{H, } 95 \text{ B, } 5.00.3314.2101, \text{P II, } 333 \text{ MHz, } 65 \text{ B} \]

The third time through the Process loop the variables will be:

\[ T[1] = \text{H, } "98 SE, 2000", 5.00.3314.2101, \text{P III, } 550 \text{ MHz, } 384 \text{ B, }, "17"" \text{ Flat}" \]
File Name
Insert the name of the text file to be opened and processed. Click on the Browse button to locate the file and path or enter manually.

Variable to receive result
This is the text variable that receives the value of the text line in the file. This variable may then be used and processed by other macro commands.

Begin processing on record ___
Use this option to select which record to begin processing in the file. To process the entire file, enter 1 in the value field to indicate starting with the first record. Or use an Integer variable when specifying which record to start processing and the number of records to process.

What to process
   Process All Records
   Select this option to process every record in the file, if electing to start with record #1. Or it will start with the record selected and process all subsequent records.

   Process Partial Records
   Choose the "Process Partial Records if only needing to process a certain range of records (or lines of text).

       Number of records to process
       Enter in this field the number of records to process if not processing all records in the file.

Text File End Process
Each Text File Begin Process command requires a corresponding Text File End Process command. All commands in the script between the Begin and the End Process commands will be repeated the number of times instructed.

Note: If all records have been read out of the text file and processed, then control goes to the macro command that immediately follows the Text File End Process command.

See Also
ASCII File Begin Process
Break
Continue
Internet

Email Send

Sending messages by email can be automated and activated by the touch of a key. Send to one or multiple recipients, carbon copy (cc), and blind carbon copy (bcc). Select recipients at macro design time or at macro run time. A built in email address manager maintains a list of frequent recipients.

Generate the email message contents at macro design time, when the macro runs, from the contents of the clipboard or from a text file. One or multiple attachments may be included with the email. Attachments may also be specified at macro design time or at macro play back time.

Optionally maintain or browse a log of all email messages sent. The log file path is set from Options > Preferences > File System > File Paths.

Note: In order for the Email Send command to work properly first set up the default email information. Click on Options > Preferences > Email to enable the email functions of Macro Express.

The Email Send command is divided into three main sections - Recipients, Message and Attachments. These are each discussed below.

Recipients
The first step is to determine whether to hard code the recipients into the macro or choose the recipients at macro runtime. Select the option preferred from the drop down list.
Choose recipients now
Select the name of the person(s) to receive the email.

To: Click on the To button and select the person to receive the email from the Address book that opens.
CC: Click on the CC button and select a person from the address book to receive a carbon copy of the message.
BCC: Click on the BCC button and select a person from the address book to receive a blind carbon copy of the message.

Request a Read Notification
Select this option to have a small dialog box open during macro playback notifying that the email was sent successfully.

Address Book
Click on the Address button to add, remove or modify any names on the email recipient list. Or edit the Address Book from Options > Preferences > Email.

More than one person (address) may be inserted in any of these fields.

Prompt for recipients at runtime
The Prompt for recipients at runtime option displays a window similar to the one shown below during playback of the macro. Enter the email address or addresses of those to receive the email in the appropriate fields. Or click on the To, CC or BCC buttons to insert an address from the Address Book.

Set Position
Use this option to specify where the prompt window should display. See the Window Position and Size topic for complete details on using this option.

Request a Read Notification
Select this option to have a small dialog box open during macro playback signaling that the email was sent successfully.

Message
The four message options available are explained below. Select the option preferred from the drop down list.
Send fixed text
The fixed text option sends the same fixed text email message each time the macro is invoked. Enter the message subject in the appropriate field and the email message into the Message edit box.

Prompt for subject and body at runtime
This option prompts during playback of the macro to include a text message. An edit window opens prompting to enter a subject heading and message. Click on the OK button to send the email or Cancel to not send the message.

Set Position
Use this option to specify where the prompt window should display. See the Window Position and Size topic for complete details on using this option.

Send the text contained in the clipboard
Use this option to send whatever is currently saved to the clipboard in an email message. Copy something to the clipboard before running the macro or have the macro make the clipboard copy and then send the email. The clipboard contents are sent via email to the designated recipients).

Send the text contained in a file
This option sends the contents of the selected text file. Click on the Browse button to locate the text file to send or enter the file name and path in the File field.

Attachments
This tab provides three options for sending attachments with the email message. Select the option preferred from the drop down list.
No attachments
Click on this option to not include an email attachment with the message.

Choose attachment(s) now
Use this option to select the email attachment during macro design time. Click on the Browse button to locate and select the attachment file. Then click on the Add button to add to the list of attachments. Variables may also be used as part of the attachment file name.

This option allows for multiple attachments. After selecting the first attachment and it is placed in the list, start again to add another file. If a mistake is made in selecting the wrong attachment, highlight it from the list and click on the Delete button to remove the attachment.

Prompt for attachments at runtime
This option prompts to select an attachment during macro playback. A Select Attachments window opens to browse the computer to find the correct attachment.

Set Position
Use this option to specify where the prompt window should display. See the Window Position and Size topic for complete details on using this option.

This option also allows for multiple attachments. After selecting first attachment and it is placed in the list, click on the Add button again to add another. If a mistake is made in selecting the wrong attachment, highlight it from the list and click on the Delete button to remove the attachment.

Once attachments are added click on the OK button to send the email.

See Also
Web Mailto
Email Settings
MAPI Settings
SMTP Settings
FTP ChMod

This command assumes familiarity with operating FTP servers and clients.

### Filename
Select the filename to be edited.

### You, Group, Other
Select the attributes for the file selected. Select file rights for yourself, your group and all others. Elect to make the file readable so that any of these three may have read rights to the file. Also elect to make this file writable, so that it may be edited by one or any of these three. Or make certain files executable so that others may be able to access the file and run it.

Place checks in the boxes or assign resulting numbers that would apply. When selecting the box, a number is automatically assigned below.

### Response from Host:
The message generated by the FTP server, whether a success or failure message, is saved to the variable assigned. There are several ways to monitor the variable to determine the status of the operation.

1. Place the variable in a Text Box Display command to display the results at the end of the macro.
2. Use the Variable Modify String command to save the variable results to a text file for later review.
3. Send the results via email.
**Note:** Before using this function, the macro script first requires the [FTP Site Connect](#) command to connect to the site. When all FTP actions have been completed, use the [FTP Site Disconnect](#) command to disconnect from the site.
FTP Directory Commands

The following commands all affect the FTP directory.

FTP Change Directory
The FTP Change Directory command changes the current working directory on the FTP site. The user can select a specific directory to change. This can be an absolute path or a relative path. This functionality is identical to the Change Directory/Folder command that applies to folders on a computer drive. However, this command also adds the ability to go up a level and switch to the previous directory in the hierarchy. Note: Path delimiters in an FTP server require the forward slash '/', not the backslash '\' that Windows uses.

- **Go up a level**
  This option moves up one folder in the FTP server folder hierarchy.

- **Specific Directory**
  This option moves to a specific folder in the FTP server.

FTP Delete Directory
This command deletes a directory from the FTP server.

- **Directory**
  Insert the directory to be deleted from the FTP server.
FTP Create Directory
This command creates a new directory on the FTP Server.

**Directory**
Insert the new directory name to be created.

Response from Host
This option is available for the FTP Change, Delete and Create Directory commands. The message generated by the FTP server, whether a success or failure, is saved to the variable assigned. There are several ways to monitor the variable to determine the status of the operation.

1. Place the variable in a [Text Box Display](#) command to display the results at the end of the macro.
2. Use the [Variable Modify String](#) command to save the variable results to a text file for later review.
3. Send the results via [email](#) to an email account.

FTP Get Current Directory
The FTP Get Directory command retrieves the present working directory on the FTP Server. This information is saved to the variable selected. If for some reason the retrieval was not successful the error message information is saved to the variable.

FTP List Directory
This command retrieves a listing of all files in the current directory on the FTP Server.

**File Mask**
Specifies the files being looked for in the directory. Wildcards are permitted.

**Detailed List**
This returns all values about the files in the current directory, such as file size, permissions and the owner.

**Variable to save result to**
The information retrieved is stored in the variable selected.

---

**Note:** Before using any of these functions, the macro script first requires the [FTP Site Connect](#) command to connect to the site. When all FTP actions have been completed, use the [FTP Site Disconnect](#) command to disconnect from the site.
FTP File Commands

Each of these commands pertain to files that are transferred via FTP.

FTP Send File
Sends the selected file from the user's computer to the FTP server.

- **File Name**
  Insert the name of the file to send or click on Browse to locate the file.

- **Transfer Mode**
  Determine whether the file being sent or received is a Binary file or an ASCII file.

- **Response from Host**
  The message generated by the FTP server, whether a success or failure, is saved to the assigned variable. There are several ways to monitor the variable to determine the status of the operation.

  1. Place the variable in a **Text Box Display** command to display the results at the end of the macro.
  2. Use the **Variable Modify String** command to save the variable results to a text file for later review.
  3. Send the results via **email** to an email account.

FTP Get File
Retrieves the selected file from the FTP server to the destination folder on the user's computer.
Remote File Name
Enter the name of the file found on the FTP server.

Local Destination Directory
Enter the folder name and path of the file to be saved on the computer. Or click on the Browse button to locate the directory.

Transfer Mode
Determine if the file being sent or received is a Binary file or an ASCII file.

Response from Host
The message generated by the FTP server, whether a success or failure, is saved to the assigned variable. There are several ways to monitor the variable to determine the status of the operation.

1. Place the variable in a Text Box Display command to display the results at the end of the macro.
2. Use the Variable Modify String command to save the variable results to a text file for later review.
3. Send the results via email to an email account.

Note: The Scroll Lock + Pause or other methods available to stop the macro do not work during the playback of the FTP Send File and FTP Get File commands.

FTP Rename File
This command renames a FTP file.

Original Filename
Insert the name or path and name of the file to be renamed.

New Filename
Insert the new filename or new path and name of the file.

Response from Host
The message generated by the FTP server, whether a success or failure, is saved to the assigned variable. There are several ways to monitor the variable to determine the status of the operation.

1. Place the variable in a Text Box Display command to display the results at the end of the macro.
2. Use the Variable Modify String command to save the variable results to a text file for later review.
3. Send the results via email to an email account.

FTP Delete File
This command deletes the selected FTP file. The FTP Delete File command also accepts wildcards, such as *..*, in the filename edit box.

File Name
Enter the name of the file to be deleted from the FTP server.

Response from Host
The message generated by the FTP server, whether a success or failure, is saved to the assigned variable. There are several ways to monitor the variable to determine the status of the operation.

1. Place the variable in a Text Box Display command to display the results at the end of the macro.
2. Use the Variable Modify String command to save the variable results to a text file for later review.
3. Send the results via email to an email account.

Get Filesize
This command returns the size of a FTP file. Note: A return value of -1 means that the FTP server does not
support the Size command.

Filename
To obtain the file size, first Insert the name or path and name of the file in question.

Destination Variable
The file size is stored in an integer variable. Select the variable to store this information.

Transfer Mode
Select whether the FTP file is a Binary file, an ASCII file or unknown. Binary is the default selection.

Response from Host
The message generated by the FTP server, whether a success or failure, is saved to the assigned variable. There are several ways to monitor the variable to determine the status of the operation.

1. Place the variable in a Text Box Display command to display the results at the end of the macro.
2. Use the Variable Modify String command to save the variable results to a text file for later review.
3. Send the results via email to an email account.

Note: Before using any of these functions, the macro script first requires the FTP Site Connect command to connect to the site. When all FTP actions have been completed, use the FTP Site Disconnect command to disconnect from the site.
FTP Keep Alive

The FTP Keep Alive command sends a signal during macro playback to keep the FTP connection alive.

There is no window for this command. From the list of commands in the Script Editor or Direct Editor click on the Internet folder to expand the list of commands. Double click on the FTP Keep Alive command to insert into the macro.

**Note:** Before using this function, the macro script first requires the [FTP Site Connect](#) command to connect to the site. When all FTP actions have been completed, use the [FTP Site Disconnect](#) command to disconnect from the site.
FTP Site Command

This command assumes familiarity with operating FTP servers and clients. This option sends a FTP command, one that we otherwise wouldn't support, to the FTP server.

Command to send to Host
This is essentially a free form field to send a command to the FTP server. There are a large number of FTP commands available. It is necessary to know the correct format of the command to send to the FTP server. This field is case sensitive. It is also necessary to make sure that the FTP server supports the command to be sent.

FTP Library Help Definition of FTP Site
"Site is a procedure used to send a site-specific FTP command directly to the FTP server. Site is used by an FTP server to provide services specific to the host system that are essential to file transfer, but not sufficiently universal to be included as commands in the FTP protocol."

In short, the FTP Site command will not send "normal" commands like "S", "get" or "put". The commands that are sent have a syntax of “SITE something”.

Response from Host
The message generated by the FTP server, whether a success or failure, is saved to the assigned variable. There are several ways to monitor the variable to determine the status of the operation.

1. Place the variable in a Text Box Display command to display the results at the end of the macro.
2. Use the Variable Modify String command to save the variable results to a text file for later review.
3. Send the results via email to an email account.

**Note:** Before using this function, the macro script first requires the FTP Site Connect command to connect to the site. When all FTP actions have been completed, use the FTP Site Disconnect command to disconnect from the site.
Only one FTP connection can be used at any given time. These commands assume familiarity with operating FTP servers and clients.

**FTP Site Connect or Disconnect**

The options shown in the window above pertain to connecting to a FTP site.

- **Host**
  Insert the address of the FTP server to be connected.

- **Port**
  Select the port used to connect to the FTP server. This is generally port 21.

- **Log in anonymously**
  Use this option to connect to the FTP server anonymously. Most servers allow these kinds of connections, though they restrict the user to specific directories.

- **User**
  The login name used to connect to the FTP server.

- **Password**
  Insert the password associated with the login name.
Passive Mode
This option is used if the user is behind a firewall. Most firewalls do not allow users to connect to FTP servers unless they are in passive mode. This is primarily for security reasons.

Response from Host
Any error or success messages are stored in the specified variable. It is up to the user to determine if the connection to the FTP server was successful. There are several ways to monitor the variable to determine the status of the operation.

1. Place the variable in a Text Box Display command to display the results at the end of the macro.
2. Use the Variable Modify String command to save the variable results to a text file for later review.
3. Send the results via email to an email account.

Don't process embedded variables
When using a variable in any of the fields of this command, the Don't process embedded variables option ignores all % signs found within the variable value and does not attempt to treat the % signs as an embedded variable. It will just expand the % sign as a standard character during macro runtime.

Example
Assume for example a variable of %T[1]% with a value of ftp://ftp.macros.com/abc%23%/macexp.exe.

1. With this option selected, the macro will connect to ftp://ftp.macros.com/abc%23%/macexp.exe.
2. If the option is not selected, then the macro will assume that there is a variable of %23% and look to expand its value.
   a. If the variable %23% does not exist, then the macro will generate an error because it could not find the value for this variable.
   b. Otherwise it will expand the value of %23% within the main variable.

FTP Site Disconnect
Disconnects a user from an FTP server. This command does not have any effect if the user is not connected when the FTP Site Disconnect command is executed.
**Get IP Address**

The Get IP Address command finds the IP (Internet Protocol) address of the computer running the macro and saves this address to a variable. This command may also help in determining if an online connection is active or not.

![Get IP Address dialog box](image)

**IP Address**

An IP address is an identifier for a computer on a TCP/IP network. Networks using the TCP/IP protocol route messages based on the IP address of the destination. The format of an IP address is a 32-bit numeric address written as four numbers separated by periods. Each number can be from zero to 255. An example IP address is 192.14.122.216.

Within an isolated network, IP addresses can be assigned at random as long as each one is unique. However, connecting a private network to the Internet requires using registered IP addresses (called Internet addresses) to avoid duplicates.

The Get IP Address command identifies the IP address of the network card on the computer - the IP address of the computer within a private network. Or if connecting to the Internet, this command identifies the IP address used to connect to the Internet. For a dial up connection, this IP address is assigned by the Internet Service Provider. It may change each time the computer is connected to the Internet.

**Store IP address in**
The IP address is stored to the selected variable.
Ping Site

This command pings a web site or IP address.

Address/Host Name
Insert the address of the site to ping. This can be an address such as www.macros.com or an IP address.

Store results in
The results of the ping are saved to an assigned variable. The results include information such as if the ping was successful, or one of a number of error messages if it was not successful.

Timeout
Set the amount of time for the macro to ping the site.

Don’t process embedded variables
When using a variable in the address field, this option ignores any % signs found within the variable value and will not attempt to treat the % signs as an embedded variable. It will just expand the % sign as a standard character during macro runtime.
Example
Assume for example a variable of %T[1]% with a value of https://www.macros.com/abc%23%/support.htm.

1. With this option selected, the macro will ping the site found at https://www.macros.com/abc%23%/support.htm.

2. If the option is not selected, then the macro will assume that there is a variable of %23% and look to expand its value.
   a. If the variable %23% does not exist, then the macro will generate an error because it could not find the value for this variable.
   b. Otherwise it will expand the value of %23% within the main variable.
**Web FTP Site**

The Web FTP Site command initiates an FTP transfer. Just insert the FTP address and click the OK button. An FTP transfer is initiated when the macro is executed.

![Web FTP Site dialog box](image)

**Don't process embedded variables**

When using a variable in the FTP edit field, this option ignores any % signs found within the variable value and will not attempt to treat the % signs as an embedded variable. It will just expand the % sign as a standard character during macro runtime.

**Example**

Assume for example a variable of %T[1]% with a value of ftp://ftp.macros.com/abc%23%/macexp.exe.

1. With this option selected, the macro will initiate the FTP transfer from ftp://ftp.macros.com/abc%23%/macexp.exe.

2. If the option is not selected, then the macro will assume that there is a variable of %23% and look to expand its value.
   a. If the variable %23% does not exist, then the macro will generate an error because it could not find the value for this variable.
   b. Otherwise it will expand the value of %23% within the main variable.
**Web Mailto**

This command provides a quick method for opening the default email program and inserting an email address in the To field of a message to be sent.

Insert the email address of the recipient in the address field, as shown above. The macro will open the computer's default email program to the New Message or equivalent window and insert the email address provided in the To: field.

This action is similar to clicking on a web page link to send an email to the web host. The action opens the email client and inserts the email address in the To: field. Most email programs support this function, though not all.

**See Also**
- Email Send
- Email Settings
- MAPI Settings
- SMTP Settings
Web Site

Use this command to open a web page. Just enter the web site address and click the OK button. The web site entered is launched when the macro is run. If the browser is not open, the macro also opens the browser.

Please enter the website
Insert the URL that is to be opened. If opening a secure web page, just insert the "s" in the default http:// setting. Change it to https://.

Favorites
Rather than type in a URL, click on the Favorites button to open the list of URL's in the Favorites folder. Select the URL, highlight it and click OK to insert the URL into the address field.

Launch Using
Select which browser to load and open the web page.

Default Browser
This option loads the browser that currently is designated by Windows as the default web browser.

Internet Explorer
The other option is to select Internet Explorer as the browser. If Internet Explorer is already the default browser, then either selection is valid. But if another browser is currently set as the default and macro timing is critical, consider selecting Internet Explorer to take advantage of the Wait for Web Page option.

Wait for the Web Page
When selected, the macro pauses until the web page has fully loaded. After the page has fully loaded, the macro continues. The Wait for Web Page option is only available for Internet Explorer.

Don't process embedded variables
When using a variable in the website field, this option ignores any % signs found within the variable value and will not attempt to treat the % signs as an embedded variable. It will just expand the % sign as a standard character during macro runtime.
Example
Assume for example a variable of %T[1]%% with a value of https://www.macros.com/abc%23%/support.htm.

1. With this option selected, the macro will load the web page found at https://www.macros.com/abc%23%/support.htm.

2. If the option is not selected, then the macro will assume that there is a variable of %23% and look to expand its value.
   a. If the variable %23% does not exist, then the macro will generate an error because it could not find the value for this variable.
   b. Otherwise it will expand the value of %23% within the main variable.

See Also
Wait for Web Page
Keyboard

Caps, Num and Scroll Lock Keys

This command activates or releases the Caps Lock, Num Lock or Scroll Lock keys.

For example, to capitalize a section of text (all caps), insert the Caps Lock On command before the text that is to be typed. To revert back to regular text, place a Caps Lock Off command before the next section of text.

Key
Select which key to use - the Caps Lock, Num Lock or Scroll Lock key.

Action
Select whether to turn the key on or off.

Note: If the Caps Lock, Num Lock or Scroll lock is turned on during macro playback, these keys will remain locked after the macro has completed, unless a corresponding Turn Key Off command is also issued during playback.
Encrypted Text

When viewing or editing the contents of the macro, the encrypted text displays as encrypted text - *****. The command is handy for passwords and the like so that people snooping through the program cannot readily uncover passwords. Use this along with the Password command for additional security.

Enter the text to be encrypted into the text edit field. Whatever is typed into this field appears as above, a series of dots. Each dot represents a character input. The actual text is typed when the macro is played back, not the encrypted dots.

Click on this icon to view the text that is typed, to ensure that it is correct. Releasing the mouse changes the text back to the encrypted view.

Store the text in a variable
Place the encrypted text into a variable with this option. Enter the variable name or select from the list of variables previously defined in the macro.

See Also
Password Protection
Security
Set/Clear Passwords
Text Type

When in the Script Editor, use this window to enter text and a variety of other keystrokes as part of the macro script. The text or keystrokes play back into the application that is open when running the macro. The Text Type command is not necessary when using the Direct Editor. Text and the keystrokes displayed below may be input directly to the Direct Editor.

Inserting Keys and Text
Type the text to include in the macro script directly into the edit box as shown above. Click on one of the entries, such as Delete, in the yellow area to insert it into the edit box. Or tab and arrow to the entry and press Enter to insert the item into the macro script. Clicking on one of the F1 - F12 buttons inserts the selected F1 - F12 key into the edit field.

Note: When using the Alt key or Ctrl Key to automate menu items, accelerator keys etc, use lower case letters after the key, such as in the example above - <Alt>f. If <ALT>FI were used instead, the program would interpret the keys as <ALT><SHIFT>f<SHIFT>i, generating unpredictable results.

Hold a Key Down
In some situations you may need the ability to hold a particular key down until you instruct the key to be released. Several keys, such as ALT, CTRL, SHIFT and the Windows key, already have options in the Text Type command to hold them down and release them.

For other keys or virtual keys, there is a special syntax that must be typed into the Keystrokes edit box. For example, enter <KEYD:VK_TAB> to hold down the "TAB" key. Enter <KEYU:VK_TAB> to release the key.
when needed. Or insert <KEYD:Q> to hold down the "Q" key and <KEYU:Q> to release it.

Click here for a list of virtual keys available for use.

Symbols
To insert symbols or characters into the macro text click on the Symbols button to open the Symbols window as shown below. Locate the symbol or character, highlight it and click on the OK button to insert it into the script. Or double click on the symbol to insert into the script.

Show symbols from this font
Select the font from the drop down list. Symbols associated with the font selected are displayed. The program default is the Arial font.

Alt-Key Sequence
Use this option to embed an Alt-Key Sequence directly into a macro. The Alt-Key Sequence is a method of inserting symbols into most Windows applications and is done by holding the ALT key down and pressing digits on the numeric keypad. Clicking on the "Alt-Key Sequence" button presents a window requesting the numeric digits that would typically be typed via the numeric keypad.

Use this functionality to enter characters that may not be present on your keyboard, such as á, Ô, ©, ¾, ç or ñ, or characters not found in the symbols list represented above.

There are three ways to enter special characters using the Alt-Key sequence:

1. + 1 to 3 digits
   Do not type a leading 0 for this method.
For example will insert the Ü character.

2. + 3 digits
   This method requires that the first digit typed be 0.

For example will insert the Å character.

Note: Be mindful when to include the leading zero or not, because the outcome may result in different characters. For example, will insert the ≈ character but inserts the ÷ character.

3. + hexadecimal value for the character
   Use this method to have Macro Express type Unicode characters into your application. The first digit input in the edit field must be the + character.

For example will insert the ç character.

Note: To use the hex input method you need to set or create the REG_SZ registry value HKEY_CURRENT_USER\Control Panel\Input Method\EnableHexNumpad and give it a value of 1. You will need to log off and back on or reboot the computer before this setting takes effect.

For those unfamiliar with this process, the steps to create the value are listed below.
1. Open the Windows Registry Editor - from the Windows Start menu search for regedit.exe.
2. Expand HKEY_CURRENT_USER and then Control Panel.
3. Right mouse click on Input Method and select New and then String Value from the menu.
4. Rename the NewValue#1 entry to EnableHexNumpad.
5. Right click on the EnableHexNumpad entry you just created and select Modify from the menu.
6. In the Value Data Field enter the number 1 and click OK.
7. The entry should show EnableHexNumpad as the Name, REG_SZ as the Type, and 1 in the Data column.
8. Log off and back on or reboot for the new setting to take effect.

Below is a sample of various characters generated via the three Alt Keypad methods and their associated codes. A quick Internet search will provide the codes and resulting character values for each of these methods.

<table>
<thead>
<tr>
<th>Character</th>
<th>Alt Code</th>
<th>Character</th>
<th>Alt Code</th>
<th>Character</th>
<th>Alt + Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ç</td>
<td>Alt 128</td>
<td>• €</td>
<td>Alt 0128</td>
<td>ç</td>
<td>Alt +00e7</td>
</tr>
<tr>
<td>Ñ</td>
<td>Alt 165</td>
<td>¥</td>
<td>Alt 0165</td>
<td>ç</td>
<td>Alt +0255</td>
</tr>
<tr>
<td>¦</td>
<td>Alt 195</td>
<td>Ä</td>
<td>Alt 0195</td>
<td>¦</td>
<td>Alt +02ab</td>
</tr>
<tr>
<td>—</td>
<td>Alt 196</td>
<td>Ä</td>
<td>Alt 0196</td>
<td>ô</td>
<td>Alt +01ff</td>
</tr>
<tr>
<td>©</td>
<td>Alt 201</td>
<td>É</td>
<td>Alt 0201</td>
<td>©</td>
<td>Alt +9f7e</td>
</tr>
<tr>
<td>Ì</td>
<td>Alt 211</td>
<td>Ó</td>
<td>Alt 0211</td>
<td>☆</td>
<td>Alt +2606</td>
</tr>
<tr>
<td>Ç</td>
<td>Alt 222</td>
<td>Ñ</td>
<td>Alt 0222</td>
<td>£</td>
<td>Alt +20a4</td>
</tr>
<tr>
<td>Ô</td>
<td>Alt 233</td>
<td>é</td>
<td>Alt 0233</td>
<td>¥</td>
<td>Alt +00a5</td>
</tr>
<tr>
<td>≈</td>
<td>Alt 247</td>
<td>÷</td>
<td>Alt 0247</td>
<td>≈</td>
<td>Alt +260e</td>
</tr>
</tbody>
</table>

Variables
Insert variables into the macro text. The variable value is typed during the playback of the macro. Click on the Variables list box to select the desired variable and then click on the Insert button. If selecting T[1] as the variable, it displays as %T[1]% in the macro script.

Misc Keys
Miscellaneous keystrokes such as the Print Screen, Left CTRL Key, Application Key, etc. can be inserted by clicking on the Misc Keys button. Select the key and click OK add to the Text Type.
Note: Make sure that the cursor is positioned correctly before inserting symbols, variables, etc. Symbols, keystrokes, variables, etc. are placed in the script wherever the cursor is located.

Playback Options
Select from the drop down list one of four options for playing back the text. These are explained below.

Simulate Keystrokes
The simulate keystrokes option types the text keystroke by keystroke into the receiving application. This is the default selection.

Caution: It is possible when typing back long strings of text that the Keyboard Buffer may overflow. When this happens some of the text may be missing or scrambled or the computer emits a strange high pitched sound. In these instances the text is playing back too fast. To correct this problem, either select the Use Clipboard to Paste Text option, set a default Text Type Delay from the Preferences window, or use the Keystroke Speed command to control the text playback speed.

Use Clipboard and Paste Text
This option pastes the text through the Windows clipboard into the receiving application. This option should only be used with text. Keys such as Alt, Ctrl, Shift, etc. paste back as <ALT>, <CONTROL>, <SHIFT>, etc. instead of simulating the actual keystroke.

Send Text Directly to Control
If a Control Variable is previously defined, the text entered in this command is typed into the selected Window Control. The control chosen must be able to accept text input. Otherwise this command will appear to do nothing.
Paste Rich Text
Select this option to display components that allow for rich text in the keystrokes edit box. Select various font types, sizes, colors for the text. Also bold, underline, italicize or justify the text.

Use the available components to create the rich text or copy the rich text from another source and paste into the edit box. The rich text will be pasted into applications that accept rich text.

Wrap Text in Editor
Select this option to have the text in the Keystrokes edit field wrap so that all text is visible without scrolling to the right. This function performs similar to the Word Wrap feature in text editor programs, such as Notepad and others.

See Also
Using Rich Text
Virtual Keys
Rich Text

Macro Express has the ability to play back text in a rich text format. Select the Paste Rich Text option from the drop down menu to display the rich text editor options. Create the rich text content directly in the Text Type command or copy the rich text from another source and paste it into the edit box.

![Rich Text Editor Options](image)

**Paste Rich Text**

With this option selected, the edit box supports rich text. Create macros with varying fonts, sizes, colors, etc. Highlight the text in the edit box and select from the rich text options described below.

- **Bold, Underline, Italics, Strike Through**

- **Justify**
  - Left, Center, Right

- **Font**
  - Choose from different font types, sizes and colors.

  Colors such as `clWindowText`, `clWindowFrame`, `clScrollBar` are assigned to specific parts of the window. For example, on different computers `clWindowText` may be black, dark gray or white depending on the theme or custom color choices.
Things to consider when using Rich Text

- If the "Paste Rich Text" option is selected, the text will always be pasted from the clipboard. Anything previously saved to the clipboard will be lost.
- If the "Paste Rich Text" option is turned off after creating rich text and the Text Type command is saved, the rich text formatting is lost and will need to be reformatted, if desired.
- If the application that Macro Express is pasting into doesn't support rich text, such as Notepad, then the text is pasted in plain text format.
- Only the Tab, Enter and Num Pad Enter keys will play back correctly when being pasted through the clipboard. Other keys will just paste back their text equivalent, such as <Alt> or <CTRL>.
- Variable values play back correctly when pasted in rich text format.
Virtual Keys

Below is a list developed by Microsoft of available virtual keys. Macro Express 5 supports these virtual keys via the `<KEYD: and <KEYU: syntax in the Text Type command.

If your system supports these keys, they may be played back through the Text Type command. For example, to hold down the Delete key and later release it, use the following syntax: `<KEYD:VK_DELETE>` and `<KEYU:VK_DELETE>`.

<table>
<thead>
<tr>
<th>Virtual Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VK_ACCEPT</td>
<td>IME accept</td>
</tr>
<tr>
<td>VK_ADD</td>
<td>Add key</td>
</tr>
<tr>
<td>VK_APPS</td>
<td>Applications key (Natural keyboard)</td>
</tr>
<tr>
<td>VK_ATTN</td>
<td>Attn key</td>
</tr>
<tr>
<td>VK_BACK</td>
<td>BACKSPACE key</td>
</tr>
<tr>
<td>VK_BROWSER_BACK</td>
<td>Browser Back key</td>
</tr>
<tr>
<td>VK_BROWSER_FAVORITES</td>
<td>Browser Favorites key</td>
</tr>
<tr>
<td>VK_BROWSER_FORWARD</td>
<td>Browser Forward key</td>
</tr>
<tr>
<td>VK_BROWSER_HOME</td>
<td>Browser Start and Home key</td>
</tr>
<tr>
<td>VK_BROWSER_REFRESH</td>
<td>Browser Refresh key</td>
</tr>
<tr>
<td>VK_BROWSER_SEARCH</td>
<td>Browser Search key</td>
</tr>
<tr>
<td>VK_BROWSER_STOP</td>
<td>Browser Stop key</td>
</tr>
<tr>
<td>VK_CANCEL</td>
<td>Control-break processing</td>
</tr>
<tr>
<td>VK_CAPITAL</td>
<td>CAPS LOCK key</td>
</tr>
<tr>
<td>VK_CLEAR</td>
<td>CLEAR key</td>
</tr>
<tr>
<td>VK_CONTROL</td>
<td>CTRL key</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>VK_CONVERT</td>
<td>IME convert</td>
</tr>
<tr>
<td>VK_CRSEL</td>
<td>CrSel key</td>
</tr>
<tr>
<td>VK_DECIMAL</td>
<td>Decimal key</td>
</tr>
<tr>
<td>VK_DELETE</td>
<td>DEL key</td>
</tr>
<tr>
<td>VK_DIVIDE</td>
<td>Divide key</td>
</tr>
<tr>
<td>VK_DOWN</td>
<td>DOWN ARROW key</td>
</tr>
<tr>
<td>VK_END</td>
<td>END key</td>
</tr>
<tr>
<td>VK_EREOF</td>
<td>Erase EOF key</td>
</tr>
<tr>
<td>VK_ESCAPE</td>
<td>ESC key</td>
</tr>
<tr>
<td>VK_EXECUTE</td>
<td>EXECUTE key</td>
</tr>
<tr>
<td>VK_EXSEL</td>
<td>ExSel key</td>
</tr>
<tr>
<td>VK_F1</td>
<td>F1 key</td>
</tr>
<tr>
<td>VK_F10</td>
<td>F10 key</td>
</tr>
<tr>
<td>VK_F11</td>
<td>F11 key</td>
</tr>
<tr>
<td>VK_F12</td>
<td>F12 key</td>
</tr>
<tr>
<td>VK_F13</td>
<td>F13 key</td>
</tr>
<tr>
<td>VK_F14</td>
<td>F14 key</td>
</tr>
<tr>
<td>VK_F15</td>
<td>F15 key</td>
</tr>
<tr>
<td>VK_F16</td>
<td>F16 key</td>
</tr>
<tr>
<td>VK_F17</td>
<td>F17 key</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------</td>
</tr>
<tr>
<td>VK_F18</td>
<td>F18 key</td>
</tr>
<tr>
<td>VK_F19</td>
<td>F19 key</td>
</tr>
<tr>
<td>VK_F2</td>
<td>F2 key</td>
</tr>
<tr>
<td>VK_F20</td>
<td>F20 key</td>
</tr>
<tr>
<td>VK_F21</td>
<td>F21 key</td>
</tr>
<tr>
<td>VK_F22</td>
<td>F22 key</td>
</tr>
<tr>
<td>VK_F23</td>
<td>F23 key</td>
</tr>
<tr>
<td>VK_F24</td>
<td>F24 key</td>
</tr>
<tr>
<td>VK_F3</td>
<td>F3 key</td>
</tr>
<tr>
<td>VK_F4</td>
<td>F4 key</td>
</tr>
<tr>
<td>VK_F5</td>
<td>F5 key</td>
</tr>
<tr>
<td>VK_F6</td>
<td>F6 key</td>
</tr>
<tr>
<td>VK_F7</td>
<td>F7 key</td>
</tr>
<tr>
<td>VK_F8</td>
<td>F8 key</td>
</tr>
<tr>
<td>VK_F9</td>
<td>F9 key</td>
</tr>
<tr>
<td>VK_FINAL</td>
<td>IME final mode</td>
</tr>
<tr>
<td>VK_HANGUE</td>
<td>IME Hanguel mode (maintained for compatibility; use VK_HANGUL)</td>
</tr>
<tr>
<td>VK_HANGUL</td>
<td>IME Hangul mode</td>
</tr>
<tr>
<td>VK_HANJA</td>
<td>IME Hanja mode</td>
</tr>
<tr>
<td>VK_KEY</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>VK_HELP</td>
<td>HELP key</td>
</tr>
<tr>
<td>VK_HOME</td>
<td>HOME key</td>
</tr>
<tr>
<td>VK_INSERT</td>
<td>INS key</td>
</tr>
<tr>
<td>VK_JUNJA</td>
<td>IME Junja mode</td>
</tr>
<tr>
<td>VK_KANA</td>
<td>IME Kana mode</td>
</tr>
<tr>
<td>VK_KANJI</td>
<td>IME Kanji mode</td>
</tr>
<tr>
<td>VK_LAUNCH_APP1</td>
<td>Start Application 1 key</td>
</tr>
<tr>
<td>VK_LAUNCH_APP2</td>
<td>Start Application 2 key</td>
</tr>
<tr>
<td>VK_LAUNCH_MAIL</td>
<td>Start Mail key</td>
</tr>
<tr>
<td>VK_LAUNCH_MEDIA_SELECT</td>
<td>Select Media key</td>
</tr>
<tr>
<td>VK_LBUTTON</td>
<td>Left mouse button</td>
</tr>
<tr>
<td>VK_LCONTROL</td>
<td>Left CONTROL key</td>
</tr>
<tr>
<td>VK_LEFT</td>
<td>LEFT ARROW key</td>
</tr>
<tr>
<td>VK_LMENU</td>
<td>Left MENU key</td>
</tr>
<tr>
<td>VK_LSHIFT</td>
<td>Left SHIFT key</td>
</tr>
<tr>
<td>VK_LWIN</td>
<td>Left Windows key (Natural keyboard)</td>
</tr>
<tr>
<td>VK_MBUTTON</td>
<td>Middle mouse button (three-button mouse)</td>
</tr>
<tr>
<td>VK_MEDIA_NEXT_TRACK</td>
<td>Next Track key</td>
</tr>
<tr>
<td>VK_MEDIA_PLAY_PAUSE</td>
<td>Play/Pause Media key</td>
</tr>
<tr>
<td>VK_MEDIA_PREV_TRACK</td>
<td>Previous Track key</td>
</tr>
<tr>
<td>Key Code</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>VK_MEDIA_STOP</td>
<td>Stop Media key</td>
</tr>
<tr>
<td>VK_MENU</td>
<td>ALT key</td>
</tr>
<tr>
<td>VK_MODECHANGE</td>
<td>IME mode change request</td>
</tr>
<tr>
<td>VK_MULTIPLY</td>
<td>Multiply key</td>
</tr>
<tr>
<td>VK_NEXT</td>
<td>PAGE DOWN key</td>
</tr>
<tr>
<td>VK_NONAME</td>
<td>Reserved</td>
</tr>
<tr>
<td>VK_NONCONVERT</td>
<td>IME nonconvert</td>
</tr>
<tr>
<td>VK_NUMLOCK</td>
<td>NUM LOCK key</td>
</tr>
<tr>
<td>VK_NUMPAD0</td>
<td>Numeric keypad 0 key</td>
</tr>
<tr>
<td>VK_NUMPAD1</td>
<td>Numeric keypad 1 key</td>
</tr>
<tr>
<td>VK_NUMPAD2</td>
<td>Numeric keypad 2 key</td>
</tr>
<tr>
<td>VK_NUMPAD3</td>
<td>Numeric keypad 3 key</td>
</tr>
<tr>
<td>VK_NUMPAD4</td>
<td>Numeric keypad 4 key</td>
</tr>
<tr>
<td>VK_NUMPAD5</td>
<td>Numeric keypad 5 key</td>
</tr>
<tr>
<td>VK_NUMPAD6</td>
<td>Numeric keypad 6 key</td>
</tr>
<tr>
<td>VK_NUMPAD7</td>
<td>Numeric keypad 7 key</td>
</tr>
<tr>
<td>VK_NUMPAD8</td>
<td>Numeric keypad 8 key</td>
</tr>
<tr>
<td>VK_NUMPAD9</td>
<td>Numeric keypad 9 key</td>
</tr>
<tr>
<td>VK_OEM_1</td>
<td>Used for miscellaneous characters; it can vary by keyboard.</td>
</tr>
<tr>
<td>VK_OEM_102</td>
<td>Either the angle bracket key or the backslash key on the RT 102-key keyboard</td>
</tr>
<tr>
<td>VK_OEM_2</td>
<td>Used for miscellaneous characters; it can vary by keyboard.</td>
</tr>
<tr>
<td>VK_OEM_3</td>
<td>Used for miscellaneous characters; it can vary by keyboard.</td>
</tr>
<tr>
<td>VK_OEM_4</td>
<td>Used for miscellaneous characters; it can vary by keyboard.</td>
</tr>
<tr>
<td>VK_OEM_5</td>
<td>Used for miscellaneous characters; it can vary by keyboard.</td>
</tr>
<tr>
<td>VK_OEM_6</td>
<td>Used for miscellaneous characters; it can vary by keyboard.</td>
</tr>
<tr>
<td>VK_OEM_7</td>
<td>Used for miscellaneous characters; it can vary by keyboard.</td>
</tr>
<tr>
<td>VK_OEM_8</td>
<td>Used for miscellaneous characters; it can vary by keyboard.</td>
</tr>
<tr>
<td>VK_OEM_CLEAR</td>
<td>Clear key</td>
</tr>
<tr>
<td>VK_OEM_COMMA</td>
<td>For any country/region, the ',' key</td>
</tr>
<tr>
<td>VK_OEM_MINUS</td>
<td>For any country/region, the '-' key</td>
</tr>
<tr>
<td>VK_OEM_PERIOD</td>
<td>For any country/region, the '.' key</td>
</tr>
<tr>
<td>VK_OEM_PLUS</td>
<td>For any country/region, the '+' key</td>
</tr>
<tr>
<td>VK_PA1</td>
<td>PA1 key</td>
</tr>
<tr>
<td>VK_PACKET</td>
<td>Used to pass Unicode characters as if they were keystrokes. The VK_PACKET key is the low word of a 32-bit Virtual Key value used for non-keyboard input methods.</td>
</tr>
<tr>
<td>VK_PAUSE</td>
<td>PAUSE key</td>
</tr>
<tr>
<td>VK_PLAY</td>
<td>Play key</td>
</tr>
<tr>
<td>Key</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>VK_PRINT</td>
<td>PRINT key</td>
</tr>
<tr>
<td>VK_PRIOR</td>
<td>PAGE UP key</td>
</tr>
<tr>
<td>VK_PROCESSKEY</td>
<td>IME PROCESS key</td>
</tr>
<tr>
<td>VK_RBUTTON</td>
<td>Right mouse button</td>
</tr>
<tr>
<td>VK_RCONTROL</td>
<td>Right CONTROL key</td>
</tr>
<tr>
<td>VK_RETURN</td>
<td>ENTER key</td>
</tr>
<tr>
<td>VK_RIGHT</td>
<td>RIGHT ARROW key</td>
</tr>
<tr>
<td>VK_RMENU</td>
<td>Right MENU key</td>
</tr>
<tr>
<td>VK_RSHIFT</td>
<td>Right SHIFT key</td>
</tr>
<tr>
<td>VK_RWIN</td>
<td>Right Windows key (Natural keyboard)</td>
</tr>
<tr>
<td>VK_SCROLL</td>
<td>SCROLL LOCK key</td>
</tr>
<tr>
<td>VK_SELECT</td>
<td>SELECT key</td>
</tr>
<tr>
<td>VK_SEPARATOR</td>
<td>Separator key</td>
</tr>
<tr>
<td>VK_SHIFT</td>
<td>SHIFT key</td>
</tr>
<tr>
<td>VK_SLEEP</td>
<td>Computer Sleep key</td>
</tr>
<tr>
<td>VK_SNAPSHOT</td>
<td>PRINT SCREEN key</td>
</tr>
<tr>
<td>VK_SPACE</td>
<td>SPACEBAR</td>
</tr>
<tr>
<td>VK_SUBTRACT</td>
<td>Subtract key</td>
</tr>
<tr>
<td>VK_TAB</td>
<td>TAB key</td>
</tr>
<tr>
<td>VK_UP</td>
<td>UP ARROW key</td>
</tr>
<tr>
<td>VK_VOLUME_DOWN</td>
<td>Volume Down key</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>VK_VOLUME_MUTE</td>
<td>Volume Mute key</td>
</tr>
<tr>
<td>VK_VOLUME_UP</td>
<td>Volume Up key</td>
</tr>
<tr>
<td>VK_XBUTTON1</td>
<td>X1 mouse button</td>
</tr>
<tr>
<td>VK_XBUTTON2</td>
<td>X2 mouse button</td>
</tr>
<tr>
<td>VK_ZOOM</td>
<td>Zoom key</td>
</tr>
</tbody>
</table>
Using If Statements

The If statements add another level of sophistication and intelligence to macros. They allow macros to take action based on certain conditions. If the condition is met, the macro takes a specific course of action. If it is not met, the macro does something else or ignores the condition. For example, insert text into a window if the window is open. If it is not open, have the macro do something else.

Below are some examples and things to keep in mind when using If statements.

1. End If

Every If statement must have a closing End If statement. The End If command signifies the end of the If statement and conditional logic used in the macro.

This sample macro highlights a line of text in Notepad and copies it to the clipboard. If the clipboard contains the word "Computer", the line is pasted into Excel. If the line does not contain the word "Computer", then the conditional is ignored and the next line in Notepad is copied to the clipboard.

Sample Macro

Repeat Start (Repeat 150 times)
  Text Type (Simulate Keystrokes): <SHIFT><END>
  Clipboard Copy
  Delay: .25 seconds, without ability to halt
  If Clipboard Contains "Computer"
    Window Activate: Excel
    Wait for Window Title: Excel
    Clipboard Paste
    Delay: .25 seconds, without ability to halt
    Text Type (Simulate Keystrokes): <ENTER>
    Window Activate: notepad
  End If
  Text Type (Simulate Keystrokes): <ARROW DOWN><HOME>
End Repeat

2. Else

The Else statement is the primary way to provide an either/or type option. If one condition isn't met, then the macro takes an alternative course of action. It does something else.

This sample macro is similar to the one above but includes an Else statement. The macro highlights a line of text in Microsoft Word and copies it to the clipboard. If the clipboard contains the word "Computer", the text is pasted into Notepad. Because of the Else statement, the text is pasted into WordPad if the clipboard does not contain the word "Computer".
### 3. AND/OR/XOR

The AND/OR/XOR options provide additional If Statement flexibility. The AND option requires that two If statements be true before action is taken. The OR option requires that either one or the other If statement be true before action is taken. With the XOR option, one If statement must be true and the other false in order for subsequent action to be taken.

Example macros using these options are included in the [AND/OR/XOR](#) help topic.

### 4. Nested If Statements

If statements may be nested inside other If statements. This example is a segment of a larger macro. It illustrates the nesting of one If statement within another. Each of the nested If statements requires a matching End If command.

#### Sample Macro

Variable Modify String %T[15]%: Copy Whole Text (%N[1]%)  
If Variable %N[1]% Is Greater Than 1  
  Variable Modify String: Replace "(" in %T[16]% with ""
  Variable Modify String: Replace ")" in %T[16]% with ""
  Else  
  If Variable %N[1]% Equals 1  
  Variable Modify String: Replace "(s)" in %T[16]% with ""
  End If
End If
End If
**AND/OR/XOR**

These commands increase the power and flexibility of the If statements. The commands are inserted directly into the script as there is not an associated edit window. From the Script Editor click on the Logic category of commands to expand the category. Then select either the AND, OR or XOR command to insert into the script.

**AND**

Use this command if requiring two or more conditions to be valid. Multiple AND commands may be placed between the If statements. In this scenario only one End If command is required at the end of the string.

**Sample Macro**

Let's use an example of T[1] and T[2]. We can create a macro that states if T[1] = Test AND if T[2] = Example, run the macro "Macrotest."

If T[1] does not = Test or if T[2] does not = Example, then a text box will display instead of running the "Macrotest" macro. Both IF statements must be true in order for the "Macrotest" macro to continue.

If Variable %T[1]% = "Test"
   AND
If Variable %T[2]% = "Example"
   Macro Run: Macrotest
Else
   Text Box Display: Not Found
End If

**OR**

Use this command if requiring one of two or more conditions to be valid. Multiple OR commands may be placed between the If statements. In this scenario only one End If command is required at the end of the string.

**Sample Macro**

In this example only one of the two If statements must be valid. Either T[1] can equal Test or T[2] can equal Example. Both are not required in order for the "Macrotest" macro to run.

If Variable %T[1]% = "Test"
   OR
If Variable %T[2]% = "Example"
   Macro Run: Macrotest
Else
   Text Box Display: Not Found
End If

**XOR**
With this option, one of the variables must be false and the other valid. Only one End If is required when the XOR command is placed between two If statements.

Sample Macro

In this example T[1] would equal Test and T[2] would NOT equal Example, or vice versa in order for the "Macrotest" macro to run. If both If statements were invalid or both were true, the macro would display a text box and not run the "Macrotest" macro.

If Variable %T[1]% = "Test"
  XOR
If Variable %T[2]% = "Example"
  Macro Run: Macrotest
Else
  Text Box Display: Not Found
End If
**Break**

The Break command may be used with the Repeat commands, Text File Begin Process or ASCII File Begin Process commands. Each of these commands processes data in a loop. Use the Break command to exit out of a loop before the entire cycle is completed.

There is not an edit window associated with this command. From the Logic category of commands click on the Break command to insert it directly into the script.

For example, create conditional statements within the Process File or Repeat loops using If commands. If the condition is met, the Break command exits out of the loop instead of continuing through the entire process. The macro skips all other steps in the loop. It resumes playback with the first command in the script found after the End Repeat or End Process command and finishes the rest of the macro.

**Sample Macro**

Here's an example of how this would work. The first few commands count the number of files in a folder. When the macro loops to the 30th file, it breaks out of the Repeat loop. It sends an email containing the data appended to the text file selected in line seven of the macro.

```
1. Variable Set Integer %N[1]% to 0
2. Repeat with Folder C:\Downloads\Macro Express
3. Variable Modify Integer: %N[1]% = %N[1]% + 1
4. If Variable %N[1]% Equals 30
5. Break
6. End If
7. Variable Modify String: Append %T[1]% to "C:\Macexp.txt"
8. End Repeat
9. Email Send: Know Recipients, Fixed Text, Attachments
```

**Note:** The Repeat Exit command performs the same function as the Break command within repeat loops. Use the Continue command if needing to skip to the end of the Repeat or Process File loop and return to process the next record or continue repeating.

**See Also**
- Continue
- Repeat Exit
- Repeat Commands
- Text File Begin Process
- ASCII File Begin Process
Case and Switch

The Switch/Case group of commands allows for the writing of complicated conditional statements that are simpler and more readable than those using a number of nested If Variable statements. Pascal or C programmers will recognize that these commands are similar to the Switch/Case statements in C and the Case statement in Pascal.

The Switch/Case commands test the content of a single variable against a series of values and execute specific macro commands based on the value in the variable.

A Switch/Case block of macro commands always begins with the Switch command and ends with the End Switch command. Place one or more Case/End Case blocks inside the Switch/Case block. The Case/End blocks begin with a Case command and end with an End Case command. Optionally include one Default Case/End Case block.

---

Switch

The Switch command requires a variable. This may include any type of variable, such as Integer, Text or Decimal. But all values in the Case statements that follow must be consistent with the type of variable chosen for the Switch statement. If the values are not consistent, the results may be unpredictable.

End Switch

The End Switch command is required to end a Switch Block and is similar to the "End If" command. No edit window is available. The command is inserted directly into the script.

---

Case

The Case command starts a Case/End Case block of macro commands.
The Case command may contain a variable or it may contain a value that is entered directly in the Case command. For example, use a value of \%T[2]\% or enter a text string such as "Done".

A Case/End Case block may contain more than one Case command with a single End Case command at the end of the block.

### Sample Macro

This example tests the value in the T[1] variable for the word Found or any of the words Done, Finished or Completed.

```plaintext
Switch (%T[1]%)  
  Case: Found  
    Text Box Display: T[1] equals Found  
  End Case  
  Case: Done  
  Case: Finished  
  Case: Completed  
    Text Box Display: The comparison is done  
  End Case  
End Switch
```

### Default Case

The Default Case/End Case block is optional. This command is similar to the standard case, but acts like an "Else" command. Basically, if none of the conditions are met in the previous case statements, then the default case is executed. No edit window is available. The command is inserted directly into the script.

If used, the Default Case/End Case block must be placed after all other Case/End Case blocks. Any Case commands that follow the Default Case command will not run.
Sample Macro

This example tests the variable T[1] for the word Found.

Switch (%T[1]%)  
  Case: Found  
    Text Box Display: T[1] equals Found  
  End Case  
  Default Case  
    Text Box Display: T[1] does not equal Found  
  End Case  
End Switch

A Case command and a Default Case command may be combined in a single block.

Sample Macro

In this example, if the variable T[1] either contains the word Searching or if it does not contain the word Found, then the commands in the Default Case block will run.

Switch (%T[1]%)  
  Case: Found  
    Text Box Display: T[1] equals Found  
  End Case  
  Case: Searching  
    Default Case  
    Text Box Display: T[1] does not equal Found  
  End Case  
End Switch

End Case

The End Case command defines the end of a Case/End Case or Default Case/End Case block of macro commands. No edit window is available. The command is inserted directly into the script.
**Else / End If**

The Else and End If commands are inserted directly into the script as there is not an edit window associated with them. From the Script Editor click on the Logic category of commands to expand the category. Then insert the Else or End If command into the script.

**Else**
The ELSE command is used in conjunction with a conditional statement. Everything after an ELSE command until an ENDIF command is reached will be executed if the conditional is FALSE.

**End If**
The ENDIF command is used to mark the place where macro control should stop after a conditional statement is encountered.

**Example**
Below is a small example of how to use the If statements. For this example we selected the If Clipboard Text Equals command.

If the text saved to the clipboard is "Macro Express" then the macro will open the www.macros.com home page. The Else command separates the If statement. If something other than "Macro Express" is saved to the clipboard, the web site command is skipped. Instead, the macro activates the Notepad window and enters "This is a test".

```
Sample Macro

If Clipboard Equals "Macro Express"
  Web Site, "https://www.macros.com", using Default Web Browser
Else
  Window Activate: Notepad
  Wait for Window Title: Notepad
  Text Type (Simulate Keystrokes): This is a test.
End If
``` ---- continue with remainder of macro commands ---

This is essentially the format used for any of the If statements when wanting to take two different actions based on the result of the If statement.

If two different actions are not needed, remove the Else statement as shown below. In this case, if the clipboard contents equal Macro Express, the macro opens the www.macros.com web page. If the clipboard contents are different, then the web site command is skipped. The End If command signifies that the If statement is finished and the macro continues with the rest of the commands.

```
Sample Macro

If Clipboard Equals "Macro Express"
  Web Site, "https://www.macros.com", using Default Web Browser
End If
``` ---- continue with remainder of macro commands ---
Look at the [AND/OR/XOR](#) and [Using IF Statements](#) topics to see other examples using the If statements.
If Commands

If Clipboard

The If Clipboard command checks for a value saved to the clipboard.

Options
Select from one of the four clipboard options available.

If the Clipboard Text Equals
Test if the text contents of the clipboard are equal to a specified value. The contents must match exactly.

If the Clipboard Contains
Test if the text contents of the clipboard contain a specific value. The value only needs to be found within the entire clipboard contents.

If the Clipboard does not Equal
Test if the text contents of the clipboard are not equal to a specified value. The clipboard contents do not match exactly.

If the Clipboard does not Contain
Test if the text contents of the clipboard do not contain a specific value.

Text
Insert the text to be compared against the clipboard contents.

**Match Uppercase and Lowercase**
Check this box if the matching text must be case sensitive - the uppercase and lowercase text must match.
If Control

The If Control command is used to determine the status of a Window Control saved to a variable.

Control Variable
Insert the name of the Control Variable in this field.

Option
There are eight options available for use. Select one from the drop down list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is Enabled</td>
<td>Verifies if the window with the control is the active window. In addition it checks to see if the control is enabled, or in other words, if the control is not grayed out.</td>
</tr>
<tr>
<td>Is Disabled</td>
<td>Determines if the window with the control is not the active window. In addition it checks to see if the control is disabled, if the control is grayed out.</td>
</tr>
<tr>
<td>Exists</td>
<td>Looks to see if the control exists on any window currently open.</td>
</tr>
<tr>
<td>Does not Exist</td>
<td>Checks to see if the control does not exist on any currently open window.</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Is Visible</td>
<td>Verifies if the control is visible. The control does not need to have focus, it just needs to be visible. This control may be a Window Title, a button, a toolbar, an edit box or some other part of the window. A control on a window that is hidden or minimized may still be visible to this command.</td>
</tr>
<tr>
<td>Is not Visible</td>
<td>Determines if the control is not visible.</td>
</tr>
<tr>
<td>Is Focused</td>
<td>Checks to see if the control has focus. <strong>Note:</strong> Not all controls are written so that they can receive focus. If this is the case for the control being used, then the Visible or Enabled options would be a better choice. Otherwise the If Focused option will always come back false and the If Not Focused option will always test as true.</td>
</tr>
<tr>
<td>Is not Focused</td>
<td>Looks to see if the control does not have focus.</td>
</tr>
</tbody>
</table>
If Dial-Up Successful

The If Dial-up Successful feature tests if a dial-up networking attempt was successful or not. All commands following this statement until an ENDIF or ELSE command is reached are executed if the dial-up connection is successful. If the dial-up fails and an ELSE command is used, then all commands following the ELSE until an ENDIF is reached will be executed. By placing this inside a "Repeat Until" loop, this command will repeatedly attempt to dial until a successful connection is made.

Dial-up networking must be set up and configured in Windows in order to use this function. Use the Create a Dial-up Connection or Change Dial-up Settings options in Windows to do this.

![Script Editor > Expand Logic Category > If Dial-Up Successful]

Phone Book Entries

The Phone Book Entries field displays a list of all the phone book entries created in Windows. If none are displayed, a phone book entry will first need to be created in Windows. Choose the dial up entry.

User Name
Enter the user name for the account selected.

Password
Enter the password for the account selected.

Note: When selecting a phone book entry, most likely the User Name will be displayed without requiring manual entry. Depending on the security settings the password may also be inserted. The actual password is not shown. A series of asterisks are displayed in its place.

Example
This set of commands instructs the macro to keep trying to dial up and connect until successful. After connecting it loads the www.macros.com site.

We have instructed the macro to repeat until variable T[1] equals 1. If the dial up connection is successful, the variable T[1] is set to 1. This action ends the Repeat loop and loads the www.macros.com site. If the connection was not successful, the variable T[1] is set to 0 and the macro continues repeating until T[1] equals 1.

Sample Macro

```
Repeat Until %T[1]% = "1"
  If Dial-Up Successful: my modem
    Variable Set String
    %T[1]%"1"
  Else
    Variable Set String
    %T[1]%"0"
  End If
Repeat End
WebSite: https://www.macros.com
```
If File Exists

This command tests if the selected file exists on the computer. **Note: This command does not support wildcards.**

### Path

Insert the file path in this field or click on the Browse button to locate the file to test.

**Use the search path**

Select this option when only inserting a partial file path or only a file name such as test.txt. In this case the macro attempts to locate the file using the Windows search path stored in the Environment variables.

If the Use the Search Path option is not selected and only the file name is inserted, then the macro will look in the Macro Express default folder. Use the [Change Default Folder](#) command to set the default folder.
If File Ready

This command tests if the file selected is no longer busy and ready to accept input. During macro playback it's possible that another application is still writing to it. The If File Ready command checks to ensure the file is no longer being written to.

**Note:** If the file does not have write permissions then the macro will always flag the file as not being ready. In Windows Vista and later, any files located in the Program Files folder do not have write permission.

**Path**

Insert the file path in this field or click on the Browse button to locate the file to test.

Select this option when only inserting a partial file path or only a file name such as test.txt. In this case the macro attempts to locate the file using the Windows search path stored in the Environment variables.

If the Use the Search Path option is not selected and only the file name is inserted, then the macro will look in the Macro Express default folder. Use the Change Default Folder command to set the default folder.
**If Folder Exists**

This command tests if the folder selected exists on the computer.

---

**Path**

Insert the path to the folder in this field or click on the Browse button to locate the folder to test.
The If Macro command tests the status of a macro. It tests if the macro is enabled or disabled, or if the requested macro even exists.

**Option**

There are four options available.

- **If the Macro is Enabled**
  Checks if the macro state is set to Enabled.

- **If the Macro is Disabled**
  Checks if the macro state is set to Disabled.

- **If the Macro Exists**
  Checks if the selected macro is located on the computer.

- **If the Macro Does Not Exist**
  Determines if the macro is not found on the computer.

**Macro Filename**

Insert the name of the macro file (.mex file) that contains the macro to test. Or click on the Browse button to locate the macro file.

**Macro Name**
Insert the macro name or click on the Browse button to locate the name of the macro to test.
If Message

The If Message Command prompts users with a question during macro playback. The question that appears in the dialog box also displays two buttons below the question. The buttons can be set to Yes/No, OK/Cancel, True/False or User defined. This statement requires an ENDIF statement and can optionally use the ELSE statement.

Text Variables may be placed in the input fields of this screen. For example, place the variable T[1] in the message. To do this enter %T[1]% into the Message field.

Caption
The caption is the text that appears in the Window Title bar of the message window created.

Message
Insert the message or question to be posed into this field.

Buttons
Select from four different button types. These are the labels for the buttons that appear with the message during macro playback. The button names selected should correspond with the type of question asked.

- Yes and No
- OK and Cancel
- True and False
- User Defined
The User Defined option creates custom labels, for use languages other than English, etc.

**Default Button**
Select which button is the default button when the message is displayed. The default button is highlighted so that pressing the Enter key will make the selection, rather than clicking with the mouse.

**Delay (in seconds)**
If a choice is not made within the number of seconds entered in this field, the macro continues by selecting the Default Button mentioned above.

---

### Positioning the Message Window
Position the message box on the screen. Insert exact coordinates or use the Set Position button to set where the window should appear during macro playback. See the [Window Positioning](#) topic for additional information.

### Sample Macro
We'll create a simple example of how this command works. The If Message was created using the image shown above in this help topic.

When running the macro and you answer yes to the question, "Would you like to purchase additional copies of Macro Express?", you are taken to the order page on the Macro Express web site. If you answer no, then a text box displays with the message "Maybe I should rethink my answer".

**Macro Script**
- If Message: "Become more Productive!"
  - Web Site: [https://www.macros.com/order.htm](https://www.macros.com/order.htm)
- Else
  - Text Box Display: Macro Express

End If
If Mouse Cursor

This command checks the status of the mouse cursor. The macro takes action based on whether or not the status of the mouse cursor matches the cursor type selected. Choose from the available mouse cursor options.

Script Editor > Expand Logic Category > If Mouse Cursor

Type of Cursor

Select the mouse cursor from the drop down list. The name and a graphical representation of the cursor are displayed to ensure selection of the correct cursor type.
If Not File Exists

This command determines if the file selected does not exist on the computer. **Note:** This command does not support wildcards.

**Path**
Insert the file path in this field or click on the Browse button to locate the file to test.

**Use the search path**
Select this option when only inserting a partial file path or only a file name such as test.txt. In this case the macro attempts to locate the file using the Windows search path stored in the Environment variables.

If the Use the Search Path option is not selected and only the file name is inserted, then the macro will look in the Macro Express default folder. Use the [Change Default Folder](#) command to set the default folder.
If Not File Ready

This command determines if the file selected is not ready to accept input. It checks if the file is still busy. During macro playback it's possible that another application is still writing to it. The If Not File Ready command checks if the file is still being written to.

**Note:** If the file does not have write permissions then the macro will always flag the file as not being ready. In Windows Vista and later, any files located in the Program Files folder do not have write permission.

Path
Insert the file path in this field or click on the Browse button to locate the file to test.

Use the search path
This option can be used when not inserting a full file path, only a file name such as test.txt. With this option selected, the macro attempts to locate the file using the Windows search path stored in the Environment variables.

If this option is not selected and only the file name is inserted, then the macro will look in the Macro Express default folder. Use the [Change Default Folder](#) command to set the default folder.
If Not Folder Exists

This command determines if the folder selected does not exist on the computer.

Path
Insert the path to the folder in this field or click on the Browse button to locate the folder to test.
If Not Mouse Cursor

This command is essentially the opposite of the If Mouse Cursor command. It checks the status of the mouse cursor, but takes action based on whether the status of the mouse cursor does not match the selection chosen. Choose from twenty one different mouse cursor options.

Type of Cursor
Select the mouse cursor from the drop down list. The name as well as a graphical representation of the cursor are displayed to ensure selection of the correct cursor type.
If Not Online

The If Not Online command tests if there is currently not a connection to the Internet.

There is not a program window associated with this command. The If Not Online command is inserted directly into the script. In the Script Editor, click on the Logic command category to expand the list and locate the If Not Online command.
If Not Program

This command is similar to the If Not Window command. It checks if the specified program is not on top (does not have focus) or if the program is not running.

Script Editor > Expand Logic Category > If Not Program

Option
Select the option from the drop down list.

If the Program Is Not Focused
Select this option to test if the selected program window does not have focus.

If the Program Is Not Running
Select this option to test if the selected program is currently not running.

Program Filename
Insert the name of the program and path to the executable in this field or click on the Browse button to navigate to the file.
If Not Window

There are two If Not Window options available. One checks to see if the window is not on top (does not have focus) or if the window is currently not open.

**Option**
Select the option from the drop down list.

- **If the Window Is Not Focused**
  Select this option to test if the selected window does not have focus.

- **If Window Does Not Exist**
  Select this option if to test if the selected window is not found (not open on the computer).

**Window Title**
Insert the name of the window to test or click on the Browse button to select from the Hidden or Visible windows currently running on your computer.

**Partial Match/Exact Match**
Select whether the window title must match exactly or if a partial match is sufficient.

- **Exact Match**
The Exact Match requires that the window name entered matches exactly with the name of the window used in the If statement. For example, if using Notepad as the window name, but the actual window open when the macro runs is Notepad - Untitled, then the macro would ignore the If statement.
Partial Match
An exact window title match is not required. For example, insert "notepad" or "notep" as the window title and either would be recognized by the If statement. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

The title contains wildcards
Select this option if using a wildcard in the window title name. A wildcard includes the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
If Online

The If Online command tests if there is a connection to the Internet.

There is not a program window associated with this command. The If Online command is inserted directly into the script. In the Script Editor, click on the Logic command category to expand the list and locate the If Online command.

Example
This macro simply loads the web site www.macros.com if connected to the Internet. If not, the macro will dial, connect to the Internet and open the web page.

Sample Macro

If Online
  Web Site, "https://www.macros.com", using Default Web Browser
Else
  Dial-Up Networking: My Modem
  Web Site, "https://www.macros.com", using Default Web Browser
End If
If OS Version

Not all Microsoft operating systems work the same. Some things function differently in each OS. The "If OS Version" command can help with this problem. A macro can be tailored to the operating system of the user.

In the sample below we created a simple macro that does something different based on the operating system in use. This is how it would be displayed in the Scripting Editor. This macro basically states that if running Windows Server 2012 or 2016, then run the macro named Server. The OR command allows for selection between two or more If commands. If running Windows 7, 8.1 or 10, run the macro named Win10.
Sample Macro

If OS Version is Windows Server 2012
    Or
If OS Version is Windows Server 2016
    Macro Run: Server
Else
    If OS Version is Windows 7
        Or
    If OS Version is Windows 8.1
        Or
    If OS Version is Windows 10
        Macro Run: Win10
    End If
End If
If Ping Successful

This option first attempts to ping the server designated. If the server responds within the specified time frame, then the result will be true.

Script Editor > Expand Logic Category > If Ping Successful

URL to Ping
Insert the URL to ping. Do not include modifiers such as http:// or ftp://. If pinging our Macro Express website, insert www.macros.com.

Seconds to Wait for a Response
Insert the number of seconds to wait before determining if the ping is successful.

Don't process embedded variables
When using a variable in the address field, this option ignores any % signs found within the variable value and will not attempt to treat the % signs as an embedded variable. It will just expand the % sign as a standard character during macro runtime.
**Example**
Assume for example a variable of %T[1]% with a value of https://www.macros.com/abc%23%/support.htm.

1. With this option selected, the macro will ping the site found at https://www.macros.com/abc%23%/support.htm.

2. If the option is not selected, then the macro will assume that there is a variable of %23% and look to expand its value.
   a. If the variable %23% does not exist, then the macro will generate an error because it could not find the value for this variable.
   b. Otherwise it will expand the value of %23% within the main variable.

---

**Example**
Here is a simple example of how to use this command. The macro is pinging the www.macros.com site to make sure that the server is running. If the ping is successful a message is logged to the ping.log file with a date and time stamp. If the server is down and the ping was not successful, an email is sent for someone to look into the problem. This could be set up as a scheduled macro to run every 30 or 60 minutes.

**Sample Macro**

If Ping Successful: "www.macros.com"
   Log Message to "ping.log"
Else
   E-Mail Send: Know Recipients, Fixed Text, No Attachments
End If
**If Program**

This command is similar to the If Window command. It checks if the specified program is on top (has focus) or if the program is running.

![If Program dialog box]

**Option**
Select the option from the drop down list.

**If the Program is Focused**
Select this option to test if the selected program has focus.

**If the Program is Running**
Select this option to test if the selected program window is currently running. It does not have to be the program that is on top. The application may be running in the background.

**Program Filename**
Insert the name of the program and path to the executable in this field or click on the **Browse** button to navigate to the file.
If Registry

This command determines whether a Windows Registry Key or Value exists or does not exist.

If Registry

This section consists of two parts. Select either registry value or registry key. Then select the If Exists or Does not Exist option. The macro determines if the registry key or value exists or does not exist on the computer.

Path

Select the registry path. Either type in the full path or click on the Browse button to navigate to the key or value needed.

Note: ALL registry commands (except the registry read and If Registry commands) REQUIRE full Read/Write access to the registry in those parts that the user is wishing to modify. This is only an issue with versions of Windows where security permissions can be set. The system administrator is responsible for these settings as we do not have the ability to modify them.

See Also

Registry Key
Registry Values
If Variable

If commands insert logic statements into macros. The If Variable command is one of the most powerful If commands available. Use it to compare a previously saved variable value such as a text string, window title, a number, or anything else for that matter with another value. If the values match (or don't match), the macro can take a specific course of action based on the results.

The If Variable command compares either a text, integer or decimal variable to a fixed value or to another variable. Comparisons may be equal, not equal, less than, greater than, less than or equal to or greater than or equal to.

The "Contains" and "Does not Contain" conditions are available for use with Text variables to test if specific characters are found or not found in the string variable.

Variable
Select the variable to compare and insert in this field. The example above shows variable N[1] being compared.

Action
Select the action needed for comparing the variable with another value or variable. Below is a list of the actions (comparisons) available.

- Equals
- Does not Equal
- Is Less Than
• Is Greater Than
• Is Greater Than or Equal To
• Is Less Than or Equal To
• Contains
• Does Not Contain
• Exists
• Does Not Exist

**Value to Compare with Variable**

Insert the value to compare with the variable selected. Or insert a variable in this field to compare the value of one variable against another.

This field is not accessible when using the Exists or Does Not Exist options as no comparison is made. These two functions verify if the variable selected exists or not.

**Ignore case (on string operations)**

When comparing Text String variables, select this option if the comparison does not need to be case sensitive. If selected, the upper or lower case status of the text is ignored.

**Note:** If using a Boolean variable in this command, the value to look for should be either True or False. True and False are the only values saved to a Boolean variable.
If Window

There are two If Window options available. One determines if the window is on top (has focus) and the other determines if the window is currently running.

![If Window dialog box]

**Option**
Select from the two If Window options described below.

- **If Window is Focused**
  Select this option to test if the selected window has focus.

- **If Window Running (Visible or Hidden)**
  Select this option to test if the selected window is currently running. The selected window may be a visible or hidden window.

**Window Title**
Insert the name of the window to test or click on the Browse button to select from the Hidden or Visible windows currently running on the computer.

**Partial Match/Exact Match**
Select whether the window title must match exactly or if a partial match is sufficient.

- **Exact Match**
The Exact Match requires that the window name entered matches exactly with the name of the window used in the If statement. For example, if inserting Notepad as the window name, but the window
currently open when the macro runs is Notepad - Untitled, then the macro would ignore the If statement.

**Partial Match**

An exact window title match is not required. For example, insert "notepad" or "notep" as the window title and either would be recognized by the If statement. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

*The name contains wildcards*

Select this option if including a wildcard in the window title name. A wildcard includes the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Macro Control

Comment

When creating a large or complex macro, consider placing comments within the macro script itself. The comments are placed within the macro script in bold blue text. This helps to easily identify what each piece of a macro does, in order to more readily find, edit or change any of the macro commands or components. The comments are reminders only and are not played back as part of the macro.

In the edit box, insert the comments and click OK to save. The comments are inserted into the macro script where positioned. The comments are displayed in blue text in the Script Editor to easily distinguish comments from other commands.

Most commands allow for comments to be displayed on the same line as the command text in the Script Editor. Use the Comments Tab in most command windows to access this feature.
Load Macro Text File

Macro Express allows a text file to be loaded during the playback of a macro and execute the text as part of the macro. This is particularly helpful for creating dynamic macros. Change the contents of a text file to fit a specific need before playing the macro.

Enter a file name and path or click on the Browse button to search for the desired text file. Click the OK button when finished.
Load New Macro File

The Load New Macro File command loads a new macro file and closes the one currently open.

Note: When loading a Read Only file, the Default Action selected in the Read Only Prompt preference panel will be used. The Macro Express Player will not notify you during macro playback that you are loading a Read Only file. If the Explorer window is open while the macro runs, you may receive a Read Only prompt, depending on the settings selected in the Preference panel.
Macro Delete

The Macro Delete command deletes a macro during playback of an existing macro. A typical use for this function would be to create reminder messages. For example, when creating a one time reminder message - to run an errand, make a call at a specific time, etc. - place the Macro Delete command as the last line of the script. After the message appears on screen during scheduled playback, the macro is deleted - saving the trouble of remembering to delete it later.

Script Editor > Expand Macro Control Category > Macro Delete

Macro Nickname

Click on the Browse button to select the macro to delete. Macro nicknames are displayed for all macro files that are currently open. If the macro file that includes the macro to be deleted is not currently open, then type the macro name in the edit box.

Skip the recycle bin

Select this option to have the deleted macro bypass the Macro Express Recycle Bin.
Macro Disable

Use this function to disable another macro during macro playback.

Macro Nickname
Click on the Browse button to select the macro to be disabled or type in the macro nickname.
**Macro Enable**

This function instructs the macro to enable another macro that has previously been disabled (not currently available for use).

![Macro Enable dialog box](Image)

**Macro Nickname**

Click on the Browse button to select the macro to be enabled. Macro nicknames are displayed for macros in the file currently open.
Macro Playback Speed

Macro Playback Speed adjusts how fast the macro runs. It is typically used to adjust the speed of a captured (recorded) macro. With timing delays recorded between each keystroke and mouse movement, use this option to speed up or slow down the macro.

Multiply delays by

To slow down the macro playback speed, place a number greater than one in the "Multiply Delays By" field. For example, placing a "4" in this field multiplies the delays by four, causing the macro to play back 4 times slower.

To speed up the macro, place a value less than one in the "Multiply Delays By" field. For example, placing 0.5 in this field cuts the delay in half, speeding up the macro by a factor of 2.
Macro Return/Stop

Neither the Macro Return or Macro Stop command opens a dialog window for editing when used in the Script or Direct Editor. Open the Script Editor and expand the Macro Control category of commands. Double click on the Macro Return or Macro Stop command to place in the script.

Macro Return
This command is intended for use with the Macro Run command to return to the top level macro. Macro Return stops the execution of the called macro. Use Macro Return in the middle of a logic statement to return to the main macro before the end of the called macro. It is not necessary to put a Macro Return at the end of the macro.

Here is an example of how this works. Macro A is the top level macro and uses the Macro Run command to execute Macro B. Macro B includes a conditional statement looking for a particular value. If the value is not found, the Macro Command stops Macro B but continues with Macro A.

In other words, inserting a Macro Return command in Macro B stops the playback of Macro B and returns to Macro A where it continues running the remainder of Macro A's script.

Macro Stop
The Macro Stop command stops the execution of a macro. Use this primarily in conjunction with a conditional statement. If a desired condition is not met, terminate the macro.

In the Macro Return example above, if Macro B executes a Macro Stop, both Macro A and Macro B are terminated immediately.

Note: It is not necessary to place a Macro Stop command as the last line of a macro. The macro stops automatically after the last line of the macro is executed.
**Macro Run**

This function is the key to stringing macros together. Incorporate one or several macros into another macro by inserting this command into the macro script. The called macro starts playing when the script finds the Macro Run command.

![Macro Run](image)

**Notes:**

1. The Macro Run command runs a macro regardless of whether or not it is disabled.
2. If two macros have the same name the one with the earliest index number will run.

**Macro Nickname**

Click on the Browse button to select the macro to run. Macro nicknames are displayed for any macro files that are currently open. If the macro file containing the macro to be run is not currently open, then type the macro name in the edit box.

**Wait for this macro to terminate before proceeding**

Check this box to make sure that the first macro does not continue running until the macro in the Macro Run command has finished playing back. If not selected, the original macro and the called macro will both play back simultaneously. **Note:** If the called macro is a Popup Menu macro, the wait option is ignored. The Popup menu will open and the original macro will continue running.

**Hint**

After inserting the Macro Run command into the script, right mouse click on the command. From the context menu, left click on Edit Macro to open a new tab in the Script Editor. The new tab displays the contents of the macro called in the Macro Run command. This provides a quick way to view the contents of the called macro.
Additional Information About Variables

Global variable values are passed from one macro to another when the macros are strung together using the Macro Run command. For example if variable N[1] were assigned a value of "123" in the main macro and the called macro types out the value of N[1] to another application using the Text Type command, "123" is typed. There is no need to set N[1] to a value of "123" again in the called macro.

The variable values are cleared after the entire macro is run. To save the variable values for use with another macro, which is not part of the original macro or called macros, use the Variable Save and Variable Restore commands.

Similarly, other functions such as the Macro Playback Speed, Keystroke Speed, etc. are passed from the original macro to the called macro. If the variable value is reset in the called macro or the speed is changed in the called macro, those values are passed back to the original macro when it resumes.
Password Protection

The password protection feature requires that a password be entered before macro playback continues. The Encrypted Text command provides additional security for sensitive information.

**Note:** The Password Protection command is somewhat redundant with the password options found in the Security tab of the Script Editor. Use the Security tab to require a user to enter a password before running the macro, before viewing the macro for editing or both. The difference being that the Password Protection command may be inserted anywhere in the macro script if requiring a user to insert a password at a particular point during macro playback.

Insert the password protection command as the first item of the macro script to password protect the entire macro. If the password protection command is the first item of the macro, then entering the password is required before the macro starts. Or use the password option found in the Security tab of the Script Editor to accomplish the same thing.

The password protect command may also be inserted anywhere in the macro script. In this instance, the first part of the macro plays until it reaches the password protection command. A dialog opens prompting for the password. Insert the password, click OK and the remainder of the macro script plays.

**Entering the Password**

Input the password in the Password edit box. This field accepts a combination of letters, numbers and symbols found on the keyboard. Type the password again in the Confirm Password field to verify that the input was correct. If typed differently, a message displays indicating that the passwords do not match and to try again.

**Positioning the Password Window**

Define the position on the screen where the input box should appear during the playback of the macro. Insert exact coordinates or use the Set Position button to set where the window should appear. See the Window Positioning topic for additional information.

**See Also**

Encrypted Text
Security
Set/Clear Passwords
Macro Express

Macro Express Commands

These commands all relate to Macro Express functionality. Only the Restart Macro Express command requires an edit window. For the other commands listed, open the Macro Express category of commands and select the command to insert into the script.

Empty Macro Recycle Bin
Macro Express has its own Recycle Bin. Any macros deleted from the Macro Explorer are sent to the Macro Express Recycle Bin. This macro command empties the Macro Express Recycle Bin during the playback of a macro. At this point the macros are permanently deleted from the program and cannot be recovered.

Reload Macro Express Preferences
This command reloads the Macro Express Preference settings from the Windows Registry.

Reset Hooks
It is possible for other programs started after Macro Express to improperly install themselves into the system wide Windows keyboard and mouse hooks. This causes Macro Express to no longer be able to monitor keystrokes or mouse movements and clicks.

This command reinstalls the Windows keyboard and mouse hooks used by Macro Express while the macro is playing so that Macro Express will have the first look at the keystrokes and mouse movements/clicks and be able to monitor them again.

Restart Macro Express
This command closes Macro Express and restarts the program. **Note:** The Restart Macro Express command should be the last command in the script. Any commands in the script after the Restart Macro Express command are ignored and will not play back.

Run startup macros on restart
If any Scheduled Macros are scheduled to play back on Macro Express startup, choose whether or not to have those macros run again after restarting Macro Express. Select this option to run the scheduled macros again after a program restart.

Run "File Load" macros on restart
If any macros are scheduled to start when a macro file loads, a restart of Macro Express causes these macros to run again. Choose whether or not to have the macros run again on startup of Macro Express. Select this option to run the File Load scheduled macro to run after a program restart.
Terminate Macro Express

The Terminate Macro Express command shuts down the Macro Express Player (which also shuts down the editor if it is running) from within a macro. This is obviously only to be used as the last command in a macro as no more commands will execute after this one.
**Mouse**

**Get Mouse Position**

The Get Mouse Position command locates the current position of the mouse cursor on the screen or window and saves the X and Y coordinates to Integer variables. This is an easy way to return the mouse cursor to its original position after a macro has completed.

![Get Mouse Position dialog box](image)

Select whether to save the mouse position relative to the screen or to the window that has focus. Then insert the variable names for saving the X and Y coordinates.

**Sample Macro**

This example saves the original mouse position, moves to another location and returns to the original spot.

1) Captures the initial position of the mouse cursor and saves the coordinates to variables N[1] and N[2].

2) Moves the mouse cursor to the screen coordinates of 300 and 300.

3) Instruct the mouse to move to coordinates N[1] and N[2], returning to its original position.

The delays are added to make the mouse movements visible. Without delays the movements are too quick to notice what is happening.

**Macro Script**

Get Mouse Position Screen: %N[1]%, %N[2]%
Delay 2 Seconds
Mouse Move Screen 300,300
Delay 2 Seconds
Mouse Move Screen %N[1]%, %N[2]%
Mouse Click on Control

This command allows the user to send a click to the specified Windows control. This is most useful with buttons because it will make the button think that the user clicked on it, even if the mouse is not on the control.

General Tab
There are three steps to setting up this command correctly.
1. Select whether to have the mouse single or double click on the control.
2. Choose the Control variable previously defined.
3. Decide whether to click with the Left, Right or Middle mouse button.

Advanced Tab
This tab determines the area of the control to click. By default, this command sends the click to the center of the control. Or select the Coordinates option and manually insert the X and Y coordinates. The coordinates are relative to the control.

The coordinates 0, 0 refer to the top left corner of the control. Or change the coordinates to move a number of pixels to the right and down from the top.
Mouse Clicks

The following mouse commands do not display a Macro Express window when editing and are inserted directly into the macro script. Open the Mouse category of commands and double click on one of the options listed below to insert into the script. This list also represents how the commands are displayed in the Script Editor.

These commands execute mouse clicks during the playback of the macro. First, use the Mouse Move command or another command that positions the mouse before inserting a mouse click command.

<table>
<thead>
<tr>
<th>Mouse Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse Left Button Down</td>
<td>Holds down the left mouse button without releasing it. This can be used for dragging items during macro playback.</td>
</tr>
<tr>
<td>Mouse Left Button Up</td>
<td>Releases the left mouse button from its held down position.</td>
</tr>
<tr>
<td>Mouse Left Click</td>
<td>Clicks the left mouse button one time.</td>
</tr>
<tr>
<td>Mouse Left Double Click</td>
<td>Double clicks the left mouse button.</td>
</tr>
<tr>
<td>Mouse Middle Button Down</td>
<td>Holds down the middle button of a three button mouse without releasing it.</td>
</tr>
<tr>
<td>Mouse Middle Button Up</td>
<td>Releases the middle button of a three button mouse from its held down position.</td>
</tr>
<tr>
<td>Mouse Middle Click</td>
<td>Clicks the middle button of a three button mouse one time.</td>
</tr>
<tr>
<td>Mouse Middle Double Click</td>
<td>Double clicks the middle button of a three button mouse one time.</td>
</tr>
<tr>
<td>Mouse Right Button Down</td>
<td>Holds down the right mouse button without releasing it.</td>
</tr>
<tr>
<td>Mouse Right Button Up</td>
<td>Releases the right mouse button from its held down position.</td>
</tr>
<tr>
<td>Mouse Right Click</td>
<td>Clicks the right mouse button one time.</td>
</tr>
<tr>
<td>Mouse Right Double Click</td>
<td>Double clicks the right mouse button one time.</td>
</tr>
</tbody>
</table>

Note: If using one of the Mouse Button Down commands, make sure to include a corresponding Mouse Button Up command in the macro. Otherwise the mouse may become stuck in the down position.
Mouse Move

The most common use of the mouse in macros is to move the cursor to a particular spot and click on a button or menu command. The first step in this process is to click on the Mouse Move command.

For the mouse functions to be accurate, use the Mouse Locator to determine the exact coordinates of the button or menu command on the window or screen.

Select the location to where you would like to move the mouse
First select from the drop down menu the frame of reference for the mouse movement. The five options are discussed in detail below.

To the Text Cursor Position
This option instructs the macro to move the mouse to the location of the text cursor. The text cursor is the flashing bar that appears on screens where text input is to be made. This can be particularly useful for applications that do not support the SHIFT and Arrow Keys for highlighting text for clipboard copying.

To copy text to the clipboard with the mouse, first use the keyboard to tab to the desired field and the arrow keys to position the cursor. Use the Text Cursor Position function to move the mouse to the same spot as the text cursor. A Mouse Left Click Down command and a Mouse Move Relative to Position command followed by a Mouse Left Click Up highlights text for a clipboard capture.

Note: This function does not work on programs that create and use their own text cursor. Programs with their own text cursor do not use the built in Windows Text Cursor functions. Ironically, MS Word appears to fall into this category.

Relative to Screen
This option instructs the macro to move the mouse cursor relative to its position on the computer screen. Use the "Screen Coordinates" numbers from the Mouse Locator with this option.

Relative to Window
This option instructs the macro to move the mouse cursor relative to its position within the window that is active. Use the "Active Window" numbers from the Mouse Locator with this option.
**Relative to Last Position**
This option instructs the macro to move the mouse cursor relative to the last position of the cursor. In this case do not input new coordinates, just the number of pixels for the mouse to move.

For example assume that the mouse position relative to the screen is \( X = 100, \ Y = 200 \). This means the cursor is 100 pixels from the left edge of the screen and 200 pixels from the top edge of the screen. If we were to plug in \( X = 20, \ Y = 50 \), then the mouse would move to an \( X \) coordinate of 120 and a \( Y \) coordinate of 250. Or, if we plugged in \( X = -20, \ Y = -50 \) then the mouse would move to an \( X \) coordinate of 80 and a \( Y \) coordinate of 150 based on our original mouse position.

Use the Mouse Locator and some simple math to determine how many pixels are needed to move. Start with the first position and jot down the \( X \) and \( Y \) coordinates. Move the cursor to the new location and subtract the difference. If the starting position is \( X = 400 \) and \( Y = 450 \) and the new position is \( X = 500 \) and \( Y = 500 \), then plug in the values of \( X = 100 \) and \( Y = 50 \).

Select coordinates by either entering the coordinates directly or assigning the coordinate value to a variable. An example of using variables might be to save the original mouse location into variables and then move the mouse back to the original location when finished processing the macro.

**Relative to Control**
This option assumes using a previously defined [Window Control](#) saved to a variable. Enter the name of the control variable or select it from the variable list and then select the coordinates. The coordinates 0, 0 refer to the top left corner of the control. Change the coordinates to move a number of pixels to the right and down from the top.

Assume that 10 is assigned as the \( X \) coordinate and 15 is the \( Y \) coordinate. In this case the mouse cursor would point 10 pixels to the right of the left edge of the control and 15 pixels down from the top.

**Note 1:** When using the Relative to Screen or Relative to Window options, open the Mouse Locator and position the mouse to the desired location. Then press the Ctrl Key and Space Bar to insert the coordinates into the \( X \) and \( Y \) fields.

**Note 2:** With each of the above selections, except for the Text Cursor Position, optionally use Integer variables for the coordinate values.

**Launch Mouse Locator**
Clicking on the Launch Mouse Locator button activates the Mouse Locator utility. If this window pops up in an area of the screen that covers important data, click on the window, hold the left mouse button down on the window title bar and drag to another part of the screen.

![Mouse Locator](#)

<table>
<thead>
<tr>
<th>Screen Position</th>
<th>209, 168</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Window</td>
<td>-193, -454</td>
</tr>
<tr>
<td>Pixel Color</td>
<td>4727808 / 0x482400</td>
</tr>
<tr>
<td>R:0 G:36 B:72</td>
<td>RGB: #002448</td>
</tr>
</tbody>
</table>

**Screen Position**
The set of numbers directly under Screen Position lists the position of the mouse relative to the computer...
screen. As the mouse is moved, the numbers on the Mouse Locator window change in relation to the mouse cursor position. The number to the left is the X coordinate, or how many pixels from the left edge of the screen. The number on the right is the Y coordinate, or how many pixels the mouse is positioned below the top edge of the screen.

**Active Window**
The set of numbers directly under Active Window lists the position of the mouse relative to the active window or the window that has the focus. The Mouse Locator window takes focus when it is first launched. Give focus back to the window and the Mouse Locator window remains on top in order to read the coordinates of the window.

As the mouse moves, notice the numbers changing in relation to the mouse position. The number to the left is the X coordinate, or how many pixels the mouse is positioned from the left edge of the active window. The number on the right is the Y coordinate, or how many pixels the mouse is positioned from the top of the active window.

**Pixel Color**
This option displays the color of the pixel underneath the mouse pointer. Windows assigns a numeric value to each color, normally from 6 to 8 digits in length. The left side is the decimal value. The right side displays the hexadecimal value in BGR format. The bottom row displays the pixel color in separate values for Red, Green and Blue. The pixel color is used with the [Get Pixel Color](#) command and is not needed for the Mouse Move command.

Click the X in the upper right corner to close the Mouse Locator window.
Mouse Wheel

This command moves the mouse wheel forward or backward the number of clicks assigned.

Move the Mouse Wheel
Forward
Moves the wheel forward the number of clicks specified when using a mouse with a wheel.

Backward
Moves the wheel backward the number of clicks specified when using a mouse with a wheel.

Clicks
Insert the number of clicks that the wheel should move backward or forward.
Move Mouse to Notification Area

This command selects a specific notification area icon and moves the mouse cursor over that icon. Many applications that place icons in the notification area need to be activated by clicking on the icon. This command moves the mouse cursor to the icon. Then follow with a Left or Right Mouse Click to open the application window.

Move the mouse to the following notification area icon
Press the Browse button and select the desired notification area icon. The names of each displayed icon are shown in the drop down list. Or type in the name of the icon into the field.

Exact Match / Partial Match
This option is for use when manually inserting the icon name in the edit field. When hovering the mouse cursor over an icon, a yellow text box appears displaying the icon name to help know what name to enter. Decide whether to match the name exactly or just use a partial text match.

Move the mouse to
The mouse cursor points to the position on the icon selected. This command defaults to the center of the icon. The other option is to select specific coordinates. The coordinates 0, 0 are in the top left corner of the icon. Change the coordinates to move a number of pixels to the right and down from the top.

Note 1: Windows XP and later have options to collapse the notification area. The Move Mouse to Notification Area Icon command will not work if the icon is hidden behind the collapsed area.

Note 2: When moving to the notification area icon for a Macro Express Popup Menu macro, use the Partial Match method. Exact Match does not work because the name associated with the Popup Menu notification area icon is changed when a macro is running.
Multimedia

Audio Controls

These audio functions adjust the volume on the computer's sound system. Not all functions may be available on a particular computer. Speaker support is dependent upon the audio device in the computer.

Some Audio commands may not be supported on certain computers or versions of Windows. If your computer does not support a specific command, the message 'This command is not supported on your computer.' will be displayed.

These commands may still be added to a macro, but they would only work on another computer that supports these capabilities.

Audio

The audio controls apply to the computer's speakers. The treble and bass are audio controls. Issue macro commands to turn the volume off, set it on its highest setting, nudge it up, nudge it down, toggle it between muted and not, nudge the balance to the left or right, center the audio balance, nudge the treble up or down or nudge the bass up or down.

For some of the commands that affect the volume, a message of 'This command only affects Macro Express's volume.' may appear on certain computers. When Macro Express is running, there is an entry in the Volume Mixer for Macro Express. This is the only volume option that will be affected when the warning message is displayed.

MIDI

The MIDI options control the volume for any MIDI instruments installed on the computer. Issue macro commands to turn the volume off, set it on its highest setting, nudge it up, nudge it down, toggle it between muted and not, nudge the balance to the left or right or center the balance.

Note: For most computers, the audio range, from lowest to highest, is comprised of 20 increments. Each volume command inserted changes the status by approximately 5%.
Beep

This command generates a "Beep" sound during the playback of a macro. Use it to call attention to a special action that needs to be taken or to simply alert that the macro has completed playback.

There is not a Macro Express window that opens when using this command. Just expand the Multimedia category of commands in the Editor, double click on the Beep command and insert it into the script. It is displayed as Beep in the Script Editor and as <BEEP/> in the Direct Editor.
**Media Player Controls**

The Media Player Controls send commands to the media player currently running, such as Windows Media Player or Real Player.

Options available from the drop down list include Play/Pause the media player, move to the Next or Previous track or Stop the player.
**Play Video Clip**

Use this function to incorporate the playback of .avi format video files into macros.

![Play Video Clip](image)

**File/Path Name**
Click on the browse button to find the video file to play back in the macro. After finding the file, click on the Open button to insert the file into the File/Path Name box. Or manually type the file path and name into this field.

- **Play immediately**
  This option launches the AVI player and plays back the video.

- **Play immediately and close when finished**
  This option launches the AVI player, plays back the video and then closes the AVI player. **Note:** When using this option, the macro cannot be stopped and the program cannot be closed until the video finishes.

- **Wait to play**
  This option loads the AVI player and waits until instructed (click on the Start button of the AVI player) to begin the video playback.

**Position**
These options define the position on the screen where the AVI player will display during playback of the macro. Insert exact coordinates or use the Set Position Manually button to set the position. See the [Window Positioning](#) topic for additional information.
Sound File

The Sound File command adds sound to macros to help bring attention to a particular action or to just liven up the macro as it plays back.

Sound File

This command plays a sound from a .wav file or one of the defined system sounds.

To select a sound file click the Browse button to locate a .wav file on your computer or type the full path and file name of the .wav file. You may also select one of the system sounds available on your computer by clicking on the drop down arrow.

A system sound is a sound assigned to specific Program Events within Windows such as Asterisk, Device Connect or Windows Logoff. The sounds assigned to these events are selected in the Windows Control Panel either individually or as part of a theme. Not all system sounds listed in the Control Panel are available in this command.

The Default Beep sound, defined in the Control Panel, plays if a system sound is not defined or no sound is assigned to the specified system sound in the Control Panel.

Test

Click on the Test button to listen to the .wav file. This is a handy way to quickly test if the correct sound was selected. (The sound file runs immediately upon clicking the button.)

Wait for the sound file to finish before continuing the macro

With this option checked, the execution of the macro stops until the .wav file has played in its entirety. If not checked, the sound file plays while subsequent macro commands execute.
Network

Dial-Up Networking

Dial-up Networking connects the computer to another computer or to the Internet using a modem.

Dial-up networking must be set up and configured in Windows in order to use this function. Use the Create a Dial-up Connection or Change Dial-up Settings options in Windows to do this.

Dial-Up Connections

The Dial-up Networking option displays a list of all the phone book entries created in Windows. If none are displayed, a phone book entry will first need to be created in Windows. Choose the entry to dial and connect.

- **User Name**
  Enter the user name for the account selected.

- **Password**
  Enter the password for the account selected.

**Note:** When selecting a phone book entry, the User Name will most likely be displayed without requiring the name to be entered. Depending on the security of the system, the password may also be inserted. The actual password is not shown. A series of asterisks are displayed in its place.

Hang Up

Choosing this option simply instructs the macro to hang up or terminate a Dial-Up Connection if one is
currently active. There is not an edit window associated with this command. Double click on the Hang Up command to insert it directly into the script.
**Network Connect**

This macro command connects, disconnects or toggles network drives. Use this feature to access a network server or another computer, bypass the network neighborhood, quickly make temporary network connections or similar. The three network options are described below.

**Network Connect**

The Network Connect command instructs Windows to map a drive letter to a drive on another computer.

**Drive**
Select from the available drive letters on the computer which drive is to be connected.

**Folder**
Enter the name of the drive and path to be connected. Either type this in directly or click on the Browse button to display all possible network drives available.

**Reconnect at logon**
This option instructs Windows to remember the network connection created so that the next time the computer is started, the connection is made.

**Use the default name and password**
This option instructs Windows to attempt to make the network connection using the home computer's logo name and password. If not using this option, enter the logo name and password required to access the network drive.
Network Disconnect
This instructs Windows to disconnect a drive from a network drive.

**Disconnect**
Select from the available drive letters on the computer which drive to disconnect from the network.

**Disconnect permanently (do not reconnect at logon)**
This option instructs Windows to remember that this drive is not to be connected to a network drive the next time Windows is started.

**Force disconnect even if the drive is in use**
This option instructs the macro to disconnect the network drive even if a program is using a file on the drive which is being disconnected. This action should typically not be taken unless absolutely sure that disconnecting will not have any adverse effects on programs currently using the drive.

Network Toggle
This command is a combination of the Network Connect and Network Disconnect commands. It first checks to see if the drive is already connected to the network. If it is, it disconnects the drive. If the drive is not currently connected, then it makes the network connection.

**Drive**
Select from the available drive letters on the computer which drive to toggle.

**Folder**
Enter the name of the drive and path to toggle. Either type this in directly or click on the Browse button to display all possible network drives available.

**Reconnect at logon**
This option instructs Windows to remember the network connection created so that the next time the computer is started, the connection is made.

**Use the default name and password**
This option instructs Windows to attempt to make the network connection using the home computer's login name and password. If not using this option, then enter the login name and password required to access the network drive.

Drives currently mapped
Use this option to display which drives are currently mapped to network drives.

Drives that will be reconnected at logon
Use this option to display which drives are mapped as permanent connections -- ones that connect when the computer first starts.
These commands create or delete Windows Registry keys.

A word of caution is in order here. Only those who have experience working with the Windows Registry should be using these commands. Otherwise problems may occur with the operating system.

Choose a registry command
Select from the drop down list whether to create or delete a registry key.

Create Registry Key
Creates the specified Windows registry subkey in the key selected.

Delete Registry Key
Deletes the specified Windows key from the registry.

Registry Key
Select the registry path. Either type in the full path or click on the Browse button to navigate the Registry to find the key needed.

Note: The Create Registry Key, Delete Registry Key, Write Registry Value and Delete Registry Value commands REQUIRE full Read/Write access to the registry in those areas that the user wishes to modify. The system administrator is responsible for assigning security permissions. Macro Express does not have the ability to modify Access Control Lists.

See Also
Registry Values
If Registry
Registry Values

These commands read values from the Windows Registry and save them to a variable, write to the Windows Registry or delete values from the Windows Registry.

A word of caution is in order here. Only those who have experience working with the Windows Registry should be using these commands. Otherwise problems may occur with the operating system.

Select from the command choices, choose a variable and then click on the Browse button to locate the registry value needed.

Read Registry Value
This command reads the value from the Windows registry key. This option does not require Write access to the registry.

- **Registry Value**
  - Insert the Registry Value or click on the Browse button to locate the value needed.

- **Destination Variable**
  - The registry value is saved to the variable selected.

Write Registry Value
This command writes a value to the specified registry key. This option REQUIRES Write access to the registry.

- **Registry Value**
  - Insert the Registry Value or click on the Browse button to locate the value needed.

- **Destination Variable**
  - The value of the variable will be written to the key selected.

Delete Registry Value
Use this option to delete a value from a registry key. The Delete Registry Value command REQUIRES Write access to the registry.

- **Registry Value**
Insert the Registry Value or click on the Browse button to locate the value needed.

Macro Express variables are stored in these registry Data Types:

<table>
<thead>
<tr>
<th>Variable Type</th>
<th>Registry Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>DecimalVar</td>
<td>REG_BINARY</td>
</tr>
<tr>
<td>IntegerVar</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>LargeIntegerVar</td>
<td>REG_BINARY</td>
</tr>
<tr>
<td>TextVar</td>
<td>REG_SZ</td>
</tr>
</tbody>
</table>

**Note:** The Create Registry Key, Delete Registry Key, Write Registry Value and Delete Registry Value commands REQUIRE full Read/Write access to the registry in those areas that the user wishes to modify. The system administrator is responsible for assigning security permissions. Macro Express does not have the ability to modify Access Control Lists.

**See Also**
- Registry Key
- If Registry
Repeat

Continue

The Continue function may be used with the Repeat, Text File Begin Process or ASCII File Begin Process commands. Continue instructs the macro to ignore the remaining commands in the repeat loop. It skips directly to the End Repeat or End Process commands in the script and starts again with the next record or cycle.

Continue is typically used in conjunction with If statements. If a specific condition is met the macro will skip a section of the repeat loop. Otherwise the script continues as normal.

This command does not open an editable Macro Express window. Expand the Repeat category of commands and double click on the Continue command to insert it into the script.

See Also
Break
Repeat Exit
Repeat Commands
Text File Begin Process
ASCII File Begin Process
**End Repeat**

Each Repeat command requires a corresponding End Repeat command. All commands in the script between the Repeat and the End Repeat commands are repeated the number of times designated.

This command does not open an editable Macro Express window. Expand the Repeat category of commands and double click on the End Repeat command to insert into the script.
Repeat Commands

Use the Repeat commands to repeat a section or the entire macro any given number of times. All macro repeat loops must include an End Repeat command. All commands immediately following the Repeat command are repeated until an End Repeat command is encountered.

Start Repeat
The Start Repeat repeats a macro sequence the number of times requested. Enter the number of times to repeat the macro in the Number of Times to Repeat edit box. Click on OK to save the settings. All macro commands after the Start Repeat are repeated until an End Repeat command is encountered.

Number of times to repeat
Insert the number of times to repeat the macro script.

Number to start counter on
This is currently only used in conjunction with a repeat counter. It specifies the starting point of the repeat counter.

Increment the counter by
This is currently only used in conjunction with a repeat counter. It specifies an increment to apply to the repeat counter each time the repeat loops.

Counter Start and Stop Example
Let's look at an example using the Counter Start and Counter Stop. If we set the counter start to 5 and the counter step to 10 and had a repeat count of 3 then a repeat counter would have the following values:

During the 1st of 3 loops: 5
During the 2nd of 3 loops: 15
During the 3rd of 3 loops: 25
Start Repeat with Prompt
Use the Start Repeat with Prompt option to repeat a script a variable number of times. When the macro reaches this command in the script during playback, a prompt window displays prompting the user to insert the number of times to repeat the macro. Enter the number and the macro string repeats the number of times requested.

Use this option to avoid having to rewrite or edit the macro each time a variable number of repetitions is required.

Start Repeat With Variable
The Start Repeat with Variable option repeats the macro based on the value saved to the Integer variable selected. If the value of the Integer variable is 10, the macro is repeated 10 times.

- **Repeat using variable**
  - Insert the Integer variable name in this field or click on the Variable button to select the variable previously defined.

 Repeat Until
The Repeat Until option repeats a macro script again and again until a condition is met. The condition is the comparison of a text, integer or decimal variable to a fixed value. Comparisons can be equal, not equal, less than, greater than, less than or equal to or greater than or equal to. The comparison can also check to see if the variable contains or does not contain a specific text string, number, decimal, etc.

One example of this function is to create a macro that copies a line of text to the clipboard and then saves the clipboard contents to a variable. The Repeat Until function looks for a specific string of text. If the string of text is found, the macro breaks out of the Repeat loop and continues with the rest of the macro. If not, the macro moves to the next line in the document and repeats the process.

This option is also a way to run a macro continuously. For example set the Repeat Until option to repeat until N[1] = 1. Then do not insert any code in the macro to allow variable N[1] to equal 1.

---

**Sample Macro - Repeat Until**

In this example, we want to make sure that Microsoft Word is closed before the macro continues. The command to close Word must be placed before the macro commands listed below.

This macro has been set up in a repeat loop. Variable N[1] has been set to 0. The macro will repeat this loop until N[1] has been changed to 1. In this macro we have instructed the N[1] variable to change to 1 when it is detected that Word has closed.

```
Variable Set Integer %N[1]% to 0
Repeat Until %N[1]% = 1
  If Not Program Name "Word" running
    Variable Set Integer %N[1]% to 1
  End If
End Repeat
```

**Note:** The macro commands between the Repeat Until and Repeat End commands are always executed at least once, because the Until condition is not evaluated until after the first iteration.

Repeat With Folder
This command scans through a folder and finds each file or subfolder in the folder. During the repeat process
each successive file name or subfolder is placed in a text variable which can then be processed by other
macro commands.

**Sample Macro - Repeat with Folder**

This macro counts the number of files in a particular folder. The count is saved to variable N[1]. Before starting the repeat loop, Integer variable N[1] is set to 0. Each time the macro repeats through the files, N[1] is incremented by one until a final count is made. After the loop is completed, a Text Box Display command has been added to display the file count.

Variable Set Integer %N[1]% to 0
Repeat with Folder
Variable Modify Integer: %N[1]% = %N[1]% + 1
Repeat End
Text Box Display: Files in folder

Folder
Select the folder to be processed. Either enter the path name directly or use the Browse button to locate the folder.

Return
Choose whether to return files only or folders.

Place Result In
Select the variable that will store the file or folder name.

*Return the Full File Path*
Use this option to save the full file path to the variable. Otherwise

*Process Sub Folders*
Optionally choose to have the macro recursively process all subfolders. This places all the file names or sub folders that are located in the folder or subfolders being processed into the variable.

**Repeat with Windows**
The Repeat with Windows command is similar to the Repeat with Folder command. It scans through all of the windows running on the computer, both visible and hidden. During the repeat process each successive window title is placed in a text variable which can then be processed by other macro commands.

*Windows to Retrieve*
Select whether to process through all windows, visible windows or hidden windows.

*Sort Method*
Select whether to process the windows alphabetically or in the order the windows are saved by the operating system.

*Place Titles in*
Select the Text String variable to store the value of the window title.

**Repeat with Processes**
This command is also similar to the Repeat with Folder command. Repeat with Processes loops through all processes currently running on the computer. During the repeat loop the name of each successive process is placed in a text string variable which can then be acted upon by other macro commands. **Note: Running processes are displayed in the Windows Task Manager.**
Store the Counter into a Variable
For the Start Repeat, Start Repeat with Prompt and Start Repeat with Variable commands, optionally place the repeat counter into a variable so that the counter value can be used and manipulated during the repeat process.

Notes:
1. Repeat commands can be nested (placed inside of each other).
2. Repeat commands can cause excessively long macros. Remember, there is a way to abort a macro! Press the Scroll Lock and Pause buttons to stop the macro.
Repeat Counter

**Note:** This command is included for backward compatibility only. We recommend using the Store the Counter into a Variable option that is part of the Repeat Start command.

A repeat counter command can be placed inside a repeat loop. What this does is type via the keyboard the current count of the repeat loop. For example, if creating a macro that repeated 5 times and the only thing inside the repeat loop was the incremental counter, it would type out "12345" when the macro is run inside a program such as Notepad.

The repeat counter can be especially useful for creating a unique name for each repeated loop. For example, while running a procedure multiple times, each result needs to be saved to a file name. Use the repeat loop and when the procedure saves the file name, add the incremental counter to the end of the file name. This provides a unique file name for each repetition.

If leading zeros are desired on counter values, then specify the "Counter Width". For example, to ensure that all values are at least 3 characters long, enter 3 for the width. This produces 001, 002, etc.

The syntax for the repeat command with a counter would be:

```
Repeat Start
   Repeat Counter: 3 digits wide
   Text Type: This is my macro text.
Repeat End
```
**Repeat Exit**

The Repeat Exit command is used to exit out of a repeat loop before the entire cycle is completed. This command would typically be used in conjunction with a conditional If statement. If the condition is met, the macro exits the repeat loop before the entire cycle is complete. The macro then continues with the command that follows the Repeat Exit.

The Break command may also be used to exit from a repeat loop. Use the Continue command if needing to skip to the end of the Repeat loop and start with a new repeat cycle.

This command does not open an editable Macro Express window. Expand the Repeat category and double click on the Repeat Exit command to insert it directly into the script.

**Sample Macro**

Below is a modified Copy and Paste Routine macro demonstrated in the Tutorial. If specific text is found during the clipboard copy, the macro exits the repeat loop. Otherwise it continues cycling through the loop.

Repeat Start (Repeat 100 times)
   Window Activate: notepad
   Wait for Window Title: notepad
   Text Type (Simulate Keystrokes): <SHIFT><END>
   Clipboard Copy
   If Clipboard Contains "phrase I'm looking for"
      Repeat Exit
   End If
   Text Type (Simulate Keystrokes): <HOME><ARROW DOWN>
   Window Activate: wordad
   Wait for Window Title: wordpad
   Clipboard Paste
   Text Type (Simulate Keystrokes): <ENTER>
End Repeat
System

Change Default Printer

Use this feature when more than one printer is connected to the computer or network. For example, create a macro to quickly change the default printer setting from a monochrome laser to an ink jet for color printing.

![Change Default Printer dialog box]

To select a new default, just click on the printer needed to highlight the selection. Click on the OK button to incorporate the printer change into the macro. When the macro is run, the printer selected becomes the new default printer for the computer.
Change Display Resolution

Macro Express provides a convenient method to quickly change the screen display resolution. For example, use this function with projects that require viewing at various screen resolutions. This option provides rapid changes between settings.

To select a screen display setting, just click on the screen resolution desired to highlight the selection. Click on the OK button to save and incorporate the screen resolution change into the macro.

**Note:** Depending on the video driver, it may be necessary to reboot the computer before the new screen resolution settings take effect. If this is the case with the system, place a Reboot command in macro - after the screen setting command. This changes the screen resolution and then reboots the computer to initiate the settings.
Control Panel

Use these two commands to open the Windows Control Panel or a specific applet in the Control Panel

Control Panel Open
The Control Panel Open function opens the Windows Control Panel. There is not an edit window associated with this command. The command is inserted directly into the script.

Control Panel Run
The Control Panel run command opens the Control Panel and the particular applet selected.

Available Applets
The available Control Panel applets are displayed by name and icon. Highlight the applet to open.

Applet
If the applet is not displayed in the Available Applets box, enter the applet file name in the Applet edit box. Control Panel applets have a file extension of .CPL.

Tab
Many applets open a window with several tabs. Insert the tab number to display when the applet opens. For example, access with 0 set for the Tab opens the Accessibility Options window to the first Tab. If the Tab were set to 1, then the Accessibility Options window would open to the second Tab.
Get Pixel Color

Use the Get Pixel Color option to obtain the pixel color underneath the mouse pointer. The pixel color is assigned a numeric value by Windows, normally 6 – 8 digits in length. This numeric value is then saved to an Integer variable such as N[1]. For details about colors see How colors are displayed.

This command can be used for a variety of tasks. For example, use this command to determine if a check box has been checked or not. Or for a particularly difficult timing problem, the Get Pixel Color command may be the solution.

Options
First select the option for determining the location of the pixel, either beneath the mouse or using specific coordinates.

**Beneath the Mouse**
This option obtains the color of the pixel located directly underneath the mouse pointer. The pixel color is obtained wherever the mouse cursor is located at the time this command takes place during the macro.

**Specific Coordinates**
With this option assign the specific mouse coordinates based on the active window or the entire screen. Insert the X and Y coordinates of the pixel to find.

**Relative to Screen**
Relative to Screen instructs the macro to move the mouse cursor relative to its position on the computer screen. Use the "Screen Coordinates" numbers from the Mouse Locator with this option.

**Relative to Window**
This option instructs the macro to move the mouse cursor relative to its position within the window that is active or has focus. Use the "Active Window" numbers from the Mouse Locator with this option.

Launch Mouse Locator
The mouse locator is an easy way to obtain the pixel coordinates when using the Specific Coordinates option. If the Mouse Locator window pops up in an area of the screen that covers important data, click on the window, hold the left mouse button down on the blue bar at the top of the window and drag to another location. See the Launch Mouse Locator topic for details on use.

Destination
Assign the pixel color obtained to a variable.

Sample Macro - Get Pixel

Here's an example of how this command could be used. Let's say that there is a web site that uses two alternating graphical images, one red and the other green. We want to determine which image is displayed and take appropriate action based on the results.

The first step is to load the web page. Use the Get Pixel Color command and select the At Specific Coordinates option, Relative to Screen.

Then launch the mouse locator from the Get Pixel Color window. Position the mouse cursor over the red image and press Ctrl Space. This inserts the pixel coordinates to the Get Pixel Color window. Write down the Pixel color on a piece of paper because we'll need this information later. Click OK to save.

With this information we can build the rest of the macro. The macro inserts a password if the image is red. If the image is not red (because the green image is currently displayed), it opens a new web page.

Macro Script
Get Pixel
If Variable %N[1]% = 255
Text Type: <TAB> 123xyz
Else
Web Site: https://www.macros.com
End If

The pixel color for red is 255. This is the value we wrote down on the piece of paper to use with the If Variable command. So what we have done is use the If Variable command, stating if variable N[1] (what we assigned to the pixel color) equals a value of 255, then press a Tab and type in the password of 123xyz.

If the red graphical image is not present when the macro is run, then N[1] will have a different value (a value for green). It will not match the value of 255 in the If Variable statement. The Text Type command is skipped and the www.macros.com web page is launched instead.
Screen Saver

These commands are used to make adjustments to the screen saver.

Launch Screen Saver
This command immediately starts the screen saver if the screen saver option is enabled in Windows.

Disable Screen Saver
This command deactivates the screen saver setting. It changes the screen saver setting to read "none" meaning that no screen saver will activate. This is the same as selecting "Display" in the Control Panel and setting the screen saver to "none".

Set Screen Saver Time Out
This option changes the minutes of inactivity required before a screen saver starts. This is the same as selecting the "wait minutes" option in the screen saver tab of the Display Control Panel applet.

Minutes to Wait
Select the number of minutes of computer inactivity required before the screen saver starts.
Set System Date/Time

Use this option to change the system date and time. There are three ways to adjust the date and time. The first option changes the date and time based on the current settings, moving them ahead a fixed number of hours, days, etc. The second option sets the clock to a specific time and date. The last option syncs with a time server.

**Note:** The Set System Date/Time command will not run in Vista or later due to the security features of these operating systems.

Options
First select the date/time option desired.

**Adjust current date/time**

- **Adjust Time**
  Use this option to set the system clock ahead by the number of hours, minutes or seconds specified. Or move it back by inserting a negative value in the field.

- **Adjust Date**
  Use this option to set the system date ahead by the number of months, days or years specified. Or move it back by inserting a negative value in the field.

**Set a specific date/time**

- **Set Time**
  Select a specific time. When the macro is run, the system clock is changed to the time designated.

- **Set Date**
  Manually enter a date or click on the arrow to display a calendar for picking a date. When the macro is run, the system date changes to the date selected.
Sync with a time server
This option synchronizes the system time with a time server (web site). Enter the server address in the field provided. The system time on the computer is updated to match the time of the server.
Show Dialog Window

This command allows for a quick method to activate several standard Windows dialog boxes. The functions are detailed below.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date and Time</td>
<td>Activates the Date and Time window for resetting the computer's clock, adjusting the date or changing the time zone.</td>
</tr>
<tr>
<td>Find Computers</td>
<td>Activates the Find Computer window in order to locate a computer on a network.</td>
</tr>
<tr>
<td>Find Files</td>
<td>Activates the Find Files window for searching the computer for a particular file.</td>
</tr>
<tr>
<td>Run Programs</td>
<td>Activates the Run Programs window in order to run a program, install a new one, etc.</td>
</tr>
</tbody>
</table>
**Terminal Services Session ID**

Windows Terminal Services provides the ability for several users to run Windows-based applications on a single server. The applications for each user run in a session. Each session is assigned a unique number. The "Store Terminal Services Session ID" command allows a macro to obtain this session ID number.

Some resources, such as the hard drive, may be shared between sessions. If a macro attempts to write to and then read from a file, macros used by different sessions may attempt to write to or read from the same file. This can lead to file corruption. By using the Session ID as part of the filename, the macro running on each session is assured of using a unique filename.

The session ID can be saved in either a text string variable or as an integer variable.
Wallpaper

If tired of looking at the same Desktop Wallpaper day after day, set up macros to incorporate images into the wallpaper. After setup, just press a hot key to change the wallpaper. Or create several timed macros to change the wallpaper at regularly scheduled intervals. This option changes the desktop wallpaper or background. The wallpaper is automatically updated in the Active Desktop as well, if the Windows operating system supports it.

Script Editor > Expand System Category > Wallpaper

Clear the Wallpaper
Select this option to remove the current wallpaper. No image is displayed on the desktop.

Graphic File
Click on the browse button to find an image on the hard drive to use as the background wallpaper. A Windows Bitmap is the default file format. Other image file types that can be used are .jpg, .gif and .png. After locating the image, click on the Open button to save the file path/name.

Background Mode
Determine how to display the image on the desktop.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile Graphic</td>
<td>Makes copies of the image to tile across and fill the entire screen.</td>
</tr>
<tr>
<td>Center Graphic</td>
<td>Centers the image on the desktop</td>
</tr>
<tr>
<td>Stretch Graphic</td>
<td>Stretches the image to fill the entire screen.</td>
</tr>
<tr>
<td>Position Graphic</td>
<td>Position the image anywhere on the screen.</td>
</tr>
</tbody>
</table>
Graphic Position
When selecting the Position Graphic option, enter the X and Y screen coordinates to position the image on the desktop.
**Windows System Commands**

The following Windows system commands do not open an edit window when using in the editors. The commands are inserted directly into the editor. Expand the System category of commands and double click on the command to insert it into the macro script.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty Recycle Bin</td>
<td>This command essentially does what its name implies, emptying the Windows Recycle Bin.</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Places a computer in hibernate mode, which saves everything in memory on disk, turns off the monitor and hard disk, and then shuts down the computer. When the computer is restarted, the desktop is restored exactly as it was when first placed in hibernation.</td>
</tr>
<tr>
<td>Lock Workstation</td>
<td>This function locks a computer workstation. <strong>Note:</strong> The Lock Workstation command is designed to only work with Windows XP and later.</td>
</tr>
<tr>
<td>Logoff</td>
<td>Closes all programs currently running and logs off of the computer.</td>
</tr>
<tr>
<td>Power Off</td>
<td>Shuts down the computer and also shuts down the power to the computer. <strong>Note:</strong> The Power Off function is only available for computers that support this feature.</td>
</tr>
<tr>
<td>Reboot</td>
<td>Closes all running programs, shuts down and restarts the computer.</td>
</tr>
<tr>
<td>Shut Down</td>
<td>Shuts down the computer.</td>
</tr>
<tr>
<td>Suspend Computer</td>
<td>Places a laptop in a suspend mode to save on battery power.</td>
</tr>
<tr>
<td>Undock Computer</td>
<td>Allows a laptop or notebook computer to undock from a docking station.</td>
</tr>
</tbody>
</table>
Windows Sizing Border

This command sets the sizable borders that appear around any re-sizable window. This may be useful when having difficulty positioning the mouse on the edge of a window. **Note:** This is a system command that will affect any window currently open or any that will subsequently be opened.

Enter the size of the window border
Enter a value from 1 to 10 in the edit field. The number 10 places the thickest border around the window, while 1 places the thinnest border.
Timing

Delays

Use this function to add Delay timing to macros. Delays may be necessary to allow time for a window to gain focus before the macro can proceed correctly or for any number of other reasons. The delay helps ensure that the macro doesn't play back faster than Windows can keep pace.

Timed delay in seconds / Timed delay in milliseconds

The Timed Delay in Seconds option puts Macro Express into a "wait state" where virtually no CPU cycles are used, thus allowing CPU intensive programs to continue uninhibited. This is similar to the Wait for Time to Elapse command. Select either the Timed delay in seconds or Timed delay in milliseconds option and then enter the number of seconds or milliseconds in the Delay Time edit box.

Note: This command suspends Macro Express for the amount of time specified. During this time the macro cannot be terminated by pressing the Scroll Lock + Pause keys or by right clicking on the "Running Man" icon in the notification area.

Delay in seconds / Delay in milliseconds

Delays can be set in seconds (up to 99999 seconds allowed) or in milliseconds (thousandths of a second). Just click on the option preferred and enter the number of seconds or milliseconds in the Delay Time edit box. Seconds can be in fractions of a second by using a decimal point such as .5 to signify a half second delay. Or 350 milliseconds equates to a little over 1/3 of a second delay.

Ignore Macro Speed Factor

This option instructs the Delay command to ignore the Macro Playback Speed so that the delay time remains constant. If this option were not checked and a Macro Speed command instructs the macro to play back at four times its normal speed, the delay would also be sped up. For example a one second delay would be reduced to a one quarter second delay.

Note: Delay timing halts the macro for at least the amount of time specified. The delay works by continually checking to see if the specified time has elapsed. While checking, any waiting or new Windows commands are processed. If a Windows command that takes a bit of time happens to be processed, then the delay may last longer than the time specified.
**Keyboard Repeat**

These commands adjust the keyboard speed.

---

**Set Keyboard Repeat Delay**

The Set Keyboard Repeat Delay changes the amount of time it takes before holding a key down on the keyboard to start repeating the key. Valid values are 0 through 3 with 0 being the shortest delay. This is the same as selecting "Repeat Delay" under the speed tab when selecting "Keyboard" in the Control Panel. Insert a value from 0 to 3 or adjust the slider bar to the desired setting.

**Set Keyboard Repeat Speed**

This option changes the speed of keys being repeated when it is being held down on the keyboard. Valid values are 0 through 31 with 0 being the slowest speed. This is the same as selecting the "Repeat Rate" under the speed tab when selecting "Keyboard" in the Control Panel. Insert a value from 0 to 31 or adjust the slider bar to the desired setting.
Pause

Macro Express allows for pauses to be placed in macros. When a macro is invoked, it plays back until the script reaches the pause command. When the pause is reached, playback stops and a small Pause window opens indicating that the macro has been paused. While the macro is paused, the mouse or keyboard may be used without adversely affecting the macro.

Resume the macro playback or cancel the macro at any time by clicking the appropriate button on the pause window. Or use the System Macro to resume macro playback. The default hot key setting is Ctrl + Alt + Shift + Y.

Select from the drop down list whether to use the Basic or Complex pause.

Basic Pause
The Basic Pause stops the macro and displays a window in the center of the screen stating that the macro pause is in effect. Click on the Resume button, press the hot key assigned to the macro or press the system hot key to continue the macro playback. Click on the Abort button to cancel the remainder of the playback.

Complex Pause
The complex pause displays a message during the pause and allows for positioning the pause window so that it does not interfere with the application window in use.

Message to be displayed
Include an optional message to display in the pause window giving additional instructions to the user. Just type a message of up to 180 characters in the edit box.

When the pause message appears during macro playback, click on the Resume button to continue the macro playback or the Abort button to cancel the remainder of the macro. Also resume the playback of the paused macro by pressing the hot key assigned to the macro or by pressing the system hot key.

Location of Pause Window
Use this option to position where the Pause window is to be displayed on the screen during macro playback. See the Size and Position topic for more details about positioning a window.

**Do not set the focus to the previous window**
Select this option to force the Pause window to retain window focus. If this option is left unchecked, the window open before the Pause window was activated keeps the focus. This option is available for either the basic or complex pause.

**Other Ways to Pause a Macro**

1. The Wait for Key Press command causes the macro to pause. It instructs the macro to wait until a specific key is pressed. The macro resumes once the key is pressed. This command does not allow for a message to display while the macro is paused.

2. If the macro is paused so that the user can insert text, another option is the Variable Set String command - Prompt for Value option. This command prompts the user to type text into the prompt. The text is saved to a variable which can then be inserted into another application using the Text Type command. This also applies to the Variable Set Integer and Variable Set Decimal commands.
Speed

The Speed commands adjust the playback speed of keystrokes or mouse movements or adjusts the playback rate of the entire macro.

Keystroke and Mouse Speed

It is possible for the keystrokes or mouse movements sent by Macro Express to move too quickly in the intended application or for Windows to keep pace. This option slows down the playback speed so that the macro runs correctly.

**Delay in milliseconds**

Enter the delay time, in milliseconds (thousandths of a second), to place between each keystroke or mouse playback.

In some cases it may only be necessary to slow down part of the macro. In this situation place the speed command before the section of the macro that needs to be slowed down. Then place another speed command after the slowed down section of the macro with a delay set to "0" zero. The remainder of the macro resumes with no delays between keystrokes and mouse movements.

It is also permissible to place a Keystroke Speed delay and a Mouse Speed delay in the same macro. The delays remain constant throughout the macro until another speed command is inserted with a different delay setting.

Macro Speed

The macro speed function is typically used with capturing (recording) a macro. The Macro Speed command occupies the first line of a recorded macro script. The speed factor is initially set for captured macros in the Capture preference settings.

With all the timing delays between each keystroke and mouse movement recorded, it may be advisable to speed up or slow down the macro. Double click on the Macro Speed command in the script to edit the speed factor.

**Multiply delays by**

To slow down a macro, place a number greater than one in the Multiply Delays By field. For example, placing a 4 in this field causes the macro to play back 4 times slower. To speed up the macro, place a value less than one in the Multiply Delays By field. For example, placing 0.5 in this field speeds up the macro by a factor of 2, using 0.25 by a factor of 4, etc.
**Wait For**

**Wait for Control**

This command allows the user to create a macro that waits for a specific Window Control to gain focus, become visible or become enabled. Or have the macro wait for their opposites - wait for control to lose focus, become invisible or become disabled. So, the user could write a macro that looks like the following:

```
Wait for Control %C[1]% to be Enabled
Mouse Click on Control %C[1]%
```

This would cause the macro to click on the control as soon as the control would allow.

![Wait for Control](image)

**Control to Wait For**
First a Window Control variable needs to be defined in the macro. Then use this function to select the control for which the macro will wait.

**Wait until the control**
Select the status of the control. Choose from the following options - If the Control:

- Exists
- Does not Exist
- Is Enabled
- Is not Enabled
- Is Visible
- Is not Visible
- Is Focused
- Is not Focused
Wait Indefinitely
With this option checked, the macro does not resume until the Wait For action specified has occurred.

Wait at most
With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
Start for File to be Ready

This command instructs a macro to wait until a file is ready before continuing. If a macro launches a particular file, it could wait until the application is loaded and the file is ready, before allowing the subsequent steps to proceed. This is a different approach than using a [Wait for Window Title](#) command.

Use this command in situations where the macro should continue only after an application has finished writing to the file. The file may exist for some time before the application has finished writing to it. The Start for File to Be Ready command waits until the file is no longer being written to.

**Note:** If the file does not have write permissions then the macro will always flag the file as not being ready. In Windows Vista and later, any files located in the Program Files folder do not have write permission.

![Wait for File to be Ready](image)

**Filename**
Insert the entire file path and drive or click on the Browse button to navigate to the location of the file.

**File must be ready for xx seconds**
Insert the number of seconds that the file should be ready before the macro continues. This helps ensure that the file is ready for other activity before the macro continues.

---

**Wait Indefinitely**
With this option checked, the macro does not resume until the Wait For action specified has occurred.

**Wait at most**
With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
**Wait for File to Exist**

This option waits for a specific file to exist. As an example, a macro creates a new file and then uses the Wait for File to Exist command to instruct the macro to wait until the file has been created before continuing.

**Filename**
Insert the entire file path and drive or click on the Browse button to navigate to the location of the file.

**Wait Indefinitely**
With this option checked, the macro does not resume until the Wait For action specified has occurred.

**Wait at most**
With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
**Wait for Folder to Exist**

This option is similar to the Wait for File to Exist command. It instructs the macro to wait until a specific folder has been created or exists on the computer before continuing.

![Wait for Folder to Exist](image)

**Foldername**  
Insert the entire folder path and drive information or click on the Browse button to locate the folder.

**Wait Indefinitely**  
With this option checked, the macro does not resume until the Wait For action specified has occurred.

**Wait at most**  
With this option checked, the macro waits the number of hours, minutes, and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
The Wait for Key Press command instructs the macro to wait until a specific key is pressed. The user may input text, move the mouse, etc. until that key is pressed. Once the selected key is pressed, the macro resumes.

**Key Press to Wait for**
Select the key to use from the drop down list. During playback, the macro stops when it reaches the Wait for Key Press command in the script and waits for the selected key to be pressed. Choices include letters of the alphabet, the function keys or several other common keys such as Enter, Tab, etc.

**Note:** Use caution when this command follows a Text Type command. For example, a macro contains the command "Text Type: <TAB>" and the next command in the script is the Wait for Key Press command. Since the previous command is to play back the TAB key, do not select the TAB key as the Wait For key. Macro Express sees the TAB from the Text Type command, thinks it is finished waiting and continues with the macro. It looks like the Wait for Key Press did not function properly. In this situation, either select a different key or insert a Delay command after the Text Type command. Or use the Wait for Text Playback command. This ensures proper macro functionality.

---

**Wait Indefinitely**
With this option checked, the macro does not resume until the Wait For action specified has occurred.

**Wait at most**
With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
Alternative Method for Pausing a Macro

The Pause command is an alternative method for pausing a macro. The pause displays a small window which may include a message for users to follow. Click on the Resume button or use the System Macro - Ctrl Alt Shift Y to resume the macro.
Wait for Mouse Click

These options require a mouse click before the macro resumes playback.

Wait for Left Mouse Click
The macro waits until the left mouse button has been clicked before resuming.

Wait for Middle Mouse Click
The macro waits until the middle mouse button has been clicked before resuming.

Wait for Right Mouse Click
The macro waits until the right mouse button has been clicked before resuming.

Wait Indefinitely
With this option checked, the macro does not resume until the Wait For action specified has occurred.

Wait at most
With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
Wait for Mouse Cursor

This option instructs the macro to wait until the mouse cursor type selected appears on the screen. When the specific mouse cursor type appears on the screen, the macro continues.

Script Editor > Expand Timing Category > Wait for Mouse Cursor

Cursor to wait for
Select the mouse cursor from the drop down list. The name as well as a graphical representation of the cursor are displayed to make sure the correct cursor type is selected.

**Note:** The mouse cursor must remain in the requested state for at least one half second in order for Macro Express to recognize the cursor type.

Wait Indefinitely
With this option checked, the macro does not resume until the Wait For action specified has occurred.

Wait at most
With this option selected, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
**Wait for Not Mouse Cursor**

This command is essentially the opposite of the Wait for Mouse Cursor option mentioned above. With this command the macro is waiting until the mouse cursor changes to a different type from the one selected. When the cursor changes to something different, the macro continues.

![Wait for Not Mouse Cursor](image)

**Cursor to wait for**

Select the mouse cursor from the drop down list. The name as well as a graphical representation of the cursor are displayed to ensure the correct cursor type is selected.

---

**Wait Indefinitely**

With this option checked, the macro does not resume until the Wait For action specified has occurred.

**Wait at most**

With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
Wait for Program Terminate

The macro waits until the program selected has finished closing, before continuing with the next macro step.

**Program Name**
Select the name of the program waiting to terminate. Either insert the name and file path of the program or click on the *Browse* button to select from the list of programs installed on the computer.

---

**Wait Indefinitely**
With this option checked, the macro does not resume until the Wait For action specified has occurred.

**Wait at most**
With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
Wait for Text

The macro waits until the specified text is input.

Text to Wait For
Insert the text to wait for in this field.

The case of the text must be exact
Check this box to require that the text matches exactly as originally input, using capital and lower case letters.

Wait Indefinitely
With this option checked, the macro does not resume until the Wait For action specified has occurred.

Wait at most
With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
**Wait for Text Playback**

This option is to be used immediately after a Text command, such as the Text Type function. Wait for Text Playback prevents the macro from continuing until all of the text has finished playing back.

![Wait for Text Playback dialog box](Image)

**Wait Indefinitely**

With this option checked, the macro does not resume until the Wait For action specified has occurred.

**Wait at most**

With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
The Wait for Time to Elapse function instructs the macro to wait a specified number of minutes and seconds before continuing. This command is similar to the Delay command, but with a couple of noticeable differences. First, it allows for a much longer wait period (up to about 7 days). And perhaps more important, this command puts Macro Express into a wait state where virtually no CPU cycles are used, thus allowing CPU intensive programs to continue uninhibited.

**Wait for Time to Elapse**

Wait for Time to Elapse function inserts the number of hours, minutes, seconds to have the macro wait before continuing.

**Note:** This command suspends Macro Express for the amount of time specified. During this time the macro cannot be terminated by pressing the Scroll Lock + Pause keys or by right clicking on the "Running Man" icon in the notification area.

**Warning:** By putting Macro Express into this wait condition, access to Macro Express functions is not available, including stopping the macro until the specified time has elapsed. Use this command with caution.
Wait for Web Page to Load

The Wait for Web Page to Load command instructs the macro to wait until a web page has finished loading before continuing. This command typically follows a Web Site command. Insert either a partial or complete URL in the URL field of the Wait for Web Page command.

**Note:** The Wait for Web Page to Load command only works with Internet Explorer.

This command waits for Internet Explorer to report the URL that it last loaded. With some web pages, the URL requested is not the last URL that is loaded. For these web sites there are two choices.

1. Leave the URL field of the Wait for Web Page command empty. Doing this causes the macro to wait until Internet Explorer reports that it is not busy. This works correctly for many web pages.

2. Enter the actual URL that is loaded last into the URL field. To discover what is the last URL loaded, enter some text in the URL field, perhaps "JUNK" and set the "Wait a Maximum of:" field to something short, like 45 seconds or 1 minute. Then run the macro containing the Wait for Web Page command. After 45 seconds or 1 minute a message will pop up that includes the last loaded URL. It may be necessary to repeat this step with a longer wait time to make sure the web page has actually been loaded. Then, knowing the actual URL loaded last, enter all or part of that URL in the Wait for Web Page command.

---

**Wait Indefinitely**

With this option checked, the macro does not resume until the Wait For action specified has occurred.

**Wait at most**

With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the
action selected in the On Error tab.
Wait for Window Title

If writing a macro that changes windows during playback, the macro commands may be ready to execute before the correct window has been activated. This may cause the macro to abort because it didn't find the correct window or subsequent macro commands could play back in the wrong window. To make sure this doesn't happen, insert a Wait for Window Title command instructing the macro to wait until the proper window has focus.

For example, if in a copy and paste routine between two applications, make sure that the macro waits for the second application's window to appear before pasting the copy from the first.

Window Title

Enter the name of the Window (the title in the caption bar of a window). Or click on the Browse button to select from a list of windows currently open on the computer. Choose from Hidden or Visible windows.

**Exact Match**

This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

**Partial Match**

The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

*The title contains wildcards*

Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Wait Indefinitely
The macro does not resume until the Wait For action specified has occurred.

Wait at most
The macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
**Wait for Window to Lose Focus**

The Wait for Window to Lose Focus command instructs the macro to continue only after the Window selected has lost focus or is no longer on top.

**Window Title**

Enter the name of the Window (the title in the caption bar of a window). Or click on the **Browse** button to select from a list of windows currently open on the computer. Choose from Hidden or Visible windows.

**Exact Match**

This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

**Partial Match**

The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

**The title contains wildcards**

Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.

**Wait Indefinitely**

With this option checked, the macro does not resume until the Wait For action specified has occurred.
Wait at most

With this option checked, the macro waits the number of hours, minutes and seconds specified for the Wait For action to occur. If that action does not take place within the specified time frame, the macro takes the action selected in the On Error tab.
Variables

Variables Overview

About Variables

Variables and conditions add an intelligence element to macros. They also bring an added level of power. Variables provide the capability that software developers find when writing software programs. However, variables in Macro Express are integrated into the commands so that they are easy to implement and use.

A variable is simply something that holds a value. The value can be changed and modified. In other words, it is variable because it can be anything.

Variables allow input of data into the macro from a variety of sources such as from the macro itself, a file, user input, the Windows clipboard, a .INI file, the title of a window and many others. The variables can then be manipulated, processed and tested. Actions can be taken on the results of the test or on the variables themselves. Some specific examples are provided in this section to help cement the idea behind the use and power of variables.

Types of Variables
Macro Express supports the following types of variables - Text, Integer, Large Integer, Decimal and Control. Variable names may be up to 31 characters in length.

<table>
<thead>
<tr>
<th>Variable Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text String</td>
<td>Holds any type of character, number, word, phrase or paragraph.</td>
</tr>
<tr>
<td>Integer</td>
<td>Stores a whole number - values that do not contain fractions (... -2, -1, 0, 1, 2 ...). Note: An integer variable value can range from -2147483648 to 2147483647. When the value exceeds 2147483647, it 'wraps'. If an integer variable contains 2147483647 and you add 1 to it, the integer variable will contain -2147483648.</td>
</tr>
<tr>
<td>Large Integer</td>
<td>Large Integers also store whole numbers. Note: A large integer variable value can range from -9223372036854775808 to 9223372036854775807. When the value exceeds 9223372036854775807, it 'wraps'. If an integer variable contains 9223372036854775807 and you add 1 to it, the integer variable will contain -9223372036854775808.</td>
</tr>
</tbody>
</table>
Decimal

Holds any type of number, such as 12.432 or -1.3.

Note: A decimal variable value can range from $5.0 \times 10^{-324}$ to $1.7 \times 10^{308}$ with 15 to 16 significant digits. This first example is a decimal expanded to include 324 leading zeros followed by the number 5, represented as .000(321 more zeros)5. The second range extends to 17 followed by 308 zeros which would look like 1700000000(300 more zeros).0. The numbers are rounded to 15 or 16 significant digits.

Control

Captures information from a window control, such as an edit box, window title, button, etc. This information can then be manipulated to work with other variables in Macro Express.

---

Examples of using variables

There are virtually an unlimited number of uses for variables in macros. Here are a few examples.

1. Load the mouse cursor position into variables at the beginning of a macro. Restore the mouse location at the end of a macro.

2. Load the position and size of a window into variables at the beginning of a macro. Restore the size and position after manipulating the window.

3. Prompt the user for information and load the information into variables. Save the information to a file and send it via email.

4. Processing a text file or processing an ASCII delimited text file saves values in the files to variables. These values can then be inserted into other applications.

5. Prompt for a text variable. Create boilerplate text that uses the text variable (such as a name) throughout the boilerplate text to customize it. Paste the text into an application.

6. Process a whole set of files by loading in the file names from a text file (i.e. use the process text file command).

7. Manipulate text strings, such as extracting the last 10 characters from a string, finding all characters before the @ symbol, etc.
**Defining Variables**

There are numerous commands that may be used to define an initial value for a variable. See the `Variable Set String`, `Variable Set Integer` and `Variable Set Decimal` commands, or any number of variable set functions. In addition, variables can be set using the date, time, encrypted text, repeats, processing a text file, processing an ASCII delimited text file macro and practically every other command.

There are also methods available to modify or manipulate the variables once they have been created. See the `Variable Modify String`, `Variable Modify Integer` and `Variable Modify Decimal` commands, or other variable modify functions.


**Create a New Variable**

There are three ways to create a variable to be used in a macro.

1. From the Scripting Editor click on the Variables tab. Click on the Add button to open the Variable Properties window and create the variable.

   **Step by Step Instructions**

   This example shows how to create an Integer Variable named Insight with an array of 25 elements.

   1) From the Script Editor click on the Variables tab to open the Variable Properties window.
   2) Enter Insight in the Variable Name field.
   3) Click on the drop down menu and select Integer Variable as the Variable Type.
   4) Click the check box to create the macro as an array.
   5) Enter 25 as the number of elements in the array.
   6) Click OK to save and return to the Variables Tab.
   7) The new Integer variable, Insight, with 25 elements available is displayed.

2. When editing a macro command click on the Variables button to the right of the edit field. Click on the Add button to open the Variable Properties window as shown below and create the variable.
Step by Step Instructions
This example shows how to create a Decimal Variable named Software from within the Variable Set Decimal command. This variable will not include an array.

8) From the Script Editor expand the Variables section of commands and double click on Variable Set Decimal to open the Variable Set Decimal window.
9) Select the Set Value Now option.
10) Click on the Variables button to the right of Destination Variable to open the Insert Variable window.
11) Click on the Add button to open the Variable Properties window.
12) Enter Software in the Variable Name field.
13) The Variable Type defaults to Decimal Variables.
14) Click OK to save and return to the Insert Variable window.
15) Click OK to save and return to the Variable Set Decimal window.
16) %Software% should now be listed as the Destination Variable.

3. In the macro command window enter the name of the variable in an edit field that accepts variables. After clicking OK to save the information in the command window, a prompt informs that the variable does not exist and asks to create it now. Verify that the Variable Type is correct and create as an array, if necessary.

Variable Name
In the Variable Properties window assign a name to the variable being created. Assign any name to the variable or use the variable assignments defined in previous versions of Macro Express, such as T1 or D95. Macro Express displays them as T[1] or D[95] because they are now part of a variable array. In the sample image above the variable name is sales. Variable names may not exceed 31 characters.

Note: If assigning original names to variables, rather than using T[1], D[1], etc., then the following characters are not allowed in the variable name: [ ] < > , . - + = \ / * %

Variable Type
Select from the drop down list the type of variable to create, such as a Text variable, Integer variable, Decimal variable, etc.

Create as an Array
At times it may be appropriate to assign more than one value to a single variable. In such instances, create a variable that contains a series of values. This series is called a variable array. If the variable is named "sales", then the array elements would be designated as sales[1], sales[2] and so on up to the number of elements defined in the array. Array elements start with [1] and not [0]. Each element stores a separate value.

Select the Create as an array option to set the variable as an array and then choose the number of elements to be available in the array. Variable arrays place brackets around the element number of the variable.

Elements
Select the number of elements needed in the array. In the example above, 30 elements have been selected. This allows the use of up to 30 variables in the array. The variable format looks like the following:

sales[1]
sales[2]
sales[3]
...
sales[30]

In the above example, an array with 30 elements allows assignment of a value to variable sales[1], another value to variable sales[2], etc. - up through sales[30]. There is not a limit to the number of elements that may be assigned to an array variable.

Note: The "T", "N", "D" and "C" variables are predefined and always available for use as an array. The variables are assigned as T[1], T[2], T[3], etc. By default, each of these predefined variables are set to an array of 99 variables. There is not a limit to the number of elements in the array and the default arrays may be expanded if desired. Using example #1 above, change the array value. The element of the array is placed in brackets as shown in the Elements example above.

Make this Variable Available to Macros Called by this Macro
Select this option in order to allow the variable value to be passed between macros when using the Macro Run command or when using the Variable Save and Variable Restore commands.

When this option is selected the variables are also referred to as Global variables, because they are available to other macros. When not selected, the variable values are Local and may only be seen in the current macro.

Click OK to save the variable information.
**Note:** See the Using Integer Variables and Using Text String Variables tutorials for actual examples of how to create variables and use them in macros.
Variable Scope

Variable Scope describes when the information in a variable is accessible. When created, the stored value is only available for a certain part of a macro. Macro Express allows for variables with either a Local or Global scope.

Local and Variable Scope

When a variable is created, the ‘Make this Variable Available to Macros Called by this Macro’ option determines whether the variable has a Local or Global scope. Select this option to save the variable with a Global scope. Leave this option unchecked to save the variable with a Local scope.

Local Variable
A Local variable is accessible only inside the macro where it is defined.

For example, suppose you have macros A, B and C, and A is the main macro that calls macros B and C via the Macro Run command. Macro A could have a local variable named %Address%, and macro B could also have a local variable named %Address%. Each of these variables contain separate and distinct values. Changing the variable value in macro B has no effect on the variable in Macro A.

Global Variable
A Global Variable is accessible inside the macro where it is defined and in all other macros called by that macro via the Macro Run command. It is recommended that global variables be defined in the main macro.

For example, suppose you have macros A, B and C and A is the main macro that calls macros B and C via the Macro Run command. After defining a variable named %Address% in macro A both macros B and C can use this variable. Changes made to the value of %Address% in macro B would be available in macros A and B.

Mixing Scope

Separate variables may be defined with the same name and different scopes. Using the example above, a global variable named %Address% may be defined in macro A and a local variable named %Address% defined in macro C. The global %Address% will be used in macros A and B but the local %Address% will be used in macro C.

Macro Threads

Macros are activated in a variety of different ways. Each activation can be thought of as a separate task or thread. This macro thread consists of the main macro and any macros called from that macro by the Macro Run command. If the same macro runs more than once as a result of two separate activations, each activation is running on its own thread.

Variables are not Global between macro threads. This applies even if the same macro is called. For example, suppose you have macros A, B, C and Z. Both macros A and Z call macros B and C via the Macro Run command and both contain the global variable %Address%. The variable %Address% in macro A is separate and distinct from the variable %Address% in macro Z. If macro A sets %Address% to ‘PO Box 106’ and macro Z sets %Address% to ‘120 South Main’ then %Address% in macros B or C would contain ‘PO Box 106’ if called from macro A and ‘120 South Main’ if called from macro Z.

Making information available to different macro threads

Sometimes information needs to be shared between different macro threads. Some examples might include paths to common files, user names, department names, company names or delay values. Each individual or organization will have different needs. There are several effective ways to share values between macro threads.
Environment Variables
Use the 'Variable Modify String: Save to Environment Variable' command to save a variable to the environment variables area of Windows. Later, use the 'Variable Set String: Set from an Environment Variable' command to read an environment variable into a text variable.

Values saved in the environment variable will remain until Macro Express is terminated and are also available to any programs called by Macro Express after the variable has been saved.

Some older versions of Windows may impose a size limit on an individual environment variable or the size of the environment block.

Environment variables are a good place to store text variables. Numeric information may also be stored, but it must be converted to and from a text string. Avoid trying to store control (non-printable) characters in the environment variables.

Registry
The 'Write Registry Value' and 'Read Registry Value' commands may be used to save and restore variables. Saving information in the Registry this way is safe as long as the value is not written to a registry key or value that is used by another program or by the operating system. Also, some users can write to certain areas of the registry and others cannot.

There should not be any problems writing registry values to a registry key similar to this:

    HKEY_CURRENT_USER\Software\<Your organization or company name>\Macros

All variable types except control variables may be saved to and restored from the Registry.

INI Files
Text variables can also be saved in INI files using the 'Variable Modify String: Save to INI File' and 'Variable Set String: Set Value from INI File' commands.

Values saved in INI files remain until the INI file is modified or deleted. It is possible to store numeric information but it will need to be converted to and from a text string. Avoid trying to store control (non-printable) characters in INI files.

Text Files
Save anything that can be stored in a text variable to a file using the 'Variable Modify String: Save to Text File' command. Later, read this information using the 'Variable Set String: Set Value from File' command.

Values saved in text files remain until the file is modified or deleted. It is possible to store numeric information but it will need to be converted to and from a text string. Unlike storing information in environment variables or INI files, control (non-printable) characters may be stored in a text file.

Variable Save / Variable Restore
Global variables may be passed from one macro to the next using the Variable Save and Variable Restore commands.
Playback of Variables

Variables can be placed in the input fields of practically all macro commands. There are a couple of methods that may be used for inserting existing variables into command fields.

1. Type the existing variable name directly into the edit field. To do so, place the name of the variable surrounded by percent signs (%). This would look like %T[1]% for the Text variable array T[1] or %results% for a variable previously defined as results.

2. Click on the Variable button to open the Insert Variable window. Expand the variable type needed, select an existing variable and click OK. If using an array variable such as N in the example below, N[ ] will appear in the variable name field. Enter the number of the array to be used such as 2 in this example and save. Array elements start with [1] and not [0].

![Insert Variable Window]

**Note:** In many of the commands, only one variable type may be available for selection in the Insert Variable window. For example, if using the Variable Set String command only Text Variables are available for use.

Before selecting a variable, it must first be defined, as discussed in the Defining Variables topic.

**Example 1**
To launch a program, enter %T[1]% in the Program/Path Name field of the Program Launch command. When the macro is executed, it attempts to run the program that is defined by T[1]. Assign a value (file name and path) to T[1] previously in the macro.

**Example 2**
A macro may include several Delay commands each for the same amount of time. Instead of inserting 2 seconds as the delay time, insert %delay%. In this case, the macro delays the amount of time previously defined in the variable named "delay". If a need arises to increase or decrease the delay time, just edit the command that defines the value of %delay% instead of changing each Delay command individually.

There are many ways to use variables. Besides placing variables in commands as described above, there are some functions that accept and use variables directly as part of the command. These include window resizing
and repositioning commands, mouse movement commands, repeat commands, processing text or ASCII delimited text files and many others.

**Note:** See the [Using Integer Variables](#) and [Using Text String Variables](#) tutorials for actual examples of how to create variables and use them in macros.
Clear Variables

Use this option to clear the value of a variable during macro playback. Select to clear the values of all variables of a specific type, a range of elements in a single array variable or every variable used in the macro.

Clear all of this type
Select this option to clear all of the variable values of the type selected.

Variable Type to Clear
Select the type of variable to clear. There are five different variable types to choose from. These include Text, Integer, Large Integer, Decimal and Control variables.

Clear the elements of a single array variable
If using an array variable in a macro, this option clears a range of array elements for the variable selected.

Variable
Select the variable array to be cleared of values. Either enter the variable name such as %Sales%, %D%, etc. or click on the Variables button to find the variable from the list of available choices.

From
Select the first element in the array to be cleared.

To
Select the last element in the array to be cleared.

All variables between the first (From) element chosen and the last (To) element are cleared of their values. For example, consider an array variable with 10 elements and the numbers 2 and 5 are placed in the From and To fields. When the macro is run, only the values of elements 2 through 5 are cleared. The values of the other variables in the array, 1 and 6 - 10 remain unchanged and are not cleared.

Array elements start with [1] and not [0].

Clear all variables
Select this option to clear the values of all variables, regardless of variable type.

**Note:** The Clear Variables command does not affect variables saved through the Variable Save command.
Build date and time formats with this command. Many of these formats are based on the definitions in the Regional Settings of the Control Panel. The month, day, etc. display in the language defined in the Regional Settings. Either save the date and time to a variable or have the macro insert the information into another application.

How would you like to set the date?
Select one of the four options from the drop down menu to set the date and/or time.

Set it to the current date/time
This option uses the date and time from your system clock at macro run time.

Use a specific date/time
Use this option to have a specific date or time played back in a macro. Set the value to a specific date or time, either in the past or future.

Adjust the current date/time
Adjust the date or time by Days, Months, Years, Hours, Minutes or Seconds into the future or past. The calculations are based on the computer's current system time and date. Insert negative numbers in the fields to adjust the date or time to the past.

Prompt the user
This option opens a small dialog window during macro playback requesting the user select a date and or time. The date and/or time is displayed in the format selected.

Prompt
Enter any instructions for the macro user in the Prompt field. The instructions display in the window that opens during macro playback. The current date is displayed in the edit field. The user can either
overwrite any of the date information or use the attached calendar to select a date. If a time prompt is selected the current time is displayed in the edit field. Overwrite the time by highlighting the hours, minutes or seconds and editing the current entry or use the up and down arrows on the keyboard to change the values.

**Set Manually**
The Set Manually button opens a window to allow positioning of the Prompt window - to set where it will appear on the screen during macro playback. See the [Position Window](#) topic for more details.

**Prompt for a date / Prompt for a time**
Select to have the macro prompt the user for a date, a time or both.

**Operation Tab**

![Date/Time Window](image)

What would you like to do with the date/time stamp?
Select from the drop down list what to do with the date and time stamp.

**Type the date/time stamp out**
This option types the text (date and/or time) in the format selected into the application that is open when the macro runs.

**Store the date/time stamp in a text variable**
This places the date and/or time into a text string variable. Select or create the text string variable to store the date/time information.

**Select the variable to receive the date/time stamp**
Choose the text string variable to store the date/time information.

**Choose a date/time format**
Select the date and or time format from the drop down list of pre-defined formats. Or create a new format by typing in the date or time characters into this field.

[Related Topics](#)
<table>
<thead>
<tr>
<th>Modifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>Displays the date using the Short Date Format defined in the Control Panel - Regional Settings, followed by the time using the Long Time format defined in the Control Panel - Regional Settings. The time is not displayed if the fractional part of the Date Time value is zero.</td>
</tr>
<tr>
<td>d</td>
<td>Displays the day as a number without a leading zero (1-31).</td>
</tr>
<tr>
<td>dd</td>
<td>Displays the day as a number with a leading zero (01-31).</td>
</tr>
<tr>
<td>ddd</td>
<td>Displays the day as an abbreviation (Sun-Sat) using the Short Day Name format defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>dddd</td>
<td>Displays the day as a full name (Sunday-Saturday) using the Long Day Name format defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>ddddd</td>
<td>Displays the date using the Short Date format defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>ddddddd</td>
<td>Displays the date using the Long Date format defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>m</td>
<td>Displays the month as a number without a leading zero (1-12). If the m specifier immediately follows an h or hh specifier, the minute rather than the month is displayed.</td>
</tr>
<tr>
<td>mm</td>
<td>Displays the month as a number with a leading zero (01-12). If the mm specifier immediately follows an h or hh specifier, the minute rather than the month is displayed.</td>
</tr>
<tr>
<td>mmm</td>
<td>Displays the month as an abbreviation (Jan-Dec) using the Short Month Names format defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>mmmm</td>
<td>Displays the month as a full name (January-December) using the Long Month Names format defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>yy</td>
<td>Displays the year as a two-digit number (00-99).</td>
</tr>
<tr>
<td>yyyy</td>
<td>Displays the year as a four-digit number (0000-9999).</td>
</tr>
<tr>
<td>Character</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>h</td>
<td>Displays the hour without a leading zero (0-23).</td>
</tr>
<tr>
<td>hh</td>
<td>Displays the hour with a leading zero (00-23).</td>
</tr>
<tr>
<td>n</td>
<td>Displays the minute without a leading zero (0-59).</td>
</tr>
<tr>
<td>nn</td>
<td>Displays the minute with a leading zero (00-59).</td>
</tr>
<tr>
<td>s</td>
<td>Displays the second without a leading zero (0-59).</td>
</tr>
<tr>
<td>ss</td>
<td>Displays the second with a leading zero (00-59).</td>
</tr>
<tr>
<td>z</td>
<td>Displays the millisecond without a leading zero (0-999).</td>
</tr>
<tr>
<td>zzz</td>
<td>Displays the millisecond with a leading zero (000-999).</td>
</tr>
<tr>
<td>t</td>
<td>Displays the time using the Short Time format defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>tt</td>
<td>Displays the time using the Long Time format defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>am/pm</td>
<td>Uses the 12-hour clock for the preceding h or hh specifier, and displays 'am' for any hour before noon, and 'pm' for any hour after noon. The am/pm specifier can use lower, upper, or mixed case, and the result is displayed accordingly.</td>
</tr>
<tr>
<td>a/p</td>
<td>Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a' for any hour before noon, and 'p' for any hour after noon. The a/p specifier can use lower, upper, or mixed case, and the result is displayed accordingly.</td>
</tr>
<tr>
<td>ampm</td>
<td>Uses the 12-hour clock for the preceding h or hh specifier, and displays AM symbol defined in the Control Panel - Regional Settings for any hour before noon, and the contents of the PM setting defined in the Control Panel - Regional Settings for any hour after noon.</td>
</tr>
<tr>
<td>/</td>
<td>Displays the date separator character defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>:</td>
<td>Displays the time separator character defined in the Control Panel - Regional Settings.</td>
</tr>
<tr>
<td>'xx'/'xx'</td>
<td>Characters enclosed in single or double quotes are displayed as-is, and do not affect formatting.</td>
</tr>
</tbody>
</table>
Get Array Length

At times it may be appropriate to assign more than one value to a single variable. In such instances, create a variable that contains a series of values. This series is called a variable array. If the variable is named "sales", then the array elements would be designated as sales[1], sales[2] and so on up to the number of elements defined in the array. Array elements start with [1] and not [0]. Each element stores a separate value.

Get Array Length returns the maximum number of elements defined for an array variable. This command is useful when used in conjunction with a Repeat command. Use it to change the number of array elements without modifying the macro script.

Array to retrieve length of:
Select the array variable from which to retrieve the number of elements.

Store result in:
The maximum length of the array is saved to the variable selected. The variable selected must be an Integer variable. The Integer variable stores the number of elements that were defined for the variable - in this case the variable named "sales".

See the Defining Variables topic for more information about arrays.
**Get Control Class**

This command places the class name of the control into a text string variable. In the example below, when selecting a control, a class name for the control is listed. For example if capturing a button as a control variable, such as %control% in the example below, the class name very likely would be "Button". The class name of "Button" would be saved to text string variable %T[1]% based on the image below.

The **Place Text in Variable** is %T[1]% and the **Retrieve the Class From** is %Title%.

---

**Place Text in Variable**
Select the text string variable to receive the control class information.

**Retrieve the Class From**
Select the control variable that contains the class information to be passed to a string variable.
Get Control Text

This command looks at the text saved to a control variable and saves it to a text string variable. This is helpful for determining the text currently in an edit box and allows for further manipulation of the text string.

Place Text in Variable
Select the text string variable to receive the control text information.

Retrieve the Text From
Select the control variable that contains the control text information to be passed to a string variable.
Get File Version

This command obtains the file version number of the file selected and saves the information to a text string variable or integer variable. This can be useful in comparing two program files to determine which is the later file. Use this command primarily with executable (.exe) files, .dll files, and similar, as these files normally contain version number information.

Retrieve entire version as a string
This option saves the entire version number to a text string variable. The resulting version number would look something like 3.5.1.1.

File to retrieve version from
Press the browse button to locate the file to be examined or type in the full file path and name into the edit box.

Place result in
Select or create the variable to store the file version number information.

Retrieve Individual Numbers
Use this option to save the components of the version number needed. Select from the major, minor, release or build number.

File to retrieve version from
Press the Browse button to locate the file to be examined or type in the full file path and name into the edit box.

Select the desired components of the file version number and save variables.

We will use Macro Express version 4.0a build 1 as an example. The major version number is 4. The minor version is 0. This corresponds to version 4.0 of Macro Express. In this example the release number would be 1, which also corresponds to the letter "a". The build number is 1, which represents build 1. So the version number is Macro Express v4.0a build 1, represented as 4.0.1.1.
Get OS Version String

This command obtains the operating system information and saves the data to a variable.

![Get OS Version String](image)

**Destination Variable**
Select the variable to store the operating system information.

The information saved to a variable will look something like the following:

*Windows 7 6.1.7601 Service Pack 1*
Run Macro in Variable

Macro Express allows the contents of a variable to be loaded during the playback of a macro and executed as part of the macro. This can be used to change the behavior of the macro as it runs.

The "Run Macro in Variable" command is similar to the "Load Macro Text File" command, but because there is no file I/O, the "Run Macro in Variable" command runs much faster.

Script Editor vs Direct (ASCII) Editor

When creating a macro that will run in a variable it needs to be written in ASCII format. In the Script Editor, macro commands are displayed in an easily recognized and understood format. To achieve this simplicity, some of the details about each command are only displayed in the edit dialog for the macro command. In the Direct Editor, all details about each macro command are visible. When describing these two ways of viewing macros, we refer to them as the Script and ASCII representations.

To view the ASCII representation of a macro click View > Direct Editor. Note that when in the Direct Editor view, all open macros are displayed in their ASCII form.

Another way to see the ASCII representation of a macro or macro commands is to highlight the commands you want to view, while in the Script Editor, and paste them into another program such as Notepad.

<table>
<thead>
<tr>
<th>Script Format</th>
<th>ASCII Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Type (Simulate Keystrokes): Text Type example</td>
<td>&lt;TEXT TYPE Action=&quot;0&quot; Text=&quot;Text Type example&quot;/&gt;</td>
</tr>
<tr>
<td>Variable Set String %Colors% to &quot;blue&quot;</td>
<td>&lt;VARIABLE SET STRING Option=&quot;\x00&quot; Destination=&quot;%Colors%&quot; Value=&quot;blue&quot; NoEmbeddedVars=&quot;FALSE&quot;/&gt;</td>
</tr>
<tr>
<td>If Variable %Colors% Equals &quot;Blue&quot;</td>
<td>&lt;IF VARIABLE Variable=&quot;%Colors%&quot; Condition=&quot;\x00&quot; Value=&quot;Blue&quot; IgnoreCase=&quot;FALSE&quot;/&gt;</td>
</tr>
</tbody>
</table>

Dynamically Create Macros

Macro Express allows you to dynamically create macros. You can use one or more macros to create other macros that are different depending on events and choices that occur as the macro runs. In order to do this
you need to put the ASCII representation of the macro commands that make up your macro into a variable.

For example, to include a Text Type command in the variable %RunThis% you would need to set the content of the %RunThis% variable.

```
Variable Set String %RunThis% "<TEXT TYPE Action="0" Text="A Text Type example"/>
```

Expansion of Variables

Normally commands that deal with variables substitute the contents of a variable for the variable name. For example, %FirstName% will be changed to something like George. When using the Run Macro in Variable command, often the name of a variable is needed instead of the content of the variable. Up until now, the automatic substitution with the content of a variable has made it awkward to use the Run Macro in Variable command.

The option 'Do not process embedded variables' has been added to many of the Variable Set String and Variable Modify String commands. This makes it easier to create a variable that contains variable names for use in the Run Macro in Variable command.

We have added another method of specifying a variable name. If you surround the variable name with { } then the content of the variable will not be used. Instead the name of the variable will be passed to the Run Macro in Variable command. If you include { }FirstName{ } it will be changed to %FirstName% in the Run Macro in Variable command. If you include %FirstName%, the content of the variable will be passed to the Run Macro in Variable command.

**A)** When a variable is included in a macro command, the content of the variable is used when the macro runs. Consider this example:

```
Variable Set String %My% to "My example"
Variable Set String %RunThis% "<TEXT TYPE Action="0" Text="%My% of the Text Type command"/>
```

When this runs the %RunThis% variable will become "<TEXT TYPE Action="0" Text="My example of the Text Type command"/>

**B)** There are times, however, when you want the %FirstName% variable to contain the name of a variable, not its content. To do this change the command to look like this:

```
Variable Set String %FirstName% "<VARIABLE SET STRING Option="\x00" Destination="{ }FirstName{ }
Value="%Name%" NoEmbeddedVars="FALSE"/>
```

The value "{ }FirstName{ }") will be changed to %Name% and will not be changed to the content of variable %Name%.

**Note:** If you need to include the value { } in your macro use this { { } }. It will be changed to { }.

**C)** Another way to encode a variable is to use the \c parameter. This option expects two hexadecimal digits to represent a single character. The sample above may be written this way:

```
Variable Set String %RunThis% "<VARIABLE SET STRING Option="\x00" Destination="\c25FirstName\c25"
Value="%Name%" NoEmbeddedVars="FALSE"/>
```

This works because 25 is the hexadecimal value for %. The \c is case sensitive, \C will not work.

**Note:** When including file paths in the Run Macro in Variable command, be careful when including certain characters in the path. For example, if needing to include a path like c:\charlie the \c will be interpreted as a hexadecimal character command. There are two ways to avoid this problem. You can change the case to avoid this situation by using c:\Charlie, for example. Or you may use a double backslash: c:\\charlie.
Copy a control variable
This option simply copies the information saved to one control variable to another. This may be useful if needing to retain the value of the original variable, but at the same time manipulate the value. Use this command to make a copy of the variable and now do both.

  Control variable to receive result
  Select the variable to receive the information from the control variable being copied.

  Control variable to copy from
  Select the control variable that contains the information to copy to another variable.

Copy the control from the activation
This command can be used only if the macro is a Control Activated macro. For example, later in the macro script it may be necessary to modify the control that activated the macro. Rather than use the Get Control function and capture the control again, save the activation control to a variable.

  Control variable to receive result
  Select the variable to receive the information from the control activated macro.

Modify the top-level window title
When the Get Control or Capture Control commands are used, Macro Express saves a description of the Window Controls in the control variable. This information is used to identify the control. The information includes the name of the program and the name of the top-level window that contains the control.

  Note: This command modifies the content of a control variable. It does not modify the control itself.

Many programs, including but not limited to Internet Explorer, change the title of the top level window depending on what is happening within the program. By using the ‘Modify the Top-Level Window Title’ command, the Control Variable may be changed so that the Get Control or Capture Control commands are not needed again.
The window title can be either a partial or an exact match. For example, if using a control in Internet Explorer, use "Internet Explorer" as the window title, despite what the window title shows, and specify a partial match.

Use the Partial Title option of the ‘Modify Top-Level Window Title of Control Variable’ command to modify the window title (stored in the Control variable) to work with either Edit or View modes. In the example above, the title could be set to ‘Sample #5’. To make this even more flexible, change it to ‘Sample #’ so that it works in Edit and/or View modes and with all items in the database.

Example
Consider a program that has ‘Edit’ and ‘View’ modes. When in Edit mode the title bar displays ‘Edit Sample #5’. When in View mode the title bar shows ‘View Sample #5’. In this example, there is an OK button on the form.

If Edit mode is open when the macro is created to access the OK button on the form, the macro will not work when in View mode ... even though it is the same control. There are two choices. Use two Get Control commands to capture the control in both Edit and View modes. Or, use one Get Control command and use the ‘Modify the Top-Level Window Title’ command to change the Window title.

When using controls, the top-level window is the main window that contains the control. This command allows the user to adjust what window title the control looks for. For example, Internet Explorer changes its window title often. This option allows the user to define one control variable and use it to work with different windows in order to perform actions with the desired control.
Variable Modify Decimal

Use the Variable Set Decimal command to assign a decimal value to a variable. The commands listed below modify or manipulate the original decimal variable.

**Note:** A decimal variable (D[1]) can range from $5.0 \times 10^{-324}$ to $1.7 \times 10^{308}$ with 15 to 16 significant digits. This first example is a decimal expanded to include 324 leading zeros followed by the number 5, represented as $.000(321$ more zeros)5. The second range extends to 17 followed by 308 zeros which would look like $1700000000(300$ more zeros).0. The numbers are rounded to 15 or 16 significant digits.

**Add**
Add a decimal variable to a number or to a second decimal variable. Save the results to another decimal variable.

- **Destination Decimal Variable**
  Select the variable to receive the results of the addition.

- **Value One / Value Two**
  Insert either a decimal value or a decimal variable into these fields. The values are added and saved to the variable selected.

**Subtract**
Subtract a decimal variable from a number or from another decimal variable or subtract a number from a decimal variable. The result is placed in the decimal variable selected.

- **Decimal Variable**
  Select the variable to receive the results of the subtraction.

- **Value One / Value Two**
  Insert either a decimal value or a decimal variable into these fields. The values are subtracted and saved to the variable selected.

**Multiply**
Multiply a decimal variable with a number or with another decimal variable and place it in the decimal variable selected.
Decimal Variable
Select the variable to receive the results of the multiplication.

Value One /Value Two
Insert either a decimal value or a decimal variable into these fields. The values are multiplied and saved to the variable selected.

Divide
Divide a decimal variable with a number or with another decimal variable or divide a number with a decimal variable. The result can be placed in the decimal variable chosen.

Decimal Variable
Choose the variable to receive the results of the division.

Value One /Value Two
Insert either a decimal value or a decimal variable into these fields. The values are divided and saved to the variable selected.

Round
This command rounds the value of a decimal variable to the number of decimal places selected. If copying a decimal value and saving it to a variable or modifying a decimal variable through multiplication or division, use this feature to trim the number of decimal places. Just select the variable to round and insert the number of decimal places.

Decimal places to round to
Insert the number of decimal places to save to the variable.

Note: The Round Decimal Variable command uses asymmetric arithmetic rounding to determine how to round values that are exactly midway between the two values that have the desired number of significant digits. This method always rounds to the larger value.

The following examples illustrate the use of the Rounding command:

For example:
- If %D[1]% is 1.234 then Round Decimal Variable %D[1]% to 2 decimal places results in 1.23
- If %D[1]% is 1.235 then Round Decimal Variable %D[1]% to 2 decimal places results in 1.24
- If %D[1]% is -1.235 then Round Decimal Variable %D[1]% to 2 decimal places results in -1.23

Convert to Text String
Use this command to convert a decimal variable to a text variable. Specify the number of decimal places to use.

Destination String Variable
Select the string variable to receive the decimal variable value.

Decimal Places
Insert the number of decimal places to save to the text string variable.

Truncate to Integer
Use this command to convert a decimal variable to an integer variable. Any fractional part of the decimal value is truncated.

Integer Variable
Select the integer variable to receive the truncated decimal variable value.
**Remove Integer Portion**
Use this command to remove the integer value portion (whole numbers) from the decimal variable. For example, if the decimal variable has a value of 1.9087653, the new value would be .9087653.

**Destination Decimal Variable**
Select the decimal variable to receive the value with the integer portion removed.

**Copy Value**
Copy the value of one decimal variable to another decimal variable.

**Destination Decimal Variable**
Select the decimal variable to receive the value of the copied decimal variable.
Variable Modify Integer

Use these commands to modify or manipulate an integer variable.

Script Editor > Expand Variables Category > Variable Modify Integer

Add
Add an integer variable to a number or to another integer variable and place the sum into an integer variable.

Destination Integer Variable
Choose the variable to receive the results of the addition.

Value One /Value Two
Insert either an integer value or an integer variable into these fields. The values are added and saved to the variable selected.

Subtract
Subtract integers and/or integer variables. The result is placed in the integer variable chosen.

Destination Integer Variable
Select the variable to receive the results of the subtraction.

Value One /Value Two
Insert either an integer value or an integer variable into these fields. The values are subtracted and saved to the variable selected.

Multiply
Multiply an integer variable with a number or with another integer variable and place the result into the integer variable selected.

Destination Integer Variable
Select the variable to receive the results of the multiplication.

Value One /Value Two
Insert either an integer value or an integer variable into these fields. The values are multiplied and saved to the variable selected.
Divide
Divide an integer variable with a number or with another integer variable or divide a number with an integer variable. The result is placed into the integer variable chosen.

Destination Integer Variable
Select the variable to receive the results of the division.

Value One / Value Two
Insert either an integer value or an integer variable into these fields. The values are divided and saved to the variable selected.

Convert to String
This command converts an integer variable to a text variable.

Integer Variable
Select the variable to be converted to a text string variable.

New Variable
Select the name of the new variable to contain the contents of the integer variable.

Convert to Decimal
Converts an integer variable to a decimal variable.

Integer Variable
Select the variable to be converted to a decimal variable.

New Variable
Select the name of the new variable to contain the contents of the integer variable.

Copy Value
This command copies the value of one integer variable to another integer variable.

Destination Integer Variable
Select the variable to be receive the copied information.

Variable to Copy
Select the variable to copy its contents to another integer variable.

Increment
This option increases the value of the selected variable by one. For example, if variable N[1] had an original value of 25, the value would change to 26 after running this command.

Decrement
This option decreases the value of the selected variable by one. For example, if variable N[1] had an original value of 25, the value would change to 24 after running this command.
Variable Modify String

The functions discussed in this topic modify the values of text string variables previously created in the macro.

Don't process embedded variables
This option is for use when the variable being modified contains variables or a combination of % symbols. Select this option to have the macro ignore any variables embedded in the variable to be modified.

In the image above, we will assume that the variable %Start% contains another variable - %T[15]%. When the "Don't process embedded variables" option is selected %T[15]% is saved to the %Results% variable rather than the expanded value of the variable.

This feature is available for the following Variable Modify String options: Append Text, Copy Whole Text, Copy Part of Text, Replace Substring, Save to Clipboard, Save to Text File, Append to Text File, Save to INI File and Save to Environment Variable.

Trim
The Trim option removes all spaces and control characters on the left and on the right of the text string variable being modified.

Left Trim
Left Trim removes all spaces and control characters to the left of the text string variable being modified.

Right Trim
Right Trim removes all spaces and control characters to the right of the text string variable being modified.
Strip CR/LF
Strip CR/LF removes any Carriage Returns and Line Feeds embedded in the text string variable being modified.

Convert to Integer
Use this function to convert the value of a text string variable to an integer variable. If the text variable does not contain a valid value to be converted to an integer (i.e. non-numeric characters), then the integer value is set to zero.

Convert to Decimal
Use this option to convert the value of a text string variable to a decimal variable. If the text variable does not contain a valid value to be converted to a decimal (i.e. non-numeric characters), then the decimal value is set to zero.

Append Text
The Append Text function adds text to the end of an existing text string variable.

   Text to Append
   Insert the text to be added to the variable selected.

Append Text String Variable
The Append Text String Variable command combines the contents of one text variable with another text variable. The text is appended to the end of the receiving variable.

   Text Variable
   Select the variable to receive the additional text from the second variable.

   Text Variable to Append
   Select the variable to be appended to the first string variable.

Copy Whole Text
The Copy Whole Text command copies the contents of a text string variable to new text string variable.

   Text Variable
   Select the variable to receive the copy.

   Text Variable to Copy
   Select the variable to be copied to another variable.

Copy Part of Text
The Copy Part of Text function copies a portion of the contents of one text string variable to another text string variable. Specify the starting position and the number of characters to copy. The starting position and the characters to copy can be set to either a value or set to an integer variable. Integer variables can be created using the length of a text variable or the position of text in a text variable, providing much greater flexibility in determining what to copy.

   Text Variable
   Select the variable to receive the copy.
Variable to Copy From
Select the variable from which to copy a portion of the text.

Starting Position
The Starting Position indicates the first character to copy. To start with the 5th character in the variable, insert 5 as the starting position.

Number of Characters to Copy
Insert into this field the number of characters to copy.

Delete Part of Text
The Delete Part of Text command deletes a portion of the contents of a text string variable. Specify the starting position and the number of characters to delete. The starting position and the characters to delete can be set to either a value or set using an integer variable. Integer variables can be created using the length of a text variable or the position of text in a text variable, providing much greater flexibility in determining what to copy.

Text Variable
Select the variable from which to delete part of the text.

Starting Position
The Starting Position indicates the first character to be deleted. If starting with the 5th character in the variable, insert 5 as the starting position.

Number of Characters to Delete
Insert in this field the number of characters to delete.

Uppercase
The Uppercase command converts the entire contents of a text string variable to uppercase letters.

Lowercase
The Lowercase command converts the entire contents of a text string variable to lowercase letters.

Pad Left
The Pad Left function pads the left side (beginning) of a text string variable with spaces. Specify the width that the resulting variable should occupy. For example, if the text variable contained the name "Fred" and the Pad Left width is set to 15, a total of 11 spaces would be added to the left side of (before) "Fred" since "Fred" takes up 4 spaces (4 + 11 = 15). The pad left can be used for right justifying values such as columns of numbers.

Width of Text
Insert the total width that the variable should occupy.

Pad Right
The Pad Right function pads the right side (end) of a text string variable with spaces. Specify the width that the resulting variable should occupy. For example, if the text variable contained the name "Fred" and the Pad Right width is set to 15, a total of 11 spaces would be added to the right side (end) of "Fred" since "Fred" takes up 4 spaces (4 + 11 = 15). The pad right can be used for left justifying values.

Width of Text
Insert the total width that the variable should occupy.

Replace Substring
The Replace Substring option locates a string of text within the text string variable and replaces it with other text.
Text to Replace
Enter the text found in the variable selected that is to be replaced.

Replace Text With
Insert the text to replace the text currently found in the variable.

Replace All Instances
Check this box to have every instance of the text string replaced. With this box not checked, the first instance of the text string is replaced. Any other instances are ignored.

Ignore Case
The Ignore Case option ignores upper and lower case letters in the substring. The replacement takes place even if the case does not match. If this option is not selected, an exact match is required in order for the replacement to occur.

Save to Clipboard
This option saves the contents of the selected text string variable to the Windows Clipboard.

Save to Text File
Save to Text File saves the contents of the selected text string variable to a text file.

Filename
Select the file to receive the text saved to the variable. Insert the name of the file and path or click on the Browse button to locate the text file.

Add a Trailing CR/LF
This option inserts a carriage return or line feed to the end of the text string that is saved to the text file.

Append to Text File
Append to Text File appends the contents of the text string variable to the end of a text file. The text is positioned after any text that already exists in the file.

Filename
Select the file to receive the text saved to the variable. Insert the name of the file and path or click on the Browse button to locate the text file.

Add a Trailing CR/LF
Add a Trailing CR/LF option inserts a carriage return or line feed at the end of the text string saved to the file. Any subsequent appending to the text file would start on a new line.

Save to INI File
Save the contents of a text string variable to an INI file.

INI File Name
Insert the INI file name and path in this field or click on the Browse button to locate the file.

Key - Insert the Key name in this field.
Value - Insert the Value name in this field.

Save to Environment Variable
Windows maintains "global" variables that the system can access at any point. Some common ones are as follows:
temp -- holds the location of the temporary folder on the computer
windir -- holds the folder name where windows is installed
path -- holds a number of folder names where files should be searched if a file cannot be found in the current folder

Use this command to set up environmental "global" variables for later use or to modify existing variables. A complementary command that can "read" an environment variable is part of the Variable Set String commands.

Additional information about Environmental Variables from Microsoft

To determine which Environment variables exist on your computer, run the Command Prompt. Type set in the Command Prompt window and press Enter to view the Environment variables.

--- Definition #1 ---

Environment variable
An element of the operating system environment, such as a path, a directory name, or a configuration string. Environment variables are typically set within batch files.

--- Definition #2 ---

Environment variables specify search paths for files, directories for temporary files, application-specific options, and other similar information. The system maintains an environment block for each user and one for the computer. The system environment block represents environment variables for all users of the particular computer. A user's environment block represents the environment variables the system maintains for that particular user, including the set of system environment variables.
Variable Restore

The Variable Restore command used in conjunction with the Variable Save command is the key to passing variables between independently running macros.

Used with the Variable Save command, variables can be passed quite easily from one macro to the next on independent running of macros. Where one macro saves out the variables to memory, the next macro can restore variable values used in the first macro.

The Variable Restore command restores values of variables from system memory. Select to restore all variables or a specific variable type, such as Text String, Control, Integer, etc.

**Example**

At the end of the Macro A script, insert a Variable Save command to save all variable values to memory.

At the beginning of the Macro B script, insert a Variable Restore command. This utilizes the values of the variables created in Macro A in Macro B.

**Note 1:** Upon closing the Macro Express Player or rebooting Windows, the values of the variables saved to memory are lost.

**Note 2:** Only Global variables may be restored. Local variables are not saved with the Variable Save command and therefore cannot be restored.
Variable Save

This command, along with the Variable Restore command, is the key to passing variables between independently running macros.

Used in conjunction with the Variable Restore command, variables can be passed quite easily from one macro to the next on independent running of macros. Where one macro saves out the variables to memory, the next macro can restore variable values used in the first macro.

The Variable Save command saves the values of variables set in the macro to system memory. Select to save all variables or a specific variable type, such as Text String, Control, Integer, etc.

**Example**
At the end of the Macro A script, insert a Variable Save command to save all variable values to memory.

At the beginning of the Macro B script, insert a Variable Restore command. This utilizes the values of the variables created in Macro A in Macro B.

**Note 1:** Upon closing the Macro Express Player or rebooting Windows, the values of the variables saved to memory are lost.

**Note 2:** Only Global variables may be restored. Local variables are not saved with the Variable Save command and therefore cannot be restored.
Variable Set Control Text

The Variable Set Control Text command changes the text in the control variable in order to look for the control using different text. For example, if the "Get Control" command was used to capture an edit box, Macro Express will not be able to find the edit box on playback if the text changes.

Below is an example of how this works. Capture an edit box containing the word "Testing". Subsequently the word "Testing" is changed to the word "Macro". In this case the macro would not find the edit box. But, knowing that the edit box could contain the word "Macro" then the Variable Set Control Text command will help. Set the New Text to "Macro" and the edit box would be found if it contained the word "Macro".

Control variable to have text modified
Select the control that is to be modified.

New Text
Insert the text that will modify the control variable.

Note 1: This command affects the Control Variable only. It does not affect the control in the application.

Note 2: Macro Express uses two different methods to identify a control.

Method one identifies the Class name of the control and the Text contained in the control. For example an OK button may have a class name of Button and the text of OK.

Method two identifies the Class name and what is called the Z index. Basically the Z index is the order that the control appears on the form. For example you may have two buttons, "OK" and "Cancel". Macro Express will identify the OK button as class name Button and Z index of 12, but will identify the Cancel button as class name Button and Z index 13.
The second method is the only one that can be used with the Variable Set Control Text command. Select which method to use when capturing a control. Leave the Capture Using Text option unchecked to capture using this second method.
Variable Set Decimal

The Variable Set Decimal command assigns a value to a decimal variable. This command provides three options for setting a decimal variable. Use the Modify Decimal Variables command to manipulate the original values assigned to a macro.

**Note:** A decimal variable can range from $5.0 \times 10^{-324}$ to $1.7 \times 10^{308}$ with 15 to 16 significant digits. This first example is a decimal expanded to include 324 leading zeros followed by the number 5, represented as .000(321 more zeros)5. The second range extends to 17 followed by 308 zeros which would look like 1700000000(300 more zeros).0. The numbers are rounded to 15 or 16 significant digits.

Script Editor > Expand Variables Category > Variable Set Decimal

**What method would you like to use?**
Select from the drop down list the method required for defining the variable. Each of the options are described below.

**Set Value Now**
The Set Value Now option assigns a value to the decimal variable now for use later in the macro.

- **Destination Variable**
  Select a variable to use or create a new decimal variable.

- **Initial Value**
  Insert the contents of the variable in this field.

**Prompt for Value**
The Prompt for Value function opens an edit box during macro playback. The user is prompted to insert a decimal value.
**Destination Variable**
Select a variable to use or create a new decimal variable.

**Prompt**
Optionally enter text in the Prompt edit field to explain the type of value the user should input. During macro playback, the instructions appear above the input field.

**Mask the Input**
The Mask the Input option masks the text entered into the input box and is viewed as *** instead of the actual digits.

**The dialog should always be on top**
This option makes sure that the prompt window is always on top of other open windows.

**Positioning the Prompt window**
Use this feature to define the position on the screen where the input box will appear during the playback of the macro. Insert exact coordinates or use the Set Position button to set where the window should appear. See the [Window Positioning](#) topic for additional information.

**Hint: Setting a Default Value in the Prompt Window**

First use the Set Value Now option. Insert the decimal value that you want set as the default. Then use the Prompt for Value option. Both options must reference the same variable, such as D[1]. When the macro is run, the prompt window displays the default value. The user can overwrite, amend, accept or append to this value.

Below is a sample of the commands as they would look in the Scripting Editor. The decimal .52 is the default value.

```
Variable Set Decimal %D[1]% to .52
Variable Set Decimal %D[1]% from Prompt
```

**Set Value from Clipboard**
Set Value from Clipboard examines the text contents of the clipboard. It takes this value and strips off any spaces, carriage returns or line feeds. It then attempts to convert the contents to a decimal value and place it in the variable. If a non-decimal value (i.e. a string of text) is in the clipboard or the text clipboard is empty, the variable value is set to zero.

**Destination Variable**
Select a variable to use or create a new decimal variable.
Variable Set from File

The Variable Set from File command obtains either the date and time of a specific file or the path of the file and saves the information to variables. Compare the variables for possible further action. For example, check to verify if the tested file should be replaced with one that has a more recent date and time.

Get File Date/Time

The Get File Date/Time option obtains the date and time of the file specified and saves the information into Integer variables. There are three different time frames to choose from.

- **Creation Date/Time** - The date and time that the file was originally created.
- **Modified Date/Time** - The date and time that the file was last modified or updated and saved.
- **Last Accessed Date/Time** - The date and time that the file was last accessed or opened.

**Note:** Not every file system supports all three of these date/time formats. Macro Express issues a warning during playback if the format selected is not available.

The date and time components are broken down to six different variables as described below.

**Month/Date/Year**

In the example above, the month is saved to Integer variable N[1], the day to N[2] and year to N[3]. So if the file date was December 25, 2016, the value saved to variable N[1] would be 12. The value saved to N[2] would be 25. And the value saved to N[3] would be 2016.

- **Month** - The month is saved to the variable as 1 through 12.
- **Day** - The day is saved to the variable as 1 through 31.
• **Year** - The year is always saved to the variable as a four digit number.

**Hour/Minute/Seconds**

• **Hour** - The hour is saved in a 24 hour format. If the file time were between midnight and 1:00am, the hour would be saved to the variable as 0. If the file time was between 11:00 am and noon, the hour would be saved to the variable as 11. If the file time was between 11:00 pm and midnight, the hour would be saved to the variable as 23.
• **Minute** - Minutes are saved to variables as 0 to 59.
• **Seconds** - Seconds are also saved to variables as 0 to 59.

---

**Get File Path Info**

The Get File Path option obtains the file path of a particular file and saves the information into text string variables. The file path is split into four distinct units, as explained below.

![Variable Set From File](image)

- **Drive** - This is the letter drive on the computer, including the colon.
- **Path** - This variable contains the folder or folders where the file is located.
- **Filename** - This variable contains just the name of the file without the file extension.
- **Extension** - This variable contains the file extension, such as .txt, .bmp or .exe.
**Example**
For the file displayed in the image above, here is what would be saved to each variable.

<table>
<thead>
<tr>
<th>Drive</th>
<th>Path</th>
<th>Filename</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:</td>
<td><code>\Program Files (x86)\Macro Express\</code></td>
<td>MacExp</td>
<td>.exe</td>
</tr>
</tbody>
</table>

**Expand the File Name**
The Expand Filename converts a relative file name into a fully qualified path name. For example, if the current directory is `c:\Temp` and the Filename/Path is `..\work.txt` and Expand Filename is unchecked, then resulting values would be:

- Drive: \n- Path: ..\  
- Filename: work  
- Extension: .txt

But if Expand Filename is checked, then the resulting values would be:

- Drive: c:  
- Path: \  
- Filename: work  
- Extension: .txt

**Get File Size**
The Get File Size option obtains the size of the file selected and saves it to a variable. The value is saved in bytes.

**Store Size In**
Enter the variable name to receive the file size.
Variable Set from Miscellaneous

The Variable Set from Miscellaneous command is used to retrieve a variety of information about the computer, the macro file, or Macro Express.

Variable to receive the information
Select the text string variable to store the information retrieved. The variable can be used later in the macro.

Value to retrieve
Select the information needed from the drop down list. This information is stored in the variable chosen.

1. Obtain the path information to various folders on the computer such as My Documents shown in the example above.
2. Obtain various Macro Express information such as the macro file in use, the installation path, where the Macro Express preference settings are stored, etc.
3. Retrieve machine specific information such as owner name, machine name, etc.

List of values available
- Path to My Documents
- Path to Start Menu
- Path to Desktop
- Path to Common Documents
- Path to Common Start Menu
- Path to Common Desktop
- Installation Path
- Preferences Registry Key
- Name of Current Macro
- Name of Machine
- User Name
- Registered Owner
- Registered Company
Variable Set Integer

This command assigns a value to an integer variable. Once saved to an integer variable, use the Modify Integer Variable commands or others to manipulate the original values.

**Note:** An integer variable (N[1], etc.) can range from \(-2,147,483,648\) to \(2,147,483,647\). When the value exceeds \(2,147,483,647\), it 'wraps'. If an integer variable contains \(2,147,483,647\) and 1 is added to it, the integer variable will contain \(-2,147,483,648\).

What Method Would You Like to Use?
Select from the drop down list the method required for defining the variable. Each of the options are described below.

**Set Value Now**
Set Value Now assigns a value to the variable now. Enter the variable value and save. This value will be used when the macro is run.

- **Destination Variable**
  Select a variable to use or create a new integer variable.

- **Initial Value**
  Insert the contents of the variable in this field.

**Prompt for Value**
Prompt for Value opens an input box when the macro runs and prompts the user to input an integer value.

- **Destination Variable**
  Select a variable to use or create a new integer variable.
Prompt
Optionally enter text in the Prompt edit field to explain the type of value the user should input. The instructions appear above the input field during macro playback.

Mask the Input
The Mask the Input option masks the text entered into the input box and is viewed as *** instead of the actual digits.

The dialog should always be on top
This option makes sure that the prompt window is always on top of other open windows.

Positioning the Prompt window
Use this feature to define the position on the screen where the input box will appear during the playback of the macro. Insert exact coordinates or use the Set Position button to set where the window should appear. See the Window Positioning topic for additional information.

Hint: Setting a Default Value in the Prompt Window
First use the Set Value Now option. Insert the integer value to be set as the default. Then use the Prompt for Value option. Both options must reference the same variable, such as N[1]. When the macro is run, the prompt window displays the default value. The user can overwrite, amend, accept or append to this value.

Below is a sample of the commands as they would look in the Scripting Editor. The number 10 is the default value.

Variable Set Integer %N[1]% to 10
Variable Set Integer %N[1]% from Prompt

Set to the Mouse X Coordinate
Set to the Mouse X Coordinate examines the current mouse position on the screen at macro runtime and places the X pixel coordinate of the mouse position in the variable.

Destination Variable
Select a variable to use or create a new integer variable.

Set to the Mouse Y Coordinate
Set to the Mouse Y Coordinate examines the current mouse position on the screen at macro runtime and places the Y pixel coordinate of the mouse position in the variable.

Destination Variable
Select a variable to use or create a new integer variable.

Set to the Size of a File
Set to the Size of a File examines the size of the file selected. The file size (in bytes) is saved to the variable.

Destination Variable
Select a variable to use or create a new integer variable.

Filename
Insert the name of the file and path to be examined or click on the Browse button to select the file.
Set to a Random Value
Set to a Random Value saves a random number to an Integer variable. Select the range of Integer values. If 5 is selected as the minimum value and 99 as the maximum value, then the possible random number may be any integer from 5 to 99.

Destination Variable
Select a variable to use or create a new integer variable.

Minimum Value
Insert the lowest number that may be included as a possible random number.

Maximum Value
Insert the highest number that may be included as a possible random number.

Set to the Screen
These two options save the width or height of the screen to an integer variable. Select a variable to use or create a new integer variable.

Set to the Screen Width
The integer value is set to the width of the screen. The value assigned is the number of pixels in the width of the screen.

Set to the Screen Height
The integer value will be set to the height of the screen. The value assigned is the number of pixels in the height of the screen.

Set to the Current Window
These four commands examine the current window that has focus and saves values to the variable. Select a variable to use or create a new integer variable.

Set to the Current Window's Top
Set to the Current Window's Top examines the window that is currently on top of all others, specifically its location on the screen. This function obtains the top position (in X,Y screen coordinates) of the window and places the value in the variable. Note: Obtain the bottom coordinate of the window by adding the Window Top to the Window Height.

Set to the Current Window's Left
Set to the Current Window's Left examines the window that is currently on top of all others, specifically its location on the screen. This function obtains the left position (in X,Y screen coordinates) of the window and places the value in the variable. Note: Obtain the right coordinate of the window by adding the Window Left to the Window Width.

Set to the Current Window's Width
Set to the Current Window's Width examines the size of the window that is currently on top of all other open windows. This function obtains the width (in pixels) of the window and places the value in the variable.

Set to the Current Window's Height
Set to the Current Window's Height examines the size of the window that is currently on top of all other open windows. This function obtains the height (in pixels) of the window and places the value in the variable.

Set to the Clipboard Value
Set to the Clipboard Value examines the text contents of the clipboard. It reads this value and strips off any spaces, carriage returns or line feeds. This function then attempts to convert the value to an integer and place it in the variable. If a non integer value (i.e. a string of text) is in the clipboard or the clipboard is
empty, the variable value is set to zero.

**Destination Variable**
Select a variable to use or create a new integer variable.

### Set to the Length of a Text Variable
Set to the Length of a Text Variable counts the number of characters in a text string variable and saves that number to an integer variable. For example, if the length of text string variable T[1] is 100 characters, then the value saved to the Integer variable is 100.

**Example**
This example shows how to obtain the last 14 characters of a text string when the string is of varying lengths.

For this example, the text string is saved to variable T[1]. The text string could have been copied to the clipboard and then saved to a variable, extracted from a Text File, input by a user, or any number of ways.

1. Variable Set Integer %N[1]% to the length of variable %T[1]%
2. Variable Modify Integer: %N[1]% = %N[1]% - 13
3. Variable Modify String %T[2]% to a substring in %T[1]% starting at %N[1]% and 14 characters long

- Step one calculates the length of the text string variable and saves the value to N[1].
- Step two subtracts 13 characters from the length of the string and saves the new value to N[1].
- The last step copies just the last 14 characters of the string and saves the text to a new value of T[2].

**Destination Variable**
Select a variable to use or create a new integer variable.

**Text Variable**
Enter the variable name or select the text variable that is to be examined.

### Set to the Position of Text in a Text Variable
Set to the Position of Text in a Text Variable locates specific text in a text string variable and saves the location (position) to an integer variable.

For example, if variable T[1] contained "myemailaddress@myisp.com", this command could find the location of the @ symbol in the string. The integer variable would be set to 15 as @ is the 15th character. This information could then be used to delete or copy all of the text found before the @ symbol, or after. **Note:** If the text string cannot be found during playback of the macro, the position is set to (0) zero.

Also look at the Split String command for another text string manipulation option.

**Example**

\[509\]
Example
This example shows how to save all characters before the @ symbol to a new text string variable when the string is of varying lengths. If the text string was always the same length, you would just use the Copy Part of Text option from the Variable Modify String command.

For this example, the text string is saved to variable T[1]. The text string could have been copied to the clipboard and then saved to a variable, extracted from a Text File, input by a user, or any number of ways.

4. Variable Set Integer %N[1]% to the position of "@" in %T[1]%
5. Variable Modify Integer: %N[1]% = %N[1]% - 1
6. Variable Modify String %T[2]% to a substring in %T[1]% starting at 1 and %N[1]% characters long

-Step one calculates the position of the @ symbol in the text string variable and saves the value to N[1].
-Step two subtracts one character from the length and saves the new value to N[1].
-The last step copies all of the characters before the @ symbol and saves the text to a new value of T[2].

Destination Variable
Select a variable to use or create a new integer variable.

Text Variable
Enter the variable name or select the text variable that is to be examined.

Text to Search for
Enter the text that you want to find in the variable you have selected.

Ignore case sensitivity
Select this option if you want to ignore upper or lower case letters in the string.

Set Value to Date or Time
These seven Date or Time functions set a value to the variable based on the date or time of the computer’s system clock. If the system clock is incorrect, the integer values will also be incorrect.

An example of using one of these options would be the Set Value From Current Hour. The macro could play one set of instructions if the system clock reads before 5:00pm or play back another set of instructions if the system clock reads after 5:00pm.

Select a variable to use or create a new integer variable.

Set to the Current Day
Set to the Current Day sets the integer value based on the current date. A value of 1 to 31 is saved to the variable.

Set to the Current Month
Set to the Current Month sets the integer value based on the current month. A value 1 to 12 is saved to the variable.

Set to the Current Year
Set to the Current Year sets the integer value based on the current year. The value is saved as a four digit number.
Set to the Current Day of Week
Set to the Current Day of Week sets the integer value based on the current day of the week. The day of the week is an integer between 1 and 7. Sunday is the first day (i.e. 1) of the week and Saturday is the seventh (i.e. 7).

Set to the Current Hour
Set to the Current Hour sets the integer value based on the current hour. The hours are set in military time. For example, 5:00pm would be set as 17:00, or 8:00am would be set as 8:00. The integer variable is saved as 17 for 5:00pm or 8 for 8:00am.

Set to the Current Minute
Set to the Current Minute sets the integer value based on the current minute. A value of 0 to 59 is saved to the variable.

Set to the Current Second
Set to the Current Second sets the integer value based on the current second. A value of 0 to 59 is saved to the variable.

Set to Control
These four commands are similar to the Set Value to the Current Window commands. But rather than look at the current window, these commands set the value from a specific control.

Controls refer to the identifiable parts of a specific application window. Controls may include such things as a button, an edit box, a toolbar, a window title bar or other items. The control may be part of the main application window or be part of a child window (a window within a window). Depending on how the application was written, the entire window may be a single control.

Set to a Control's Left
Set to a Control's Left examines the location on the screen of the selected Control. This function obtains the left position (in X,Y screen coordinates) of the Control and places the value in the variable. **Note:** Find the right position of the Control by adding the Control Left to the Control Width.

Set to a Control's Top
Set to a Control's Top examines the location on the screen of the selected Control. This function obtains the top position (in X,Y screen coordinates) of the Control and places the value in the variable. **Note:** Find the bottom position of the Control by adding the Control Top to the Control Height.

Set to a Control's Width
Set to a Control's Width examines the size on the screen of the selected Control. This function obtains the width (in pixels) of the Control and places the value in the variable.

Set to a Control's Height
Set to a Control's Height examines the size on the screen of the selected Control. The function obtains the height (in pixels) of the Control and places the value in the variable.

Computer Monitor
These monitor options obtain the width or height of a monitor in pixels, as well as determine the active monitor or the number of monitors in use. Then use the If Variable command to take specific actions based on the variable results.

Set to a Monitor's Width
Save the width of the monitor in pixels to an Integer variable. If using a single monitor, then insert 0 (zero) as the monitor number. If multiple monitors are connected to the system, then insert 0 as the first monitor, 1 (one) as the second monitor, 2 (two) as the third monitor, etc.
Set to a Monitor's Height
Save the height of the monitor in pixels to an Integer variable. If using a single monitor, then insert 0 (zero) as the monitor number. If multiple monitors are connected to the system, then insert 0 (zero) as the first monitor, 1 (one) as the second monitor, 2 (two) as the third monitor, etc.

Set to Number of Monitors
Determine the number of monitors attached to the system and save the value to an Integer variable. So, for example, if there are three monitors attached to the computer, then the Integer variable value would be 3.

Set to Active Monitor
This option saves the value of the active monitor (whichever monitor has focus) to an Integer variable. The values are similar to the monitor numbers mentioned above. The first monitor receives a value of 0 (zero). A second monitor receives a value of 1 (one), the third monitor 2 (two), and so on.

Get the Idle Time
Get the Idle Time calculates the computer idle time and saves the value to a variable. The idle time is specified as no mouse or keyboard activity occurring. The amount of time since the last mouse event or keyboard activity is saved to the Integer variable. The value is saved in time increments of seconds.

Desktop
These two desktop options obtain the width or height in pixels of the entire desktop, which may span more than one monitor. Macro Express retrieves the desktop size from what Windows reports as the desktop.

Set to Desktop Width
Save the width of the desktop in pixels to an Integer variable.

Set to Desktop Height
Save the height of the desktop in pixels to an Integer variable.
Variable Set String

The Variable Set String command assigns a value to a text string variable. Once saved to a string variable value, use the Modify String Variables command to manipulate the original values assigned in the macro.

Don't process embedded variables
This option is for use if the initial value text contains variables or a combination of % symbols. Select this option to have the macro ignore any variables embedded in the Initial Value field.

For example, select %T[15]% as the destination variable and insert %sample% in the Initial Value field. When the "Don't process embedded variables" option is selected %sample% will be stored in variable %T[15]% as %sample% rather than the expanded value of the variable.

This feature is available for the following Variable Set String options: Set Value Now, Set Value from Clipboard, Set Value from File, Set Value from INI File and Set from Environment Variable.

Set Value Now
Set Value Now assigns a value to the variable now, which will be used later in the macro.

Destination Variable
Select a variable to use or create a new string variable.

Initial Value
Insert the contents of the variable in this field.

**Prompt for Value**
Prompt for Value displays an input box during macro playback prompting the user to input a text string.

**Destination Variable**
Select a variable to use or create a new string variable.

**Prompt**
Enter text in the Prompt edit field to explain the type of value the user should input. During macro playback, the instructions appear above the input field.

**Mask the Input**
The Mask the Input option masks the text entered into the input box and is viewed as *** instead of the actual digits.

**The dialog should always be on top**
This option makes sure that the prompt window is always on top of other open windows.

**Positioning the Prompt window**
Use this feature to define the position on the screen where the input box will appear during the playback of the macro. Insert exact coordinates or use the Set Position button to set where the window should appear. See the [Window Positioning](#) topic for additional information.

---

**Hint: Setting a Default Value in the Prompt Window**

First use the Set Value Now option. Insert the text to be set as the default. Then use the Prompt for Value option. Both options must reference the same variable, such as T[1]. When the macro is run, the prompt window displays the default value. The user can overwrite, amend, accept or append to this value.

Below is a sample of the commands as they would look in the Scripting Editor. "This is a test" is the default value.

```
Variable Set String %T[1]% "This is a test"
Variable Set String %T[1]% from Prompt
```

---

**Set Value from Clipboard**
Set Value from Clipboard extracts the text currently saved to the clipboard and places it into the variable.

**Destination Variable**
Select a variable to use or create a new string variable.

**Set Value from File**
Set Value from File loads the contents of a text file into a variable.

**Destination Variable**
Select a variable to use or create a new string variable into which the file contents will be loaded.

**Filename**
Insert the file name and path into this field or click on the Browse button to select the file to be used.
Strip the trailing CR/LF characters
Use this option to save the text file contents to a variable with all trailing carriage returns or line feeds removed. This does not remove all CR/LFs from the variable, just any that trail the end of the text. Use the Variable Modify String - Strip CR/LF option to remove all carriage returns or line feeds from a text variable.

Set Value to Top Most Program Name
Set Value to Top Most Program Name examines the window that is currently on top of all others and determines what program it is from. It places the program name (i.e. the EXE file name) into the variable.

Destination Variable
Select a variable to use or create a new string variable.

Set Value to Top Most Window Title
Set Value to Top Most Window Title examines the window that is currently on top of all others, extracts the name that is in the caption bar (i.e. the Window Title) and saves it to the variable.

Destination Variable
Select a variable to use or create a new string variable.

Set Value to Current Folder Name
Set Value to Current Folder Name obtains the folder name that Windows is currently pointing to and saves the name to the variable.

Destination Variable
Select a variable to use or create a new string variable.

Set Value From INI File
Set Value From INI File obtains a value from an INI file and places it into a variable. Specify the file name of the INI file, the section name and the key name.

Destination Variable
Select a variable to use or create a new string variable.

Filename
Insert the name and path of the INI file in this field or browse to the file location.

Key - Insert the Key name in this field.
Value - Insert the Value name in this field.

Prompt for Filename
Prompt for Filename prompts the user to select a file during macro runtime by displaying a standard "Find File" dialog box. The file name and path chosen by the user are saved to the variable.

Destination Variable
Select a variable to use or create a new string variable.

Titlebar
Name the window title of the dialog box that opens. This may include instructions in the title bar for users to follow.
**Hint: Starting the Prompt in a Predetermined Folder**

When prompting for a file you may want to start the search from a specific folder, rather than starting at Computer, in order to save time. To do this, use the Variable Set String - Set Value Now command and save the starting folder path and a file in that folder to a variable. Use this variable in the Destination Variable field of the Prompt for Filename command.

Variable Set String %T[1]% to "C:\Users\Stan Jones\Documents\Insight Software Solutions\Testing\Sample.txt"
Variable Set String %T[1]%: Prompt for a filename

In the example above, the search prompt will start in the Testing folder to save time clicking through several other folders to arrive at the starting point you want.

---

**Prompt for Foldername**

Prompt for Foldername prompts the user with a standard "Browse for Folder" dialog box during macro playback. The folder name and path selected by the user are saved to the variable. If that variable is predefined, Macro Express looks to make sure that there are no invalid values in the variable string. The value will only be saved up to the invalid character in the string.

- **Destination Variable**
  Select a variable to use or create a new string variable.

- **Titlebar**
  Name the window title of the dialog box that opens. This may include instructions in the title bar for users to follow.

---

**Hint: Starting the Prompt in a Predetermined Folder**

When prompting for a folder you may want to start the search from a specific folder, rather than starting at Computer, in order to save time. To do this, use the Variable Set String - Set Value Now command and save the starting folder path to a variable. Use this variable in the Destination Variable field of the Prompt for Foldername command.

Variable Set String %Folder[1]% to "C:\Users\Howard\Documents\Insight Software Solutions\Macro Express"
Variable Set String %Folder[1]%: Prompt for a foldername

In the example above, the search prompt will start in the Macro Express folder to save time clicking through several other folders to arrive at the starting point you want.

---

**Set to a Random Letter**

Set to a Random Letter randomly selects a letter of the alphabet and saves the result to a variable.

- **Destination Variable**
  Select a variable to use or create a new string variable.

---

**Set from Environment Variable**

Set from Environment Variable obtains a value from an environmental variable and places it into a Text
String variable. The complementary command to write a text value to an environmental command may be found in the Variable Modify String window.

**Destination Variable**
Select a variable to use or create a new string variable.

**Environment Variable**
Select the Environmental Variable by clicking on the Variables button or type the variable name in the edit field.

### Additional information about Environmental Variables from Microsoft

To determine which Environment variables exist on your computer, run the Command Prompt. Type `set` in the Command Prompt window and press Enter to view the Environment variables.

--- **Definition #1** ---

Environment variable
An element of the operating system environment, such as a path, a directory name, or a configuration string. Environment variables are typically set within batch files.

--- **Definition #2** ---

Environment variables specify search paths for files, directories for temporary files, application-specific options, and other similar information. The system maintains an environment block for each user and one for the computer. The system environment block represents environment variables for all users of the particular computer. A user's environment block represents the environment variables the system maintains for that particular user, including the set of system environment variables.
Variable Set to ASCII Char

The Variable Set to ASCII Char command converts a numeric value into its ASCII character equivalent. For example, the number 65 represents the letter A. Or in the example below, the number 123 represents the character {. The range of values allowed is from 0 to 255.

![Variable Set to ASCII Char dialog box](image)

**Value to Convert**
Insert the numeric value to be converted to an ASCII character. Or insert a variable that contains the numeric value to be converted.

**Destination Variable**
The ASCII character that matches the numeric value is saved to a text string variable. Enter the variable name or click on the Variables button to select a variable for use.

---

**Chart of ASCII Characters 0 - 127**
For convenience, the list below displays the numeric value and the ASCII character represented by that number. Values 0 - 31 are non-printable characters, such as line feeds, tabs, etc. Extended ASCII codes 128 - 255 may be found with a quick online search.

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>#</th>
<th>Char</th>
<th>#</th>
<th>Char</th>
<th>#</th>
<th>Char</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null char</td>
<td>32</td>
<td>Space</td>
<td>64</td>
<td>@</td>
<td>96</td>
<td>'</td>
</tr>
<tr>
<td>1</td>
<td>Start of Heading</td>
<td>33</td>
<td>!</td>
<td>65</td>
<td>A</td>
<td>97</td>
<td>a</td>
</tr>
<tr>
<td>2</td>
<td>Start of Text</td>
<td>34</td>
<td>&quot;</td>
<td>66</td>
<td>B</td>
<td>98</td>
<td>b</td>
</tr>
<tr>
<td>3</td>
<td>End of Text</td>
<td>35</td>
<td>#</td>
<td>67</td>
<td>C</td>
<td>99</td>
<td>c</td>
</tr>
</tbody>
</table>

518
<table>
<thead>
<tr>
<th>4</th>
<th>End of Transmission</th>
<th>36</th>
<th>$</th>
<th>68</th>
<th>D</th>
<th>100</th>
<th>d</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Enquiry</td>
<td>37</td>
<td>%</td>
<td>69</td>
<td>E</td>
<td>101</td>
<td>e</td>
</tr>
<tr>
<td>6</td>
<td>Acknowledgment</td>
<td>38</td>
<td>&amp;</td>
<td>70</td>
<td>F</td>
<td>102</td>
<td>f</td>
</tr>
<tr>
<td>7</td>
<td>Bell</td>
<td>39</td>
<td>’</td>
<td>71</td>
<td>G</td>
<td>103</td>
<td>g</td>
</tr>
<tr>
<td>8</td>
<td>Back Space</td>
<td>40</td>
<td>(</td>
<td>72</td>
<td>H</td>
<td>104</td>
<td>h</td>
</tr>
<tr>
<td>9</td>
<td>Horizontal Tab</td>
<td>41</td>
<td>)</td>
<td>73</td>
<td>I</td>
<td>105</td>
<td>i</td>
</tr>
<tr>
<td>10</td>
<td>Line Feed</td>
<td>42</td>
<td>*</td>
<td>74</td>
<td>J</td>
<td>106</td>
<td>j</td>
</tr>
<tr>
<td>11</td>
<td>Vertical Tab</td>
<td>43</td>
<td>+</td>
<td>75</td>
<td>K</td>
<td>107</td>
<td>k</td>
</tr>
<tr>
<td>12</td>
<td>Form Feed</td>
<td>44</td>
<td>,</td>
<td>76</td>
<td>L</td>
<td>108</td>
<td>l</td>
</tr>
<tr>
<td>13</td>
<td>Carriage Return</td>
<td>45</td>
<td>-</td>
<td>77</td>
<td>M</td>
<td>109</td>
<td>m</td>
</tr>
<tr>
<td>14</td>
<td>Shift Out</td>
<td>46</td>
<td>.</td>
<td>78</td>
<td>N</td>
<td>110</td>
<td>n</td>
</tr>
<tr>
<td>15</td>
<td>Shift In</td>
<td>47</td>
<td>/</td>
<td>79</td>
<td>O</td>
<td>111</td>
<td>o</td>
</tr>
<tr>
<td>16</td>
<td>Data Line Escape</td>
<td>48</td>
<td>0</td>
<td>80</td>
<td>P</td>
<td>112</td>
<td>p</td>
</tr>
<tr>
<td>17</td>
<td>Device Control 1</td>
<td>49</td>
<td>1</td>
<td>81</td>
<td>Q</td>
<td>113</td>
<td>q</td>
</tr>
<tr>
<td>18</td>
<td>Device Control 2</td>
<td>50</td>
<td>2</td>
<td>82</td>
<td>R</td>
<td>114</td>
<td>r</td>
</tr>
<tr>
<td>19</td>
<td>Device Control 3</td>
<td>51</td>
<td>3</td>
<td>83</td>
<td>S</td>
<td>115</td>
<td>s</td>
</tr>
<tr>
<td>20</td>
<td>Device Control 4</td>
<td>52</td>
<td>4</td>
<td>84</td>
<td>T</td>
<td>116</td>
<td>t</td>
</tr>
<tr>
<td>21</td>
<td>Negative Acknowledgement</td>
<td>53</td>
<td>5</td>
<td>85</td>
<td>U</td>
<td>117</td>
<td>u</td>
</tr>
<tr>
<td>22</td>
<td>Synchronous Idle</td>
<td>54</td>
<td>6</td>
<td>86</td>
<td>V</td>
<td>118</td>
<td>v</td>
</tr>
<tr>
<td>23</td>
<td>End of Transmission Block</td>
<td>55</td>
<td>7</td>
<td>87</td>
<td>W</td>
<td>119</td>
<td>w</td>
</tr>
<tr>
<td>-----</td>
<td>---------------------------</td>
<td>------</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>-----</td>
<td>----</td>
</tr>
<tr>
<td>24</td>
<td>Cancel</td>
<td>56</td>
<td>8</td>
<td>88</td>
<td>X</td>
<td>120</td>
<td>x</td>
</tr>
<tr>
<td>25</td>
<td>End of Medium</td>
<td>57</td>
<td>9</td>
<td>89</td>
<td>Y</td>
<td>121</td>
<td>y</td>
</tr>
<tr>
<td>26</td>
<td>Substitute</td>
<td>58</td>
<td>:</td>
<td>90</td>
<td>Z</td>
<td>122</td>
<td>z</td>
</tr>
<tr>
<td>27</td>
<td>Escape</td>
<td>59</td>
<td>;</td>
<td>91</td>
<td>[</td>
<td>123</td>
<td>{</td>
</tr>
<tr>
<td>28</td>
<td>File Separator</td>
<td>60</td>
<td>&lt;</td>
<td>92</td>
<td>\</td>
<td>124</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Group Separator</td>
<td>61</td>
<td>=</td>
<td>93</td>
<td>]</td>
<td>125</td>
<td>}</td>
</tr>
<tr>
<td>30</td>
<td>Record Separator</td>
<td>62</td>
<td>&gt;</td>
<td>94</td>
<td>^</td>
<td>126</td>
<td>~</td>
</tr>
<tr>
<td>31</td>
<td>Unit Separator</td>
<td>63</td>
<td>?</td>
<td>95</td>
<td>_</td>
<td>127</td>
<td>Delete</td>
</tr>
</tbody>
</table>
Variable Set to ASCII Value

The Variable Set to ASCII Value command is essentially the inverse of the Variable Set to ASCII Character. It converts an ASCII character to its ASCII numeric equivalent. For example, the letter "a" converts to a numeric value of 97. The letter "A" converts to a numeric value of 65. The numeric value is saved to an Integer variable that can be used later in the macro.

ASCII Value to Convert
Enter the ASCII character to be converted to its ASCII numeric equivalent. Or insert the variable that contains the ASCII character to be converted.

Destination Variable
The ASCII character selected is saved as a numeric value and placed in an integer variable. In the example above the ASCII character "A" is saved to the variable selected, which in this case is N[1].

Chart of ASCII Characters 0 - 127
For convenience, the list below displays the numeric value and the ASCII character represented by that number. Values 0 - 31 and 127 are non-printable characters, such as line feeds, tabs, etc. Extended ASCII codes 128 - 255 may be found with a quick online search.

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>#</th>
<th>Char</th>
<th>#</th>
<th>Char</th>
<th>#</th>
<th>Char</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Null char</td>
<td>32</td>
<td>Space</td>
<td>64</td>
<td>@</td>
<td>96</td>
<td>'</td>
</tr>
<tr>
<td>1</td>
<td>Start of Heading</td>
<td>33</td>
<td>!</td>
<td>65</td>
<td>A</td>
<td>97</td>
<td>a</td>
</tr>
<tr>
<td>2</td>
<td>Start of Text</td>
<td>34</td>
<td>&quot;</td>
<td>66</td>
<td>B</td>
<td>98</td>
<td>b</td>
</tr>
<tr>
<td>3</td>
<td>End of Text</td>
<td>35</td>
<td>#</td>
<td>67</td>
<td>C</td>
<td>99</td>
<td>c</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Code</td>
<td></td>
<td>Code</td>
<td></td>
<td>Code</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>----------------------------------</td>
<td>------</td>
<td>---</td>
<td>------</td>
<td>---</td>
<td>------</td>
<td>---</td>
</tr>
<tr>
<td>4</td>
<td>End of Transmission</td>
<td>36</td>
<td>$</td>
<td>68</td>
<td>D</td>
<td>100</td>
<td>d</td>
</tr>
<tr>
<td>5</td>
<td>Enquiry</td>
<td>37</td>
<td>%</td>
<td>69</td>
<td>E</td>
<td>101</td>
<td>e</td>
</tr>
<tr>
<td>6</td>
<td>Acknowledgment</td>
<td>38</td>
<td>&amp;</td>
<td>70</td>
<td>F</td>
<td>102</td>
<td>f</td>
</tr>
<tr>
<td>7</td>
<td>Bell</td>
<td>39</td>
<td>'</td>
<td>71</td>
<td>G</td>
<td>103</td>
<td>g</td>
</tr>
<tr>
<td>8</td>
<td>Back Space</td>
<td>40</td>
<td>(</td>
<td>72</td>
<td>H</td>
<td>104</td>
<td>h</td>
</tr>
<tr>
<td>9</td>
<td>Horizontal Tab</td>
<td>41</td>
<td>)</td>
<td>73</td>
<td>I</td>
<td>105</td>
<td>i</td>
</tr>
<tr>
<td>10</td>
<td>Line Feed</td>
<td>42</td>
<td>*</td>
<td>74</td>
<td>J</td>
<td>106</td>
<td>j</td>
</tr>
<tr>
<td>11</td>
<td>Vertical Tab</td>
<td>43</td>
<td>+</td>
<td>75</td>
<td>K</td>
<td>107</td>
<td>k</td>
</tr>
<tr>
<td>12</td>
<td>Form Feed</td>
<td>44</td>
<td>,</td>
<td>76</td>
<td>L</td>
<td>108</td>
<td>l</td>
</tr>
<tr>
<td>13</td>
<td>Carriage Return</td>
<td>45</td>
<td>-</td>
<td>77</td>
<td>M</td>
<td>109</td>
<td>m</td>
</tr>
<tr>
<td>14</td>
<td>Shift Out</td>
<td>46</td>
<td>.</td>
<td>78</td>
<td>N</td>
<td>110</td>
<td>n</td>
</tr>
<tr>
<td>15</td>
<td>Shift In</td>
<td>47</td>
<td>/</td>
<td>79</td>
<td>O</td>
<td>111</td>
<td>o</td>
</tr>
<tr>
<td>16</td>
<td>Data Line Escape</td>
<td>48</td>
<td>0</td>
<td>80</td>
<td>P</td>
<td>112</td>
<td>p</td>
</tr>
<tr>
<td>17</td>
<td>Device Control 1</td>
<td>49</td>
<td>1</td>
<td>81</td>
<td>Q</td>
<td>113</td>
<td>q</td>
</tr>
<tr>
<td>18</td>
<td>Device Control 2</td>
<td>50</td>
<td>2</td>
<td>82</td>
<td>R</td>
<td>114</td>
<td>r</td>
</tr>
<tr>
<td>19</td>
<td>Device Control 3</td>
<td>51</td>
<td>3</td>
<td>83</td>
<td>S</td>
<td>115</td>
<td>s</td>
</tr>
<tr>
<td>20</td>
<td>Device Control 4</td>
<td>52</td>
<td>4</td>
<td>84</td>
<td>T</td>
<td>116</td>
<td>t</td>
</tr>
<tr>
<td>21</td>
<td>Negative Acknowledgement</td>
<td>53</td>
<td>5</td>
<td>85</td>
<td>U</td>
<td>117</td>
<td>u</td>
</tr>
<tr>
<td>22</td>
<td>Synchronous Idle</td>
<td>54</td>
<td>6</td>
<td>86</td>
<td>V</td>
<td>118</td>
<td>v</td>
</tr>
<tr>
<td>23</td>
<td>End of Transmission Block</td>
<td>55</td>
<td>7</td>
<td>87</td>
<td>W</td>
<td>119</td>
<td>w</td>
</tr>
<tr>
<td>24</td>
<td>Cancel</td>
<td>56</td>
<td>8</td>
<td>88</td>
<td>X</td>
<td>120</td>
<td>x</td>
</tr>
<tr>
<td>25</td>
<td>End of Medium</td>
<td>57</td>
<td>9</td>
<td>89</td>
<td>Y</td>
<td>121</td>
<td>y</td>
</tr>
<tr>
<td>26</td>
<td>Substitute</td>
<td>58</td>
<td>:</td>
<td>90</td>
<td>Z</td>
<td>122</td>
<td>z</td>
</tr>
<tr>
<td>27</td>
<td>Escape</td>
<td>59</td>
<td>;</td>
<td>91</td>
<td>[</td>
<td>123</td>
<td>{</td>
</tr>
<tr>
<td>28</td>
<td>File Separator</td>
<td>60</td>
<td>&lt;</td>
<td>92</td>
<td>\</td>
<td>124</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Group Separator</td>
<td>61</td>
<td>=</td>
<td>93</td>
<td>]</td>
<td>125</td>
<td>}</td>
</tr>
<tr>
<td>30</td>
<td>Record Separator</td>
<td>62</td>
<td>&gt;</td>
<td>94</td>
<td>^</td>
<td>126</td>
<td>~</td>
</tr>
<tr>
<td>31</td>
<td>Unit Separator</td>
<td>63</td>
<td>?</td>
<td>95</td>
<td>_</td>
<td>127</td>
<td></td>
</tr>
</tbody>
</table>
Window Controls

Controls - Overview

The use of the Control commands can be a very powerful addition to macro building. We will attempt to explain some of the benefits of using these commands in this page and subsequent topics. But first, here is a definition of controls from Microsoft:

"A control is a child window an application uses in conjunction with another window to perform simple input and output (I/O) tasks. Controls are most often used within dialog boxes, but they can also be used in other windows. Controls within dialog boxes provide the user with the means to type text, choose options, and direct a dialog box to complete its action. Controls in other windows provide a variety of services, such as letting the user choose commands, view status, and view and edit text."

For our purposes, controls refer to the identifiable parts of a specific application window. Controls may include such things as a button, an edit box, a toolbar, a window title bar or other items. The control may be part of the main application window or be part of a child window (a window within a window).

Assigning Controls to Variables
A Control type variable contains the control information. There are two commands that can be used to obtain the control information and assign it to a Control variable.

The first choice would be to use the Get Control command. This launches a small utility and a pointer that is dragged over top of a control. The control information is captured and assigned to a variable. In this case the control information is assigned while building the macro.

The other option is to use the Capture Control command. The control information is captured during the playback of a macro. The information is taken from the control sitting underneath the mouse cursor at the time the command is run.

Manipulating the Variable
After the information has been saved to a Control type variable, there are a number of options available for using this information.

<table>
<thead>
<tr>
<th>If Statements</th>
<th>Set up conditional If Control statements, such as if the Control is visible, has focus or is enabled. Or base the statement on if the control is not visible, doesn't have focus or is disabled.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse Click</td>
<td>Have the mouse click on the control at some point during the macro. This is a good way to make sure the correct button is pressed, the right edit field has focus, etc.</td>
</tr>
<tr>
<td>Set Focus</td>
<td>Set focus to the control during playback of the macro.</td>
</tr>
<tr>
<td>Set Control Text</td>
<td>This Set Control Text option defines the text for the control variable. This is helpful when the captured control is an edit box containing text.</td>
</tr>
<tr>
<td>Modify the Controls</td>
<td>The <strong>Variable Modify Controls</strong> options allow for copying the variable to another variable or to modify the top level window for more macro flexibility.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Post Message</td>
<td>The <strong>Post Message</strong> command allows the user to send a Windows message to a specific control.</td>
</tr>
<tr>
<td>Send Text Directly to a Control</td>
<td>The <strong>Text Type</strong> command includes a Send Text Directly to Control option. The text is inserted directly to the control (if the control selected accepts text input). The control must be running on the computer, but focus to the control is not required for the text to be inserted.</td>
</tr>
<tr>
<td>Wait for Control</td>
<td>Instruct a macro to <strong>wait for the control</strong> to gain focus, become visible or become enabled. Or cause the macro to wait for their opposites - wait for control to lose focus, become invisible or become disabled.</td>
</tr>
</tbody>
</table>

In summary, the controls open up many more possibilities for creating macros. Use them to more reliably work with Child Windows (windows within windows). Directly click on a button or go to a specific edit box without having to Tab through fields or position the mouse just right.

**Note:** Not every button, menu item or component on a program is actually a Control. Sometimes the only control in a given program is the window or dialog that pops up when the program starts. How the controls work depends on how the application was written.
**Capture Control**

The Capture Control command saves the Window Control information to a variable. The control information is captured during playback of the macro. Use the Get Control command to obtain the control information during the creation of the macro.

How to capture the control

Select to capture the control that currently has focus, is underneath the mouse cursor or at a specific location on the screen.

**Beneath Mouse**

During playback of the macro, this command determines the location of the mouse cursor. The control located beneath the mouse cursor is captured and saved to the variable in the "Save to" field.

**Focused Control**

During playback of the macro, this command determines which control has focus. The control information is captured and saved to the variable you specify.

**Specific Coordinates**

During playback of the macro, the mouse moves to the X and Y coordinates of the screen. The X coordinate represents the number of pixels from the left edge of the screen. The Y coordinate represents the number of pixels the mouse is positioned from the top of the screen.

If necessary, click on the Launch the Mouse Locator button to find the screen coordinates. The control that exists beneath these coordinates is captured. This control information is saved to the variable.

**Save to**

Save the control to a variable. Select the control variable to store the information.
Capture using the contents of the control

This option makes the capture of a control more exact by also capturing the text found in the control. So for example, assume capturing an edit box with the word Test in it. During playback the macro looks for the edit box and verifies that it contains the word Test. If the edit box text is changed to something else, such as Reset or left blank, then the control that was captured, such as C[1], will not match the actual control in the window - edit box.

**Note:** Not every button, menu item or component on a program is actually a Control. Sometimes the only control in a given program is the window or dialog that pops up when the program starts. We have also noticed that many of Microsoft's programs seem to have fewer controls than programs from other manufacturers. How the controls work depends on how the program was written.
Clear Control Cache

The Clear Control Cache command is inserted directly into the script as there is not an associated edit window. From the Script Editor click on the Window Controls category of commands to expand the category. Select Clear Cache Control to insert into the script.

When a control is used in Macro Express, the control data is cached. The information cached is used to help the Window Controls commands function more reliably.

The Clear Control Cache command clears the information that is being cached.
Get Control

The Get Control command saves the control information to a variable. A capture utility is launched to select buttons, edit boxes, etc. that can be used later in the macro. Use the Capture Control command to obtain the control information during playback of the macro.

Launch Utility

Below is an image of the window that appears when launching the control utility. Place the mouse cursor on the crosshair image, hold down the left mouse button and drag the mouse over the control needed. Drag it over title bars, buttons, edit boxes, forms, toolbars, etc.

After selecting the control, release the left mouse button. The Control Details edit field is populated with the control information. Click on the Save button to return to the Get Control Window. The control information is saved in the Get Control Window.
Save the control using the z-order of the control
This method saves the control information based on the order in which the controls are created or manipulated by the parent program. In some applications, the z-order may change without notice or the user being able to determine that it has changed.

Save the control using the contents of the control
This option makes the capture of a control more exact by also capturing the text found in the control. So for example, assume capturing an edit box with the word Test in it. During playback the macro looks for the edit box and verifies that it contains the word Test. If the edit box text is changed to something else, such as Reset or left blank, then the control that was captured, such as C[1], will not match the actual control in the window - edit box.

Save the control using its coordinates
There are some controls that change information each time the window with the control is opened or the program with the control is restarted as mentioned above. This renders the information saved to the control obsolete and the control will not be found the next time the macro is run. This Coordinates option saves the control information based on the location of the control in the window.

    Relative to the bottom-right
    Typically the coordinates of the control are measured from the top, left corner of the window that contains the control. Use this alternative method to obtain the position of the control from the bottom, right corner of the window.

    Restore parent window size
    This option restores the size of the parent window (the window that contains the control) to the size of the window when the original capture of the control was made.

Hide Macro Express
Hide Macro Express does what it implies. The program hides or gets out of the way after pressing the Launch Get Control Utility. This makes it easier to locate the application containing the control to capture.
Store the control in
Select the variable to store the control name and information.

Top Level Window Caption
The Top Level Window Caption contains the text that appears in the Window Title of the application where the control was captured.

Partial Match
A partial match allows the Control variable to find a Window Title that partially matches the name defined in the control.

Exact Match
An exact match requires that the Control variable find the Window Title that matches exactly - letter for letter.

Use wildcards
Select this option if using a wildcard in the window title. A wildcard would include a * or ??? characters in the title to expand the possibilities of a match.

**Note:** Not every button, menu item or component on a program is actually a Control. Sometimes the only control in a given program is the window or dialog that pops up when the program starts. We have also noticed that many of Microsoft's programs seem to have fewer controls than programs from other manufacturers. How the controls work depends on how the program was written.
Set Focus

Set Focus is similar to the Window Activate command, but uses a control instead. It brings the window that contains the selected control to the front and then sets focus to the control. This is most useful for edit box controls. Set focus to the edit box and then use the Text Type command to insert text, etc.

Set Focus to Control
First use the Get Control or Capture Control command to save the control to a variable. Then select the variable to receive focus.
Activate or Launch

The Activate or Launch command first looks to see if the program window selected is running. If so, the macro activates the window or brings focus to that window. If the window is not running, the macro launches the program and then activates the window.

Options

Window Title
Enter the title of the window to open. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

Exact Match
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

The name contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in
Program

Program/Path Name
Enter the complete file path and program name (typically a .exe file). Or click on the Browse button to search for the program desired. Select programs listed in the Start menu or from a list of processes running on the computer. If the program is not found, then click on the Browse button of the Select a Program window to access all programs on the computer.

Run Mode
Choose to have the program launch and either maximize, minimize, hide or display the window as it would normally at program launch. These options may not be available if the application being launched does not support them.

Program Parameters
Some programs allow values following the name of the program to make it behave in a specific manner. These are called Program Parameters and can be set in this field, if desired.

Advanced

Wait for ___ seconds after executing the command
This Wait option instructs the macro to wait after executing the program and attempting to switch to the window specified in the Window Title field. For many programs, this will simply be zero as no wait is required. For others, it may require a second or two delay. A little experimenting may be necessary.

Wait for ___ seconds after launching the program
This specifies the maximum time the macro should wait for the window title of the launched program to appear. Some programs may take a little while to load before the final window appears that has the correct window title. The default value for this field is 12 seconds.

Some larger programs may take longer than 12 seconds to load, especially on a fresh reboot of Windows where many common DLL's have not yet been loaded. Some experimenting with this value may be necessary when launching larger applications. But for most programs 12 seconds will be sufficient.
Launch Program and Activate Window

This command instructs the macro to launch a program and activate the window (or give focus to the window) that opens when the program is started. Define the window and program to launch.

Options

Window Title
Enter the title of the window to open. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

Exact Match
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

The name contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Program

Program/Path Name
Enter the complete file path and program name (typically a .exe file). Or click on the Browse button to search for the program desired. Select programs listed in the Start menu or from a list of processes running on the computer. If the program is not found, then click on the Browse button of the Select a Program window to access all programs on the computer.

Note: Any type of file extension that has been defined on the computer may be inserted in the Program Path/Name field. As long as there is a file type association set up in Windows for that particular file type, the corresponding program is loaded and the specific file is opened. For example, if inserting C:\My Documents in the file path, and .doc files are associated with Microsoft Word, then Microsoft Word starts and loads the test file.

Run Mode
Choose to have the program launch and either maximize, minimize, hide or display the window as it would normally at program launch. These options may not be available if the application being launched does not support them.

Program Parameters
Some programs allow values following the name of the program to make it behave in a specific manner. These are called Program Parameters and can be set in this field, if desired.

Start this Program in its Default Directory
Some programs require a specific default folder to be set before they are run. The default folder may contain the program shortcut or the program .exe file. This option allows the program to start from the default directory.

Advanced

Wait for ___ seconds After executing the command
This option instructs the macro to wait after executing the program and attempting to switch to the window specified in the Window Title field. For many programs, this will simply be zero as no wait is required. For others, it may require a second or two delay. A little experimenting may be required.

Wait for ___ seconds after launching the program
This specifies the maximum time the macro should wait for the window title of the launched program to appear. Some programs may take a little while to load before the final window appears that has the correct window title. The default value for this field is 12 seconds.

Some larger programs may take longer than 12 seconds to load, especially on a fresh reboot of Windows where many common DLL's have not yet been loaded. Some experimenting with this value may be necessary when launching larger applications. But for most programs, 12 seconds will be sufficient.
Program Launch

The Program Launch command instructs the macro to start a specific program. If the program cannot be found, the macro terminates. This option may not display the launched program on top of other programs currently running. To ensure that the program window opens at program launch, use the Launch Program and Activate Window command.

![Program Launch](image)

Script Editor > Expand Windows/Programs Category > Program Launch

Program
Program/Path Name
Enter the complete file path and program name (typically a .exe file). Or click on the Browse button to search for the program desired. Select programs listed in the Start menu or from a list of processes running on the computer. If the program is not found, then click on the Browse button of the Select a Program window to access all programs on the computer.

**Note:** Any type of file extension that has been defined on the computer may be inserted in the Program Path/Name field. As long as there is a file type association set up in Windows for that particular file type, the corresponding program will be loaded and the document specified will be opened. For example, if you insert C:\My Documents in the file path, and .doc files are associated with Microsoft Word, then Microsoft Word will start and load the test file.

Run Mode
Choose to have the program launch and either maximize, minimize, hide or display the window as it would normally at program launch. These options may not be available if the application being launched does not support them.

Program Parameters
Some programs can have values following the name of the program that can make the program behave in a specified manner. These are called Program Parameters and can be set here if desired.
Start this program in its default directory
Some programs require a specific default folder to be set before they are run. The default folder may contain the program shortcut or the program .exe file. This option allows the program to start from the default directory.

Capture Console Output
This option captures the standard output (stdout) from the launched application and places output in a variable. When using this option, the Macro Express script does not continue until the application being launched closes.

  **Store in variable**
  Select or input the variable to store the information output from the Console Application.

Advanced
Wait for _____ seconds after executing the command
This option instructs the macro to wait after executing the program. For many programs this value will simply be zero as no wait is required. For others, it may require a second or two delay. A little experimenting may be required.
**Program Shut Down**

Program Shut Down closes a program based on the window title name. While the Window Close command can be used to shut down a program if the window specified is the main window, the Program Shut Down option closes the program regardless of which program window is selected.

**Note:** Another option for closing programs is the Terminate Process command. This option also closes applications where the window title is not seen, such as notification area applications that run in the background.

---

**Choose a window**

First choose the window of the program to shut down. Select from the current window or specific window options.

**Current Window**

Current Window refers to the window that has focus when the Program Shut Down command is run in the macro.

**Specific Window**

Enter the title of the specific window to close. Or click on the Browse button to view a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

**Exact Match**

This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

**Partial Match**

The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is
not required. For example, "NOTepad" will work as well as "notepad".

**The title contains wildcards**
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.

Related Topics
Set Window Order

Set Window Order places a window as the top most window or sends it to the bottom of the list of windows open on the screen.

Select a window
First choose the window to order. Select from the current window or specific window options.

Current Window
Current Window refers to the window that has focus when the Set Window Order command is run in the macro.

Specific Window
Enter the title of the specific window or click on the Browse button to see a list of all windows currently running. Select the window to insert the title in the edit box.

Exact Match
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

Contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.

Place the window
After selecting the window, now choose the window order.
Always on top
This option sets the window so that it is always on top. If other windows are opened, the window selected still
displays on top of all others.

Remove topmost status and place on top
If the window was previously set to always be on top, this option removes the always on top status and
leaves the window on top of all others.

Otherwise this option places the window on top of all others, but does not set the always on top status.

Place on bottom
Place on Bottom sends the window to the bottom of the list of windows open on the computer.
**Terminate Process**

The Terminate Process command goes through several routines to make sure that the window or program selected is completely closed.

Identify by
First select whether to terminate the process by process name (typically a .exe file name) or by the window title.

Name
Based on the selection above, insert the name of the window or process to close. Or click on the Browse button to choose from a list of open windows or running processes.

If using the Close Window option, select an exact or partial match of the window title.

**Exact Match**
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

**Partial Match**
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

**Use wildcards**
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.

**Timeout:**
The Terminate Process command uses several methods to attempt to close the window or program. The Timeout setting determines how long Macro Express waits before trying the next method.
Window Activate

The Window Activate command activates the selected window or in other words brings focus to the window so that it can accept keystroke or mouse input.

![Window Activate](image)

Script Editor > Expand Windows/Programs Category > Window Activate

Window Title

Enter the title of the window to activate. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

**Exact Match**

This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

**Partial Match**

The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

**The name contains wildcards**

Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Window Close

This command instructs a window to close. If the window selected is the window that opens when the program loads, the application as well as the window closes.

Choose a window
Choose from the drop down list whether to close the current window or a specific window.

Use the current window
Current window refers to the window that has focus when the Window Close command plays in the macro.

Specify a window
Enter the title of the specific window to close. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

Exact Match
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

The title contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Related Topics
Window Hide

This instructs a window to be hidden from the screen. The window is still running, but is hidden from view. Use the Window Show command to display the window so that it returns to view.

Choose a window
Choose from the drop down list whether to hide the current window or a specific window.

Use the current window
Current Window refers to the window that has focus when the Window Hide command runs during macro playback. Whichever window is on top and has focus when the Window Hide command runs is hidden.

Specify a window
Enter the title of the specific window to hide. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

Exact Match
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

The title contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Window Maximize

The Windows Maximize command resizes a window to fill the entire screen.

Choose a window
Choose from the drop down list whether to maximize the current window or a specific window.

Use the current window
This refers to the window that has focus when the Window Maximize command runs during macro playback. Whichever window is on top and has focus when the Window Maximize command runs is maximized.

Specify a window
Enter the title of the specific window that you want to maximize. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

Exact Match
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

The title contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the "*" or "?" characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
**Window Minimize**

The Window Minimize command reduces the selected window to a button on the Task Bar.

Choose a window
Choose from the drop down list whether to minimize the current window or a specific window.

Use the current window
Current Window refers to the window that has focus when the Window Minimize command is run during macro playback.

Specify a window
Enter the title of the specific window to minimize. Or click on the **Browse** button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

*Exact Match*
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

*Partial Match*
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

*The title contains wildcards*
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Window Move and Size

The Window Move and Size command provides an easy method for sizing and positioning a window on the screen. Set up automated sequences for rearranging windows on the desktop. Or standardize the window position and size for each macro run to ensure that mouse moves and clicks work correctly.

Select a Window

Choose from the drop down list whether to reposition the current window or a specific window.

Current Window

This refers to the window that has focus when the Window Move and Size command runs.

Specific Window

Enter the title of the specific window to be moved and resized. Or click on the Select Window button to see a list of all windows currently running. Select the window needed and the title is inserted in the edit box.

Exact Match

This requires that the window name entered matches exactly with the name of the window to be moved and resized. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the command would fail.

Partial Match

The Partial Match option does not require an exact window title match. For example, if resizing or moving a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

Contains wildcards

Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Coordinates
Enter the coordinates manually or use the Size and Position Tool to simplify the process.

Specify Exact Size and Location
Enter the coordinates directly into the edit box. The Left and Top options determine the location of the window. The Height and Width options determine the size of the window. The values are expressed in pixels.

If using multiple monitors, select which monitor to display the window. The first monitor receives a value of 0 (zero). A second monitor receives a value of 1 (one), the third monitor 2 (two), and so on. If using a single monitor, leave the setting as 0.

Below is an example of setting the exact size and location of a window.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>100</td>
<td>The left edge of the window is positioned 100 pixels to the right of the left side of the screen.</td>
</tr>
<tr>
<td>Top</td>
<td>200</td>
<td>The top edge of the window is positioned 200 pixels down from the top of the screen.</td>
</tr>
<tr>
<td>Width</td>
<td>600</td>
<td>The window is sized to 600 pixels in width.</td>
</tr>
<tr>
<td>Height</td>
<td>750</td>
<td>The window height is set to 750 pixels.</td>
</tr>
<tr>
<td>Monitor</td>
<td>0</td>
<td>Zero represents the main monitor.</td>
</tr>
</tbody>
</table>

Set Size and Position Tool
Click the Set Size and Position button for a simple way to select the size and position of the window. Clicking on this button opens the Window Move and Size window and the Dialog Positioner. Stretch this window to the size needed and drag to the location desired. Or after sizing the window, click on one of the position buttons in the Dialog Positioner to have the window move to the location indicated.

Click OK to save. The pixel values are automatically filled out.

When the macro is run, the window selected in the Window Title field is moved and sized to the same location and dimensions as drawn in the Window Tool window.

The Window Position and Size topic explains these options in detail.
**Window Reposition**

Use this command to position program windows anywhere on the screen.

Choose a window
Choose from the drop down list whether to reposition the current window or a specific window.

Use the current Window
Use the Current Window refers to the window that has focus when the Window Reposition command runs during macro playback. Whichever window is on top and has focus when the command runs will be repositioned.

Specify a window
Enter the title of the specific window to reposition. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

**Exact Match**
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

**Partial Match**
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

**The title contains wildcards**
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Choose a method to reposition the window
Twelve reposition options are available. Nine of these options are essentially self-explanatory. Clicking on the Center of Screen option places the window in the center of the screen. The Move to Top Left command moves the window to the top left corner of the screen, etc. We'll discuss the other three choices below.

Specify the exact location
This option places the window anywhere on the screen based on the coordinates that you provide. Enter the coordinates for positioning the window in the Left and Top edit fields.

Specify Exact Location Example

<table>
<thead>
<tr>
<th>Left</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>200</td>
</tr>
</tbody>
</table>

With the above coordinates, the left edge of the window is positioned 100 pixels to the right of the left side of the screen. The top edge of the window is positioned 200 pixels down from the top of the screen.

Move in pixels relative to the current location
This option moves the window a fixed number of pixels away from the current location of the window. Insert the number of pixels in the left and top boxes when using the Value option. Or insert integer variables in these fields. Negative numbers (place a "-" sign before the number) move the window to the left or up. Positive numbers move the window to the right or down.

Move In Pixels Example

<table>
<thead>
<tr>
<th>Left</th>
<th>-150</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>250</td>
</tr>
</tbody>
</table>

For this example, we'll assume the current window is positioned at left 400 and top 100.

Moving the window the number of pixels we have listed above, positions the window at left 250 and top 350. The window moved to the left 150 pixels and down 250 pixels on the screen.

The left edge of the window is now positioned 250 pixels to the right of the left side of the screen. The top edge of the window is positioned 350 pixels down from the top of the screen.

Move in percent relative to the current location
This option moves the window proportionally, on a percentage basis. Insert the percent change in the left and top boxes when using the Value option. Or insert integer variables in these fields. Negative numbers (place a "-" sign before the number) move the window up or to the left. Positive numbers move the window down or to the right.
Move In Percent Example

<table>
<thead>
<tr>
<th>Left</th>
<th>Top</th>
</tr>
</thead>
<tbody>
<tr>
<td>-10</td>
<td>25</td>
</tr>
</tbody>
</table>

For this example, we'll assume the current window is positioned at left 400 and top 500.

Using the values we input above, the negative 10 value moves the window to the left 10% of the available screen distance.

The positive 25 value moves the window down 25% of the available distance towards the bottom of the screen.
Window Resize

Three options are available for changing the size of a window - select a specific size in pixels, resize by a percentage or change the size by a set number of pixels. These options are described below.

Choose a window
Choose from the drop down list whether to resize the current window or a specific window.

Current window
Current window refers to the window that has focus when the resize command is run in the macro.

Specify a window
Enter the title of the specific window that you want to resize. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

Exact Match
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

The title contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Choose a method of resizing
Resize the selected window by using one of the three options listed in the drop down menu. The resizing methods are described below.

Specify Exact Size
The Specify Exact Size option sizes the window to specific dimensions. Insert the pixel values for the width and height of the window in the appropriate fields. If 500 in entered in the width box and 400 in the height box, the window is resized to a width of 500 pixels and a height of 400 pixels during macro playback. Integer variables may also be used in the width and height fields.

Enlarge/Decrease in pixels
This option enlarges or decreases the size of a window by a fixed number of pixels. Insert the number of pixels in the width and height boxes by which to increase or decrease the window size. Integer variables may also be used in the width and height fields.

Negative numbers (place a " -" sign before the number) decrease the size of the window. Positive numbers increase the window size. In the example above, a window size is set to width 350 and height 700 pixels. Inserting values of width -100 and a height of 50 change the window size to width 250 and height 750 when the macro is run.

Enlarge/Decrease by percent
This option enlarges or decreases the size of a window proportionally on a percentage basis. Insert the percentage values by which to increase or decrease the window size. Integer variables may also be used in the width and height fields.

Negative numbers (place a " -" sign before the number) decrease the size of the window. Positive numbers increase the window size. In the first example, a window size is set to a size of width 500 and height 400 pixels. Inserting values of width -10 and a height of 25 will decrease the window width by 10% and increase the height by 25% when the macro is run.
Window Restore

The Window Restore command instructs a window to be restored (resized) to its original dimensions before a maximize or minimize command was issued.

Choose a window
Choose from the drop down list whether to restore the current window or a specific window.

Current window
Current window refers to the window that has focus when the Window restore command is run in the macro.

Specify a window
Enter the title of the specific window to restore. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

Exact Match
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

The title contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Window Show

The Window Show command displays a window that has been hidden. It typically brings the window to the front of the screen. Use the Window Activate command to bring a window to the top of the screen.

Choose a window
Choose from the drop down list whether to show the current window or a specific window.

Current window
Current window refers to the window that has focus when the Window Show command is run in the macro.

Specific window
Enter the title of the specific window to show. Or click on the Browse button to see a list of all windows currently running. Select the window from the list to insert the name into the Window Title edit box.

Exact Match
This requires that the window name entered matches exactly with the name of the window waiting to receive focus. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the macro would not wait.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is not required. For example, "NOTepad" will work as well as "notepad".

The title contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the " * " or " ? " characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.
Add Program

This window or similar is used in several places throughout the program, such as selecting a program specific scope, using the Terminate Process command, the Launch Program command and others that require selecting a program.

There are three methods for selecting a program. Each are described below.

**Start Menu**
Choose from programs that are listed in the Windows Start Menu. Choose from the drop down menu to find a program in the User Start Menu or the Shared Start Menu. Highlight the program to insert in the Executable Path field.

**Running Processes**
Click on the Running Processes tab to view a list of all programs currently running on the computer. Highlight the program to insert in the Executable Path field.

**Browse**
Click on the Browse button to open a window similar to My Computer. Navigate to find the program on the computer and select.

---

**This program must have a window on top**
This option requires that a window of the program selected be on top in order for the macro to continue. Otherwise, the macro will complete it's task whether the program window is on top or not. This option is available when selecting a Scope.
Add Window

This window or similar is used in several places throughout the program, such as selecting a window specific scope, using the Wait for Window Title command, the Window Activate command and others that require selecting a window title.

Visible
The Visible tab displays a list of windows currently running on the computer that are viewable.

Hidden
The Hidden tab displays a list of windows currently running on the computer that are not open (minimized to the notification area) or run in the background and are never seen.

Window Title
Enter the name of the window title or select the title from the hidden or visible list of windows.

Exact Match
This requires that the window name entered matches exactly with the name of the window running. For example, if listing Notepad as the window name, but the actual window title is Notepad - Untitled, then the match is ignored.

Partial Match
The Partial Match option does not require an exact window title match. For example, if waiting for a notepad window, inserting "notepad" or "notep" as the window title will find the running window. This is particularly useful as some Window Titles change based on whether a given file is open. Case sensitivity is
not required. For example, "NOTepad" will work as well as "notepad".

The title contains wildcards
Select this option if a wildcard is included in the window title name. A wildcard uses the "*" or "?" characters in the title to expand the possibilities of a match. These are similar to the wildcards used in Windows for searches.

A window with this title must be on top
This option requires that the window be on top in order for the macro to continue. Otherwise, the macro will complete its task whether the window is on top or hidden.

Include hidden windows in the scope
By default the macro will only look for windows that are visible, not those that run hidden and are not seen by the user. Select this option to have the scope apply to the windows listed in the Hidden tab, as well as those that are visible.
On Error Tab

Most macro command windows have a corresponding On Error tab for error handling during playback of the macro. For example if a specific condition isn't met during macro playback, such as a file or a window could not be found, the On Error tab can instruct the macro to stop, ignore the error and proceed, or prompt for a course of action.

![Image of Window Activate dialog with error handling options]

In the example above the Window Activate command has four possible types of errors that may occur during macro playback. Each command lists a different set of errors that are pertinent to that specific macro command. In most cases it is appropriate to just leave the default action for each of the errors. But there may be cases for debugging or other situations where one of the other actions is more appropriate. A description of the actions is listed below.

Halt Macro
Halt Macro stops the macro if the error occurs during playback. This is the default error action and the one most commonly required.

Ignore Error
Ignoring the error instructs the macro to continue even though the error has occurred.

Prompt for Action
If an error occurs, a message similar to the one below appears on the screen prompting the user to decide how to proceed with the macro. Choose to stop the macro or ignore the error and continue.
Date: 3/20/2018 10:13:37 AM

The following error was encountered:
Window could not be found
Macro Name: Sales Report
Line Number: 3

What would you like to do?
○ Halt the macro
○ Ignore the error

OK  Cancel
Position and Size Macro Express Dialogs

During the playback of a macro, Macro Express may open a dialog box, such as a prompt, multiple choice, text box, etc. Many of these macro commands allow for sizing and/or positioning the dialog box on the screen.

This topic discusses the options to size or position dialog boxes, if the macro command supports the function.

The macro commands that allow for the positioning and sizing of dialog boxes contain edit boxes similar to these displayed below.

| Left: Center | Width: 278 | Monitor: 0 |
| Top: Center | Height: 200 |
| Set Size and Position | | | |

Left
The Left edit box positions the dialog a specific number of pixels from the left edge of the screen. In this example the left side of the dialog box is positioned one pixel to the right of the left screen edge.

Top
The Top edit box positions the dialog a specific number of pixels from the top edge of the screen. In this example the top side of the dialog box is positioned one pixel below the top screen edge.

Width
Insert the pixel values for the Width of the dialog to be displayed. In the example above, the text box displays with a width of 300 pixels.

Height
Insert the pixel values for the Height of the dialog to be displayed. In the example above, the text box displays with a height of 300 pixels.

Monitor
This option applies to systems that utilize more than one monitor. If a system has a single monitor, then leave the monitor setting to zero (0). Zero represents the single monitor or the left monitor if there is more than one monitor. One (1) represents a second monitor or the monitor to the right of the left monitor. Similarly, two (2) represents the third monitor or two monitors to the right of the left monitor, and so on.

Always on Top
Always on Top keeps the text box visible on the screen (on top of other running applications) until the box is closed.

Keep Focus
Keep Focus ensures that the text box is the window that has focus. This allows users to immediately input information into the dialog without first giving focus to the text box. Unchecked, this option leaves focus with the application that had focus before the dialog opened.
Position Manually
The position manually button is used to visually set and view the position of the dialog box. Or view and set the size of the dialog by dragging the edges.

Dialog Positioner
Instead of using pixels coordinates, the Pause window may appear in the center, corners or midpoints of the screen by using the Dialog Positioner. Pressing the Position Manually button activates the Dialog Positioner and Dialog Sizer windows.

Click on one of the arrows or the center button. This moves the Dialog Sizer window relative to the button selected. If the arrow button in the upper left corner is selected, the Dialog Sizer window moves to the upper left corner of the screen. Click Save and this is where the dialog displays during macro playback.

Dialog Sizer
This window displays the text of the dialog box. It is also displayed in the same dimensions as it will appear during macro playback.

Drag the edges of this window to resize it to preferred dimensions. Click OK to save the size. The new size is displayed in the Width and Height edit boxes.
**Comments Tab**

The Comments tab is found in any of the macro command windows. Insert comments about the command into the edit field - what it is supposed to do, why, etc. The comments appear in the Script Editor on the same line in the script as the command. The comments text displays as blue text to be distinguishable from the command text.

Script Editor > Open Any Macro Command Window > Comments Tab

**Insert Comments**

Or with the Script Editor open, highlight a line in the macro script and click on the Insert Comments button. This option opens a Comments edit box. Type any comments about the line in the script in the this field and click OK to insert the comments next to the command listed in the script.
Network and other topics

Networking Questions

How can I deploy Macro Express across a network?
There is a silent install option for installing Macro Express from a network server. Read the Advanced Installation topic for more information about this process and the command line options available during the install.

How do I run the program over a network?
Place the macro (.mex) file on an accessible network drive. Have each copy of Macro Express point to the file on the network. Use File > Open Macro File to load in the file or set this up during the silent install process.

Click on Options > Preferences > Network from the Macro Express - Explorer window and choose the "File Locking of Macro Files" option. This enables the networking capabilities of the program.

File locking prevents overwriting of data by 2 or more users. If a user attempts to change any data in the Macro Express file and the data currently displayed has been altered by another user, the user is notified that the data has been changed and the new data is loaded and displayed.

The Automatic Synchronization Updating option is available to allow automatic synchronization of data files between users on a network. This updating can be set to occur every minute, every two minutes on up to every 999 minutes.

For example, if the interval is set to 5 minutes and another user makes a change to the same macro file currently open, then within 5 minutes, the macro data is automatically synchronized between the networked computers.

How do I prevent my network users from changing the macro data?
Use the command line option /B which places Macro Express in a browse only mode. All macros still function, but they cannot be changed by the user.

**Note:** Please note that multi-user networking of this product requires multi-user licensing.
Frequently Asked Questions

Please visit our Macro Express Knowledge Base for additional topics.

Why are so many of the icons and menu items grayed out in the Explorer window?
Most likely focus is on the System Macros category, with all of the system macros displayed. Select any other macro category and the icons/menu items will be accessible.

How do I place a macro in an endless loop?
The best way to place a macro in an endless loop is to use the Repeat Until Command. Basically, assign a value to a variable such as N[1] = 0. Use the Repeat Until condition to test the variable against a different value such as Repeat Until N[1] = 1. As long as variable N[1] never is changed to 1 during the macro playback, the macro repeats indefinitely. Below is a brief example of what the code would look like in the Script Editor:

```
Set Integer Variable N[1] to 0
Repeat Until N[1] = 1
.... (your macro code here)
Repeat End
```

**Note:** Please do not have one macro call another macro (via the "Macro Run" command) and in turn have the second macro call the first macro. Putting two macros in an endless loop in this fashion will eventually end up in a system crash. The system resources used by Macro Express for each macro never get freed in this instance because the macro never actually finishes executing before calling the other macro.

How do I stop a running macro?
There are several ways to do this. If the Running Man icon is displayed in the notification area when a macro runs, right mouse click on the icon to stop the macro. Or press the default keys of Scroll Lock and Pause keys to stop the macro. Click on Options > Preferences > Playback - Miscellaneous Tab to change the default to Win + ` or the Pause key.

Any of these options will cancel a macro that is playing. Please note that macros that consist of many keystrokes may send the keystrokes rather quickly and Windows will buffer up the keystrokes. Once such commands have been buffered up in Windows, aborting a macro does not cancel them. In this cases, it may appear that the abort command did not work when in reality the macro has already finished issuing its commands and Windows is now processing them.

How do I click on a button on a web page?
Once the cursor is positioned over a button (via the tab key), press the Space bar. Use the Text Type command to issue a Space bar press or insert using the Direct Editor.

For example, when inserting name, street address, city, state and zip code followed by a submit button on a web page, the macro may look as follows: "Fred Smith<TAB>123 Apple Lane<TAB>Small Town<TAB>UT<TAB>80000<TAB><SPACE>". When invoked, this macro tabs through the fields, inserting the data and then presses the Space bar to trigger the Submit button. The Space bar key works equally well with checkbox and radio type buttons on web page forms.

How do I ensure the CTRL, ALT or SHIFT keys are held down in a macro?
There are two methods that may be employed. They are listed below.
1. The first method is to use the CTRL, ALT and SHIFT Keys that can be accessed in the Text Type command or through the Direct Editor. By default, anything that follows <CTRL>, <ALT> or <SHIFT> is acted upon as if it were being held down.

For example, if the macro contains <CTRL>a, then this is the same as holding down the CTRL key and pressing the "a" key. If the macro contained <CTRL><ALT>a, then this would be the same as holding down the CTRL key and the ALT key at the same time and then pressing the "a" key. The same applies to the SHIFT key.

Two notes about these keys:

A. Use a lower case letter with these keys, such as <CTRL>a. Macro Express interprets <CTRL>A as <CTRL><SHIFT>a, which renders a different result.

B. There are certain system keystroke commands that are built into the operating system at a low level such as CTRL+ALT+DELETE. These keystroke sequences in macros are not recognized by Windows at this low level and will not work as intended.

2. The second method uses the specific functions for "Alt Key Down", "Alt Key Up", "Ctrl Key Down", etc. These are found in the Text Type command. Choose "Alt Key Down" followed by the letters to be associated with the ALT key. Then follow with an "Alt Key Up" command. Again, be sure to use lower case letters. An example would look like <ALTD>fo<ALTU>.

Make sure to include the corresponding Up key or the key will remain held down and cause unpredictable results. The "WIN" key is also available for down and up usage.

How do I dynamically change the contents of a macro?
There are a couple of ways to accomplish this.

1. One method is the "Text Insertion" option. The macro can load in a text file at any point during playback and execute the text of the file as part of the macro. The dynamic portion of the macro is stored in the text file. Change the contents of the text file to alter the playback of the macro.

2. A second method is to include "Variables" in the macro script. Populate the variable in any number of ways including being prompted, loading from a text file, loading from the clipboard and many others.

How do I get Macro Express to not display when I first start the program? I just want the icon in the notification area.
From the Macro Explorer, click on Options > Preferences > Startup. Make sure the Show the Editor option is not checked.

If the Macro Express icon does not display in the notification area, click on Options > Preferences > General - Notification Area tab and select the Display Icon in Notification Area option.

How can I not have any delays between keystrokes when capturing a macro?
Before capturing a macro click on Options > Preferences > General - Capture tab. Remove the check next to the "Capture at a Specific Speed" option. This captures the macro without any delays or hesitations. Be careful with this option as it may cause the macro to play back too fast and throw off the timing of the macro.

Can I use macros in DOS programs?
Macro Express currently only works with Windows programs. It does not paste keystrokes into a DOS
program. The global Windows "keyboard hooks" that we tap into are not relayed to DOS programs even if they are running under Windows.

Can I auto repeat keystrokes?
This question references the "Why can't I hold down the CTRL key and continue to press and release the "a" key for multiple CTRL+A macros to be played?". The real answer deals with the "global" nature of our program -- that is our macros will work in any program at any time. For this to occur, we actually send the keystrokes through the Windows internal keystroke processing system just as if the key were pressed from the keyboard. Because of this, all keys must be released before the macro plays back. This is to ensure that no adverse keyboard effects will affect the playback of the macro.

Let's take an example. Suppose a company name of "My Company, Inc." is assigned to the hot key "Alt-A". Hold down the ALT key and press the "A" key to activate the macro. If the macro were to start playing immediately upon doing this, the ALT key would still be held down and the macro would play back as ALT-M, ALT-y, etc until the ALT key is released. To prevent this from occurring, we require all keys to be released before the macro will start.

My macros do not play back.
There are a couple of possibilities here.

1. The simplest and sometimes overlooked by new users is that the Macro Express Player needs to be running for the macros to work.

2. It is possible that another program loaded after Macro Express installs itself improperly into the Windows Keyboard Hooks. When this happens, our program never sees the keystrokes and therefore does not work. (The last program run gets first look at the keystrokes). Your recourse here is to try one of the following:
   A. Unload the program that is causing the problem
   B. Make sure that Macro Express is run after starting the offending program
   C. Use the Tools > Restore Keyboard & Mouse Hooks menu option.
   D. Choose Options > Preferences > Activation - General Tab and select Auto Restore Keyboard and Mouse Hooks.

In the latter three cases both Macro Express and the offending program will work as Macro Express properly handles the situation. Ultimately, the vendor of the offending program needs to fix the problem.

3. Make sure that the Macro Scope is set correctly.

My macro does not seem to invoke menu commands.
Some programs appear to interpret ALT keystroke sequences as something other than menu commands. This exhibits itself when certain menu commands work from Macro Express and others do not. There are two methods for working around this problem.

1. Use the ALT Key Down and ALT Key Up keystrokes in the Text Type command or Direct Editor. This option holds down the ALT key while the letter is pressed and then releases the key. The syntax would look like the following if attempting to execute an ALT f - <ALTD>f<ALTU>.

2. The other option is to use a double ALT (<ALT><ALT>). Two ALTs in a row is the equivalent of pressing the ALT Key and releasing it. Doing so activates the menu and the next letter activates the appropriate menu option. The syntax would look like the following if attempting to execute an ALT f - <ALT><ALT>f.

My macro seems to go bonkers or play out of sequence.
The problem is a timing issue. It is sometimes possible for the keystrokes themselves to be sent too quickly
for the desired actions. The program or window may not be ready to accept the keystrokes from the macro. There are several ways to work around this problem.

1. Use one of the **Wait** commands to instruct the macro to wait until ready to proceed.
2. Insert a **Delay** at the necessary spot in the script.
3. Use the **Keystroke or Macro Speed** command to slow down the keystrokes in the macro.
4. Apply a **system wide delay** to all keystrokes played back via macros.
Command Line Parameters

Command Line Parameters are commands that can be passed to Macro Express when the program is first run. The following command line parameters apply to the Macro Express player (macexp.exe). A command line parameter follows the name of the program and is separated by a single space from the program name and other command line parameters.

The /A and /MXE command line parameters listed below are used for launching macros.

The command line parameters may also be used with another program supplied with Macro Express called MEPROC.EXE. This program is designed to speed up the playing back of macros. The advantage of using meproc.exe is that if Macro Express is already running the macro will launch much quicker. This is because meproc.exe is so much smaller that it does not take as long to load and execute the macro.

Not all command line parameters can be combined on a single command line. For example, the /IC option imports the program configuration, including the macro file. This cannot be combined with the /F option used to load a macro file.

/A<Nickname> (Activate a Macro)
The Activate Macro command specifies a given macro to run when invoking Macro Express. <Nickname> is the nickname of the macro to run. For example, if a macro is nicknamed "My Address", use the command line parameter of "/AMy Address" (without quotes). This command can be particularly useful when running macros from batch files. If Macro Express is already running, it will not launch a second copy of the program yet the macro will still be executed. Spaces are allowed in the nickname.

The /A command does not load the macro file that contains the macro to be run. If that macro file is already loaded or will load when Macro Express is started, the selected macro will run. If not loaded, the macro will not execute.

Note: If more than one macro has the specified <Nickname> only the first macro encountered with that name will run.

/A::<FileName>?<Nickname> (Activate a Macro in a specific macro file)
This Activate Macro command allows you to specify both the macro file and the specific macro to run when invoking Macro Express. <FileName> is the path to the macro file. <Nickname> is the nickname of the macro to run. Spaces are allowed in the pathname of the macro file and in the nickname. For example:

"C:\Program Files\Macro Express\MeProc.exe" /A::c:\My Macros\Test Macros.mex?Test macro

This command can be particularly useful when running macros from batch files or other programming languages. (See Launching macros from a command line parameter.) If Macro Express is already running, it will not launch a second copy of the program yet the macro will still be executed.

Note: If more than one macro has the specified <Nickname> only the first macro encountered with that name will run.

/B (Browse Mode)
This sets Macro Express to a browse mode where the macro data cannot be modified. The Macro Express editor cannot be invoked when this option is used. This option can be especially helpful in administrating uniformity of macros over a network.
/EN (Do Not Run Editor)  
This option instructs the Macro Express editor to not run when the Macro Express player first runs.

/EY (Run Editor)  
This option instructs the Macro Express editor to run when the Macro Express player first runs.

/F<FileName> (Load Macro Express File)  
Use this option to select a specific Macro Express file for loading on startup of Macro Express. <Filename> is replaced with the Macro Express file name. A full path along with the "mex" extension on the file name must be used. For example:

/Fc:\program files\macro express\mymacros.mex

**Note:** This command can have spaces in the file name and the path.

The macro file specified by the /F command will be added to the list of macro files to open by Macro Express. If the Close open macro files before loading another macro file preference option is enabled, only the macro specified by the /F command will be opened.

/H (Hide Program)  
This completely hides the Macro Express player program. Invoke the Macro Express editor by using the system "Activate Macro Express Editor" hot key.

/IC<FileName> (Import Program Configuration)  
This option loads in the program configuration settings on startup of Macro Express. If more than one user shares a computer, each user could have their configuration settings loaded in when they start up Macro Express. Each individual user would need to create their own startup shortcut in order to do this.

/MXE (Run .MXE file)  
Use this option to run a macro that is contained in a playable macro file (.MXE file). Example: 
"/MXEc:\program files\macro express\mymacro.mxe" (without the quotes).

/N (Network)  
This option forces the program to use the Network Mode.

/NQS (No Quick Start)  
This option prevents the Quick Start program from running for the current session.

/S (Synchronize Network)  
This option is only useful if the Network Mode is active. This option forces the network synchronization option to be used.
/SMxx (Synchronization Minutes)
This option is only useful if the Network Mode is active. "xx" should be substituted with the number of minutes that macro file synchronization should take place. Valid values are from 1 minute to 99 minutes. /SM10 would synchronize the file every ten minutes.

/T (Notification Area)
This option places an icon in the notification area.

/V (Variables)
This option is used for passing variable information into Macro Express and is best used in conjunction with one of the other commands that launches a macro. For example, launch a macro and the variable information is already predefined. Text, Integer or Decimal variable values may be used.

Follow the /V with the Text, Integer or Decimal type variable. Place a colon after the variable name and follow with the data to populate the variable value. Some examples are shown below:

/VMyString:Now is the time - Places "Now is the time" (without quotes) into variable "MyString"
/VN34:150 - Places the value 150 into variable "N34"
/VADecimal:3.1459 - Places the value 3.1459 into variable "ADecimal"

This function places the values into the "Saved Variable Locations". The macro must use the "Variable Restore All", "Variable Restore Text", etc. commands first before it can access the data.

**Note 1:** Most of these options allow for a quick and easy setup for network considerations. For example, users can be restricted from changing Macro Express data using the browse mode, allowing manageable uniformity across the network. Users can all access the same Macro Express file using the "Load Macro Express File" option so no configuration is required by first running the program. Network usage can be enforced using the "Network" option, etc.

**Note 2:** Insert quote marks around the file path and file name when there are spaces in the path or name. An example of how this would look is shown below.

"C:\Program Files\Macro Express\MeProc.exe" /AMyMacro

Launching macros from a command line parameter
Below are examples of launching macros from a command line parameter with Delphi, C/C++/Visual C or VBA. Replace Filename?Macroname with the actual path, file name and macro when using this function. An example would be c:\Macro Express\mymacrofile.mex\Play System Sounds.

**Example: Delphi**

```delphi
  ShellExecute (0, nil, 'c:\Program Files\Macro Express\MeProc.exe', '/A::Filename?Macroname', nil, SW_SHOW);
```

**Example: C/C++/Visual C**

```c
  ShellExecute (NULL, NULL, "c:\Program Files\Macro Express\MeProc.exe", "/A::Filename?Macroname", NULL, SW_SHOW);
```

**Example: VBA**

```vba
Sub CallMEMacro()
  Shell ("C:\Program Files\Macro Express\MeProc.exe /A::Filename?Macroname")
End Sub
```
Backup and Restore Macros

Macro Express allows for the creation of multiple files of macros. The macex.mex file is the default file installed. Or create a new macro by clicking on File > New Macro File from the Macro Express - Explorer window.

Backup
There are several ways to back up the macro file that is currently open.

1) Use the automatic backup routine found in Options > Preferences > General - Backup tab. Backups can be created at scheduled intervals and saved to specific locations.

2) Click on File > Backup Macro File(s). The file is backed up to the default location defined in Options > Preferences > General - Backup tab.

3) Click on File > Export > Export Macros to activate the Export Macros window. All macros in the file are displayed. Select all or some of the macros and save to a new macro file. This option does not preserve any category information.

4) Use the Copy and Paste options of Windows Explorer or My Computer. Navigate to the .mex file, copy and save to a different location.

Restore
1) From the Macro Express - Explorer window, click on File > Restore. A Windows dialog will open prompting to select the backup file. The dialog opens to the folder designated in the Backup preferences panel for file backups. If the backup options were recently changed, then it may be necessary to browse to the location where previous backups were stored.

Performing the restore closes the file currently open and replaces it with the backup file selected.

2) Click on File > Open Macro File to load in the backup macro file or a copy of the file. Navigate to the location where the backup or copy resides and open the file.

3) Click on File > Import > Import Macros to activate the Import Macros window. All macros in the .mex file selected are displayed. Highlight all or some of the macros in the file and import them to the macro file currently open.
License and Support Issues

Macro Express 5 End-User License Agreement (EULA)

Agreement
The use of this Software indicates your understanding and acceptance of the following terms and conditions. If you do not understand or accept these terms you must cease using this product immediately.

Copyright
This product is Copyright © by Insight Software Solutions, Inc. All Rights Reserved. This Software is protected by United States copyright law and various international treaties.

License
You may use an unlicensed copy of this Software for up to 30 days for evaluation purposes only. After the 30 day evaluation period you must purchase a license to continue to use the Software.

Once you have purchased a license you will receive a license code that will enable you to continue using the Software on a non-exclusive basis. This license will not expire.

The Software is licensed, not sold. Ownership of the Software, Documentation and all intellectual property rights therein shall remain at all times with Insight Software Solutions, Inc. In licensing the Software you do not acquire any rights beyond the right to continue to use the Software on the system for which you purchased the license.

Personal License: A single-user ("Personal") License may either be used by a single user who uses the Software personally on one or more computers, or installed on a single computer used by multiple people, but not both.

Multi-User License: A multiple-user ("Multi-User") License may be purchased based upon either (a) the number of users who have access to the Software on any number of computers, or (b) based upon the number of computers on which the Software will be installed for use by any number of users. You may not use the Software in excess of either (a) the number of purchased users or (b) the number of purchased computers, whichever is applicable. A Multi-User License may not be used by your subsidiary companies, customers, or any other third parties.

You shall be responsible for maintaining the License in a safe location and are specifically prohibited from distributing the License, intentionally or unintentionally, to any third party. Upon loss or distribution of the License, Customer shall be required to pay a reinstatement fee at Insight Software Solution's discretion.

License Transfer
You may not sell, rent, lease, or transfer the Software to any third party and may not lend the Software other than as authorized by this EULA.

You may transfer the product to another party only if the other party agrees to all the terms and conditions of this agreement and if you provide Insight Software Solutions notice of the transfer including your name, company (if applicable), and address and the name, company (if applicable), and address of the person to whom you are transferring the rights granted herein. If you transfer the program you must at the same time transfer or destroy any back-up copies. You may not retain any portion of the program, in any form, under any circumstance. If the Product is an upgrade, any transfer must include all prior versions of the Product. You must secure written approval and a personalized license code from Insight Software Solutions, Inc. The license code issued to the initial user will be invalidated.
If the Software was purchased as part of a Multiple User license, you may only sell or transfer the entire multiple user license; you may not sell or transfer a portion of a Multiple User license. You may not sell or transfer any Trial Version or Not For Resale Version of the Software. The sale or transfer of the Software does not transfer the 30 day money back guarantee offered to the original purchaser.

**Restrictions**

You may not copy, modify, translate, loan or create derivative works based upon the Software or any part thereof. You may not reverse engineer, decompile, adapt, or disassemble the Software, nor shall you attempt to create the source code from the object code of the Software. You may not attempt to unlock or bypass any licensing algorithm utilized by the Software. You may not distribute the license code you received when purchasing the Software or post this information to discussion forums, web sites, email messages or servers. You may not remove or modify any copyright notices. Violations will result in termination of this license.

**Limited Warranty**

Insight Software Solutions, Inc. warrants that the Software will perform substantially in accordance with the user documentation for a period of ninety (90) days from the date of receipt. This limited warranty is void if failure of the Software has resulted from accident, abuse, or misapplication. Any replacement Software will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

**Disclaimer of Warranty**

THERE ARE NO OTHER WARRANTIES RESPECTING THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY REPRESENTATIONS OR ENDORSEMENTS REGARDING THE USE OF, THE RESULTS OF, OR PERFORMANCE OF THE PRODUCT, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, ACCURACY, RELIABILITY, OR THAT THE SOFTWARE IS ERROR FREE. THE ENTIRE RISK AS TO THE USE OF THIS SOFTWARE IS ASSUMED BY THE USER AND/OR LICENSEE. INSIGHT SOFTWARE SOLUTIONS, INC. DOES NOT ASSUME LIABILITY FOR THE USE OF THIS SOFTWARE BEYOND THE ORIGINAL PURCHASE PRICE OF THE SOFTWARE. IN NO EVENT WILL INSIGHT SOFTWARE SOLUTIONS, INC. BE LIABLE FOR ADDITIONAL DIRECT OR INDIRECT DAMAGES INCLUDING ANY LOSS OF PROFITS OR OTHER INCIDENTAL, SPECIAL, EXEMPLARY OR CONSEQUENTIAL DAMAGES ARISING FROM ANY DEFECTS, OR THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF INSIGHT SOFTWARE SOLUTIONS, INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO LIMITATIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY BY JURISDICTION.

**Customer Remedies**

The entire liability of Insight Software Solutions, Inc. and your exclusive remedy shall be, at the option of Insight Software Solutions, Inc., either (a) return of the original purchase price paid for the Software, or (b) repair or replacement of the Software that does not meet the Limited Warranty and that is returned to Insight Software Solutions, Inc. with a copy of your receipt.

**Export Controls**

None of the Software, Documentation or underlying information or technology may be downloaded or otherwise exported or re-exported (i) into (or to a national or resident of) any country to which the U.S. has embargoed goods; or (ii) to anyone on the U.S. Treasury Department's list of Specially Designated Nationals or the U.S. Commerce Department's Table of Denial Orders. By downloading or using the Software, you are agreeing to the foregoing and you are representing and warranting that you are not located in, under the control of, or a national or resident of any such country or on any such list.

**High Risk Activities**

The Software is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-line control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in which the failure of the Software could lead directly to death, personal injury, or severe physical or environmental damage ("High Risk Activities"). Insight Software Solutions, Inc. specifically disclaims any express or implied warranty of fitness for High Risk Activities.
Terms
This license is effective until terminated. You may terminate it by destroying the Software, the documentation and copies thereof. This license will also terminate if you fail to comply with any terms or conditions of this agreement. You agree upon such termination to destroy all copies of the Software and of the documentation, or return them to Insight Software Solutions, Inc.

Other Rights
No amendments or modifications may be made to this Agreement except in writing signed by both parties. If one or more provisions of this Agreement are found to be invalid or unenforceable, this Agreement shall not be rendered inoperative but the remaining provisions shall continue in full force and effect.

No Insight Software Solutions, Inc. dealer, distributor, or agent is authorized to make any modification or addition to this Agreement.

All other rights not specifically granted in this license are reserved by Insight Software Solutions, Inc.

Governing Law
This agreement shall be governed by the laws of the State of Utah. The application of the United Nations Convention of Contracts for the International Sale of Goods is expressly excluded.
Support

**Important:** Before requesting support, please ensure that the answer to your question is not already contained in the Help File, the Frequently Asked Questions or the web based Knowledge Base for Macro Express. For questions or comments regarding Macro Express please visit our support page at [www.macros.com/support.htm](http://www.macros.com/support.htm).

If you are experiencing an issue with Macro Express, please provide the following:

- The product name and version number. (Click on Help > About for version information.)
- The version of Windows you are running (7, 8.1, 10, etc.) including service packs.
- The sequence of actions that produces the problem.
- Any other relevant details.

Before contacting us for technical support, please make sure that you are using the latest version of Macro Express, as the problem may have been fixed in a later update. Information about the latest release may be found at [www.macros.com/download.htm](http://www.macros.com/download.htm).
Licensing the Evaluation Version

Macro Express is available as an evaluation copy. The evaluation copy is fully functional for a fixed period of time. To use the program beyond the evaluation period requires purchasing a license.

To purchase a license open the Macro Express - Explorer window and click on Help > Buy Macro Express. Or right click on the Macro Express icon in the notification area and left click on Buy Macro Express. Either method opens the order page on our web site to display several purchasing options.

After purchasing the license for Macro Express you will receive a license code. From the Macro Express-Explorer click on Help > License Macro Express to activate the License Information window. Enter the name and code exactly as they appear on the license instructions received after purchase. Press OK to save the license information. The license status will now display in the lower left corner of the Macro Express - Explorer window.

After successfully entering the license code, the program is fully licensed and will not expire. The Buy Macro Express links mentioned above now change to License Information.

It is recommended that the program be licensed while logged on as the administrator. See the Advanced License Information topic for consideration of Administrator and non-Administrator login rights and Macro Express licensing.
Upgrade Policy

A license key is supplied when Macro Express is purchased. Please keep this key in a secure place as it will be needed if reinstalling Macro Express.

This license key is valid for any version 5.x of Macro Express. Future revisions that bear the "5.x" identifier version are generally for minor enhancements and bug-fixes. Any release containing major new functionality will bear a different version identifier (e.g., 6.x) and an upgrade fee will be chargeable.

The prime location for new releases of Macro Express is our web site download page at www.macros.com/download.htm.

If installing a newer version of the product, install it over top of the existing version (into the same folder). Close Macro Express completely before installing a new version.

**Note**: Uninstalling and then reinstalling Macro Express does not affect the macro file(s). The macro file(s) remain intact. However, as always, we recommend backing up the macro (.mex) file(s) before uninstalling or reinstalling.
A portable version of Macro Express is available for use on a USB drive or similar portable device. Install Macro Express Portable on the device and run it from that device rather than the local computer. This version will not leave traces of the program on the hard drive of the machine where the program is run.

Macro Express Portable includes the following differences from the standard version.

- No 30-day trial available.
- The options to import or export the program preferences have been removed.
- There is no uninstaller. Use Windows Explorer or File Explorer to delete the files.
- The "Run when Windows starts up" preference option is not available.
- The "Save settings as defaults for all users" preference option has been removed.
- There is no support for playable (.mxe) macros.
- The .mex file association is not linked to Macro Express Portable. You cannot double-click on a .mex file to load it into the program.
- Default locations for the .mex macro file, temp directory, etc. are stored on the portable drive.

To Run Macro Express Portable

When a portable drive is connected to the computer, the AutoPlay menu will typically appear. Click on 'Open folder to view files' in the AutoPlay menu. Double click on LaunchApps to display a menu similar to the one shown below. The menu displays the programs you have installed that are recognized by LaunchApps. Click on the program that you want to load.

Or open Windows Explorer to the portable drive and double click on LaunchApps to open the menu.

AutoRun for Windows XP and prior

On Windows XP and prior, you may be able to specify a program to automatically run when the portable drive is inserted into your computer. The file autorun.inf allows this to happen (if it is supported by your version of Windows). Autorun.inf will only load one program at a time and may be disabled if the AutoRun feature in Windows is disabled.
When Macro Express Portable is installed it will create an autorun.inf file in the root directory of your portable drive if one does not already exist. If your portable drive already contains an autorun.inf when you install you may choose to edit it. The autorun.inf file will load the program LaunchApps. LaunchApps may be configured to automatically load more than one program.

The file autorun_ISS.inf demonstrates how autorun.inf could be set to load LaunchApps.

---

To close Macro Express Portable

Before instructing Windows to eject the portable drive, close Macro Express Portable and any other open programs. Macro Express interfaces with Windows at a low level and each program that is running loads the Macro Express hook into its memory space. Even after closing Macro Express other programs may still have the hook loaded. If this is the case, Windows will display a message saying the drive is currently in use when you attempt to eject the drive.

If closing all open programs does not release the hook you will need to log off of Windows and then remove the portable drive.
Index

.AVI Video Files, 404

A
Abort Macro, 102, 186, 387
Activate Macros, 98, 60, 72, 74, 94, 96, 101, 130, 244
Activate Window, 545
Add Program, 560
Add Window, 561
Address Book, 163
Alarm, 144
Alt-Key Sequence, 321
And, 339
API Macro Activation, 56
Array Length, 477
ASCII Character, 518
ASCII File Process, 52, 281
ASCII Value, 521
Assign Macro Activation, 120
Audio (.wav) File, 405
Audio Controls, 401

B
Back Up your Macros, 171, 577
Bass, 401
Beep, 402
Break, 341

C
Call Another Macro, 388
Caps Lock Key, 213, 319
Capture Control, 526
Capture Macro, 28, 30, 123, 173, 234, 237
Cascade Desktop Windows, 265
Case Statements, 342
Categories, 131, 136
CD-ROM Commands, 256
Change Default Printer, 421
Change Directory, 286
Choose Macro Activation, 120
Clear Error Messages, 186
Clear Variables, 470
Clipboard Commands, 258, 259, 261, 262, 347
Clipboard Settings, 142, 184
Close Program, 539, 543
Close Window, 546
Colors, 228
Combine Macros, 388
Command Line Parameters, 573
Comments, 380, 567
Compare Variables, 376
Continue, 413
Control Event, 98
Control Panel, 423
Controls, 524
  Capture Control, 526
  Clear Control Cache, 528
  Control Event Activation, 98
  Get Control, 529
  Get Control Class, 478
  Get Control Text, 479
  If Control, 349
  Set Focus, 532
  Using Controls Tutorial, 43
  Variable Modify Control, 484
  Variable Set Control Text, 498
  Wait for Control, 440
Convert File Name, 287
Copy a Macro, 126
Copy and Paste, 40
Copy Files, 290
Create New Folder, 288
Create Variables, 49, 182, 211, 462
CSV File process, 281

D
Date, 427, 472
Debug a Macro, 224
Debug Functions, 224
Decimal Variables, 486, 500
Default Printer, 421
Default System Macros, 103
Delays, 184, 435, 453
Delete a Folder, 289
Delete Files, 290
Delete Macro, 129, 383
Desktop Icon, 132
Dialog Windows, 429
Dial-Up Networking, 406
Direct Editor, 230
Disable Macro, 127, 384
Display Dialog Box, 274
Display Resolution, 422

E
Edit Macro, 125
Else, 345
Email, 158, 160, 162, 295, 316
Email Address Book, 163
Email Log, 202
Empty Macro Recycle Bin, 391
Empty Recycle Bin, 433
Enable Macro, 385
Encrypted Text, 320
End Error, 203
End If, 345
End Process, 543
Environment Variables, 466, 491, 513
Error Handling, 203, 329, 563
EULA, 578
Exit Repeat Loop, 420
Export Macros, 116, 119
Export Program Configuration, 197

F
FAQ, 569
File Associations, 176, 198
File Attributes, 292
File Date/Time, 502
File Menus, 109, 220, 221, 224, 226, 227, 244
File Paths, 165, 502
File Size Info, 502
File Version Number, 480
Find, 140
Floating Menu, 33, 244, 246, 248, 251, 254, 255
Font Selections, 155
FTP
  FTP ChMod, 300
  FTP Directory, 302
  FTP File, 304
  FTP Keep Alive, 307
  FTP Site Command, 308
  FTP Site Connect, 310
  Web FTP Site, 315

G
Get Pixel Color, 424
Global Variable, 462, 466

H
Hibernate, 433
Hide Window, 548
Hooks, 142, 192
Hot Keys, 22, 60
Hourly Schedule, 80

I
Icons on Desktop, 132
If Statements, 337
  If Clipboard, 347
  If Control, 349
  If Dial-Up Successful, 351
  If File Exists, 353
  If File Ready, 354
  If Folder Exists, 355
  If Macro, 356
  If Message, 358
  If Mouse Cursor, 360
  If Not File Exists, 361
  If Not File Ready, 362
  If Not Folder Exists, 363
  If Not Mouse Cursor, 364
  If Not Online, 365
  If Not Program, 366
  If Not Window, 367
  If Online, 369
  If OS Version, 370
  If Ping Successful, 372
  If Program, 374
  If Registry, 375
  If Variable, 376
  If Window, 378
Import Macros, 111
Import Program Configuration, 196
Import Text File, 113
INI File, 491, 513
Insert Symbols, 321
Installation of Macro Express, 15, 16, 19
Integer Variables, 49, 489, 506
IP Address, 312

K
  Keyboard Hooks, 192
  Keyboard Remapping, 199
  Keyboard Speed, 436

L
  Large Integer Variables, 460
  Load New Macro File, 382
  Load Program, 533, 535, 537
  Load Text File, 381
  Load Web Page, 317
  Local Variable, 462, 466
  Lock Workstation, 433
  Log Errors, 186, 263
  Log Messages, 264
  Log Off Windows, 433
Long File Name, 287
Looping a Macro, 414, 415

Macro Activation, 56, 120, 209
  Control Event, 98
  Hot Keys, 60
  Mouse Event, 96
  No Activation, 101
  Popup Menu, 244
  Run Macro Now, 130
  Schedule Overview, 74
  ShortKeys, 72
  Window Title, 94
Macro Explorer Window, 106, 152
Macro Express Configuration, 196, 197
Macro Express Startup Options, 189
Macro Notes, 219
Macro Playback Speed, 386, 439
Macro Properties, 133
Macro Recycle Bin, 135
Macro Return Command, 387
Macro Run Command, 388
Macro Scopes, 35, 215, 251
Macro Script Comments, 380
Macro Stop Command, 387
MAPI Settings, 162
Math Functions, 486, 489
Maximize Window, 265, 549
Media Player, 403
Menu Builder, 244, 246, 248, 251, 254, 255
Menus, 109, 220, 221, 224, 226, 227, 244
Message Box, 266
MIDI Controls, 401
Minimize Window, 265, 550
Misc Info Saved to Variable, 505
Monthly Schedule, 86
Mouse Commands, 394, 395, 396, 399, 400
Mouse Event Macro, 96
Mouse Hooks, 192
Mouse Locator, 193
Mouse Position, 393
Move Files, 290
Move Window, 551, 553
Multiple Choice Menu, 268

Navigation, 13
Network Command, 239, 408
Networking Macro Express, 167, 568
New Macro, 120
Notes, 219, 255
Notification Area, 180, 400
Num Lock Key, 319

O
Open Folder, 278, 279, 280
Open Web Page, 317
Open Window, 545
Operating System Version, 370, 481
Or, 339
Order Information, 582
OS Version, 370, 481
Overview, 9, 150

P
Pack File, 191
Password, 138, 217, 390
Pause, 437
Pause a Running Macro, 186
Ping, 313, 372
Pixel Color, 424
Play Back Sound, 402, 405
Play Video Clip, 404
Playable Macro, 115, 119
Playback Speed, 184, 386, 435
Pop Up Menu, 33, 244, 246, 248, 251, 254, 255
Portable Version, 584
Position Windows, 565
Power Off, 433
Print Macro List, 118
Printer, 421
Process Stop, 543
Process Text File, 281, 293
Program Configuration, 196, 197
Program Defaults, 195
Program Launch, 537
Program Shutdown, 539, 543

Q
Quick Wizards, 32, 124

R
Read Only, 169
Reboot Computer, 433
Recapture Macro, 128
Record Macro, 28, 30, 123, 173, 234
Registry Key, 410
Registry Values, 411
Reload Macro Preferences, 391
Remap Keyboard, 182, 199
Remarks, 380
Remove Macros, 383
Rename Files, 290
Rename Folders, 290
Repeat Commands, 414, 415, 419, 420
Repeat Exit, 420
Reposition Window, 551, 553
Reset Hooks, 391
Resize Window, 556, 565
Restart Macro Express, 391
Restore Macros from Backup, 577
Restore Variables, 496
Restore Window, 265, 558
Rich Text, 321, 327
Run a Macro, 60, 96, 98, 101, 130, 72, 74, 94, 244
Run Macro in Variable, 482

S

Save Variables, 497
Scheduled Macro, 74
  Creating a Scheduled Macro, 26
  Daily, 82
  Hourly, 80
  Monthly, 86
  Once, 78
  Specified Time Elapsed, 90
  System Idle, 88
  Weekly, 84
    When Macro File Loaded, 92
    When the Program Starts, 76
Scopes, 35, 215, 251
Screen Saver, 144, 426
Script Editor, 155
Scroll Lock Key, 319
Security, 138, 217, 390
Select Macro Activation, 120
Select Program, 560
Select Window, 561
Set Focus to Control, 532
Short File Name, 287
Shortkeys, 24, 72, 146
Show Window, 559
Shut Down Computer, 433
Shut Down Program, 539, 543
Size Window Borders, 434
Slow Down Macro, 184, 435, 439
SMTP Settings, 160
Sound File, 405
Speed, 439
Start a Macro, 60, 72, 74, 94, 96, 98, 101, 130, 244
Start a Program, 533, 535, 537
Startup Options, 189
Stop a Macro, 102, 186, 387
Stop Process, 543
String Macros Together, 388
String Variables, 46, 491, 513
Support, 581
Suspend Computer, 433
Switch Statements, 342
Symbols, 321
System Date and Time, 427, 429
System Idle Schedule, 88
System Macros, 103
System Tray, 180, 400

T
Temporary Macro, 237
Terminal Services Session ID, 430
Terminate Macro Express Function, 391
Terminate Process, 543
Text Box Display, 274, 277
Text File Process, 293
Text Type, 321
Text Variables, 46, 491, 513
Tile Desktop Windows, 265
Time, 427, 472
Time Elapsed Schedule, 90
Timer Interval, 144
Treble, 401

U
Undock Computer, 433
Unicode, 321
Uninstall Macro Express, 20
Upgrading, 583

V
Variable Overview, 460, 462, 468
Video Clip Playback, 404
View Menu, 141
Virtual Keys, 329

W
Wait for Commands
  Wait for Control, 440
  Wait for File to Be Ready, 442
  Wait for File to Exist, 443
  Wait for Folder to Exist, 444
  Wait for Key Press, 445
Wait for Mouse Click, 447
Wait for Mouse Cursor, 448
Wait for Not Mouse Cursor, 449
Wait for Program Terminate, 450
Wait for Text, 451
Wait for Text Playback, 452
Wait for Time to Elapse, 453
Wait for Web Page to Load, 454
Wait for Window Title, 456
Wait for Window Title to Lose Focus, 458
Wallpaper, 431
WAV File, 405
Web Mailto, 316
Web Page, 317
Window Focus, 545
Window Order, 541
Window Position, 551, 553
Window Size, 551, 556
Windows API, 56
Windows Dialogs, 429
Windows Explorer, 278, 279, 280
Windows Registry, 410, 411
Windows Terminal Services, 430
Wizards, 32, 124, 238, 239, 240, 242
X
XOr, 339